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1. EasyBuilder Pro Installation

and Startup Guide

This chapter explains how to install EasyBuilder Pro.

1.1.  Installation REQUIFEMENTS.......cceeiiiiieee e e e e e e e s snrranneeeeeas 1-2
1.2.  Steps to Install EasyBUIlAEr Pro ......eeeeeeiii ettt e e e e e e ee e 1-3
1.3.  Software Update REMINAET .....ccooiiiieeceee et e e e e e e e eaar e e e e 1-7
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1-1. Installation Requirements

Software:

Download EasyBuilder Pro from the CD or visit the Omniflex website at
http://www.omniflex.com/easyview.php. and download the installation package which
include the following languages: Simplified Chinese, Traditional Chinese, English,
Japanese, German, Italian, Korean, Spanish, Russian, French, Polish, and Turkish. The

latest updates can be downloaded too.

Operating System:

Windows® 7 SP1 (32bit / 64bit)
Windows® 8 (32bit / 64bit)
Windows® 8.1 (32bit / 64bit)
Windows® 10 (32bit / 64bit)

N WE!NTEK FasyBuilder Pro V6.07.02
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1.2. Steps to Install EasyBuilder Pro

1. Click [Install] and select the language for the installation process, and then click [Next].

15! Setup - EasyBuilder Pro V6.05.02.200 o @

Welcome to the EasyBuilder Pro

@ V6.05.02.200 Setup Wizard

This will install EBpro V6.05.02.200 on your computer.

Itis recommended that you close all other applications before
continuing.

Click Next to continue, or Cancel to exit Setup.

{ Next > ‘ [ Cancel ]

2. Ifthereis a previous version of EasyBuilder Pro on the PC, please remove it before
installation.

3. Please read and accept the License Agreement before continuing.

15! Setup - EasyBuilder Pro V6.05.02.200

\=d

E=3Ec)

License Agreement
Please read the following important information before continuing. C

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

GENERAL TERMS ("The Terms”)

Version 2.0
March 2019

1. OWNERSHIP AND ABOUT THE TERMS

1.1 cMT Viewer, EasyBuilder Pro, EasyConverter, EasyDownload, EasyDiagnoser,
EasyLauncher, EasyPrinter, and Utility Manager software ("Weintek Software”) is
developed by Weintek Labs., Inc. ("Weintek™), and the authorized user will be
granted for license to operate it exdusively on Weintek's specific products Y

9 I accept the agreement

() I do not accept the agreement [ Third-party Licenses... ]

[ < Back ][ Next > ][ Cancel ]

4. Select a folder for EasyBuilder Pro installation, or use the default folder. Click [Next].
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5.

6.

I__| WE!NTEK

Select a

i

15! Setup - EasyBuilder Pro V6.05.02.200 =&

Select Destination Location H
Where should EasyBuilder Pro V6.05.02, 200 be installed? C

J Setup will install EasyBuilder Pro V6.05.02.200 into the following folder.

To continue, dick Next. If you would like to select a different folder, dick Browse.

C:\EBpro Browse...

Atleast 1,685.8 MB of free disk space is required.

[ < Back ][ Next > ][ Cancel ]

start menu folder, or use the default folder. Click [Next].

r[fg’.‘ Setup - EasyBuilder Pro V6.05.02.200 =l

==
Select Start Menu Folder ‘
Where should Setup place the program's shortcuts? C

8

[v
L] Setup will create the program's shortcuts in the following Start Menu folder.

To continue, dick Next. If you would like to select a different folder, dick Browse.

EasyBuilder Pro Browse...

[ < Back ][ Next > J[ Cancel ]

Select additional tasks, for example: [Create a desktop icon]. Click [Next].

EasyBuilder Pro V6.07.02
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7. Confirm

8. Installat

I__| WE!NTEK

15! Setup - EasyBuilder Pro V6.05.02.200

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing EasyBuilder
Pro V6.05.02.200, then dick Next.

Additional icons:

[V] Create a desktop icon

[ < Back ][ Next > ][ Cancel ]

all setting. To change the setting, click [Back]. To start installation, click [Install].

15 Setup - EasyBuilder Pro V6.05.02.200 = B [

Ready to Install H
Setup is now ready to begin installing EasyBuilder Pro V6.05.02.200 on your C

computer.

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Destination location: -
C:\EBpro

Start Menu folder:
EasyBuilder Pro

Additional tasks:
Additional icons:
Create a desktop icon

< Back ][ Install ] [ Cancel

ion in progress.
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LSS

1

15! Setup - EasyBuilder Pro V6.05.02.200 =

Installing
Please wait while Setup installs EasyBuilder Pro v6.05.02.200 on your computer.

Extracting files...
C:\EBpro\firmware\opcua.c30

| E | 3

Cancel

9. Click [Finish] to complete the installation.

_BJ Setup - EasyBuilder Pro V6.05.02.200 ol @ | &R

Welcome to the EasyBuilder Pro

C‘@ V6.05.02.200 Setup Wizard

Setup has finished installing EasyBuilder Pro v6.05.02,200 on
your computer. The application may be launched by selecting
the installed icons.

Click Finish to exit Setup.

| Finsh |

10. The EasyBuilder shortcut can be found in [Start] » [All Programs] » [EasyBuilder Pro].

The description of each item in EasyBuilder Pro menu:

Installed file Description

Administrator Tools Saves User Accounts, USB Security Key, e-Mail SMTP
Server Setting, e-Mail Contacts to an external device
(USB drive or SD card) so that the data become
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portable and can be imported to HMI.

cMT Viewer

Supports access to cMT / cMT X Series HMI via
network, for operating cMT / cMT X Series HMI on
PC.

Easy Access

Supports access to remote HMI by connecting

EasyAccess server over Internet.

EasyBuilder Pro

EasyBuilder Pro project editor.

EasyConverter

Conversion tool for Data Sampling and Event Log.

EasyDiagnoser

Monitoring and debugging tool operated on HMI.

EasyPrinter

Allows exporting data to a remote server on PC via

Ethernet, realizing remote printing / backup.

EasySimulator

Executes simulation.

EasySystemSetting

Allows updating hardware system settings by using
SD card or USB drive.

EasyWatch

An easy to use debugging and remote monitoring
tool running on PC that allows monitoring or setting

HMI and PLC addresses and executing macro.

Recipe Editor

Tool for setting the format of Recipe data. Users can
open Recipe data or the data in the External

Memory.

Release Note

Software release notes.

UtilityManagerEx

EasyBuilder Pro management tool.

‘@ Note

Certain HMI supports downloading/uploading projects via USB cable. After installing
EasyBuilder Pro, the USB driver will be automatically installed. A message saying
“Windows can’t verify the publisher of this driver” may show, please continue anyway.
After installing the USB driver, open [Computer Management] » [Device Manager] to

check if installation succeeded.

1.3. Software Update Reminder

After launching EasyBuilder Pro, the system will check whether the latest version has been

installed, and show a reminder dialog if there is a newer version.

L—| WE!NTEK
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Software Update >

EI A new version of EasyBuilder Pro is avaliable.

EasyBuilder Pro w6.05.02 200 is now avaliable. Would you like to
download it now?

Remind Me Later™ | |Download Mow

After clicking [Download Now], the latest version of EasyBuilder Pro will be downloaded to a
temporary folder, and a progress bar is shown as below. After download, please follow the
steps explained in the previous section to install EasyBuilder Pro.

b3 casyBuilder Pro Downloading — >

downloading. ..

[ 2%

Cancel

@ Note

B Please note that the Software Update reminder cannot be turned off permanently. It may
be rescheduled to one day or one week later.

Users can open File » About in EasyBuilder Pro to see current version and check for updates.

About EasyBuilder Pra x

EasyBuilder Pro V56.05.02. 180 Build 2021.01.18
| bl Copyright ¢ 2006 Weintek Lab. , Inc.

All rights reserved

Licenses 4 sreement. .
Third-paty Licenses... Check for updates... i 0K
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2. Utility Manager

This chapter explains how to use Utility Manager.

2.1, OVEIVIEW cciiieitettte e e e ettt e e e e e sttt e e e e e s e nb bttt eeeeeesaannrbeaeeeeeesasnnbrebeeeeeeeeanannnrreas 2-2
A 1 T I -{ o E TR 2-3
2 T N =Y A g <A 1= o oY - RS 2-4
2.4, PUDBIISN e e e e s e e s e e s araeeas 2-6
D TR |V, = Y1 01 (T o = [ < OSSO PP PP PPPPPPPPPPPRPN 2-10
2.6, Data CONVEISION....ciiiiiiiiieiietttee et ettt e e e e e e ettt et e e e e e s e saabbteeeeeeesesannnrbeeeeeeeesennns 2-12
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2.1. Overview

After installing EasyBuilder
start. Utility Manager is for

Pro, double click [UtilityManagerEx] shortcut on the desktop to

launching several utilities and it is a stand-alone program. Please

select a model first and note that certain features may not work as expected if an incorrect

model is selected.

Utility Manager
> lloT Gateway Series

[ select Model >

Design

Analysis &
Testing

Publish

Maintenance

BEIE]
Conversion

| Run ® l Edit®

@0

TK Series
S
@
E P Series ,, the HMI screen

projects.

=z | IE Series
; /iewer
v eMT Series svices (or related
- )sponding operable PLC

nats.

:}'il XE Series
cMT Series )y On-line Simulation @

mulation (without PLC).
cMT X Series - Standard

= B cMT X Series - Advanced

2-2

Utilities

Description

Minimize Utility Manager window.

Close Utility Manager.

v

Add the frequently used utilities to the toolbar at the bottom of the

window.

Run

Run the selected utility on the toolbar.

Edit

Delete the selected utility on the toolbar.

[\& WE!NTEK
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2.2. Design

Run ® Edit®

Design

Analysis &

Testing

Publish

Maintenance

Data
Conversion

EasyBuilder Pro @

Launch EasyBuilder Pro, the HMI screen
composer/editor, to edit projects.

1

EasyAddressViewer @

Show supported PLC devices (or related
devices), and their corresponding operable
PLC address ranges and formats.

Simulation

Simulate a HMI on PC by On-line Simulation
(with PLC) or Off-line Simulation (without PLC).

2-3

Utilities

Description

EasyBuilder Pro

Launch EasyBuilder Pro to edit projects.

EasyAddressViewer

Review the address ranges and formats of supported PLCs.

Simulation

Simulate an HMI on PC by running On-line Simulation or Off-line
Simulation. Please select an .exob / .cxob file as source first.
Off-line simulation: Simulate project operation on PC without
connecting any devices.

On-line simulation: Simulate project operation on PC and PLCs are

directly connected with PC.

0 Note

B When using [On-line simulation] on PC, if the target device is a
local PLC (the PLC directly connected to PC), there is a 10

minutes simulation limit.

[\& WEINTEK
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2.3. Analysis & Testing

Utility Manager
> lloT Gateway Series

[ select Model >

Analysis &
Testing

Publish

Maintenance

Data
Conversion

©0
|

cMT Diagnoser

On-line monitoring and debugging tool. Diagnose
the connection status between PC/HMI and PLC.

EasyWatch

A debug/monitor tool that monitors HMI/PLC
addresses, or execute macro on HML.

o

Reboot

Restart a HMI to its initial condition by Ethernet or
USB connection.

o

2-4

Utilities

Description

cMT Diagnoser

A diagnostic tool that can monitor data and status of all objects in
the current window when it is connected to a cMT Series HMI,
show the status of individual communication packet, show
communication status with MQTT server, and debug macros.

E25_T‘See “31 cMT Diagnoser”.

EasyDiagnoser

Diagnoses the connection status between eMT/iE/XE/mTV HMI and
PLC.

@See “33 EasyDiagnoser”.

EasyWatch

Allows users to monitor or configure HMI or PLC address values via
Ethernet on PC.

C?See “35 EasyWatch”.

Reboot HMI

Reboots the HMI without unplugging. After reboot, the system
returns to the initial state.

Serial Pass-Through

Opens a local serial port (virtual/physical) and allow other PC

[\& WEINTEK
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applications to connect to PLC via HMI.

The Serial Pass-Through feature provides two modes: Ethernet and
COM port.

Before using [Ethernet] mode, please check if virtual serial port

driver has been installed.

@See “29 Pass-through”.

Ethernet
Pass-Through

When PC and PLC are respectively connected to different Ethernet
ports of a Dual-port HMI, this feature allows running the
application on PC to control PLC through HMI. This feature is only
supported on ctMT / cMT X Series models.

Cf’See “29 Pass-through”.

Pass-through feature allows the PC application to connect PLC via HMI. In this case, the HMI

works like a converter.

[\& WEINTEK
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2.4. Publish

Utility Manager
> lloT Gateway Series

[ select Model >

Design

Analysis &
Testing

Publish

Maintenance

BEIE]
Conversion

o | e (I

@0

Download
Download given files from PC to HMI, such as |

firmwares, project, recipes, data log, or startup
screen.

Upload
Upload data from HMI to PC, such as project,

recipes, event logs, operation logs, data logs, or
extended memory (EM).

2-6

7|
Utilities Description

Download Downloads project file to HMI via Ethernet or USB cable.

Upload Uploads files on HMI to PC via Ethernet or USB cable.

Build Download Builds the data to be downloaded to HMI in an SD card / USB drive.
Data for SD/USB For cMT / cMT X Series, the data needs to be built in EasyBuilder
Disk Pro.

[\& WE!NTEK
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2.4.1. Download (PC->HMI)

Download files to HMI via Ethernet or USB cable.

eMT, iE, XE, mTV Series

cMT, cMT X Series

Download (PC->HMI)

7] System settings PLEASE INPUT A SYSTEM SETTINGS NAME !

[V]Runtime (firmware) [VImarT " Diagnostic tool [~ usB audio driver
] Project PLEASE INPUT EXOB FILE NAME !

VIrRW PLEASE INPUT RECIPE FILE NAME !

“IRw_A PLEASE INPUT RECIPE_A FILE NAME !

[7|Recipe database PLEASE INPUT RECIPE DATABASE FILE NAME !

[V] Startup sareen PLEASE INPUT LOGO FILE NAME !

Download (PC->HMI)
Comnecton
(®) Ethernet () UsB cable
4| T A e
Browse...
HMI: | cMT3080-FAE ~
—
Search All
Bearch and Change IP
[MProject | c:\usersipina\Desktop \EBProject 1.cxob =]
[Praject Chedksum : 55022 54360ed3eb 10331200359 2ch443 |
owse...
[ZRuntime (firmware)
Mrw [PLEASE INPUT RECIPE FILE MAME 1
MRw_A [PLEASE INPUT RECIPE_A FILE NAME |

|| Delete existing user accounts, e-Mail contacts and SMTP settings

Port No. Setting...

Password : 111111 [T Mask

o o)

[“IRedipe database [PLEASE INPUT RECIPE DATABASE FILE NAME |
[“startup screen [PLEASE INPUT START-UP SCREEN FILE MAME !
[[Juse system settings file
Connection -
(©) Ethernet 2 USB cable [ADelete existing user accounts
4 P HMIName »| [V Delete existing e-Mail contacts and SMTP settings
[ M- < [1921682.142 (HMI-0396) Reset recipe (RV, RWW_A) Reset recipe database [“IReset operation log
192.168.2.223 (HMI-EDFA) Reset event log Reset data log Reset string table
192.168.2.231 (MT8090XE-FAE) R m e = GE)
——
CODESYS
[|Reboot HMI after download [~ Ssynchronize HMI dlock with PC ["IDelete startup screen BEhect [PLEASE NPUT CODESYS PROJECT FILE NAME ! =
["]Reset recipe (RW, RW_A) [¥]Reset data log [7]Reset eventlog
["]Reset recipe database [¥]Reset operation log [¥]Reset string table

Port No. Setting...

Password : 111111 [(Imask

Setting

Description

Project

Select an .exob or .cxob project file. For a cMT /
cMT X project, the Project Checksum will be
shown under the directory of the project for
users to check whether the project file has been

tempered with.

Runtime (firmware)

Update HMI kernel programs. The firmware
must be downloaded at the first time

downloading data to HMI.

MQTT

If MQTT is used in the project and HMl is the
broker, this checkbox must be selected before

download.

Diagnostic tool

Enable the diagnostic tool to send diagnostic
data to the developers when an error occurs for

quick troubleshooting.

USB Audio Driver

Enable audio output on HMI so it can

immediately emit a sound when a USB sound

I__| WE!NTEK
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card and a speaker are connected.

RW /RW_A

Select an .rcp recipe file.

Recipe database

Select a .db file of Recipe Database.

Startup screen

Download a .bmp file to HMI. After HMl is
rebooted, this .bmp file will be shown before
project starts.

Use system settings file

Select a .conf system settings file.

Reboot HMI after
download

Automatically reboot after download.

Port No. Setting

Select the port by which to download the

project file via Ethernet.

Synchronize HMI clock
with PC

Synchronize HMI time with PC time when
downloading project file.

Reset recipe / recipe
database / event log /
data log / operation log
/ string table / OPC UA
history (HDA) / startup
screen / Delete existing
user accounts, e-Mail
contacts and SMTP
settings

Erase the selected files on HMI before
download.

CODESYS

Use Utility Manager to download CODESYS boot

project.

2.4.2. Upload (HMI->PC)

Upload files from HMI to PC via Ethernet or USB cable. Click [Browse] and assign the file path

before uploading.

eMT, iE, XE, mTV Series cMT, cMT X Series
S B [ pion PO
Connection
Project PLEASE INPUT EXOB FILE NAME ! @ Ethermet O usn cable
W PLEASE INPUT RECIPE FILE NAME |
RW_A PLEASE INPUT RECIPE_A FILE NAME ! 4] IP HMI Name
Recpe database PLEASE INPUIT RECIPE DATABASE FILE NAME | HMI - o
Cperation log PLEASE INPLIT OPERATION LOG FILE NAVE |
Datalog PLEASE INPUT DATA LOG FOLDER NAME | Search
Eventlog PLEASE INPUIT EVENT LOG FOLDER NAME | Search All
Use CSV (Comma Seprated Values) format to save data/event log files. Search and Change IP hd
Extend Memery (EM)  PLEASE INPUT EM FOLDER NAME !
EM file location : (7 5D card © UsB disk [Project
| c:\sersiuser \Desktop|\cMT3090.cx0b [
History
Redpe Recipe database
Comnection Event log Data log Operation log
© Ethernet ©) UsB cable
| e ol [C:\sers\userlDeskiop 6]
HMI: -
Password : 111111 [Mask [ e ] Port No. Setting... Password : [ mask Upload Exit
| l WE!NTEK EasyBuilder Pro V6.07.02
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Setting Description

Event log Upload the .evt file on HMI to PC.

Extended Memory Upload the .emi file saved in SD card or USB disk
(EM) to PC.

or For information about [Project], [RW / RW_A], [Recipe database] or [Data log], see “2.4.1

Download” in this chapter.

0 Note

B The file will be uploaded to PCin .exob / .cxob format. Please decompile it into

editable .emtp / .cmtp file first and open the .emtp / .cmtp file in EasyBuilder Pro.

B To upload the historical files saved in the external device, please use FTP. See “32 FTP

Server Application” for more information.

2.4.3. Build Download Data for SD/USB Disk

Build Download Data for SD/USE Disk

Select the folder to save download data :

PLEASE INPUT DIRECTORY NAME !

Sources
Project
PLEASE INPUT EXOB FILE MAME !

Browse...

Browse...

Redpe (RW)
PLEASE INPUT RECIPE FILE NAME !

Browse...

Recipe A (RW_A)
PLEASE INPUT RECIPE_A FILE NAME !

Browse...

Data log
PLEASE INPUT DATA LOG FILE NAME !

Browse...

User-defined startup screen

PLEASE IMPUT START-UP SCREEN FILE MAME !

[ Build ]

Browse...

g LR ! )

Exit

Insert an external device (SD card or USB drive) to PC.
Designate the directory to save data.

Browse for the directory of the source files.

A W NR

Click [Build] to create download file.

Files will then be saved to the inserted device for users to download to HMI without having to

use a USB cable or Ethernet.
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2.4.4. Steps to Download Project to HMI via USB Disk or SD Card

To download data in a folder (e.g. a folder named “123” (K:\123)) in a USB disk.
1. Insert USB (in which the project is saved) to HMI.

In [Download / Upload] dialog box select [Download].

2
3. Enter Download Password.
4. In [Download Settings] dialog box, select [Download project files] and [Download history

files].
5.  Press [OK].

6. In [Pick a Directory] dialog box, select directory: usbdisk\disk_a_1\123.

7. Press[OK].

Project will then be updated.

0 Note

B If history data is downloaded but not the project file, please reboot HMI to update files.

2.5. Maintenance

Options in this tab may vary according to model.

Utility Manager
> cMT Series

[ select Model >

Analysis &
Testing

Publish

Maintenance

Data
Conversion

Administrator Tools

Build user account and mail setting files in a USB
drive/SD card without modifying project file, and
then transfer them to HMI by USB/SD.

cMT Viewer

Connect to a cMT-SVR machine. PC acts as a
display terminal for cMT-SVR.

cMT-iV5/iV6 Firmware
Update

Update firmware on cMT-iV5/iV6

|

o

o

2-10

Utilities

Description

Administrator Tools

Allows saving the data of [User Accounts], [USB Security Key],

[\& WEINTEK
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[e-Mail SMTP Server Settings], and [e-Mail Contacts] to USB.
C?See “36 Administrator Tools”.

cMT Viewer

cMT Viewer can connect to a cMT / cMT X Series model. PC is the
display terminal for cMT / cMT X project.

cMT-iV5/cMT-iV6
Firmware Update

Updates cMT-iV5/iV6 runtime (firmware) or OS.

cMT-Server OS
Update

Updates cMT-SVR/SVR-200 OS.

cMT-Gateway/CTRL
OS Update

Updates cMT-Gateway/CTRL OS.

CODESYS Firmware
Upgrade

Updates CODESYS firmware on cMT HMI.

SSL/TLS Certificate
Upgrade

Upgrades the built-in expired SSL/TLS certificate on HMI.

HMI Information
Collector

Obtains a file with diagnostic information from HMI.

EasyPrinter /
Backup Server

Runs remote backup/printer server on PC.

Data/Event log
Information

Connects with HMI via USB cable or Ethernet to check the number
of history files on HMI. This feature is not supported on cMT / cMT

X Series.

Data/Event Log File Infermation @

i [=-sample_HMI

- 1.20130826.dtl
- 2,20130825.dt
- 3.20130824.dt
- 4,20130822.dt
- 5.20130821.dt

[# GreenHouse

E| event log

-1, EL_20130830.evt
-2, EL_20130826.evt
-3, EL_20130809.evt

EasyAccess 1.0

Supports access to remote HMI by connecting EasyAccess server

over Internet. You can find more information at: www.ihmi.net

@ Note

B HMI Information Collector is available only on cMT / cMT X Series models, and the

applicable OS version is 20210705 or later.

I__| WE!NTEK
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2.6. Data Conversion

Utility Manager
> iE Series

[ select Model >

Design

Analysis &
Testing

Publish

Maintenance

BEIE]
Conversion

@0

Recipe Database Editor @

Modify recipe database (without modifying the
project directly).

EasyConverter @

Convert HMI-generated data logs (.dtl), event
logs (.evt) into Excel-compatible .csv files.

Recipe Editor @

Create/modify recipes (RW, RW_A) or extended
memory (EM).

2-12

Utilities

Description

Recipe Database
Editor

Edits recipe data.
A

Click the icon to download the document about Recipe

Database.

Easy Converter

Reads HMI-generated data logs, event logs, and operation logs and

converts the files to Excel (.xlsx) format.

C?See “25 EasyConverter”.

Recipe Editor

Creates new recipe data to be used on HMI and modifies the
existing recipe data.

L/—?See “24 Recipe Editor”.
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Create an EasyBuilder Pro Project

3. Create an EasyBuilder Pro

Project

This chapter explains the basic steps to create an EasyBuilder Pro project.

3.1 OVBIVIEW ceieeeteteeee ettt et e e e ettt e e e e e s e b bbbttt e e e e e s e anbbe e e e e e e e s e nbbbteeeeeeeeaaannrreas 3-2
3.2, Create @ NeW ProjeCt FIle ...t e e e e e 3-2
3.3. Save and Compile the Project File ...t 3-4
3.4.  Run On-Line or Off-Line SimuUlation........ccccoviiiiiiiiiiiiecieccecce e 3-5
R T of Y, W BV T Y= U PP U PP PPPPPP PP 3-5
3.6. Download the Project File to HMI .......ovviieiiiiieeee et 3-6
3.7.  Upload the Project File from HMI.........ccoooiiiiiiiiiiee et 3-13

I__| WE!NTEK EasyBuilder Pro V6.07.02



Create an EasyBuilder Pro Project

3.1. Overview

The following is the process of creating a project.

1.
2.
3.
4.

Create a new project file.
Save and compile the project file.
Run On-line or Off-line simulation.

Download the project file to HMI.

The following describes each process.

E Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.

3.2. Create a New Project File

1.
2.

3.

Launch EasyBuilder Pro and open a new project file.
Select a model and select [Use template] check box.

‘ O New  New Project

‘ i 7?“" | Model: | 4 @B iPSeries
MT6051iP (480 x 272)
MT8051iP (480 x 272)
MT6071iP/MT8071iP (800 x 480)
MT6103iP (1024 x 600)
MT8102iP (1024 x 600)
MT6102iQ (1024 x 600)

4 @ eMT Series
€MT3070 (800 x 480)

£eMT3105 (800 x 600)

eMT3120/eMT3150 (1024 x 768)
4 @ iE Series
MTB8050iE (480 x 272)
MT6070iE (800 x 480)
MT6071iE (800 x 480)
MT8070iE/MT8100iE (800 x 480)
MT8071iE/MT8101iE (800 x 480)
MT8073iE (800 x 480)

mn

[¥] Use template (template_800x600.emtp)

eMT3105

Orientation :

[ Portrait

[Uncompress Pche:t] I.L, Demo Prc}e(tJ

Click [New] button in the Device tab and select a device.
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.
System Parameter Settings 3
| PrinterBackupServer |  TimeSyne/DST | eMeil | Recipes |  Cellular Data Network
Device | Model | Gemeral | SystemSetting | Security | Non-ASCIIFonts | Extended Memory
Device list : What's my IP ?
Name Location  Device type Interface IIF Protocol

(3 Local HMI Local HMI lLocal  [em73105(800..[- |- |

< | m »

[ New... J [ Delete ] [ Security... ]

4. Configure parameters.

Device Properties

MName :  Mitsubishi FX0S/FXON/FX1S/FX1N/FX2

) HMI @ PLC
PLC type : | Mitsubishi FEOS/FEON/FE 1S/FE LN/FH2 |

IV.1.4U, MITSUBISHI_FXOM.e30

PLCIF : [R5485 4W -

* Support communications between HMI and PLC in pass-through mode
* Set LW-9903 to 2 to enhance the speed of download/upload PLC program in pass-through mode

COM : [COM1 (9600,E,7,1) Settings...

PLC default station no. : g

[] Default station no. use station no. variable

[7] Use broadcast command

Interval of block pack (words) :

Max. read-command size (words) @ |32

Max. write-command size (words) : |22

[ OK ] l Cancel
5. A new device is added to the [Device List].
“:System Parameter Settings ==
| Printe/Backup Server I Time Sync /DST I e-Mail I Recipes I Cellular Data Network
Device | Model | Genersl | SystemSetting | Security | Non-ASCIIFonts | Extended Memory

Device list : What's my IP ?

No. Name Location Device type Interface I/F Protocol
] Local HMI Local eMT3105 (800 -

s I o = T e

6. Create an object, for example, a Toggle Switch, and then set the address.
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 New Toggle Switch/Bit Lamp Object

General | Security | Shape | Label |

Comment :

~) Bit Lamp @ Toggle Switch

[V] ReadMWrite use different addresses

Read address
PLC: [Mimbi.shi FEOS/FEONFEISFELINFELZ v] Settings...
Address : [X v] 0 fi
[ Invert signal
Write address :
PLC: [Miwubishi FEOSFEONFEISFEINFLZ v] Settings...
Address [y ,J 0 [
[} Write when button is released
Attribute

7.  Place the object in the edit window. A project is now created.

EasyBuilder Pro : EBProjectl - [10 - WINDOW,_010]
File HE« »
"@’ B LR =R RORE - B=N—1-1

— — o0 =] v
System i 28=E S =
Parameters S OG|F
Editing Object

GEIGEM Project  Object  Data/History View  Tool

Paste

Clipboard Arrange

=

- 8 X &

AdobeDevanagari: ~ |5

Ao Z A= T

A L1 L2 13 L4(1

S1|S2 s3 s4|1

Font State/Language

Windows v X ( 10 - WINDOW_ 010 x

>

Object list -

I|I|I|I|I|I|x|I|I1MI|I|I|x|I|I|Ill|IlloﬁllllI|I|I|I|I|l|I;lxliIllllllll|l|l|l|ml|l|l

- T T

3 : Fast Selection
4 : Common Window @
5:PLC Response
6 : HMI Connection
- 7 : Password Restriction
- 8:Storage Space Insufficient
i 9:Backup
#10: WINDOW_010

P )

24 =
R ] P——— Y

m

-
o

[ poo poo |ioo |

bbb bbbt bbb b Db b b b b b b b D b b b b B b b bbb bbb

[Address | windows [Web [

3.3. Save and Compile the Project File

1. In EasyBuilder Pro toolbar click [File] » [Save] to save the .emtp file.

2. In EasyBuilder Pro toolbar click [Project] » [Compile] to compile .emtp file as .exob file,

which could be downloaded to HMI. This also checks if the project can run correctly.

[\& WEINTEK
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0 Note

B For cMT / cMT X Series models, the project file extension is .cmtp, and the compiled file

extension is .cxob.

3. To use multiple languages, all languages must be configured in Label Tag Library first.
When downloading the project to HMI, select the needed languages only. A successful

compilation is shown in the following figure.

Compiling @I
Project name : C:\Users\user\Desktop\EMTP2.emtp
EXOB file name : C:\Users\user\Desktop\EMTP2.exob
EXO0B password : (used in decompiler) [l Decompilation is prohibired
Select the languages used on the HMI
Startup language after redownloading the project : |Language 1 -
[#] Language 1 [#]Language 2 [#]Language 3 [¥#]Language 4 [¥lLanguage 5 (¥ Language 6
Language 7 [¥|Language 8 Language 9 Language 10 Language 11 Language 12
Language 13 Language 14 Language 15 Language 16 Language 17 Language 18
Language 19 Language 20 Language 21 Language 22 Language 23 Language 24
Mote : A maximum of 8 lBnguages can be selected simultaneously.
Double click error messages to modify the attributes of relative objects !

3.4. Run On-Line or Off-Line Simulation
F!I!l!
'_x

any device.

Fm

>

Off-line simulation: Simulate project operation on PC without the need for connecting

On-line simulation: Simulate project operation on PC without downloading the project

to HMI. The PLC is connected to PC, please set correct parameters.

0 Note

B When using On-line Simulation on PC, if the target device is the PLC directly connected to

PC, there is a 10-minute simulation limit.

3.5. cMT Viewer

This program connects to cMT Series models via network. To run this program, execute

I__| WE!NTEK
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cMTViewer.exe under installation directory. Or, in EasyBuilder Pro toolbar, click [Tools] » [cMT
Viewer].
E Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.
E MT Viewer [=[E] =]

2017-02-09 19:21:24

3.6. Download the Project File to HMI

The following explains four ways to download the project file to HMI.

@ Note

B For cMT-SVR, only the way described in 3.6.1 is available.
B When download project file to HMI using mini USB cable, please do not connect PLC

simultaneously, in order to avoid noise from PLC interfering with HMI.
E Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.
3.6.1.  Configure in EasyBuilder Pro

1. In EasyBuilder Pro toolbar, click [Project] » [Download]. Make sure that all the settings are
correct.
2. Select [Ethernet], set password and HMI IP.

EWE!NTEK EasyBuilder Pro V6.07.02
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1P 192.168.1.100 -

Download @
(@ Ethernet () USB cable Password/Port no. of download/upload :
4 7 P HMI Name I

W hat's ey IF 7
Font files
Runtime * Mecessary if update runtime or execute download first time.
ry it up
Use user-defined startup screen
File location :
Use system settings file =
Synchronize HMI clock with PC
Delete existing user accounts, e-Mail contacts and SMTP settings
9 9
[ Delete user-defined startup screen
[¥] Reset recipe |#] Reset event log |¥] Reset data sampling
[¥] Reset recipe database [#] Reset operation log [ Reset string table

[/] Reboot HMI after download
[] Automatically using current settings to download after compiling

Setting Description
Font files Download the font used in the project to HMI.
Runtime

Select the check box to update the HMI kernel
programs. If this is the first time downloading file or
EasyBuilder Pro version is updated, please download

the firmware before downloading files to HMI.

EasyAccess 2.0

Download EasyAccess 2.0 driver to HMI. (This option
is available only for MT8000iE models. For other
models, EasyAccess 2.0 will be automatically

downloaded.)

Use user-defined
startup screen

Download the selected .bmp picture to HMI as the

startup screen.

Use system settings
file

Download the system settings file to update

hardware settings.

Synchronize HMI
clock with PC

Synchronize HMI time with PC time when
downloading project file.

Delete existing user
accounts, e-Mail
contacts and SMTP
settings

Select the check box to delete existing user
accounts, e-Mail contacts or SMTP settings before

downloading the project. This setting is only

L—| WE!NTEK
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effective when one of the following settings is

enabled:

1. [System Parameters] » [Security] » [Enhanced
security mode] » [Use existing user accounts on
HMI first (if existed), Othrewise, use settings
below].

2. [System Parameter s] » [e-Mail] » [Use existing
user accounts on HMI first (if existed),

Othrewise, use settings below].

Reset recipe/

event log/

data sampling/ ' _

recipe database/ The selected files will be erased before
operation log/ downloading.

string table/
user-defined
startup screen

Reboot HMI after HMI will reboot after the downloading process is
download

done.

Automatically
using current
settings to to the latest target HMI. The way to enable this
download after
compiling

The system will compile the project and download it

function is described in the following part.

[Automatically using current settings to download after compiling]

If this check box is selected, EasyBuilder Pro will compile the project and download it to the
latest target HMI.

1. In EasyBuilder Pro toolbar, click [File] » [Preferences].

2. Select [Automatic save and compile when download and simulate] check box.

I__| WE!NTEK EasyBuilder Pro V6.07.02



Create an EasyBuilder Pro Project

Preference
Project
Dopiy [¥] Automatically save and compile the project when download and simulate
Grid [7] Generate backup of project file before save
Library [] Automatically make used pictures and shapes into the project library

[] save AutoRecover information

[ OK J [ Cancel

3. In EasyBuilder Pro toolbar, click [Save] and then [Download)].

4. In the dialog box, select [Automatically using current settings to download after compiling]
check box.

5. Click [Download].

6. When finished, next time when [Download] is clicked, EasyBuilder Pro will automatically

compile and download the project to the latest target HMI.
3.6.2. Use HMI Name

1. Go to [System settings] on HMI and then set HMI name first.

.Systern settings

Netwcrk‘ Time,fDate" Securit  HMI mame¥eﬁing\gg\

HMI namel

i Cancel | | Apply |iok <!
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2. OnPC, select the HMI name and start downloading. To use [Search], enter the HMI name

first to search for the HMI. [Search all] searches for all HMIs in the same subnet network.

[V|Runtime *Necessary if update runtime or execute download first time.

[ Use user-defined startup screen

[ Use system settings file

[¥] synchronize HMI clock with PC

[ Delete user-defined startup screen
[7|Reset recipe
[7] Reset recipe database

[V|Reset event log
[V Reset operation log

[¥]Reboot HMI after download
[] Automatically using current settings to download after compiling

Download (==
@ Ethernet Password/Port no. of download/upload :
4 /. IP/ HMIName 3
T v /
HMI: ie7 v
Search All
[Z]Font files [V] Use EasyAccess 2.0 What's sy IP?

[¥] Reset data sampling
[V]Reset string table

I__| WE!NTEK
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3.6.3. Use USB cable

Download (==

@) USB cable Password : | Settings...

|7 Font files
[V|Runtime *Necessary if update runtime or execute download first time.

[ Use user-defined startup screen

[ Use system settings file

[ Delete user-defined startup screen
[7]Reset recipe [V|Reset event log (V] Reset data sampling
[] Reset recipe database [7|Reset operation log [V|Reset string table

[#]Reboot HMI after download

[~ Automatically using current settings to download after compiling

| Download Stop Exit

Select USB cable to download project to HMI. The way of setting is same as “3.6.1 Configure in

EasyBuilder Pro”. Before downloading via USB cable, please make sure the USB driver is

installed. Go to [Computer Management] » [Device Manager] to check if USB driver is installed.

If it is not installed, please refer to to install manually.

3.6.4. Use USB Drive or SD Card

The following explains how to download project file by using USB drive or SD card.
1.  On EasyBuilder Pro toolbar click [Project] » [Build for SD card / USB disk download].

Browse for the project file and then click [Build], the file for download will be generated in
the connected external device.

I__| WE!NTEK EasyBuilder Pro V6.07.02
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USB Disk/CF Card/SD Card Data ==

Select the folder to save download data :

)

Use system setting (OS5 version 20131106 or later supports only)
System setting file location =

’ Build ] l System Settings...
2. Insert an external device to HMI.
3. Select [Download] on HMI and enter password.
Download/Upload
— Pownioad settngs [
Upload Password: ||
Restart project and exit ‘
¥ Download project files
Load System Setting |7 Download history files
Cancel l_ Clear history files
Stop after download/upload . Cancel
Time remaining 4

4.  After password is confirmed, it will show the directories in the external device. (pccard: SD
Card; usbdisk: USB Drive)

pick abirectory P4
Directory: Jusbdisle/disk_a_1

=¥ pecard
usbdisk

oK /‘r Cancel

5. Select the directory that contains project, and then click [OK] to start downloading.

I__| WE!NTEK EasyBuilder Pro V6.07.02
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@ Note

B Please select the parent directory of the generated files when downloading. For the
structure above, please select disk_a_1, not mt8000ie.

B You may click [System Settings] to save the hardware settings configured in EasyBuilder
Pro into SD card or USB disk, and then download the settings file to HMI. See “4 Hardware
Settings” for more information.

E Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.

3.7. Upload the Project File from HMI

1. On EasyBuilder Pro toolbar click [File] » [Upload].
2. Set HMI IP, HMI model, project location and project name, and then click [Upload].
Upload @

@ Ethernet 71 USB cable Password/Port no. of download/upload :

4 P Name 2
IP: 192.168.1.100 -
What's oy [P 2
HMI model : | eMT3070 >
Project location : C:\EMTP1.exob

v
H
[

Upload
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Hardware Settings

4. Hardware Settings

This chapter explains HMI settings.

4.1, OVEIVIEW .eiiieieiiiiiiiieiteeee ettt e e e e e s ee e e e e e e s enreeeeeas
By B 1 L @ 1 >o Y o £ RO
4.3, LED INAICALOrS ..evveeiiiiieeeeiieee ettt
4.4, System ReSel.....uuuciieiiiiiiiiiiiiiieee et e e
4.5. System Toolbar.....ccoveeeeiiiecccec e
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4.1. Overview

4-2

This chapter discusses the HMI settings.

4.2.1/0 Ports

The I/0 ports may vary between models; please see the datasheet for more information.

The 1/0 Ports include:

® SD card slot: Allows downloading / uploading project file, including recipe data, event log,

data log...etc and also allows recording history data and data backup.

® COM Port: Connects PLC or other peripheral devices. The type of serial port include:
RS-232, RS-485 2W, RS-485 4W, and CAN Bus.

® Ethernet: Allows downloading / uploading project file, including recipe data, event log,

data log...etc. Connects to Ethernet devices, such as PLC, laptop.

® USB Host: Supports USB devices, such as mouse, keyboard, USB disk, printer, or barcode

device.

® USB Client: Allows downloading / uploading project file, including recipe data, event log,

data log...etc and also allows recording history data and data backup.

For the first time operating HMI, please complete the following system settings. When finished,

the project files designed using EasyBuilder Pro can be used on HMI.

4.3. LED Indicators

The LED indicators on the HMI indicate:
Models: MT8121XE, MT8150XE, MT8121iE, MT8150iE

LED

Description

PWR (Orange)

Indicates power status.

CPU (Green)

Blinks when read/write Flash Memory.

COM (Blue)

Indicates COM port communication status, blinks
during communication. When communication is
good, it may stay on. (Not including network

communication)

Other Models:

LED

Description

PWR (Orange)

Indicates power status.

CPU (Green)

Indicates CPU status. If it blinks or goes out, there

L—| WE!NTEK
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may be a CPU error.
COM (Blue/Red) Indicates communication status, blinks during
communication. When communication is good, it

may stay on.
4.4. System Reset

Certain HMI models are equipped with a reset button and a set of DIP switches. When using
the DIP switches to change modes, the corresponding functions will be triggered. If system
password is lost or forgotten, see the following steps to restore factory default.

1. Flip DIP Switch 1 to ON and the rest to OFF, and then reboot HMI. HMI will switch to touch
screen calibration mode.

2. A “+” sign appears on the screen, touch the center of the sign, after all 5 signs are touched,

+” disappears and the touch screen parameters will be stored in HMI system.

3. After calibration, confirm to restore the default password, select [Yes].

4. Confirm to restore the default password again by typing [yes] and clicking [OK]. The
project files and history records stored in HMI will all be removed. (The default Local
Password is 111111. However, other passwords, such as Download/Upload passwords
have to be reset.)

The following lists the DIP switch settings of different models. Please see the relevant

installation instruction.

cMT / cMT X / eMT / i

Dip Switch OFF Touch Screen Calibration Mode
AN OFF ON OFF OFF Hide HMI System Setting Bar
HHHH OFF OFF ON OFF  Boot Loader Mode
: OFF OFF OFF ON Reserved

OFF OFF OFF OFF Normal

@ Note

B The state of DIP Switch 4 on each unit may be different. If it should be ON when out from
factory, the Dip Switch 4 would be set ON and cut off. If it should be OFF, the Dip Switch 4
would be set OFF but the switch is not cut.

ON ON Restore factory default
ON  OFF Hide system setting bar
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mTV OFF ON Boot loader mode
Dip Switch OFF OFF Normal mode

e

cMT-SVR

Dip Switch ON ON Restore factory default
H B ON  OFF Restore Ethernet IP Settings
T B OFF  ON Boot loader mode
ON

OFF OFF Normal mode

4.5. System Toolbar

After rebooting HMI, you can set the system with [System Toolbar] at the bottom of the screen.
Normally, this bar is hidden automatically. Only by touching the arrow icon at the bottom-right
corner of the screen will the System Toolbar pop up. From left to right the icons are: System

Settings, System Information, Text Keyboard, and Number Keyboard.

How to hide HMI System Setting Toolbar:

® When [DIP Switch 2] is set ON, the system setting toolbar is disabled. When set OFF; the
system setting toolbar is enabled. Please restart HMI to enable/disable the toolbar.

® For mTV Series, flip DIP Switch 1 to ON to hide system setting toolbar.

® System register [LB-9020] can also enable/disable system setting toolbar. When [LB-9020]
is set ON, the toolbar is displayed, and set OFF to hide the toolbar.

4,5.1. System Setting
cMT/cMT X Series

Set or modify system parameters. Confirm password for security first. The factory default
password is 111111.
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System setting

@ Information

-

i General

® Network

® Time/Date

&£ HMIName

CODESYS Activation Cod

Restore CODESYS License

e:

Restore

TN g L% N
@
System setting

@ Information
li CODESYS

® Network

@® Time/Date

£ HMIName

General

Direction

Brightness

Popup download window

FTP Port (default: 21)

FTP client can modify USB/SD data

Show Start button

System setting

@ Information
Iii CODESYS
= General

@® Time/Date

&£ HMIName

Ethernet1

MAC address

Obtain an IP address automatically

IP address

Subnet mask

Gateway

DNS

00:0c:26:14:47:3e

()

[\ WEINTEK

CODESYS
Enter the activation code to activate
CODESYS.

General

General settings including FTP settings.
[Direction]

Set screen orientation mode to landscape
or portrait by selecting degrees from 0 / 90
/180 / 270.

[Brightness]

Adjust screen brightness.

[Popup download window]

When enabled, the download window can
pop up.

[Show Start button]

When enabled, the Start button is
displayed.

Network

Download project file to HMI via Ethernet.
The IP address of the target device (HMI)
must be correctly set. Users can choose
from obtaining an IP address automatically
or entering an IP address manually. To use
Email or EasyAccess 2.0, please set DNS
correctly.
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Time/Date

Setting

System setting

@ Information
lii CODESYS
22 General

® Network

& HMIName

Date 2020-05-18 )

13:49:45 )

HMI Name

E Setting

System setting HMIname

@ Information
i CODESYS
i General

@ Network

@ Time/Date

CMT-473E )

Setting

System setting

Clear History

Clean Recipe

Clean Recipe Database

[ Project Management

Clean Event Log
A System Password
Clean Data Log
&2 Enhanced Security
Clean Operation Log
© VNC Setting

4 EasyAccess 2.0

Setting

System setting

Project Management

Restart EB Project
Clear History

A System Password

&R Enhanced Security
@ VNC Setting

W3 EasyAccess 2.0

Restart

[\& WE!NTEK

Time/Date
Set HMI local date and time.

HMI name
Set the HMI name for identification when

downloading / uploading a project.

Clear History

Clear historical data stored in HMI.

Project Management
HMI can be rebooted by clicking the
Restart button.
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getting

System setting

© Clear History

[ Project Management

[

&R Enhanced Security
© VNC Setting

T4 EasyAccess 2.0

éygtém Password ;
System setting

Update project

History

User

Setting

Systemn setting

® Clear History
[ Project Management

A System Password

[

@ VNC Setting

W3 EasyAccess 2.0

Enhanced Security

Start edit user account

Start

@ Setting

System setting

® Clear History

[ Project Management
A System Password
&R Enhanced Security

@ VNC Setting

]

EasyAccess 2.0

EasyAccess 2.0 Connection

Proxy

Setting

System setting
T4 EasyAccess 2.0
@ Language

B8 [nput Method

X 0S Upgrade

O Reset options

Printer
Printer name
URI

Install network printer

Not installed

[\& WE!NTEK

System Password

By default the password is 111111.
User-defined passwords can be used after
verification.

Enhanced Security
Add or delete user accounts and manage
user privileges.

EasyAccess 2.0

Activate EasyAccess 2.0 service.

n!n Click the icon to download the demo
project. Please confirm your internet
connection before downloading the demo

project.

Printer

Please see Chapter 23.3 in EasyBuilder Pro
user manual for more information on
installing printers.
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28T - RALL LAV LA A LA LB A AL AL L AR OS Upgrade
w1 Setting 0S Upgrade

System setting

Select an OS file saved in an SD card or USB

Image path :
2 Essyeiss ey . disk to upgrade OS. When OS is upgrading,
Pl please do not cut off HMI power. For more
e et information on upgrade steps or notes, see
2 Printer the OS upgrade manual of the model in
use.
O Reset options
R - BAEEEE Ve L L L E L LR AL E LR RS ) Reset options
=8 Setting Reset options

System settin,
i o 3 Reset HMI to default

Restore HMI to factory settings.
"3 EasyAccess 2.0
©® Language

B [nput Method

é Printer

X 0S Upgrade

eMT/iE/XE/mTV Series

System settings .& Network
Netwcrk\TlmejDate\ Secur\tv\v\me\\r semng‘\ﬂ

When downloading project file to HMI via Ethernet,

(€ Obtain an IP Address Automatically set the correct IP of the target HMI. You can obtain
@ 1P address get from below an IP address automatically or enter the IP address
Paddress:  [102 168 \[1  [s4 | manually. To use Email and EasyAccess2.0, please set

SubnetMeski 555 |[o5s a5 1o correct DNS address

(et 192|168 [t |[254
DNS address: g s g s
Prev | MNext | Cancell Apply | oK /Il
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Time / Date
Set HMI local time and date.

Security

Password protection, the default is 111111. Please
click the buttons to set the passwords, and finish
password confirmation.

[Password for entering system]

[Password for uploading project]

[Password for downloading project]

[Password for uploading history data]

History
Clears history data in HMI.

HMI name
Set HMI name to be used when download/upload
project.

Default HMI

’__Ib WE!NTEK EasyBuilder Pro V6.07.02
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System settings =

Network' Tlme/Date‘ Se 0OS settmg\r semnq‘\o
Upagrade

Upgrade OS

Portrait Mode

0 C o0 |C 180 270

(It will take effect at next reboot)

Prev | Next | Cancell Apply | OK e |
[Systemsettings P4

Network Time/’Date\ Sec  WNC server setting\

Start VNC single-connection

Start VNC multi-connection

Stop VNE ‘

VMNC login password |

Prev | Next | Cancel | Apply | OK ”l

System settings =

Network' Tlme/'Date\ Sec  VNC Miscellaneous
Backlight

Brightness

Download setting

V¥ Popup download window

¥ Restart after download/upload

| Prev | Next | Cancel | i Apply | 10K /Il

L—| WE!NTEK

OS setting

[Upgrade OS]

Upgrade firmware. Please do not turn off or unplug
HMI during OS upgrade process. For more details,
see the instruction about OS upgrade of the model
used.

[Portrait Mode]

Set screen orientation mode. After changing the
mode, reconnect HMI to power supply, for the
setting to take effect. That is, disconnect all power
from HMI, and then connect again. If portrait mode
is used (90 or 270 degree), the project must be
designed for portrait mode, otherwise it cannot be
correctly displayed.

VNC server setting

Remote HMI monitoring and controlling via
Ethernet.

[Start VNC single-connection]

Allows connection with one VNC client.

[Start VNC multi-connection]

Allows connection with multiple VNC clients.
Connecting more VNC clients may slow down the
communication speed.

Please see the settings steps in the later part.

E Click the icon to watch the demonstration film.
Please confirm your internet connection before
playing the film.

Misc 1

Rotary switch for adjusting LCD brightness.
[Popup download window]

If selected, after inserting USB disk or SD card to
HMI, the Upload / Download dialog box shows.
[Restart after download/upload]

If selected, restarts HMI automatically after
uploading / downloading project.

EasyBuilder Pro V6.07.02
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T < Misc 2

Network' Time/Date' Secur’ _ VNr Misc 2\;tess ;.D\

[Hide mouse cursor]

" Hide mouse cursor

If selected, the mouse cursor will be hidden.
""" raton mage [Enable [Reset HMI to default] button in calibration

" FTP client can modify USB/SD data

i— Enable [Reset HMI to default] button
bi

mode]

If selected, when the operator presses and holds

anywhere on the screen for more than 2 seconds

during HMI startup, the touch screen calibration

Prev | Next | Cancell Applyl oK /Il

mode will start. After calibration, [Reset HMI to

default] option shows.
[FTP client can modify USB/SD data]
If selected, USB/SD data can be modified using FTP.
[Modify HMI ports]
Change the port number for Upload/Download and
FTP.

I | EasyAccess 2.0

Network' Tlme/Date‘ Se VN EasyAccess 2.0

Activate EasyAccess 2.0 service.

EasyAccess 2.0 Is activated

ACCOUMLE | '

= Click the icon to download the demo project.

password |
Please confirm your internet connection before
HWlkey =YCTSE500-S5BN-JOWE

-WSH7-42A4-NVBMEWHH

downloading the demo project.

i Proxy | IEEEE | PACHVERS

Prev | Next | Can Apply | OK e |

The following steps explain how to set VNC server.

1. Enable HMI VNC server, set password.

2. Install Java IE or VNC Viewer on PC.

3. Enter remote HMI IP in Internet Browser. Or, in VNC Viewer enter remote HMI IP and

password.

3 TG viewes for dove s Micseenty obermet Reolowms, [ (O

OQt1-Q XEBNH Pme ramex @ 3-5 9
&) by 1921601 2 ¥ Qo 2
REAL

Vn B VEC Yiewer | Conmestion Detnids
‘ s | O

VNG Viewer Free ESon 41
Copyright (C) 2002- 2004 RealviNC Ly
So0 180 Moww realre COmM 100 DESMABon on VN

&) R [ 2=
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4.5.2.  System Information

Network: Displays network information & HMI IP address.

n information (Default HMI)

Version: Displays HMI firmware version and model type.

ation (Default HMI)
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5. System Parameter Settings

This chapter introduces the system parameter settings.

5.1.
5.2.
5.3.
5.4.
5.5.
5.6.
5.7.
5.8.
5.9.

5.10.
5.11.
5.12.
5.13.

OVBIVIBW ...ttt ee ettt e e e e ettt et e e e e e sttt e e e e e e s e anbe et eeeeeesesanssseeeeeeeeessannnrnenaeaeens 5-2
DIBVICE .eeeeeee ettt ettt e ettt et e e e e e s b bt e e e e e e e s e rr e et e e e e e e s e nnrreeeeeeeeaeaann 5-2
1Yo e 1] DO PP PRSP PPRTPPPRRRO 5-11
(CT=T Y] - | AP PP OPPPPRRUPPPPPRI 5-13
SYSEEM SELHING oo 5-20
REMOTE ...ttt ettt aaeeeeeesbebebeseeesnsessnsnnsnnnnnnnnnnes 5-23
L =To{ U1 g1 AV 5-25
[ T=T Yo [=Te Y/ =T ' o] VU RUPRR 5-28
PriNter / BaCKUP SEIVEN........uviieeieecee ettt ettt re e e e e e eare e eeaaeeeneeas 5-31
THMIE SYNC./DST ottt ettt e et e e et e e e te e e e be e e e beeesabeeesaseeeeaseeenaseesnseeenrens 5-32
L1V T DU PPPTRRUPUPPPRN 5-34
Cellular Data NETWOIK ...cooeiieeeeieeee et s siee e e 5-36
o I PP PR PP PP 5-38
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5.1. Overview

Launch EasyBuilder Pro, in the main menu select [Home] » [System Parameters] to open the
[System Parameter Settings] dialog box. System Parameter Settings are divided into several

tabs, these tabs will be introduced respectively in this chapter.

5.2. Device

Parameters in this tab determine the attributes of each device connected with HMI. The device
can be a Local / Remote HMI / PLC. A default device "Local HMI" exists when creating a new

project. This device is the HMI that will be updated and programmed.

5.2.1. How to Control a Local PLC

P
a SQl.Eee, JPLC Device

HMI

“Local Device” is a device connected to the local HMI. To control/connect a Local Device, add
this type of device first. Click [System Parameters] » [New] to open [Device Properties] dialog

box. For example, when connecting MODBUS RTU as a Local Device:

-

Name :  MODBUS RTU
() HML (@) Device

Location @ |Local - Settings...

= Select Local for a device connected to this HMI, or Remote for a device connected through another
HMI.

Device type : [ MODBUS RTU, RTT aver TCP | » ]

PLC ID : 4, V.3.30, MODBUS_RTU.e30

IfF: [RS—485 2w v] Open Device Connection Guide. ..

* Support offine simulation on HMI {use LB-12358)
* Support communications between HMI and device in pass-through mode

*5et LW-9903 to 2 to enhance the speed of download jupload device program in pass-through mode

COM : [COM1 (3600,E,3,1)

Device default station no. @ 1
[ Default station no. use station no. variable

[ Use broadcast command

How to desiznate the station no. in object’s address?...

Interval of block pack (words) : D [ Address Range Limit... ]
Max. read-command size (words) : [ Data Conversion... ]
Max. write-command size (words) :

I__| WE!NTEK EasyBuilder Pro V6.07.02
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Setting Description

Name The name of the device.

HMI / Device In this example a device is used, so select [Device].
Location Select [Local] or [Remote]. In this example the device is

connected to the Local HMI, so select [Local].

Device type Select the type of the device.

I/F The available interface: [RS-232], [RS-485 2W], [RS-485
4W)], [Ethernet], [USB], and [CAN Bus].
® |f the interface used is [RS-232], [RS-485 2W], or

[RS-485 4W)], configure communication parameters

by clicking [Device Properties] » [Settings] and then
[Com Port Settings] dialog box opens.

COM Port Settings

COM : Timeout (sec) :
Baud rate : Tum around delay (ms) : 0
Dats bits : Send ACK delay (ms) : 0

Parity : Send RESET when power on :
Stop bits :

The number of resending commands :

* DS version 20120920 or later support 14400 baud rate | oK | [ cancel |

Timeout

If the communication has been disconnected for more

than preset time limit configured in [Timeout] (in sec),

Window No. 5 will pop up and show “Device No

Response” message.

Turn around delay

While sending the next command to the device, HMI will

delay the sending according to the time interval set in

[Turn around delay]. This may influence the efficiency of

the communication between HMI and the device. Default

value is “0”.

Note: If the device used is SIEMENS S7-200 Series, it is

recommended to assign “5” to [Turn around delay] and

“30” to [Send ACK delay].

® |[f the interface used is [Ethernet], click [Device
Properties] » [Settings] and the [IP Address Settings]
dialog box opens. Please set correct device IP address
and port number.

I__| WE!NTEK EasyBuilder Pro V6.07.02
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IP Address Settings

IPaddress: 192 . 168 . 1 . 100

Port no. : 500

Timeout (sec) : Tumn around delay (ms) : 0

Send ACK delay (ms) : 0 Parameter 1: 0
Parameter2: 0 Parameter3: 0
The number of resending commands :
[ oK ] [ Cancel ]

® [f the interface is [USB], no further setting is
required. Please check the settings in [Device
Properties].

® |If the interface is [CAN (Controller Area Network)
Bus], please see “Device Connection Guide” for

“CANopen” and import the .eds device file.

Device Set the default station number for device address if the
default device station number is not included in the address.
station no. Device station no. can be set in its address. The address

format: ABC#Addr

ABC stands for device station number and ranges from 0 to
255. Addr stands for device address. And the “#” sign
separates the station number and the address. As shown
in the following figure, the data is read from device station
number 1, and address 0x-20.

Toggle Switch/Bit Lamp Object's Properties =]

General | Secusity | Shape | Label | Profile
Comment :

©) Bit Lamp Toggle Switch

Read address

PLC name : [Moogus RTU v] Settings...
Address : [ px v | 1220

[ Invert signal
Address @

PLC name : IMODBUS RTU ,}

Device type : [Ox 'l

Address: 120

Address format : DDDDD [range : 1 ~ 65535]

Default Use the station number variables as the default device

station |:10. station number. Select one from LW-10000 to LW-10015
use station

no. variable (varO to var15) as the station number variables. If the
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station no. is not specified in device address, the station
number will be determined by the station no. variable.

For example, if var3 is set for default station no:

PLC default station no. : [Lw_lgggg (16bit) : var2 -]

Default station no. use station no. variable

[ use broadcast command

The followings demonstrate some examples:
® The device station number is “5”.

Read address

PLC name : [MODBUS RTU v] Setting. ..

Address:[4x v] 5111

® The device station number is determined by var7

(LW-10007)
Read address
PLC name : [MODBUS RTU v] Setting...
Address :[4,( v] var7#111

® Device address is set to “111”, since device station
no. is not specified, and the default station no. is

var3, the device station no. is determined by var3

(LW-10003).
Read address
PLC name : [MODBUS RTU v] Setting...
Address :[4,( v] 111

4

=4 Click the icon to download the demo project. Please
confirm your internet connection before downloading the

demo project.

Use When [Use broadcast command] check box is selected,
broadcast please fill in [Broadcast station no.] according to the
command broadcast station number defined by the device. When

HMI sends a broadcast command to the station number
set here, the device will only receive the command and
not reply to HMI.

PLC default station no. : ¢
[7] Defautt station no. use station no. variable

[#] Use broadcast command Broadcast station no. : [255 -

As shown in the following figure:
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Read address
PLC name i[MODBUS RTU

v] Setting...

Address :[4,( v] 255%200

When HMI sends a command to address 255#200, all the
devices will receive this command and will not reply.
Only devices that support broadcast command can use
this feature.

Interval of

If the interval between read addresses of different

block pack commands is less than this value, the commands can be

(words) combined to one. The combining function is disabled if
this value is set to “0”.
For example, the interval value is set to “5”, to read 1 word
from LW-3 and 2 words from LW-6 respectively (read from
LW-6 to LW-7), since the interval of addresses between
LW-3 and LW-6 is less than 5, these two commands can be
combined to one. The result is to read 5 consecutive words
from LW-3 to LW-7.
Note: The maximum size of command combination data
must be less than [Max. read-command size].

Max. read - The maximum data size to read from the device at one

command time. Unit: word

size (words)

Max. write - The maximum data size to write to the device at one time.

command

size (words)

Unit: word.

After all settings are completed, a new device named “Local PLC 1” is added to the [Device list].

@ Note

System Parameter Settings @
| Cellular Data Network | Printex/Backup Server l Time Syne [DST 1 e-Mail l Recipes
Device | Model | Geneal | SysemSetting | Security | Non-ASCIIFonts | Extended Memory
Device list : What's sy IP ?
No. Name Location ~ Device type Interface IIF Protocol
Local HMI Local HMI Local MT8070iE/MTS... - -

@ Local PLC1  [MODBUSRTU [Local  |MODBUSRTU,..[|COM 1 (9600,E... |[RS485 2W

B When using a ctMT / cMT X Series model, select “Local HMI” in [System Parameter Settings]
dialog box and then click [New Device] to add a “Local PLC 1” under “Local HMI".

I__| WE!NTEK
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System Parameter Settings @
| Extended Memory |  TimeSwneDST |  eMail |  Recipes | Cellukw Data Network
Dievice | Model | Creneral | Swstem Sethng I Security | Font Mapping
Device list : W heat's ey IP 7
Mo, Mame Location Device type Interface I/F Protocol
= Local HMI Local HI Local CMT-SVR (1024... - -
¥ Local PL.. |MODBUS RTU MODBUS RTU | COM 1 (9600.E..

El Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.

5.2.2.

How to Control a Remote Device

m Ethernet e Ethernet
-\-al-¢ ﬂ

Desktop

(%)
o
-
b
g

HMI

PLC Device

HMI

bod NGD

IPLC Device

“Remote Device” is a device being connected to a remote HMI. To control a remote device, add

this type of device first. Please click [System Parameters] » [New] to open [Device Properties]

dialog box. For example, use MODBUS RTU as the Remote Device:

Mame :

() HMI

MODBUS RTU

@ Device

= Select Local for a device connected to this HMI, or Remote for a device connected through another

HML,

Location ; [Remote ~| [ settings... | [P:0.0.0.0 {Port = 8000)

Device type : [
F‘LC ID : 4, V.3.30, MODBUS_RTU.=230

MODEUE RTU, RTU over TCP

)

IfF: [RSJISS W w | Open Device Connection Guide. .
COM: [COM1 Settings. ..

Device default station no. :

| Default station no. use station no. variable

How to desizmate the station no. in object's address?.

Interval of block pack (words) : E]
Max. read-command size (words) :
Max. write-command size (words) :

[\& WEINTEK
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Setting Description

HMI or

Device In this example, a device is used, so select [Device].

Location Select [Local] or [Remote]. In this example the device is
connected to Remote HMI, so select [Remote]. Set the IP
address and port number of the Remote HMI by clicking
[Settings] next to [Remote].

IP Address Settings
@ Ethernet () COM port (use master-slave protocol)
IP address: 192 . 168 . 1 . 10
Portno. : 8000
| ok | [ cancel

Device Type Select the type of the device.

I/F The interface used for Remote Device. If the remote device
uses a COM port, select [RS-232], [RS-485 2W], or [RS485
4W].

coM Set the correct COM port used by the Remote Device.

Device

default Set the station number of Remote Device.

station no.

After all settings are completed, a new device named “Remote PLC 1” is added to the [Device

list].
 System Parameter Settings @
i__ggnular Data Network I Printex/Backup Server ] Time Syne /DST l e-Mail | Recipes
Device | Model | Gemeral | SystemSetting | Secwrity | Non-ASCIIFonts | Extended Memory
Device list : What's my IP ?
No. Name Location Device type Interface I/F Protocol
Local HMI Local HMI Local MT8070iE/MTS... - -

0 Note

(3l Remote PLC 1 [MODBUSRTU  [Remote (I..| MODBUS RTU,... |COM 1 (9600 E... |RS485 2W

When using a cMT / cMT X Series model, select the defined “Remote HMI 1” in [System

Parameters] dialog box and then click [New Device] to add a “Remote PLC 1” under

“Remote HMI 1”.

I__| WE!NTEK
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System Parameter Settings @
|  ExtndedMemory | TimeSyne/DST | eMail |  Recipes |  Cellubr Dais Network
Device | Madel I General | Systern Setting I Security | Font Mapping
Device list : ¥hat's moy IF 7
No. MName Location Device type Interface IIF Praotocol
Local HMI Local HMI Local CMT-SVR (1024... - -
= [Remote HMI 1 CMT-SVRHMI  Remote (I.. CMT-SVR Ethernet TCPIP
> MODBUS RTU  [Remote (1. |MODBUS RTU  |COM 1 (9600,E... | RS485 2W

E Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.

5.2.3. How to Control a Remote HMI

M Ethernet -
: -
HMI HMI HMI

Desktop
“Remote HMI” is the HMI other than “Local HMI”, and PC is also a “Remote HMI”. To control a

Remote HMI, add this type of device first. Click [System Parameters] » [New] to open [Device
Properties] dialog box as shown in the following figure:

Device Properties

Name : Device
@ HMI I PLC

Location : [Remote +| [ Settings ... | [P : 192.168.1.10 (Port = 8000)

Setting Description
HMI or ] . ]
. In this example, the device used is a HMI, so select [HMI].
Device
Location Select [Local] or [Remote]. In this example Remote HMI is

used, select [Remote]. Set the IP address and port number
of the Remote HMI by clicking [Device Properties] »
[Location] » [Settings].

IP Address Settings
@ Ethernet

IPaddress: 192 . 168 . 1 . 10

Port no. : 8000

[ 0K J [ Cancel

After all settings are completed, a new device named “Remote HMI 1” is added to the [Device
list].
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@ Note

B When using a cMT / cMT X Series model, in [Device list] click [New HMI] to add a “Remote

HMI 1”.

El Click the icon to watch the demonstration film. Please confirm your internet connection

 System Parameter Settings ==

| CellulurDataNetwork |  PrintewBackupServer |  TimeSne/DST |  eMail |  Recipes
Device | Model | Gemerl | SystemSetting | Secrity | Non-ASCIIFonts | Extended Memory

Device list : What's my IP ?
No. Name Location  Device type Interface IIF Protocol

Local HMI Local MT8070iEMTS... -

(M Remote HMI 1 [Device ~ [Remote (l... | eMT/XE/E SER... | Ethernet TCP/P

System Parameter Settings
| ExtendedMemory | TimeSwne/DST |  e-Mail |  Recipes |  Cellulas Dats Network
Device | Model | General I Swatem Seting I Security | Font Mapping
Drevice list : What's mey [P 7
Mo. Name Location  Device type Interface IIF Protocol
Local HMI Laocal HMI Local cMT-SVR (1024... - -

Remote HMI 1 | CMT-SVR HMI Remaote (I..| CMT-3VR Ethernet TCPIP

before playing the film.

[\& WEINTEK
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5.3. Model

Configure the [HMI model], [Timer], [Printer] and [Scroll bar] settings, and more.

eMT, iE, XE, mTV Series

cMT, cMT X Series

[\& WEINTEK

System Parameter Settings ==
| Cellular Data Network | 802.1X (WicF) | Server | TimeSyneDST | eMadl |
| Device | Model | Generl | System | Remote | Secuity | Extended Memory |
HMImodel: [ iE Series - MT8103iE (1024 x 600) <) [Landscape -
HMIssonno. [0 ]
Portno. : 8000
[¥] Support eMT communication protocol
Portno. : 8010
Printer
Type : [SB-M, D, E, F ~]
COM : [COM 3 RS-232 v
N —
Paaity : [None v  Dewbis:[8Bis |  Stpbis

Pixels of width : 100 pixel(s)

Sereen hard copy scale

*100 pixels (for 1610 type) or 220 pixels (for 2407, 4004 type)

Scroll bar
Defult Sty - [« >
Width
©) Small *) Middle O Large
Pass through (Virtual COM port)
Portno.: 2000 (2000~2100) [7] Enable RSLinx broadcast response
o J[ concel J[ rep |
System Parameter Settings

| Extended Memory | Cellular Data Network | Time SyneDST | eMail | Recipes | FontMapping

| Device | Model | Generl SystemSetting | Seowity |  Non-ASCIIFonts |
HMI model : (cMT3090 (1024 x 768) ~) [Landscape
HMIsstonno.: [0 o]
Portno.: 8000
7] Support iE/XE/M T4nTY HMI communication protocol and EssyWatch
Portno.: 8010 (used as MODBUS server’s port no.)
Printer
Type : HP Laserletom1412fn Iy Status/Control...
Paper Size : | A4 v
Interface
) Ethemet © USB
Pass through (Virtual COM port)
Portno.: 2000 (2000-2100)  [7] Enable RSLinx brosdesst response

o ]

Cancel

EasyBuilder Pro V6.07.02
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Setting

Description

HMI model

Select an HMI model.

The [Resize pop-up windows / objects] dialog box will pop
up when changing to a model with a different resolution.
Select required adjustment and click [OK]. In most cases,
select all options.

Resize pop-up windows/objects @
General windows
[¥]Resize pop-up windows
[¥] Resize objects

Keyboard windows
Resize keyboard windows
Resize function key objects

[ OK | ’ Cancel

Landscape/Portrait
Change the orientation of the project.

HMI station no.

Set the station number of current HMI. The default value is
IIOII.

Port no. Set the port number of current HMI. The default value is
“8000".

ggﬁﬁﬁ{xtn?ggon Supports communication with cMT / cMT X Series models.

protocol cMT / cMT X Series project file should use the same

communication port.

Printer (eMT,
iE, XE, mTV
Series)

Type

A printer can be connected with the HMI. The HP PCL Series
printer is connected through USB interface while other
printers through a COM port.

& For more information, see “23 HMI Supported
Printers”.

If the printer is connected through [COM], configure the
parameters correctly. If the printer type is [SP-M, D, E, F],
the [pixels of width] has to be set accurately, i.e. the set
pixel(s) cannot exceed printer’s default setting, or the HMI

will fail to print data.

Printer (cMT,
cMT X Series)

The printer driver can be installed on HMI.
Type

Select printer type.

Status address

L—| WE!NTEK
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Shows printer status.

LW-n Status

0 Printer driver is not installed yet.
1 Installing printer driver.

2 Printer is ready.

3 Printer is printing.

4 Print job is canceled.

LW-n+1 Error

0 None

1 Printer is not found.

2 Unknown error.

Control address
Updates printer connection parameters.

LW-n Command

0 None

1 Update connection parameters.
2 Restart printer driver.

LW-n+1 1/0

0 Ethernet

1 USB

LW-n+2 IP address (Total: 4 words)
LW-n+6 Port (Default port number: 9100)

Please note that using only the ppd file for a printer may
not be able to run the printer since the corresponding

driver is absent. Using tested models is recommended.

Scroll bar Set the width of Scroll Bar, when the size of the object is too
small to display the contents, a scroll bar is displayed in the
object. This feature can be applied to objects that allow
scrolling, such as Alarm Display, Event Display, History Data

Display, and Option List.

Pass through
(Virtual COM Set the port number for Pass-through communication.
port)

5.4. General

Configure the properties related to screen display.
eMT, iE, XE, mTV Series
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cMT, cMT X Series

[\& WEINTEK

System Parametergettings
| CelltlarDataNetwork |  PrintowBackupServer |  TimeSync/DST |  eMal |  Recipes |
| Device | Model | Genesl | SystemSetting | Security | Non-ASCIIFonts | Extended Memory |
Options
|| Enable fast display mode when change window RW_A enabled
Windows

Startup window no. : (10, WINDOW_010

z)

Common window : | Above base window v

Screen saver

Object layout : | Nature 52

*1f this key is different from HMI key, the project won't be executed normally.
*Use LWO046-~9047 to change HMI key. LBI046 indicates check result (key exror when status is on).

Back light saver : | 30 v | minute(s)
Ensble back light when alarm occurs
Screen saver : |25 v | minute(s)
Saver window no. : [804 Screen Saver i
Fast selection button
Attribute : (Enable v [ Settngs.. |
Position : [ Hide button when HMI starts
Event
Use LW9450-9455 as time tags of event logs
Time tag format : |[BCD v
Keyboard
50, Keypad 11 - Integer = External keyboard layout (L W-9199)
2L © QWERTY (0) © AZERTY (1)
Contote: ]

[ Add... ] [ Delete ] Select color : ‘:B
Project protection
[¥] Enable Projectkey : 111111 (range : 0 ~4294901750)

Coc Jlome ] [ reo ]

System Parameter Settings

| Extended Memory |  Cellular Data Network Time $ync/DST | eMail |

FTP

| Device | Model | Gemewl |  Sydem |  Remoe |

Security

Options
[ Enable fast display mode when change window
Trigger release actions anyway if touch moves out of the button

RW_A enabled

[ Set value when leaving focus

CSY ke e
Windows

Startup window no. : (10, WINDOW_010

Common window : [ Above base window v]

[ Enable window layers {This can be used to organize/show/hide objects)

Screen saver
Back light saver : |30 v | minute(s)
[7] Enable back light when alarm occurs

Screen saver : [25 v | minute(s)

Saver window no. : [80. Screen Saver

Monitor mode

[ Enable D

Event
[7] Use LWO450~9455 as time tags of event logs

Keyboard
59, Keypad 10 - Integertranslocent) ]
66. ASCII Middle E(;{mnslucent) 3

56. Keypad 7 - Hl
57. Keypad 8 - Floating
83, Systm Standrd ASCIL

[ ada. ] [

External keyboard layout (L W-9199)
Type : |QWERTY{0)

Delete |

Project key
[7] Ensble

- ©®
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Setting

Description

Options

Enable fast display mode when change window

With this option selected, certain objects will cache the
most recent value and display it after changing window, to
achieve fast display.

The objects are: Bit Lamp, Word Lamp, Numeric, ASCI|, Bar
Graph, Meter Display, Animation, and Moving Shape...etc.
RW_A enabled

Enable or disable recipe data RW_A. Enable this, the
objects can then control RW_A .The size of RW_A is 64K.
Trigger release action anyway if touch moves out of the
button. (cMT / cMT X Series)

With this option selected, releasing the finger after
touching the button and then sliding the finger out of the
button area is still considered as button release; its release
action(s) will be triggered.

Set value when leaving focus (cMT / cMT X Series)

With this option selected, values will be written upon
leaving the input mode of an object (e.g. Numeric object),
even if not by pressing the ENTER key. For example, data
entry for the current numerical object is considered
completed and value is written when one selects another
object to enter value. An alert message shows when an
invalid value is entered.

@ Note

1. Values will not be retained after pressing the ESC key to
leave.

2. When the system keyboard is used, values will be
directly written after closing the keyboard.

3. With [Input order] enabled, the sequential input is
performed after leaving the object by pressing the
ENTER key. The sequential input will be stopped if
another object is touched during the input process.

CSV delimiter (cMT / cMT X Series)

Save the CSV file generated from Backup or Import/Export

with Comma (,) or Semicolon (;) delimiter.

Windows

Startup window no.

Designate the window shown when start up HMI.

Common window

The objects in the common window (Window No. 4) will be

L—| WE!NTEK
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shown in each base window. This determines that the
objects in common window are placed above or below the
objects in the base window.
Object layout
If [Control] mode is selected, when operating HMI,
[Animation] and [Moving Shape] objects will be displayed
above other kinds of objects neglecting the sequence that
the objects are created. If [Nature] mode is selected, the
display will follow the sequence that the objects are
created, the first created will be displayed first.
Enable window layers (This can be used to
organize/show/hide objects)
With this option selected, layers within a window can be
created in the window tree.
At most 10 layers can be added to a window.
As shown in the following figure, right-click on a window
number and then select [Add layer].
Windows Tree - X
3 : Monitor Mode
3 Done respone
7 Pastwerd reseton

8 : Storage Space Insufficient
9 : Backup

D .

[ Laye New

[# Laye Open
u Close
12
13 Delete
14 Settings
15
16 Add layer

The following is an example of creating a layered window:
Place a Bit Lamp object in Layer 1 and a Numeric object in
layer 2.

*10 - WINDOW_010
Layer 1 (Bottom)
BL_O(LE-0) (Bottom)
[# Layer2
MNE_Q (LW-0)

Selecting Layer 1 shows only the Bit Lamp object in the

editing window.

L—| WE!NTEK
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Selecting Layer 2 shows only the Numeric object in the
editing window.

= #10 WINDOW 010
=+ @ Layer1 (Bottormn)
“— BL_0 (LB-0) (Bottarm)
Aloyers |
— NE_D (LW-0)

{1}

Selecting window 10 shows all objects.

- *10 : WINDOW 010
= [# Layer 1 (Bottom)

L BL 0 (LB-0) (Bottom)
= [# Layer2

L NE_O (LW-0)

D‘WE!NTEK EasyBuilder Pro V6.07.02
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Screen saver

Back light saver

If the screen is left untouched and reaches the time limit
set here, the back light will be turned off. The setting unit is
minute. Back light will be on again once the screen is
touched. If [none] is set, the back light will always be on.
Screen saver

If the screen is left untouched and reaches the time limit
set here, the current screen will automatically switch to a
window assigned in [Saver window no.]. The setting unit is
minute. If [none] is set, this feature is disabled.

Saver window no.

Specify a window to be displayed when HMI goes to screen
saver mode.

Note: In a saver window, the [Return to previous window]
option of a Function Key can be used to wake up HMI from
screen saver mode; therefore, please avoid editing the
project in the way shown as the example below, to prevent
the HMI from going to screen saver mode repeatedly.
Example: A Function Key used to “Return to previous
window” is placed in Window no. 11, and the HMI goes
into screen saver mode when Window no. 11 is displayed.
In this case, the HMI can wake up from screen saver mode
when any point on its screen is touched, and Window no.
11 will be displayed again. At this moment, if the Function
Key in Window no. 11 is touched, the HMI goes into screen
saver mode again.

Solution: 1. When a Function Key with “Return to previous
window” selected is placed in the saver window, please use
“Change full-screen window” for all other windows.

L—| WE!NTEK
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2. When “Change full-screen window” is used for the saver
window to change to a specific window (e.g., home page),
please make sure that “Return to previous window” is not
used in this destination window. The “Return to previous
window” option can still be used for other windows.

Fast This setting is applicable for eMT, iE, XE, mTV, and iP Series.
selection Setting the attributes for fast selection button for Window
buttons No. 3. To use the fast selection button, create Window No.
3 first.
Attribute
Enable or disable fast selection window. Select [Enable] and
click [Settings] to set the attributes, including color and text
of the button.
Position
Select the button position on the screen. If [Left] is chosen,
the button will show at bottom left side of the screen; if
[Right] is chosen, the button will show at the bottom right
side of the screen.
Settings
Set the shape and label font of the Fast Selection Button.
Hide button when HMI starts
The Fast Selection Button will be hidden, calling it out
requires system registers LB-9013~LB-9015.
Monitor This setting is applicable for cMT / cMT X Series.
Mode Window no. 3 in the project is monitored in this mode in
cMT Viewer. The user can select up to 50 cMT / cMT X
Series HMlIs to monitor in cMT Viewer, and in 3x3 or 5x4
tile view.
Event Use LW9450~9455 as time tags of event logs

When this option is selected, Event Log will use the
following time tags to show the time that the event is
triggered.

LW-9450: time tag of event log — second (range: 0~59)
LW-9451: time tag of event log — minute (range: 0~59)
LW-9452: time tag of event log — hour (range: 0~23)
LW-9453: time tag of event log — day (range: 1~31)
LW-9454: time tag of event log — month (range: 1~12)
LW-9455: time tag of event log — year (range: 1970~2037)
Please note that the system will not be able to use these
time tags when one of them exceeds acceptable range.
= Click the icon to download the demo project. Please

confirm your internet connection before downloading the

L—| WE!NTEK
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demo project.

Keyboard

The window number in which the keyboard is placed.
When using Numeric Input or ASCII Input objects, the type
of keyboards can be selected. Up to 32 keyboards can be
added. To design a keyboard, a window should be
designated for creating it. Press [add] after creating and
add the window to the list.

l:ﬁ?See “12 Keyboard Design and Usage”.

External keyboard layout

The available USB keyboard layouts are QWERTY, AZERTY,
and Cyrillic. System register LW-9199 allows switching
keyboard layouts on HMI.

Caret color / Select color

This setting is applicable for eMT, iE, XE, mTV, and iP Series.
Set the color of caret that appears when entering data in
Numeric Input and ASCII Input objects or change the
selection color.

Project
protection

Projects can be restricted to be executed by a specific HMI.
& See “30 Project Protection”.

5.5. System Setting

[System Setting] is used to configure different features of EasyBuilder Pro.

L—| WE!NTEK
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System Parameter Settings @
Extended Memory [ Cellular Dats Network | Time Sync DST [ e-Mail !
Device Maodel | General | System | Remot: | Secuity
Startup language after redownloading the project : [LW 1 -

Delay time of device communication after HMI staxts : second (s)

* Use this option to prevent communication exrors when HMI starts faster than PLC.

Execute init. macro when power on
Auto logout
[T]Enable
* When a user does not operate the HMI for longer than the setting time, the system will antomatically logout.

[V] Hide mouse cursor Mouse cursor size © lDefau.lt v
[ Hide start button
*Use LB-9062 to open hardware sstting dialog
Sound control
_ With each touch on a button, a sound is emitted.
@ With each operation from a button, a sound is emitted.

[V] Disable sound output {or use LB-9019 to disablefenable sound output)
|| Play next sound after stopping previous. (i )

[7] Disable upload function {effective after rebooting HMI){or set LBI033 on)
[¥] Display disconnection icon on already shown objects after communication fails

(7] Enable watch dog (LB-9049) Reboot HMI v|  Timeout LW-11456) : second (s)

[V] Enable font preloading (optimize pexformance but HMI may start slower)

[ Display timer for min. press time. Timer location : .

[ OK H Cancel H Help ]

Some features are duplicated from system registers, such as, [Hide system setting bar
(LB-9020)], [Hide mouse cursor (LB-9018)], [Disable buzzer (LB-9019)], and [Disable upload
function (LB-9033)]. Users can also set these features via system tag.

To select a system tag, select [Address] » [System tag] check box when adding a new object and
then select the [Address Type].

To browse all the system tags, Select [Project] » [Tag] » [System] from the main menu of

EasyBuilder Pro.

Setting Description

Startup language after Set the language to use when HMI starts after
redownloading the the project is re-downloaded.

project

Delay time of device Certain PLC models need relatively longer
communication after startup time. In order to prevent

HMI starts communication error that occurs when HMI

I__| WE!NTEK EasyBuilder Pro V6.07.02
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attempts to communicate with a PLC that has
not yet started, a delay time can be set.
Include delaying the execution of all init.
Macros when HMI starts.

With this option selected, the macros that
have [Execute one time when HMI starts]
enabled will also be delayed.

Execute init. MACRO

when power on

Designate the macro to be executed when HMI
power on.

Auto logout

If leaving HMI untouched for longer than the
set time, the objects protected by security
classes will not be able to operate. The user ID
and password must be entered again to unlock
it.

Hide system setting bar /
Start Button

Hide the system setting bar from HMI screen.

Hide mouse cursor

Hide the mouse cursor in HMI screen.

Mouse cursor size

Set mouse cursor size.

Sound control

With each touch on a button, a sound is
emitted: A sound is emitted when touching a
button.

With Each operation from a button, a sound is
emitted: When the [Min. press time] is
specified, there may be a time gap between
touching the object and the action of the
object. With this option selected, the sound is
emitted when the object actions.

Disable sound output: Mute HMI. (Not
including the sound played when tapping
system setting button on HMI.)

Play next sound after stopping previous:
(cMT / cMT X Series only) When the next
sound is triggered at the time the current
sound is playing, the current sound will stop,
and the next sound will start.

Disable upload function
(effective after rebooting
HMI) (or set LB9033 ON)

Disable HMI to upload project.

L—| WE!NTEK
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Use a disconnection icon
or relative objects when
device communication
fails

If selected, a disconnection icon is

displayed on relevant objects %5‘
when failing to communicate with ﬁ
the device.

This icon will be shown in the .-//\\
Iovyer right corner of the \xﬁfi,
object.

This icon will only show for
disconnection after successful connection.

Enable watch dog
(LB-9049)

Watchdog automatically reboots the system
after the HMI stops functioning for a specified
period of time.

Enable font preloading
(optimize performance
but HMI may start

slower)

(cMT / cMT X Series only)

With this option selected, the speed of
changing windows that contain more texts is
optimized. Please note that using this feature
may slow down HMI boot time.

Display timer for min.

(cMT / cMT X Series only)

press time With this option selected, a countdown timer
is shown when an object with min. press time
set is being pressed.
5.6. Remote

Parameters in this tab configure remote connections. Certain functions can be carried out

using system registers.
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System Parameter Settings @
Extended Memory |  CellularDataNetwork | TimeSync/DST | e-Mail |  Recipe Database
Device I Model General l System Setting | Remote [ Security

[¥] Prohibit remote HMI connecting to this machine
[¥] Prohibit password remote-read operation (or set L9053 on)
[¥] Prohibit password remote-write operation (or set LBI054 on)

VNC server

[7] Password free
[¥] Password from project
Password :

[¥] Monitor mode

EasyAccess server

Location of EasyAccess 2.0 server : lGIobal v

Diagnoser

[¥] Enable

[7] Password free

Password :
cMT viewer
Max connectcount: 3 [$ Count:1~10
Warning : too many connect count will affect performance.
[ OK ] [ Cancel Help

Setting Description
Prohibit remote HMI Prohibit the connection with a remote HMI or
connecting to this cMT Viewer. The remote HMI will not be able
machine to control the local HMI.
Prohibit password Prohibit Remote HMI to read Local HMI’s
remote-read operation project password and user password.
(or set LB9053 ON)
Prohibit password Prohibit Remote HMI to write to Local HMI’s
remote-write operation project password and user password.
(or set LB9054 ON)
VNC Server If [Password free] check box is selected, the

client can connect with HMI via VNC without
entering the password.

If [Monitor mode] check box is selected, the
HMI connected via VNC can only be monitored
but not controlled.

I__| WE!NTEK EasyBuilder Pro V6.07.02
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If [Password from project] check box is
selected, set the password for VNC login.

Easy Access server

Login EasyAccess 1.0 server:

Through this technology, users can easily

access to any HMI connected to the internet

and operate them on PC just like holding touch

screen in hand.

Easy Access does not transmit updated graphic

images directly but only the real time data.

This makes transmission really quick and

efficient. Please refer to “EasyAccess Manual”

for more information.

Location of EasyAccess 2.0 server:

Current location includes Global and China.
Click the icon to watch the demonstration

film. Please confirm your internet connection

before playing the film.

Diagnoser

Enable

When selected, cMT Viewer will allow
diagnostic operations when connecting to a
cMT / cMT X model. System register LB-12656
can also be used to control Diagnoser.
Password free

Enabling Disgnoser will not require password
login. System Register LB-12657 can also be
used to set whether a password is required.
Password

Enter the password for logging in Diagnoser.
System register LW-11756 (4 words) can also
be used to set this password.

cMT Viewer

Max connect count

Allows specifying the allowable number of cMT
Viewer connections for a local cMT / cMT X
HMI.

5.7. Security

Parameters in this tab configure the user passwords and security classes. There are two

authentication modes: General Mode and Enhanced Security Mode.

& For more information, see “10 Security”.
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5.7.1. General Mode

System Parameter Settings
Ex?eih}:iéd'l;'riemory | Printer/Backup Server | Time SyncJD’ST 7L iM;a:l J R:c;ipes
| Device | Model | Gemenl |  SytemSeting | - Seowsty | Fomt

@ General mode Enhanced security mode
Select operable classes for each user
Password range : 0 ~ 4294967295
No. Enable Password Class 4 ClassB ClasC ClassD Clas ~
1 & 0 ® = & ] =
2 @ 222 4] E
3 @ 333 4]
4 (F o 2
A A BN 2 I (i M - 2
< n »

Up to 12 sets of user and password are available. Password should be one non-negative integer.
Once the password is entered, the objects that the user can operate are classified.

There are six security classes available: Ato F.

If [None] is selected for an object, every user can access this object.
For example, when the security class of User No. 3 is set as the preceding figure, User No. 3

could only access objects of classes A, B, C and “none”.

5.7.2. Enhanced Security Mode

At most 11 users can be set here. An [Administrator] user is provided in this mode. An

[Administrator] has all privileges and can operate all object classes. User passwords must be

alphanumeric, and each user can have up to 12 classes: A to L.

L—| WE!NTEK
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System Parameter Settings (==
i Cellular Data Network | Printex/Backup Server LMW}DST ] e-Mail | Recipes |
| Device | Model | Genemal | Sysemfetting | Secwity | Non-ASCIIFonts | Extended Memory |

General mode @ Enhanced security mode Editable...
Select operable classes for each user
[ Use existing user accounts on HMI first (if existed). Otherwise, use settings below.
User name Password Class & Class B o
userl 1 2} a8 (A
user2 2 ] = (T
user3 3 [#] ¥
userd 4 ] B
userS 5 2} B
userfi 6 [ [l ¥
< »
Administrator
[T Secret user User name : | admin Password : 111111
Control sddress
PLC : Local HMI
Address: Ly 8950
Project password
[] Enable Settings
Execute auto logindogout when insert an USB key into HMI
[T Enable
* Simulation does not support this function and L W-11165s display expiration time of USE key.

[ OK ] I Cancel Help
Setting Description
Editable Determines whether other users can change the

password settings or see passwords.

Read-only Settings @

[¥]Enable read-only

Password : 111111 (1 ~ 4294967295)

[¥] Mask password

Enable read-only

Under this mode, the settings can be viewed but not
changed.

Mask password

Passwords are masked by asterisks (*).

Select operable When [Use existing user accounts on HMI] check box
classes for each is selected, the user accounts existing on HMI will not
user be erased after downloading the project file to HMI.

Administrator Default administrator account, cannot be deleted, has

all privileges, and cannot be changed. Enhanced
Security Mode can be used with Option List object. It
displays the account names and privileges. If [Secret
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user] is checked, the account names and privileges
will be hidden in Option List.

Control address

An address for users to manage the accounts directly
on HMI.

Project password

When this password is enabled, it has to be entered
before editing the project file.

Select [Enable] and then click [Settings] to set the
password.

Execute auto.
Login/logout
when insert an
USB key into HMI

This feature allows automatic login / logout using an
USB security key. The login / logout status will be
written into a designated address. Insert the USB disk
to HMI to log in, and remove the USB disk to log out.
The result codes of login / logout: 0x00: No action,
0x01: Login succeeds, 0x04: Login fails, 0x08: Logout
succeeds, 0x10: Logout fails.

5.8. Extended Memory

Parameters in this tab determine the location of the extended memory.

System Parameter Settings @
| Device Model General l System Remote I Security |
Extended Memory CellularDataNetwork | TimeSyneDST | e-Mail i

EMO

File name : emf) emi @ USBdisk 1 () USBdisk2
EM1

File name :  eml emi © USBdisk 1 D USBdisk 2
EM2 .

File name : em2 i @ USB disk 1 () USBdisk2
EM3

File name : em3 emi @ USBdisk 1 () USBdisk2
EM4 =

File name : emd emi @ USBdisk 1 USB disk 2
EM5

File name : emS emi © USBdisk 1 () USBdisk2
EM6

File name : emf emi @ USBdisk 1 () USBdisk2
EM7

File name : em? emi © USB disk 1 O USBdisk2
EM8

File name : emB i © USBdisk 1 () USBdisk2
EM9

File name : em9 ermi © USBdisk 1 ) USBdisk2
EM10

File name : em10 emi © USBdisk 1 () USB disk 2
EM11

File name : emll emi © USBdisk 1 USB disk 2
EM12

File name © eml2 emi © USBdisk 1 (O USBdisk2
EM13

File name : eml3 emi © USBdisk 1 () USBdisk2
EM14

File name : eml4 emi © USBdisk 1 USB disk 2
EM15

File name : eml5 emi © USBdisk 1 () USB disk 2
[¥] Enable dynamic file name (not including filename extension) Usage

oK ] [ Cancel ] [ Help
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Extended Memory is numbered from EMO to EM15. It works in a way similar to other device
types (i.e. LW or RW address). Users can simply select from EMO to EM15 in the [Address]
setting while creating a new object. Maximum allowable data size for each Extended Memory

is 2G words.

LW
PLVW
RW
RVW_A
RWI
EMO
EML
EM2
EM3
EM4
EMS
EME
EMT
EMS
EM3
EM10
EM11
EM12
EM13
EM14
EM15

IFIE

Data in the extended memory is saved as a file into [SD card] or [USB disk]. By default, the files
in [EMO] to [EM15] are with the file names “em0.emi” to “em15.emi” respectively, although
users are free to change the file names. To open these files and edit the data in the extended
memory, RecipeEditor.exe may be used.

Data in the extended memory will not be erased when HMI power is cut, which means data in
the extended memory remains the same as before power off when HMl is started again. This is
a behavior similar to recipe data (RW, RW_A).

When the device used as extended memory does not exist, reading the data in the extended
memory will get “0”, and writing data to the extended memory will display "Device no
response" message on HMI.

Cutting HMI power is not necessary for inserting or removing the external device to or from

HMI, making it easy for users to immediately update or obtain data in the extended memory.

Setting Description
Enable dynamic With this option selected, the file names of
file name EMO~EM15 can be changed dynamically. Select “EM

file name index (0~15)”, enter “EM file name”, set
“Control” to 1, and then see the “Result”. After
successfully changing the file name, the new file name
will immediately be the data source of EM address.
Please note that after changing the EM file name
dynamically, the new file name is retained after
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rebooting HMI, which may be different from the file
name specified in the project file.

Address Usage...

Centrol :
EM file name index (0~15):
EM file name :

Result:

[l
LW-12650
Lw-12651
LWwW-12652~12701 (50 words)
Lww-12702
0 success
1:fail (not support)
2 :fail {invalid file name index)
3 - fail (the same file name)
4 - fail {invalid file name)

E Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.
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5.9. Printer / Backup Server

Configure remote printer / backup server. This feature is not supported on cMT / cMT X Series

HMI.

System Parameter Settings @
[s Device [ Model ] General ] Systemn Setting [ Security [ Font
| Eended Memory |  PrintevBackupSever | TimeSynwDST | eMsl | Recipes
[¥] Use Remote Printer/Backup Server
* Use EasyPrinter to configure PC for printing screen hardcopy and storing backup data.
Qutput settings
Orientation : @) Horizontal O Vertical
Printer size © @) Qriginal size () Fit to printer margins
Margin : 0 2 mm
0 & v 0 £ mm
0 i
Communication settings
IPaddress : 192 - 168 - 1 - 100
Portno.: 8005
User name :  admin Password : 111111

Setting Description
Output Orientation
settings Set how will words or pictures be printed out, [horizontal]

or [vertical].
Printer size

Set to print out in [Original size] or to [Fit to printer

margins].
Margin

Set the top, bottom, right and left margin width.

Communication

settings

IP address

Assign the IP address of the printer via network.
[Port], [User name], [Password]

Specify the data to log in server.

Port can be set from 1 to 65535.
Maximum length of user name or password is 12
characters.

r For more information, see “26 EasyPrinter”.
4

Bemed

before downloading the demo project.
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5.10. Time Sync./DST

Configure HMI time synchronization and daylight saving time.

-

System Parameter Settings

(B

Device I

Model [

General I System ] Remote Security

Extended Memory

| CellularDataNetvork | Time Sync./DST | eMsil

HMI time zone :  {UTC+08:00) v

* [HMI time zone] setting will also be vsed for timestamps of OPC UL and MQTT.

[¥] Enable time symchronization with the external device when HMI starts

Device : [Mitsubishi FX5U

S e m|ce)

Address: |D v 0

[¥] Enable time symchronization via NTP (Network Time Protocol) server

[V] Execute time synchrondzation when HMI starts
[ Sexver response time has been adjusted in accordance with DST

Server response time
Network time server 1 :
Network time server 2 :
Network time sexver 3
Network time sexver 4

Update interval (10 ~86400) : 10

*Use LW-11273 ~ 11294 to modify settings on HMI.
*1f failed o execute time synchronization, the status of LB-12055 is set to ON.

[V] Automatically set daylight saving time (DST)

B32-bit Unsigned

(UTC+00:00) GMT Standard Time v
0.poolntp.org (e.g. wwv nist.gov or 24.56.178.140 )
1 poolntp.org
2.poolntp.org
3 poolntp.org

seconds

Stert : [March v|[Second v [Sunday v| lozoo b 3
End : [Nnvember v] [Fim v] [S\mday v] 0300 £F <
Daylight bias: 01:.00 5 (00:30 ~12:00)
*HMI entexs into DST period when LB-12355 (read only) is ON.
*Use LW-11260 ~ 11272 to modify settings on HMI.
*DST is not supported in on-line simulation.
[ oK ] [ Cancel ] [ Help J

Setting

Description

HMI time zone

Select HMI time zone.

Enable time
synchronization
with the external
device when HMI
starts

Automatically synchronizes HMI time with the designated
source address when HMI starts. As shown in the settings
above, the time source is set to D address of the device
Mitsubishi FX5U, so 6 consecutive word addresses starting
from D-0 will be the source addresses and each of them

should contain time information as follows:
D-0 - Second (range: 0~59)

I__| WE!NTEK
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D-1 - Minute (range: 0~59)

D-2 - Hour (range: 0~23)

D-3 - Day (range: 1~31)

D-4 - Month (range: 1~12)

D-5 - Year(range: 1970~2037)
Enable time Execute time synchronization when HMI starts
synchronization Automatically synchronizes HMI time with the designated
via NTP (Network NTP server when HMI starts.
Time Protocol) Server response time
server Select NTP server time zone.

Network time server

Provides four fields to fill in Network Time Servers for user’s
device. If the synchronization with server 1 fails, the system
will try to synchronize with server 2, and so on. If HMI time
cannot synchronize with any of the Network Time Servers,
the system register LB-12055 will change to ON status.
Update interval

The frequency of synchronization, the range is from 10 to

86400 seconds.
Automatically set Start / End
daylight saving Set the start/end of Daylight Saving Time.
time (DST) The option [Last] may refer to the 5% or 6! week depending

on the selected month.
Daylight bias
Set the time zone's offset during DST.

0 Note

When DST ends, and the time falls back, the Trend Display object in Real-time mode will
stop refreshing for the overlapping hour(s) when it just going back to standard time.
However, historical data will not be affected.

When DST ends, adjusting HMI time (manually or by network) back to the DST period will
not be effective to the system. The system register LB-12355 stays OFF.

When DST ends, and the time falls back, the system will not start DST for the overlapping
hour(s). The system register LB-12355 stays OFF.

Before DST starts, adjusting HMI time (manually or by network) into the DST period will
start DST. The system register LB-12355 will be set ON. The HMI time will be the specified
time without adding the offset.

During DST, adjusting HMI time (manually or by network) to a time that is not within DST
period will end DST. The system Register LB-12355 will be set OFF. The HMI time will be
the specified time without subtracting the offset.
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B This feature does not yet support the DST in Southern Hemisphere.

C?For more information on system registers relevant to DST, see “22 System Registers”.

5.11. e-Mail

Select [Enable e-Mail function] check box to configure the parameters.
When [Use existing contact settings on HMI] check box is selected, the system will use the
contact settings in HMI after downloading the project to HMI, or use the following settings

when no contact is found in HMI.

-~

System Parameter Settings
Device [ Model l General l System Setting ] _Remote I_ Security
Extended Memory | Cellular Data Network l Time Syme/DST | e-Mail Recipes
[V] Enable e-Mail function
[7]Use existing contact settings on HMI first {if existed). Otherwise, nse settings below.
SMTP settings
Server : Portno.: @
User name :
Password :
Confiom Password
[T]SMTP server requires authentication
[ Use the following type of encrypted connection
TL®
Sender information
Name : [Cushonﬁze vJ
Local HMI
Maidl sddress :
Error message
[¥] Enable
Device : | Local HMI Settings...
Address: (L i [ 20 word (s)
* Failed step and error code are stored to LW-11444~11445
Error notification
*LB-12053 or LB-12054 is ON when failed to send an e-Mail
[7] Tum OFF LB-12053 or LB-12054 before sending an e-Mail.
[ TetSMIPSeftings.. |
e
Setting Description
SMTP Settings Server: Set SMTP Server.

Port: Set communication port.

User name: Set e-mail address.

Password: Set e-mail password.

Confirm Password: Confirm e-mail password.

SMTP server requires authentication:
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Decide whether Secure Password Authentication is needed
when log in e-mail.

Use the following type of encrypted connection:

Decide whether the encrypted connection (TLS, SSL) is

needed when sending e-mail.

Sender

Information

Name:

Enter the sender name or use the local HMI name in the
device list, or the name specified using system register
LW-10884 (HMI name).

Mail Address:
Setting e-mail address.

Error message

When an error occurs in email delivery, the error message
sent from SMTP server can be shown in the designated
address.

C)?For more information on system registers relevant to

mail delivery, see “22 System Registers”.

Error

notification

Turn OFF LB-12053 or LB-12054 before send an e-Mail
When enabled, system registers LB-12053 or LB-12054 will
be turned off before sending e-mail, otherwise, when an

error occurs in email delivery, the register remains ON.

Test SMTP
Settings

Verify SMTP settings in advance by sending a test email to

the specified e-mail address.

Click [Recipients] to open the following dialog to edit contacts:

Contacts @
Mo. of groups : 1 Z
Contacts list Group information
Contact Haime Madl Address Contact Haime Mail Address
p NewContact MewContart@d omain com NewContact NewContact@d omain.com
Current group : IGroup A ']
Add I I Remove Comment :
Import... “ Export... ‘ ’ OK ” Cancel ‘

L—| WE!NTEK
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Setting Description

Contact list Add or remove contacts from the list.
Group Group up contacts.

Information No. of groups:

Set no. of contact groups, according to the number, the
groups are named from A to P and up to 16 groups can be
set.

Current group:

Displays the group that includes the contacts above.
Comment:

Enter a description for the current group.

or For more information on sending Event Log, see “7 Event Log”.

-y For more information on e-mail related system registers, see “22.3.40 e-Mail”.

E Click the icon to watch the demonstration film. Please confirm your internet connection
before playing the film.

= Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
5.12. Cellular Data Network

This tab is for setting cellular data. Cellular data network settings may differ from one model to
another.

Applicable models:

cMT X Series models

cMT-SVR (OS ver. 20151127 or later)

cMT3071/cMT3072/cMT3090/cMT3103/cMT3151 (OS ver. 20180723 or later)
cMT-HDM/cMT-FHD/cMT-FHDX (OS ver. 20190130 or later)

MT8051iP/MT8071iP/MT8102iP (OS ver. 20201007 or later)

Attaching a 3G/4G USB dongle to the USB port enables the cMT-SVR to connect to 3G/4G
networks.
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Dievice I Model I Creneral I Swatem Sethng | Security | Font Mapping |

Extended Memory | TimeSyne/DST |  eMal |  Recipes | Cellulaw Diata Network

Us

3G/4G Dongle
304G Dongle (cMT-SVR spport anly) Tethering
PIN code : 0000 AFN © internet
Usemame ©  sermame Pasgword © password

Dial number :  +30#

USE cable

Setting

Description

Use existing contact
settings on HMI

If this check box is selected, the cellular data currently
in HMI will be used. When no specific settings are
required, generally, [PIN code] is “0000”, [APN] is
“internet”, and [Username], [Password], [Dial number]
are optional.

The relevant registers:
LW-11297:
LW-11313:
LW-11329:
LW-11345:
LW-11361:
LW-11377:

LW-11378:

LW-11379:

USB Tethering

(16 words) : PIN code of SIM card (cellular network)
(16 words) : Access Point Name (cellular network)

(16 words) : username (cellular network)

(16 words) : password (cellular network)

(16 words) : dial number (cellular network)

(16bit) : stop (set 0)/start (set 1) connection (cellular
network)

(16bit) : last error code (0:success, 1:incorrect PIN code,
2:no SIM, 3:no device, 4:puk locked, 5:other) (cellular
network)

(16bit) : connection status (0:no device, 1:disconnect,
2:connecting, 3:connected) (cellular network)

By connecting an Android® mobile phone with HMI using a micro USB cable, or any USB data

cable that is compatible with the phone, the internet connection of the phone can be shared

with HMI. On the Android

L—| WE!NTEK
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Tethering or hotspot active

(== Tethering & portable hotspot

USB tethering
Tethered

Portable Wi-Fi hotspot

Set up Wi-Fi hotspot

AndroidAP WPA2 PSK portable Wi-Fi hotspot

Bluetooth tethering

aring this phone's Internet

5-38

When successfully connected, the following registers can be used to monitor and control the

connection status.

LW-11380: (16bit) : stop (set 0)/start (set 1) connection (USB
tethering)
LW-11381: (16bit) : connection status (0:no device, 1:disconnect,

2:connected, 3:fail, 4:0S not support, 5:HMI not

support) (USB tethering)
. 4

before downloading the demo project.

5.13. FTP

Click the icon to download the demo project. Please confirm your internet connection

This tab is for configuring FTP connection parameters. With [Enable FTP function] selected,

backup files (screen hardcopy or historical data) can be transferred to FTP server on PC from

HMI, in order to achieve the same effect as using EasyPrinter.

cMT / cMT X Series models.

This feature is only supported on

System Parameter Settings

Device Model

Extended Memoryr

Greneral
Cellular Data Network

Sstern
Time Bme DET

| Enable FTF function {for screen hardeopy and historical data backuop)
FTP server

FTF server : | 1. FTF server : 192.168.1.100:21

7]

Warning convention for HMI folder
@ Tse IP address
ze backup folder name (aesgn backup folder name by LW-0032-L W-0039)

Prefiv: IP_
(Ex:IP_192.168.1.25)

L—| WE!NTEK
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Setting Description

Enable FTP With this option selected, backup files (screen hardcopy
Function or historical data) can be transferred to FTP server.

FTP Server FTP server’s information.

Naming

Use IP address or HMI name to name the HMI folder.
Prefix: Add a prefix to the beginning of the folder name.

Convention for
HMI Folder

0 Note

B When FTP function is enabled with no FTP server exists in the project, the FTP Server
settings page in Data / History tab will be opened for configuration of FTP connection

parameters.

i =

# | EasyBuilder Pro @I

Mo FTP server exists. Do you want to create one?

Ok Cancel
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6. Window Operations

This chapter describes different types of windows and how to create, set and delete a window.

6.1.
6.2.
6.3.
6.4.
6.5.

OVBIVIBW ...ttt ee ettt e e e e ettt et e e e e e sttt e e e e e e s e anbe et eeeeeesesanssseeeeeeeeessannnrnenaeaeens 6-2
WINAOW TYPES .vvveeieeieeieiiieieeee e e e eesetrrre e e s e e e s ettt e e e e e e sesseasaeaeeeaeesesesnssanneeeeeesessanssnnns 6-2
Create, Set, and Delete @ WINUOW.......cooiiiiiiiiiiiieeee et 6-4
WiINAOW TranSPArENCY ....uuereiiieieeeeeicetiiiteeeeeeesesitrrreeeeeeeessssssseseeeeeesessssenseesesesessnssssens 6-8
oo T oY= T o L3S UUPRR 6-10
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6.1. Overview

A window is a basic element in a project. With a window, all kinds of information like objects,
pictures, and texts can be displayed on HMI screen. In total, 1997 windows numbered from 3 ~
1999 in EasyBuilder Pro can be built and edited.

6.2. Window Types

There are 4 types of windows, each with different functions and usages:
® Base Window

® Fast Selection Window

® Common Window

® System Message Window

6.2.1. Base Window

The most frequently used window, except for main screen, it can also be:
® A background of other windows.

A keyboard window.

A pop-up window of Function Key object.

A pop-up window of Direct Window and Indirect Window objects.
A screen saver.

0 Note

B Base Window should be in same size as the HMI screen. Therefore, the resolution of the
base window should be set to the resolution of HMI.

6.2.2. Fast Selection Window

Window no. 3 is the default Fast Selection Window. This window can co-exist with base
window. Generally, it is used to place the frequently-used buttons on the lower-left side or the
lower-right side on the screen. Please create window no. 3 first, and set the relevant properties
in [System Parameter Settings] » [General] tab. Apart from showing or hiding fast selection
window with the button on the screen, there are system registers to do so:

[LB-9013] hide (set ON)/show (set OFF) Fast Selection window

[LB-9014] hide (set ON)/show (set OFF) Fast Selection button

[LB-9015] hide (set ON)/show (set OFF) Fast Selection window/button

0 Note

B cMT/cMT X Series does not support Fast Selection Window.
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6.2.3. Common Window

Window no. 4 is the default Common Window. Objects in this window will be displayed in

other base windows, not including pop-up windows. Therefore, the common objects in

different windows are often placed in common window.

When operating HMI, select [Function Key] » [Change common window] to change the source

of common window.

In menu [File] » [Preferences] » [Display] select whether or not to [Display Common Window

objects on Base Windows] when editing a project. This can avoid overlapping objects in base

window with objects in common window.

Preferences &J
Display Object 1D Display Object Address
Font size : Text color : I ~
[¥] Background Background color : ﬂ

The number of displayed addressas :

Display Common Window objects on Base Windows

[] Display Underlay Window objects on Base Windows
|| using function key to make shape library object

Autormaticaly save and compile the project when download and simulate
[T] Generate backup of project file before save
[ Automatically rmake used pictures and shapes into the project library

Save AutoRecover information

Every minutes

6.2.4. System Message Window

Windows No. 5, 6, 7, 8 are the default System Message Windows:

Eﬁao Device No Response

Window No. 5: Device No Response
When the communication between device and HMI is

disconnected, this message window will pop up

automatically right on the base window currently opened.

This window can be disabled by system registers.

& railed Connection to
D Remote HMI

Window No. 6: HMI Connection
When failing to connect HMI with a remote HMI, this

message window will pop up automatically.

€ Password Protected!
Access Denied!!

Window No. 7: Password Restriction
When attempting to control an object without

authorization, this window may pop up as a warning

depending on the settings of the object.

L—| WE!NTEK
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Window No.8: Storage Space Insufficient
» When HMI flash memory, USB disk or SD card run out of
Storage Space Insufficient !f . . .

storage space, this message window will pop up

@ automatically. (When the memory space is under 4 MB)

The following system registers can be used to check the free memory space in HMI, USB disk,
or SD card:

[LW-9072] HMI current free space (K bytes)

[LW-9074] SD current free space (K bytes)

[LW-9076] USB disk current free space (K bytes)

To check if there is sufficient storage in the devices, the following system registers can be used.

These addresses will set ON when the space is under 4 MB.
[LB-9035] HMI free space insufficiency alarm (when ON)
[LB-9036] SD card free space insufficiency alarm (when ON)
[LB-9037] USB disk free space insufficiency alarm (when ON)

CS?For more information, see “22 System Registers”.

The text shown in windows no. 5 ~ 8 can be edited for easier reference.

0 Note

B For eMT/iE/XE/mTV models, a screen can display up to 24 pop-up windows simultaneous
including System Message Window, Direct Window and Indirect Window. For cMT/cMT X
Series, the number of pop-up windows is not limited.

B The system does not allow opening the same window with two Direct (or Indirect)
Windows in one base window.

B  Windows no. 3 to 9 are used by the system only, and windows no. 10 to 1999 can be
edited based on actual usage.

6.3. Create, Set, and Delete a Window

Check the existing windows in [Windows Tree].

[Windows Tree] displays window numbers and window names. Opened windows are marked
with T icon. Press the (+) sign to see the object ID, address and description of the objects
used in this window.

[Window preview] displays the thumbnails of windows.
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Windows Tree

™ 3: Monitor Mode

™ 4 : Common Window
[ 5: Device Response
[ 6: HMI Connection

[ 7 : Password Restriction

[T 8: Storage Space Insuffici...
] 9:Backup
[ 10: WINDOW_010

I FK_O (Back)
- FK_1
- FK 2
L FK3
11
12
13
14
15
16
17
18
19
20
21
22
23

6.3.1.

In windows tree right click on a window number then select [New].

Creating and Setting a Window

[\& WEINTEK

Windows Preview
0003

Monitor Mode

0004-

Common Window

Password Rastriction
0008

Lo

Storage Space Insufficient
0009

Backup
0010

WINDOW_010

m
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Window Settings

Name @ WINDOW_010

Window no. : 10

Size
Width : 800

Background

Color : v

[T Filled

Height : 480

Color : GG ~

Frame

Underlay window

Bottom : [11. Window_011 ']

Middle : [None hé ]

Top: [None - ]

Popup window

Start position

¥: 0 v. 0 [¥] Monopaly [¥] Title bar

Macro

Open : [[ID:UUO] macro_0 v]

Cyde : |Disable -

Close : [Disable T ]

Setting

Description

Name

The name appears on the title bar and also in windows tree.

Window no.

Can be 3 to 1999.

Size

Set the window size in accordance with the HMI resolution.

Underlay
window

Underlay Window can be seen as an extra Common
Window. When designing the project, some commonly
used objects are used in some windows but not all. These
objects can be placed in underlay window.

Each base window can set three underlay windows as
background, from [Bottom] to [Top]. The objects in underlay
windows are displayed in this order in base window.

Pop-up
window

Base window can also be used as a pop-up window. Use [X]
and [Y] to set the coordinates indicating where in the screen
will this base window pop up. The origin of the coordinates
is the upper-left corner of the window.

Monopoly

If the option is selected, when the base window pops up, no
operations of other pop-up windows and background
windows are allowed until the monopoly window is closed.
If a base window is used as a keyboard window, “Monopoly"
is automatically enabled.

Title bar

If the option is selected, a title bar appears on a system
message window. This feature is only available for system
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message windows no. 5 to no. 8.

Macro Select the macro to be executed when the window opens or
closes, or the macro to be executed periodically (each 500
ms).

Please build the macro in advance.

@ Note

B The objects in underlay window cannot be edited from the base window that displays
them. To edit those objects, please open the underlay window where they are located.

B When the window number of the underlay window used by the base window is identical
to the pop-up window, the pop-up window is disabled.

B When base window and pop-up window use the same underlay window, the objects in
the underlay window cannot be displayed in pop-up window.

El Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.

Or, from the main menu click [View] » [Open Window] and then click [New] and select the type

of the window and click [OK].

Open Window
Nao. Window name Size
3 Fast Selection 100,450
4 Common Window 800,480
5 PLC Response 320,100
6 HMI Connection 320,100 Seitiigs:
7 Password Restriction 320,100
8 Storage Space Insufficient 320,100
*10 WINDOW_010 800,480
50 Keypad 11 - Integer 275,280
51 Keypad 12 - Integer 275,280
52 Keypad 3 - Integer 200,170
53 Keypad 4 - Integer 304,213
54 Keypad 5 - Integer 160,230
55 Keypad 6 - Integer 241,331
56 Keypad 7 - HEX 306,223
57 Keypad 8 - Floating 198,220
58 Keypad 9 - Numeric 248,248
60 ASCII Middle 576,240
61 ASCII Srrall 480,200
62 ASCII Upper M 576,240
63 ASCII Lower M 576,240
64 ASCII Upper § 480,200
63 ASCII Lower S 480,200
Exit

Ways to call up [Window Settings] dialog:

® Right click on the window number in the windows tree and select [Settings].
® In[View] » [Open Window] select the window then click [Settings].
® Inthe window, right click when no object is selected, and select [Attribute].

6.3.2. Open, Close, and Delete a Window

The ways to open an existing window:
® Double click on the window number in the windows tree.
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® Inthe windows tree, select the window number, right click, and then select [Open].
® |n[View] » [Open Window] select the window number and then click [Open].

The ways to close or delete an existing window:

® |nthe windows tree, select the window number; right click, and then select [Close] or
[Delete].
® |n[View] » [Open Window] select the window number and then click [Delete].

6.4. Window Transparency

The Opacity setting in the View tab is used to adjust transparency effect of the common
window, overlay windows, and window layers.

EasyBuilder Pro @

[View] > [Layer Opacity] is set to 50% by default for window layers,
! % common window and underlay windows to enhance object
visibility in current window during editing.

Lo ]

As shown in the following screenshots, greater Opacity makes the object in the relevant

window more visible.

\ () Zoomin . @ Zoomin
) -_ o
. (2) ZoomOut o @ ZoomOut
Opacity Zoom Center Opacity Zoom Center
30% »  75%. (i FittoWindow | View + 70% -~  75%. tiy FittoWindow  View .
T 0% 0%
10% o) 10% = F— e
1 JJJL[H,{[!J,L!Jfﬂjjl,l,l,l,,l,l| Jl,llr?:1|||,||,|,|,|5?‘1|||||
20% 20%
v 30% 30%
40% 409
50% 50%
60% 60%
70% v 70%
80% 80%
90% 80%
100% 100

Additionally, the cMT / cMT X Series models support setting window transparency. This setting
is applicable for popup windows, Direct / Indirect Windows, and keyboard windows. The

settings dialog box and the effect are shown in the following screenshots. Greater transparency
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can make the object on the base window more visible when it is covered by the popup

window.
Wiﬁowﬁeﬂings
Name : WINDOW_010
oo, [0
Size
Width : 1024 Height: 748
Backaground
Color : I:IIV|
Transparency : D 20%s
* [Transparency] is used only on popup, directfindirect and keyboard windows.
Underlay window
Bottom : [None -
Middle : [Nane -
Top:lm vl
Popup window
[¥] Monopoly
Macro
Open l vl
Cycle l vl
Close l vl
ok || cancel |
Example

Setting transparency to 40%:

Setting transparency to 90%:

[\& WE!NTEK
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6.5. Editing Tips

EasyBuilder Pro provides a user-friendly interface with which users can easily edit projects. The

following are some editing tips.
6.5.1. Non-display Area, Select Tool, and Hand Tool

As shown in the following screenshot, two areas can be found in the editing window: editing
area and non-display area. The non-display area refers to the area outside the editing area (the
one in the middle). Objects placed in the non-display area will not be visible on HMI, and
communication with devices continues. The invisible objects such as Meter, Time-based Data
Transfer, or Text objects used for comments can be placed in this area to avoid overlapping
with other objects in the editing area, which adds difficulty to project editing. The objects
placed in the non-display area remain effective.
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4 10 - WINDOW_010 %

| T OE VTSI, - VTORTIRTIOONE . FVCTONTROTOTCY, . MVCPTYSPRITIICY, . FCTPISRINIIGY: . FOYPOSTPINTOOCY: - AT

h‘ Select Tool
Clicking this icon in the toolbar changes the cursor to the Select Tool. Select a

single object by clicking it, or select multiple objects by clicking on an empty

part of the editing screen and then drag a box around the objects.

4‘"}2 Hand Tool
Clicking this icon in the toolbar changes the cursor to the Hand Tool. The Hand

Tool allows moving through the project screen by simply left clicking the mouse

and dragging anywhere.

6.5.2. Ruler

| :1|I|I|I|I|I|Illllllpﬂllllll|I|I|I|I|I|:F|:1|I|I|I|I|I|I|I|I|_:P|:1|I|I|I|I|I|I|I|I|4F|:4|I|I|I|I|I|I|I|I|59|:1|I|I|I|I|I|I|I|IlfPﬂlI|I|I|I|I|I|I|I|-P|:4|I|I|I|I|I|I|I|I|I|
Selecting [View] » [Ruler] adds rulers to the top and left of the editing screen. Guides can be
added from the ruler by right click on the ruler. Objects will automatically snap to the guides

when moved or resized.
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q 10 - WINDOW 010 x|

Setting Description
Delete Delete the guide.
Edit

Settings

o]
Add or delete multiple guides.

Selecting [File] » [Preferences] » [Grid] opens the following window for setting the color or style
of the Guides.
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Project

Display

Grid
Library

B
Grid
Spacing
X(4-60): 20 = Y (4-60) : 20 =
[ Display [ snap [ Fix all objects
Guides
soie (=)

6.5.3. Quick Copy

Quick copy can be carried out by pressing and holding Ctrl key on the keyboard while an object

is selected, and then drag the cursor to a new location where the object will be created.

[\& WEINTEK
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/. Event Log

This chapter explains how to set and use Event Log.

7.0, OVEIVIEW ittt ettt e e e e e sttt e e e e e s e bbbttt e e e e e e s e nnnrbeeeeeeeesasnnsrnbeeeeeeeessannnrees 7-2
N A=Y o) oY=V - T o T=0=T0 01T o) T 7-2
7.3, Creating a NeW EVENT LOG ...ccocoiviiiiiiiecececeeeccce et e e s e e 7-9
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7.1. Overview

The following are the basic steps to use Event Log:

1.
2.
3.
4.

Define event content and trigger condition.
Trigger event according to the condition.
Save the event log to the specified device.

View the process of event by using the relevant objects.

This chapter will explain how to set and use Event Log.

El Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.

7.2. Event Log Management

Firstly, define the event content then use Alarm Bar ?, Alarm Display !', Event Display

objects to view the process of the whole event from triggering—waiting to be processed—

return to normal. The upper limit for the number of event logs is 10000.

I__| WE!NTEK EasyBuilder Pro V6.07.02
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Event Log

7.2.1. eMT, iE, XE, mTV,

Category :

Al = ]

iP Series

1 Jo

<

No.| Category| Text

Mode | Condition| Read address
|Event 0|WORD| < 0.00 |Local HMI: LW-0|Disable | Disable| Disable | Ena

Notification address | Buzzer | e-Mail |Sa\

n b

History files

[7] Enable back light when alarm occurs

[] save to HMI memory []save to USB disk

Print

Preservation limit Days of preservation: 7 day(s)

[¥] Sequence no. Trigger time :  HH:MM v Trigger date : DDMMfYY =

[ New...

][ nsert.. ][ Delete ][ settings... [ Export.. |[ import..

[ cony

] [ Paste ] [ Paste (Add Mode) ] | Exit |

Setting

Description

Category

Classifies events by dividing them into 0 ~ 255 categories.
Select one category to add or view event log. In the bracket
“[1”, it shows the number of events are in this category.

History
files

Saves event log files to the specified location. Once an event
occurs, the HMI immediately saves the history file. When
executing On-line or Off-line Simulation on PC, the files will
be saved in the HMI_memory / SD_card / USB folder under
the installation directory.

Preservation limit

This setting determines the maximum number of Event Log
files to be preserved in HMI memory. This does not include
the file generated today. That is, if [Days of preservation] is
set to 2; the two latest files excluding the file generated today
will be kept. The files that are not within the range will be
deleted automatically for saving the storage space.

[\& WE!NTEK
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Print In [System Parameter Settings] » [Model], select a printer and
set the printing format.
Copy Copy the selected item.
Paste Overwrites the selected item with the new items. A message
window will pop up to confirm this operation.
Paste
Appends as a new entry.
(Add Mode)
7.2.2. cMT, cMT X Series
Event | History/Control
Category : All[1] +  Edit category name mapping. .. 1x]
No. | Category| Text Mode |Condition| Read address | Notification address | Buzzer | e-Mail New...
0 Event0|WORD|< 0.00 |Local HMI: LW-0|Disable Disable | Disable
[ Paste
[ Paste
Enable back light when alarm occurs Number of event (alarm) log : 1 /10000
Setting Description
Category Classifies events by dividing them into 0 ~ 255 categories.

Select one category to add or view event log. The number of
events in this category is shown in the bracket “[ ]”.

Edit category name mapping... Opens a category name table
which allows editing corresponding category names.
Subcategories can also be added in this table in addition to
the exiting categories. The maximum allowable number of
entries in each subcategory is 256 (0~255) entries.

[\& WE!NTEK
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Category

Category | Subcategoryl | Subcategory 2

Category ~ Mame

B s teoon0

* Font from [Language & Fent] settings

Copy Copies the selected item.

Paste Overwrites the selected items with the clipboard contents.
A message window will pop up to confirm this operation.
Paste + Appends the clipboard contents to the end of the list.

7

Event (Alarm) Log
History/Control |
History
Enable
Save to

(©) HMI memory (10000 Limited) () HMI memory (until space full)
© USB disk 1 () USBdisk 2

| Status: LW-0+ 1 Error : LW-0+2
Syne to database
[7] Ensbls Database : [1.192.168.1.0 v

[ Status: LW-D +3 Error : LW-0 + 4
History source for display
© USB disk 1 ©) Database

[V] Preservation limit Days of preservation : 7  day(s)

Auto syme. periodically 30 inds)
Control

Enable [¥] Enable status output

Device : [Local HMI G &
Address: LW v 0 j [16-bit Unsigned

Control commeand : 1 [clear], 2 [syme.], 3 [syme. and clear]
4 [clear and restore log mdex]

11 [update messages according to imported string tables]
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Setting Description

History Saves the Event Log data to HMI memory (10000 limited or
until space full), SD card, USB disk, or database (by
synchronizing Event Log file to database server).

The rules of saving the data are:

B When [HMI memory (10000 limited)] is selected, and
the number of events reaches 10000, the system will
delete the earliest 1000 events on HMI and keep on
saving the data to HMI memory. .

B When [HMI memory (until space full)] is selected, the
system will keep on saving the data to HMI memory
without deleting the earlier events. In this case the data
may not be synchronized to database.

B  When USB disk or SD card is selected, and the number of
events reaches 10000, the system will automatically save
the data to the external device and delete the earliest
1000 events on HMII.

B To synchronize the data to database server, select a
database that has been configured before.

B If the external device already contains some events, the
new data is appended without overwriting the original
data each time in synchronization.

B When the external device is removed from HMI, or HMI
is disconnected from database server, if the connection
is recovered before the number of events exceeds 9000,
the events occur during disconnection will be saved to
HMLI. If the number of events exceeds 9000 during
disconnection, the earlier data will be deleted, and
cannot be synchronized by recovering connection.

History ] ) )

Event Log displays the history data read from the designated
source for
display source.

Preservation
limit

This setting determines the maximum number of Event Log
files to be preserved in HMI memory. This does not include
the file generated today. That is, if [Days of preservation] is
set to 2; the two latest files excluding the file generated today
will be kept. The files that are not within the range will be

deleted automatically. The system checks the time of the files

L—| WE!NTEK
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and deletes earlier files only during synchronization.
Auto sync. Data will be automatically synchronized to the designated
periodically external device in the specified time interval, regardless of
the rules explained above.
Unit: Minute(s)
Range: 1~1440
Control If select [Enable] check boxes under both [Control address]
address and [History files], entering a specific value in the control
address sends the corresponding command.
Value | Command
1 Clear the event log on HMI
2 Synchronize event log to the external device
3 Synchronize event log to the external device and then
clear the event log on HMI
4 Use the history data stored in USB disk / SD card /
database after changing HMI
6 Free unused storage space reserved for event logs
(*.db). This command can be used when historical data
is saved to HMI memory (until space full).
11 Update event log message contents by reading a new
String Table
If none of these values is entered, the system will synchronize
data in the same rules as [History] setting.
Status When LW-n is used as the control address, the four
Error consecutive addresses following LW-n (LW-n+1~LW-n+4) will

show status and error, please see the prompt in the settings

dialog box.
Control address
[¥|Enable
PLC: [Local HMI ][ Ssettings... ]
Address : [LW v|o 16-bit Unsigned
Control command : 1 [clear], 2 [sync.], 3 [sync. and clear]
History files

V| Enable |¥| Enable status address

[T] sync. to SD card [V] sync. to USB disk

| Status : LW-0 + 1 Error : LW-0 + 2 |

[¥] Auto sync. periodically 10 min(s)

[¥] Preservation limit Days of preservation : 3 day(s)

Sync to database

[¥] Enable [7] Display history from database

| Status : LW-0 +3 Error : LW-0 + 4 |

Database : (1. 192.168.1.0 v

Value | Status address: LW-n+1 and LW-n+3
0 Disconnected from external device or database
1 Connecting with external device or database
2 Connected with external device or database
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3 Storing records into the archive. When this is done, the
value returns to 2.

Error address: LW-n+2 and LW-n+4

None

Unknown error

Failed to connect with external device or database
Access denied

Wrong database name

Inconsistent data format

Failed to open table

Failed to create table

Failed to write table

Failed to open database

Database is corrupted

>
[
(0]

OO (N|OOL|A|WIN|FLR|O

=
o

0 Note

B Before removing SD card / USB disk, or disconnecting from database server, please
synchronize event log data by using control address.

B When monitoring multiple HMIs by using cMT Viewer, the Start Button on the current
HMI screen may flash to indicate that an error has occurred on another HMI that is also
being monitored, reminding the user to switch HMI and check the event.

7.2.3. Excel Editing

Click on the Excel icon in Event Log setting dialog box to open the Excel template for a
reference of editing. This template is under the installation directory, the file name is

EventLogExample.xls. This template includes the ready-made dropdown lists and validation

mechanism.
b E C D E F G H I 1 K
1 Category |Priority level | Address type|PLC name Device type System tag |User-defined tag |Address  |Index Data Format Enable
2 0[Middle Word Local HMI LW False False 100|null 32-bit Signed Tiue
3 1|Low Bit Local HiI LB-O009 True False 9009|IDX 5 16-bit ECD > [se
4 334t BCD
5 16-bit Unsigned
16-bit Finged
6 33-bit nsgmed.
32-bit Signed
7 32-hit Float

0 Note

B [System tag] and [User-defined tag] cannot be set to true simultaneously, otherwise, the
system will view the User-defined tag to be a System tag, and [User-defined tag] to be
false. If setting [Device type] to [User-defined tag], please set [System tag] to false.

B When setting [User-defined tag] to true, if the system compares the [Device type] with
the user-defined tag in the system, and no suitable tag is found, the system will set the
[User-defined tag] in event log to false

B [Color] format is R:G:B, each should be an integer form 0 to 255.
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B Before importing Label Library / Sound Library, please make sure the library names exist in

the system.

7.2.4. Quick View of Errors

When compiling the project, the errors in Event Log will be displayed in the Compile window.

To open Event Log and view the errors, double click on the item in the Compile window.

Compile
Project name : C\EMTP1l.emtp

EXOB file name : [C:\EMTP1.exob

EXOB password = (used in decompiler) || Decompilation is prohibited

[~ Disable HMI upload function

Select the languages used on the HMI
Startup language after redownloading the project : | Language 1 -

[#] Language 1 [#] Language 2

==l

i
. Event (Alarm) Log 1 (Category 1) : PLC name undefined {Rockwel DF1)
. Event (Alarm) Log 1 (Category 1) : incorrect device type
. Event (Alarm) Log 2 (Category 1) : PLC name undefined {Rockwel DF1)
. Event (Alarm) Log 2 (Category 1) : incorrect device type
. Event (Alarm) Log 3 (Category 1) : PLC name undefined (Rockwel DF1)
. Event (Alarm) Log 3 (Category 1) : incorrect device type
. Event (Alarm) Log 4 (Category 1) : PLC name undefined (Rockwell DF1)
8. Event (Alarm) Log 4 (Category 1) : incorrect device type

N RS

[

Double click error massages to modify the attributes of relative objects!
[ Compile ] [ Font Management... ] Build font files

Close

7.3. Creating a New Event Log

General Tab

Click [New] in the [Event (Alarm) Log] dialog box.

I__| WE!NTEK
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Event (Alarm) Log @
General | Message | Statistios
Category : [U:Categoryﬂ v] Subcategory
Priority level : [Low v
Delay time for event monitoring when HMI resets :
[¥] Save to history
[¥] Push notification (Easyhccess 2.0)
Type
) Bit @ Word
Read
Device : (Local HMI vJ.<d
Address: [LW v|0 [  [16-bit Unsigned.
Notification
[¥] Enable () SetON @ Set OFF
[ Follow (set ON when event recovered)
Device : [LocalHMI v][ eI«
Address: [LB v 0 [ '
Condition
Enable if value is :
[V] Dymamic condition value
[V Read/Condition vse different sddresses
Condition value
Device : (Local HMI B e
Address: [LW =) ' [6-bit Unsigned
[ oK ] { Cancel ] [ Help ]
Setting Description
Category Select event category, the range is from 0 to 255.
Subcategory Add this Event Log into the subcategories in the category
name mapping table.
Subcategory ==
Subcategory 1
Enable [0: Subcategory 0 ']
Subcategory 2
e [o:subcatgoryo -]
Priority Events in Alarm Bar / Alarm Display are ordered by priority
level level first and then by time.
Save to In Event Log main settings, if [Save to HMI memory] check
history box under [History files] group box is selected, selecting [Save
to history] here determines whether each separate event
should be saved as historical file.
Push When an event occurs, EasyAccess 2.0 push notifications can

be sent to i0S®/Android® devices.
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notification

(EasyAccess
2.0)

Delay time
for event
monitoring
when HVI
resets

This feature is used to set the delay time of Event Log after
HMI reboot, in order to avoid false alarm that occurs upon
HMI reboot due to uninitialized values. This feature is often
used with [Dynamic condition value]. The delay time only
occurs once upon HMI reboot.

Read

address

The system reads data from this address to check if the event
matches the trigger condition.

Notification

When enabled, the system will set the specified address ON
or OFF when the event is triggered.

Follow

The notification bit will reset to its original state once the
alarm condition returns to normal. For example, when the
alarm is triggered, the state of the notification bit turns ON.
When the alarm condition returns to normal, and [Follow]
check box is selected, the state of the notification bit turns
OFF.

Condition

When [Bit] is selected, Event Log will detect the state of a Bit
address.

When [Word] is selected, Event Log will detect the value of a
Word address to check if it is greater than, less than, or
equals to a specified value. See Example 1 and Example 2.
Dynamic condition value

Allows online change of the comparison value for trigger
condition when the condition is a Word address type. If
[Read/Condition use different addresses] is not selected, the
source of condition value will be the next consecutive address
from [Read address].

Read/Condition use different addresses

Allows selecting the Word address type to be the source of
condition value.

Example 1

L—| WE!NTEK
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The setting above indicates:
When [Read address] value is greater than or equals to 29 (=30 - 1)
Or less than or equals to 31 (= 30 + 1), the event will be triggered. The trigger condition:
29 < [Read address] value < 31
After the event is triggered, when [Read address] value is greater than 32 (= 30 + 2) or less than
28 (= 30 - 2) the system will return to normal condition:

[Read address] value < 28 or [Read address] value > 32

Example 2
Condition
Enableifvalveis: [o  +] 20

Drynamide condition value

In tolerance © | Ot tolerance © 2

The setting above indicates:
When [Read address] value is less than 29 (=30 - 1)
or greater than 31 (= 30 + 1), the event will be triggered. The trigger condition:
[Read address] value < 29 or [Read address] value > 31
After the event is triggered, when [Read address] value is greater than or equals to 28 (=30 - 2)
or less than or equals to 32 (= 30 + 2) the system will return to normal condition:
28 < [Read address] value < 32

I__| WE'NTEK EasyBuilder Pro V6.07.02



Event Log
Message Tab
Event (Alarm) Log @
[ General | Message | Statistos |
Text
Content :
Use label library I Label Library...
[¥] Use string table String Table... ]
Section : | [1D:000] -
String ID
[V] Dymamic [] Record string ID
Device : [Local HMI B e
Address: |[LW v |0 [16-bit Tnsigned
Cobr: ) Beckod Cob
Font : | Arial [Arial] [Droid Sans]
* Font from [Language & Font] settings
Acknowled ge valve for Event/filarm Display object
Acknowledge valve : 11
Sound
[]Enable Sound Library
Play
Addresses of WATCHI1 ~ WATCHS
Multi-watch : Symtac...
[ ] I Cancel ] [ Help
Setting Description
Content The text content displayed in [Alarm Bar], [Alarm Display],
and [Event Display] objects. Use the formats in the
following two examples of WATCH addresses to use
register data in content. The content in Label Tag Library
and String Table can be used in the Event Log message.
String ID [Event Display] and [Alarm Display] objects display

messages according to the String ID in the designated
register.

Record String ID

With this option selected, when an event occurs, the
string’s ID number will be recorded. Message of the event
triggered before can be retained.

Font / Color /
Background

The font / color / background color can be set respectively

I__| WE!NTEK
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color

for each event. The font and color settings determine how
[Alarm Bar] shows the text, while The font, color, and
background color settings determine how [Alarm Display]
and [Event Display] show the text. These settings are not

available in the [Event Display] under History mode.

Write value for
Event/Alarm
Display object

When an event in [Event Display] or [Alarm Display] is
acknowledged, the value is written to the assigned [Write
address].

i. Click the icon to download the demo project. Please
confirm your internet connection before downloading the

demo project.

Sound Sound
(V] Enable Beep
Continuovs beep : | Disable continuous beep X
Disable continuous beep A
Enable continuous beep until recovered
Enable continuous beep wntil acknowled ged ’
Enable continuous beep until acknowled ged or recovered
If enabled, the selected sound will be played when an
event is triggered. Continuous beep can also be enabled,
which only stops when the event is acknowledged or
recovered.
For continuous beep, a delay time can be set between
triggering the alarm and the start of beeping.
{ .“’_\dﬂqwladgedJ
_| L]
L{ser defined |
Sound I I |
(10 ssconcs]The ime o beep sound
i Click the icon to download the demo project. Please
confirm your internet connection before downloading the
demo project.
Address of Users can set how the value is displayed in the designated
WATCH1~ 8

watch address when an event occurs. Up to 8 watch
addresses can be used simultaneously. Click [Syntax] to
see how to use the syntax to embed device data in the
content of an event log displayed in the watch address.
in Click the icon to download the demo project. Please
confirm your internet connection before downloading the

demo project.
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e-Mail Tab

Please enable this function in [System Parameter Settings] » [e-Mail] first.

Event (Alarm) Log @

| General I Message | e-Mail |Oocurrenoe|

Enable Condition Recipients
Send when event triggered
» Send when event cleared Giroup &

Recipients
[ As recipients of triggered mail settings

Group A

Subject
Use event content as subject

Subject : | Tank level low. level=":(WATCH1)d.0 -

] 3

Message
Opening : -
4 3
Use label library

Ending : -

] 3

Use label library

Label Library... ] [Language i -

o ) [comm

Setting Description

Recipients Select the [To], [Cc], and [Bcc] recipients.

Subject Enter the subject of the e-mail.

Message Enter the [Opening] and [Ending] content of an e-mail.

Attach If the [Contains a screenshot of window] check box is
selected, the screenshot of the selected window will be
attached.

0 Note

B The priority level of an event determines its importance in e-mail delivery.

Event Priority Level Email Importance
Emergency High

High / Normal Normal

Low Low
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Statistics
Event (Alarm) Log =]
\ General l Message | Statistics ‘
Occurrence read and reset address
[V] Enable
PLC: [Loca.l HMI v] Settings...
Address [LW ,] 0 i 16-bit Unsigned
Elapsed time read and reset address
[V] Enable
PLC : [Local HMI v [ Settings... |
Address : [LW ,] 0 ] [16-bit Unsigned.
Unit of elapsed time : second
Setting Description
Occurrence

If enabled, the number of occurrence of the event after
read and reset HMI startup will be written to the designated word

address address. The word address can be read / written.

Elapsed time If enabled, from an event occurs to its recovery, the
elapsed time (in seconds) will be written to the
designated word address. The word address can be read /
written.

read and reset

address

A

Click the icon to download the demo project. Please confirm your internet

connection before downloading the demo project.
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Data Sampling

8. Data Sampling

This chapter explains how to set and use Data Sampling.

8.1.
8.2.
8.3.
8.4.
8.5.

OVBIVIBW ...ttt ee ettt e e e e ettt et e e e e e sttt e e e e e e s e anbe et eeeeeesesanssseeeeeeeeessannnrnenaeaeens 8-2
Data Sampling ManagemENt .......cciii i i e e e e e e e rer e e e e e e e e 8-2
Creating a New Data SampPling .......ueieiieiiiiicceeee ettt e e e et e e 8-2
Synchronizing cMT Viewer data and Saving to External Device.......cccocceeeeeeeeicnnnneee. 8-14
Checking History Data of a Specific Date on cMT VIieWEr. ........cceeevivieeeeiiieee e, 8-15
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8.1. Overview

After defining how the data is sampled, by sampling time, address, or data length, the sampled
data can be saved to the designated location, such as HMI memory, SD card, or USB disk. Trend

Display and History Data Display objects can be used to display sampling records.

8.2. Data Sampling Management

Create a new Data Sampling object first by the following steps:
1. From the menu select [Data/History] and click [Data Sampling].

2. Click [New] to finish relevant settings.

No. | Description | Read address Sample mode | Trigger address | Control address | History file | Synchronous
Local HMI: LW-0 | Periodical Disable Local HMI: LWO | Disable

< LIRS »

[ New. ][ Deete | setings.. | [ EBpot. [ impot. |
[ Copy | Pate | Paste (Add Mode)

I

8.3. Creating a New Data Sampling

The following introduces how to set a new Data Sampling.
eMT, iE, XE, mTV, iP Series
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Comment :

Sampling mode

Read address

Data Sampling Object

| High priority (this may reduce refresh rate of screen components.) [C]Enable

@) Time-based 2 Trigger-based

Sampling tme interval : | 1 second(s) -

PLC name : [Local HMI -

Clear real-time data address

Hold address
[ Enable

PLC name : ILU@' HMI

-J[ Settings... |

History files

Address : |Lw x|0
Save to HMI memory

=1 prior to display or store the data log, you can use the conversion tag to check and [T save to USE disk

modify the data log.

Each fil ts of all ds of a d

=When the Data record is converted by the user-defined conversion tag, the RSSO e SR

GetCnvTagArraryIndex() function of [Read conversion] subroutine can get the relative *) Customized file handling

array index.
Data Record Folder name : Datalog

Max. data records (real-time mode) 1 1000 [F] Auto. stop File name example : | 20150727.dt
Data Format ... Datalength : 1word(s) Preservation limit 7 day(s)
ok || cancel

Sampling mode

High priority

Data sampling processes with this feature enabled will be
prioritized. Please note that too many priorities can slow
down update rate of other objects.

Time-based

Samples data in a fixed frequency. The [Sampling time
interval] can be set from “0.1 second(s) to 120 mins”.
Trigger-based

Triggers data sampling by the status of a designated bit
address.

Mode Conditions to trigger Data Sampling:

[OFF -> ON] Triggers sampling when the status of the
address changes from OFF to ON.

[ON -> OFF] Triggers sampling when the status of the
address changes from ON to OFF.

[OFF <-> ON] Triggers sampling when the status of the
address changes.

Set ON/OFF after triggered

If selected, after triggering Data Sampling, the system will
set the designated bit address back to ON/OFF state.

Read address

Specify an address to be the source of Data Sampling. To
convert a data record, please use a user-defined
conversion tag that allows [Read conversion]. For array
addresses, the GetCnvTagArraylndex function can get the

relative array index and then calculate.
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Data Record

(Real-time)

In Real-time Mode, when [Auto. stop] is not selected, the
max. number of data records can be saved on HMl is
86400. When the number of records exceeds 86400, the
earliest data will be deleted.

Data Format

Data of different formats in consecutive registers can be
sampled. For example, setting: LW-0 (16-bit Unsigned),
LW-1 (32-bit Float), and LW-3 (16-bit Unsigned). The

upper limit for the number of records is 1000.

Data Format

1. "16bit Unsigned" 16-bit Unsigned
2. "32bit Float” 32bit Foat
signed" signed

[

[ MNew... ][ Delete ][ Settings... ][ Import.. ][ Export... ]

*When the [Read address] uses an user-defined conversion tag, it is suggested that each
item of the Data Record selects the same data length even in different data types. ..
16-bit BCD, 16-bit Signed. 16-bit Unsigned)

Auto. stop
Data sampling will automatically stop when the number

of records reaches [Max. data records].

C?See “8.3.1 Demonstration of Auto. stop”.

Clear real-time

data address

Set when the bit address status changes from [OFF -> ON]
or [ON -> OFF], clear the sampled data in Trend Display

Real-time Mode. The number of data records returns zero
but the data records that are already saved as history files

will not be cleared.

Hold address

If the status of the designated address is set ON or OFF,
sampling will be paused until the status of the designated

address returns.

History files

Save to HMI memory

Saves Data Sampling to HMI every 10 seconds. Or, use
system register [LB-9034] to force storing data. See
details on the restrictions of using LB-9034 in the Note
below.

Save to SD card / USB disk

Saves Data Sampling to the specified external device.
Each file consists of all records of a day

L—| WE!NTEK
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%4

The data sampling file will be saved on a daily basis into
the specified folder, and the file name will be
yyyymmdd.dtl, indicating the date of the file.

Folder name

Specify Data Sampling file name which must be all in
ASCII characters. The folder name will be written as:
[Storage Location] \ [Folder Name] \ [File Name]
Preservation limit

Determines the number of data sampling files to be
preserved. Please note that the current .dtl file is not
included in this limit. That is, if this limit is set to 2, apart

from the current file, two latest files will be preserved.

Customized file This feature can be used to customize naming and

handling management of data sampling files (*dtl).

C?See “8.3.2 Customized File Handling”.

Note

A Data Sampling may include more than one type of records. Data Sampling can retrieve
different types of records at the same time. For example, if define three types of data, 4
words in total, the system retrieves a 4-word data each time from the designated address to
be the content in one Data Sampling.

When using [Each file consists of all records of a day] and set [Preservation limit] to 2 files,
the data of yesterday and the day before yesterday will be kept. Data that is not built in this
period will be deleted to prevent the storage space from running out.

When using [Customized file handling] and set [Preservation limit] to 2 files, not only the
currently sampled file, another 2 newest files (3 files in total) will be kept. The rest of the
data will be deleted to prevent the storage space from running out.

When running simulation on PC, all data sampling will be saved to the datalog folder in
C:\EBPro\[Storage Location]\datalog. If you change the data format of data sampling, delete
the previous data records in the installation directory to prevent the system from reading
the old records.

When saving files to USB disk or SD card, the capacity of a FAT32 folder depends on the
length of the file names. Fewer files can be saved when the file names are longer.

When using LB-9034, the shortest interval between two successful executions is 2 seconds.
That is, after LB-9034 is triggered, it can be effective again 2 seconds later.

E Click the icon to watch the demonstration film. Please confirm your internet connection
before playing the film.
cMT, cMT X Series

The settings are almost similar to eMT, iE, XE, mTV, iP Series. The following highlights the

settings that are different.
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Data Sampling Object

Comment ;

Sampling mode

|| High prierity {this may reduce refresh rate of screen components.)

History file
Enable

@ Time-based (7 Trigger-based @ All records in one file
Sampling time interval : |1 second(s) - (7 Customized file handiing
File name : o000
Data Record Save to
Device : Siemens 57-1200/57-1500 () HMI memary (10000 limited) () HMI memory (until space full)
(@) USE disk 1 (7 USE disk 2
Data length : 17 word(s)
Sync. to database
Hold control
/| Enable
Database : |1, 192.168.1.0 -
Device : [Lgcal HMI v][ {a ]
Address @ |LB i} FEEEE
(@) USE disk 1 (7 Database
Control
V| Enabl
nabie Preservation limit (1 ~65535 days) 7 day(s)
o — — )
Device : [Local HMI e ][ J Auto sync. periodically 30 minute(s)
Add : i} 16-bit Unsigned
ress: | il Enable status address
*Control command : 1 [clear]
2 [sync.] USB Sync. status : Lw-1
3 [sync. and dear] .
4 [dear and restore log index] USE Sync. error : Liv-2
Database Sync. status : LW-3
Database Sync. error : L4

Setting

Description

Data Record

Data of different formats can be sampled. The upper limit for
the number of records is 1000. Click the [Settings...] button to
set the read addresses of different data types. For selected PLC
drivers, sampling addresses of different sections is possible. For
the drivers that can only sample contiguous addresses, simply
set the data types. The display format settings may be used by
Trend Displays and History Data Displays which are set to
display the sampled data.

Next contiguous address

With this option selected when adding a new item, simply set
the data type and it will be put into the same section as the
previous read address. The following setting aims to read
LW-0~LW-17 at a time.

L—| WE!NTEK

EasyBuilder Pro V6.07.02

8-6



Data Sampling

Data =
Device : | Local HMI 5.0 ]
Section Description Read address Data type Size

1 16-bit Unsigned 16-bit Unsigned 1 word(s)

2 16-bit Signed 16-bit Signed 1 word(s)

31 32-bit Signed  LW-0 32-bitSigned 2 word(s)

4 32-bit Float 32-bit Float 2 word(s)

5 String String 11 word(s)

"
1

=

*When the [Read address] uses a user-defined conversion tag, it is suggested that each item have the same data
length. (Their data types can still be different, i.e. 16-bit BCD, 16-bit Signed, 16-bit Unsigned.)

Exit
When [Next contiguous address] option is not selected,
multiple addresses can be read at a time.
Data =S
Device : | Siemens 57-1200/57-1500 ']
Section Description Read address Data type Size

11 16-bit Signed INT-PLC.Blocks... 16-bit Signed 1 word(s)

22 16-bit Signed INT-PLC.Blocks... 16-bit Signed 1 word(s) E]

3 16-bit Signed 16-bit Signed 1 word(s) @

3 INT-PLC.Blocks...

4 16-bit Signed 16-bit Signed 1 word(s)

54 32-bit Float REAL-PLC.Bloc... 32-bit Float 2 word(s)

65 String STRING-PLC.BL... String 11 word(s)

*When the [Read address] uses a user-defined conversion tag, it is suggested that each item have the same data
length, [Their data types can still be different, i.e, 16-bit BCD, 16-bit Signed, 16-bit Unsigned.}

* As multi-read capability varies among devices, it is possible for different sections to be sampled at slightly different
times.

Click [New] and de-select [Next contiguous address] option.
The address setting shows, and a different address can be
selected.
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Channel

Description © 16-bit Signed

[C{Next contiguous address!
Address

Device : | Siemens 57-1200/57-1500

Tag: [PLC.B\om‘DaE_black_Z.a

v]INT

Data type [lﬁ-blt Signed

Display format : [ Leading zero

Right of decimal Pt.: 0

Save to default

Please note that when contiguous address setting is used for

a tag-based PLC driver, only one-dimensional arrays are

supported.

Control
address

Entering a value in the control address sends the

corresponding command.

Value | Command

1 Clear the sampled data in HMI

2 Synchronize data to the external device / database

3 Synchronize data to the external device / database
and then clear the sampled data in HMI

4 Use the history data stored in USB disk / SD card /
database after changing HMI

5 As data sampling stops when HMI storage is full, this
command allows restarting of data sampling when
there’s free space

6 Free up memory space reserved for data logs (*.db).

This command can be used when historical data is

saved to HMI memory (until space full).

Status & Error
address

When LW-n is used as the control address, the four

consecutive addresses following LW-n (LW-n+1~LW-n+4) will

show status and error, please see the prompt in the settings

dialog box.
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Histaory file
Enable

Name: Datalog

|:| Sync, to SD card

Status: LW-10 + 1
Error: LW-10 + 2

Sync to database
Enable

Enable status address

[¥] sync. to USB disk

Display history from database

Database: [1,192.168.1.0

Status: LW-10 =3
Error: LW-10 = 4

Value | Status address: LW-n+1 and LW-n+3

0 Disconnected from external device or database

Connecting with external device or database

1

2 Connected with external device or database

3 Storing records into the archive. When this is done,
the value returns to 2.

5
c
(0]

Error address: LW-n+2 and LW-n+4

None

Unknown error

Failed to connect with external device or database

Access denied

Wrong database name

Inconsistent data format

Failed to open table

Failed to create table

Failed to write table

O I N[O | B W [IN|[FL O

Failed to open database

[EEN
o

Database is corrupted

History files History data can be saved to HMI memory (10000 limited or

until space full), USB disk, SD card, and Database (by

synchronizing history data to database server.).

The rules of saving the data are:

® When [Save to HMI memory (10000 limited)] is selected

and the sampled data reaches 10000 records, the

system will delete the earliest 1000 records and keep on

saving data to HMI memory.

® When [Save to HMI memory (until space full)] is

selected, the system will keep on saving data to HMI

L—| WE!NTEK
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8-10

memory without clearing the earlier records. In this
case, the data may not be synchronized to database.

® When USB disk or SD card is selected, and the number
of records reaches 10000, the system will automatically
save the sampled data to the external device and delete
the earliest 1000 records on HMI.

® To synchronize the data to database server, select a
database that has been configured before.

r See synchronization rules in “8.4 Synchronizing cMT

Viewer data and Saving to External Device”.

&

See Database Server usage in “13.44 Database Server”.

Customized file
handling

This feature can be used to customize naming and

management of data sampling files (*db). The current *db

file is saved in HMI memory. Please note the following two

points when Sync. Destination is USB disk / SD card:

1. When *db file name changes, the *.db file with the
former name will be synchronized to USB disk / SD card.

2. If anew *dbfile is generated when there’s no existing
USB disk / SD card on HMI, the earlier *db file will be
deleted. For example, if 20161218.db is the current file,
when 20161219.db is generated and no external device is
inserted to HMI, and then 20161218.db will be deleted.
When [Customized file handling] is used, enabling [Sync.

to database] is not possible.

&

“8.3.2 Customized File Handling”.

Find Customized File Handling settings dialog box in

Auto sync.
periodically

Data will be automatically synchronized to the designated
external device in the specified time interval, regardless of
the rules explained above. Please note that the timer will
reset when a control address is used.

[:)?See “8.4 Synchronizing cMT Viewer data and Saving to

External Device or Database Server”.

All record in
one file

When Sync. Destination is USB disk / SD card, the
preservation limit is 1 to 65535 days.

Customized file
handling

When Sync. Destination is USB disk / SD card, the

preservation limit is 1 to 65535 files.
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When Sync. Destination is HMI memory, the preservation
limit is 1 to 1000 files.

History source

Data can be read from USB disk, SD card, or Database.

8.3.1. Demonstration of Auto. stop

This feature depends on the arrangement of different objects and modes. (Set [Max. data

records] to n.)

Object

[Auto. stop] not selected

[Auto. stop] selected

Trend Display-

Real time

Deletes the earlier
records and displays the
latest number of records
(n) in Trend Display. See
the following figure.

Stops after reaching the
specified number of
data records (n).

Trend Display-

Historical

Keeps on sampling data
and displays all history
data in Trend Display.

Stops after reaching the
specified number of
data records (n).

History Data
Display

Keeps on sampling data
and displays all history
data in History Data
Display.

Stops after reaching the
specified number of
data records (n).

Data Sampling

Keeps on sampling new
data.

Stops after reaching the
specified number of
data records (n).

The figure illustrates how the data is sampled in Trend Display — Real Time mode when [Auto.

stop check] box is not selected. Set the number of data records to 10, when the 11t data is

generated, the earliest record is deleted and the newest record is added.

I__| WE!NTEK

Record

Number Data
1 101
2 102
3 103
4 104
5 105 >
b 106
7 107
a8 108
9 109
10 110
11 111

Not selecting
[Auto. stop]

102
103
104
105
106
107
108
109
110
111
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8.3.2. Customized File Handling

This feature can be used to customize naming and management of data sampling files (*.dtl,

*db).

Customized Filename Handling
File creation
() Automatic mode {A new file will be created when the file name is changed.)
(@) Trigger mode (Use the trigger method to create a new file.)
Trigger method

Limit by number of data records
Max. data recordsina file : 1000

Register status
Mode : | OFF-=0N ~ | []Set OFF after triggered

Device : [Local HMI @]

Address: (LB -1
File name

Dynamic format

Device : [Local HMI CE &
Address : |Lw -1 10 word(s)

* Please configure the value of [Dynamic format] before any data sampling.
*Only ASCII is available. Unicode is not supported.

%Y Year (2000-2038)

By ‘Year, last two digits (00-99)

%em  Month as a decimal number (01-12)
%od Day of the month (01-31)

oeW  Week number (00-53)

S Weekday, 0is Sunday {(0-6)

%H Hour in 24h format (00-23)

%M Minute (00-59)

%65 Second (00-59)

%% %

* A filename cannot contain any of the following characters: \/: *?< = |

Sort

Order : |File modification tme | This option may affect performance.

Setting

Description

File creation

Automatic mode

A new file will be created when the name of an existing
file is changed.

Trigger mode

A new file will be created according to the [Trigger

method] settings.

Trigger method

Limit by number of data records

A new file will be created when the number of data
sampling records reaches the specified "Max. data
records in a file"

Register status

A new file will be created when the status of a designated
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bit address meets the specified condition. The condition
is specified in Mode field.

Set ON/OFF after triggered

If selected, after the new file is created, the system will
set the designated bit address back to ON/OFF state.
Following HMI reboot, generate and write to a new file
only after trigger condition has been met.

When the trigger condition has not been met following
HMI reboot and therefore no new file is generated, the
new data will be written to the last file generated before
HMI is rebooted. Downloading a new project to HMl is

the same as rebooting HMI.

File name

The file name can be an alphanumeric name, and certain
half-width symbols are allowed. The file name can also be
specified by a file name syntax.

Dynamic format

The file names can be set by a designated word address,
or by a file name syntax indicating the current system
time. The file name syntax can be specified by selecting
time buttons or entering the syntax in Format field. The
length limit is from 1 to 25.

The following half-width characters are not allowed:
\/:*¥?2“<>|

Sort

This setting affects how the system determines the sort
order of historical files, which affects the file preservation
and backup logic.

File name

Files are sorted by their filenames in descending order.
File modification time

Files are sorted by the actual timestamps of the contents.
(Because the system has to check the content of the files,
this option may affect performance negatively.)

Example:

Consider the case where files have been generated in this
order: filename_05--> filename_04--> filename_03-->
filename_02--> filename_01. The earliest file is
filename_05 and the latest file is filename_01.

With preservation limit set to 5 files, the two sorting
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methods yield different results when the 6™ file is
generated:

Sorted by Filename: filename_05 is seen as the latest file;
therefore, filename_01 will be deleted.

Sorted by File Modification Time: filename_01 is seen as
the latest file; therefore, filename_05 will be deleted.
Note on naming convention:

When File Name is selected as the sorting method and
the filenames are: filename_1, filename_2, and
filename_10, filename_2 will be seen as the latest file,
followed by filename_10 and filename_1. To make
filename_10 the latest file, please zero-pad the numbers
and name the files to: filename_01, filename_02, and

filename_10.

@ Note

B |f both [Limit by number of data records] and [Dynamic format] check boxes are selected,
before startup HMI, please enter the name in the designated register for Dynamic Format,
otherwise, it is impossible the reach the “Max. data records in a file”, and the data sampling
file will not be generated.

B When a new file is generated, the system will first detect if the filename already exists. If the
file name does exist, the newly sampled data will be appended to the existing file.

&

=4 Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.

8.4. Synchronizing cMT Viewer data and Saving to External Device or Database

History data in external device Real-time data
e — V—‘-—T‘:h. — ~ ",__}.ﬁf_—____—:«
\\“/_2/ \\\\ L -.\._//_, \‘\
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For other series, when displaying the sampled data in Trend Display object, it is necessary to

select from Real-time mode or History mode and the two modes cannot simultaneously be

displayed in one object.

cMT / cMT X Series allows displaying history data and at the same time updates real-time data

in one Trend Display or History Data Display object. The data saved in the external device can

be updated.

The rule of synchronizing the data saved in the external device:

1. When the sampled data reaches 10000 records, HMI will automatically save data to the

external device and deletes the earliest 1000 records in HMI.

2. If the external device is removed from HMI and inserted back again at the time when the
sampled data is under 9000 records, the data generated during the time the external
device is removed is saved in HMI and is not cleared. If the data exceeds 9000 records

during the time the external device is removed, the earlier data is cleared and cannot be

synchronized even to insert the external device back to the HMI.

3. If there already exists sampled data in the external device, the new data is appended

without overwriting the original data each time in synchronization.

8.5. Checking History Data of a Specific Date / File on cMT Viewer.

To check the history data, see the following steps (Use Trend Display object as example).

1. Tapthe
2. The following dialog box appears.

Cancel

Begin Date

Ended Date

icon in the upper-right corner of the Trend Display object.

Option

TREND DISPLAY SETTING

Channel Visibility
Y Scale

3. Specify the date or the file.

Reset to project default

L—| WE!NTEK

Done

Cancel

FILE SELECTION
(Current)
20161228_115444
20161219_151520
20161219_151504
20161219_151454
20161219_151444

TREND DISPLAY SETTII

Channel Visibility
Y Scale

Option Done

Reset to project default
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Cancel

Begin Date

2016-12-19

Ended Date

2016-12-19

4. Tap [Done] button to finish setting.

Option Done

@

@

I__| WE!NTEK

Cancel

FILE SELECTION
(Current)
20161228_115444
20161219_151520
20161219_151504
20161219_151454
20161219_151444

Option Done
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9. Object General Properties

This chapter explains the basic settings of an object.

9.1.
9.2.
9.3.
9.4.
9.5.
9.6.

OVBIVIBW ...ttt e e ettt e e e e ettt et e e e e e st ettt e e e e e s e anb et e eeeeeese s nsssbeeeeeeeessannnrnenaeaeens 9-2
Selecting PLC and Setting Read/Write AdAress ........ccouveeceeeecieeeciee e 9-2
Using Shape Library and Picture Library......o e 9-3
SEttiNG Label TEXL.cooe i e e e e nna s 9-7
AdJUStING Profile SiZ€ .......eeeeieiieee e e 9-9
Overlapping Objects (CMT / CMT X SEIES) ..ccuireeireeeerieeeieeecree et eeree e e eeaaeeeeaeeeens 9-10

I__| WE!NTEK EasyBuilder Pro V6.07.02

9-1



Object General Properties

9.1. Overview

The basic steps to create an object:

1.
2.
3.
4.

Selecting the PLC device and setting the read/write address.

Using Shape Library and Picture Library.

Setting label text.

Adjusting profile size.

This chapter explains the basic settings of an object.

9.2. Selecting PLC and Setting Read/Write Address

Most objects read data from PLC devices, so a properly configured PLC address is needed.

Select the PLC to control at [PLC name] which comes from [System Parameters Settings] »

[Device List].

Write address
PLC name : [Local HMI v] [ Setting... |
Address:’Lw ] IDX 0  [16-bit Unsigned
Address @
PLC name : [L0C3| HMI ']
Device type : [Lw ']
Address: 0 [ system tag
Address format : DDDDD [range : 0 ~ 10799]
5] [ ot
Setting Description
PLC name Select the PLC type.
Device type Different PLCs have different device types.
Address Set the read/write address.
System tag Address tags include [System Tag] and [User-defined Tag].

This option allows users to use [System Tag]. [System Tag]
consists of the preserved addresses by system for
particular purposes. The address tags include bit registers
or word registers (LB or LW).

After selecting [System tag], not only will the [Device type]
field display the chosen tag, but [Address] field will also
display the chosen register.
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Index register

Select this check box to use the [Index Register].

& For more information about System Tag, see “22 System Reserved Words and Bits”.

¢ Q@

9.3. Using Shape Library and Picture Library

For more information about Index Register, see “11 Index Register”.
For more information about Tag Library, see “16 Address Tag Library”.

In the settings dialog box of certain objects, “Shape” tab can be found. In this tab, Shape

Library and Picture Library can be used to add visual effects on objects. Select Shape tab to use

the libraries when creating an object.

9.3.1. Picture

New Bit Lamp/Toggle Switch Object

| General | Security | Shape | Label |

Picture : Flat Button
STYLING_SVG
106x106

More picture libraries...

Picture

[ Picture Library.. | [@]Uss picture
[V] Set to original dimensions

(— v ]

[ Duplicate these attributes to every state

Shape

( Shape Library... | [#]Use shape

T
.
e

Pattern type :

[¥] Tnner

[ Duplicate thess attributes to every state

Select [Use picture] and then click [Picture Library] button to open Picture Manager window

and select a picture from the window.

I__| WE!NTEK

EasyBuilder Pro V6.07.02



Object General Properties

Project | Library
[system Flat Button -] !'—“(3]
iSystem Flat Button J
0 1 -
flat Button (Z] Flat Button Z M«
Ftateszz Ftates:z
m' :0 ﬁﬂ m :0 {?i
— o
@) [flatbuton (Z] Flat Button Z)
= = ‘ Export... H Modify... J[— v]
Ftates 5 i Ftata: 2
= — STYLING SVG
fobjects : 0 # fobjects : 0 ) 0 ‘ 106x106 W
3817 bytes
i e T STYLING_SVG
Eteuum }/71 FatBut’con @ 1 . 106x106
) 3651 bytes
S : H —
G- aeaEr~
pes ) CET &
‘ , &
Flat Button 2] Flat Button (2] =
Background: [ | :I [ New | ‘ Delete ] ‘ Clean ‘
More picture libraries.. [ ok J[ cancel [ Hep |
Setting Description
Picture Click [Picture Library] button in Picture group box to open
Library Picture Manager window.
Set to ) ) ) )
iinal When this checkbox is selected, EasyBuilder will return the
origina . . - . - .
. . picture to its original size to eliminate the redrawing step.
dimensions

Duplicate these
attributes to

every state

This button is available only when a system picture is used.
Clicking this button will duplicate the attributes of the

current picture to other states.

9.3.2, Shape

Select [Use shape] and then click [Shape Library] button to open Shape Manager window and

select a shape from the window.
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Project | Library

[System Frame

-] ([@)®)

iSyshem Frame

|

1 74

) T 2 O

-

faesiz
Fss )

. Inner,Frame

Clean

‘ Delete ] ‘

| ok

J [ concl

Hep |

Setting

Description

Inner

Select [Display] to show the inner color of the shape and

select a color as the inner color by clicking the drop-down

button.

] Default

|
|
(.
|

EEENE
[EENE
EEEN
OJOmnE
OCEEN
OOomnm
EEEN
NN
OOmm

Recent
I [

Custom...

Frame

Select [Display] to show the frame color of the shape and

select a color as the frame color by clicking the drop-down

button.

Pattern color

Click the drop-down button to select a color for the

interior pattern of the shape.

Pattern type

Click the drop-down button to select a pattern.
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|
=

9.3.3.

- IR
m | [
N\
— =l

=

Set to all
states

Duplicate the attributes of the current state to other

states.

In Picture Manager and Shape Manager windows, the currently selected picture / shape is

Shape manager

highlighted yellow as shown below.

Shape manager

Project | Library

[button2

IC:‘EBpro‘Iibrary button2.plb |

2

|5hapeo
States: 2
Objects : 0

Shape2

(Shapel

lShape3

-

—
!

Inner
[¥] Display

Frame

Display

9-6

— —_—
2 3
— :
_L -

States: 2 IStates 12
Objects : 0 @] [onjects 10 0 @
[shapes !Shapes 1 ..@
IStates 12 States: 2 —
® Objects : 0 ) @ [Objects: 0
e —
I i Bropes @ [ 1 Broper 2 -

Lo I

Cancel ] [ Help ]

The information about the selected picture / shape:

Directory  The directory from which EasyBuilder searches for the pictures / shapes.
Shape5 Name of the shape.

States: 2 Number of states of the shape.

Objects: 1 This shape is used by 0 object in the project.

Inner The state 0 and state 1 of this shape contain only “inner” but not “frame.”

&r For more information, see “14 Shape Library and Picture Library”.
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9.4. Setting Label Text

New Bit Lamp/Toggle Switch Object

]GemmllSecuxitylShape ILabe] ‘

Content

[V] Use label
e label library

[ AddtoLabelLibrary |[ LabelLibrary... |

see: e ) W) @@

[ Duplicate this label to every state

Attribute

Text ali

[V] Preview with actual font size

Color :

[7] Tracking

Font: Arial [Arial] [Droid Sans]

Size :

:

Italic [ Underline

Ol

Horizontal : | Centerx
Text area position

Horizontal : | Center
Duplicate these attributes to

II

-

Every state

o] o )

Setting

Description

Use label

Use a label for the object.

Add to Label Library

Add a new label containing the content for all states to the
Label Library.

Use label library

Use a label from the Label Library.

Label Library

View all the labels in the Label Library.
For more information, see “15 Label Tag Library and Multi

Language”.

Content

Set the content of the label. If [Use label library] is
selected, the content in the Label Library can be used.

Duplicate this
label to every
state

Copy the content of the current state to all states.

Tracking

With this option selected, changing the position of the

[\& WEINTEK
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text in one state will also change the text position in other

states.

Font Select a font from the list. EasyBuilder Pro supports
Windows True-type fonts.

Size Select a font size.

Color Select a font color.

Blink Specify the way the text blinks. Choose [None] to disable
this feature or set the blinking interval to [1 second] or
[0.5 seconds].

el Use Italic font. Ttalic Label

Underline

Underline Label

Use Underline font.

Text Alignment

Multiline text is aligned within the label outline.
Below are the corresponding shortcut keys.

[Left] [Center] [Right]
111 111 111
222222 222222 222222

333333333 333333333 333333333

Text area
position

Multiline text is aligned within the object outline.

Below are the corresponding shortcut keys.

%vﬁy L1|_2L3L45Py L1 12 L3 141

|« Left Alignment Top Alignment

ad

#l¢ Center Alignment Center Alignment

L3
+
%

-#| Right Alignment Bottom Alignment

Horizontal Vertical

Duplicate these
attributes to
every state

Copy the attributes of the current state to all states.

More

Convert labels to bitmap images (Use bitmap font)
Convert the label text into bitmap format. This setting is
only available for non-cMT models.

ON = OFF (use state 0)

The content displayed will not change due to state.
Movement:

Direction

I__| WE!NTEK
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Set the direction of the marquee effect. The directions
include: [No movement], [Left], [Right], [Up], [Down].
Continuous

Specify how the marquee effect is displayed.

If this option is not selected, the next text appears only

when the previous text disappears completely.

If this option is selected, the text will be displayed

continuously.

Speed

Adjust the speed of the text movement.

@ Note

When Text/Comment object is used with Comment enabled, the text used as comment

will not appear on HMI.

When the texts of the fonts used in the editing window and on the HMI screen are not
properly aligned vertically, it is possible to correct it with the FontRules.xml file in
“%appdata%\Weintek\EasyBuilder” folder.

By adding the names of the fonts in question into the FontRules.xml file, their vertical

metrics can be adjusted in advance to avoid the misalignment problem.

=Yuml wverzion="1.0"7=
zFontRkulegs»
=Verzion data="1.1"/=
=Eule data="[‘w]*aleerian[.'w]*"/=

=Eule data="['w]*caztellar[ . \w]*" /=

<Rule data="*Wingding=}"/=

<Rule data="fix vertical metricz = “Gotham FPro Black}"/»

<Enle data="fix wertical metrice = *jotham Pro BoldE"/»

<Enle data="fix wertical metrice = *rotham Prok"/»
=/FontRulez=

9.5. Adjusting Profile Size

When an object is created and placed in the editing screen, double click it and select the

[Profile] tab to adjust the position and size of the object.
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Bit Lamp Object's Properties @
[ General [ Secusity | Shape | Label | Profile |
Position
; X217 = ¥oo208 =
Size
[C1Keep width/height ratio
Width: 50 s Height: 50 z
Width (%) : 100 £ Height (%) : 100 =

Setting Description

Position Pinned
When this check box is selected, the position and the size
of the object cannot be changed.
[X] and [Y]
The coordinates of the position of the object in the editing
screen.

Size Adjust the [width] and [height] of the object.

9.6. Overlapping Objects (cMT / cMT X Series)

The following explains the ways to find the overlapping objects and convert them into a single
Combo Button. After conversion, the general settings of the Combo Button will follow the
settings of the frontmost object.

9.6.1. Enable Touch Area

1. Open View tab and select [Touch Area].

File H ¥ « #» 3 Home Project Object Data/History DoT/Energy RIS

v] Common Window [v] Object Address v| Ruler Address Grid Web Wind

] Underlay Window [v] Object Label Tag v] Grid | Windows Tree Shape

| ObjectID v] Comment v| Snap  [v] Windows Preview [_] Picture

2. All the touchable objects in the proejct will be highlighted in yellow, the overlapping areas
will be highlighted in pink, and the objects that are not touchable will remain the same.

SB_0 (LB-0)
SB_1 (LB-0)
SB_2 (LB-0)

D\’WE!NTEK EasyBuilder Pro V6.07.02
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9.6.2. Find Overlapping Objects

Open Tool tab and click [Find Overlapping Objects] to find all the touchable overlapping
objects in the project.

File H i « » : Home Project Object Data/History lloT/Energy  View I _
—n €= = =
: p B % O D
Find Overlapping Data/Event Log Address Easy Administrator [System Setting] Recipe Database
Objects Com Converter Viewer Watch Tools Editor Editor

Upgrade External

At the first time clicking [Find Overlapping Objects], the system will find the first group of
overlapping objects in the current window. To search for the next group, click this button
again. When all the overlapping objects in the current window are found, the system will
start searching for overlapping objects in the next window, and then open the window in
which overlapping objects are found.

SB_0 (LB-0}
[SB_1 (LB-0)
|SB_2 (LB-0)

0 Note

B All layers of a window must be editable before clicking [Find Overlapping Objects].

9.6.3. Convert to Combo Button

When the overlapping objects found are Set Bit, Toggle Switch, Set Word, Multi-State Switch and
Function Key, they can be converted to a single Combo Button by the following ways.
Way 1. Open Tool tab and click [Convert to Combo Button].

viswer

Fle: E S % + < Home Project Objsct Data/Mistory  lloT/E Comba Button Object's Properties

= +O g O. ;

] g = 010 x | General Security Shape Font  Profile
Find Overlapping | Convertto | Data/Eventlog Address  Easy  Administ e e 54

Objects Combo Buttan Converter Viewer Watch Tool:

Comment

Upgrade Lamp

Windows Tree v X q
-] 3:Monitor Mode ~ a
1 4: Common Window
-1 5: Device Response
1 6: HMI Connection

i~ 1 7 Password Restrict.

— [ 8: Storage Space In..

10 - WINDOW_010 X

) . ;i R HTA, ;. A Tn e

Mode: | None v

1 9: Backup

= [ 10: WINDOW_010
I BL_O (LB-0) (Back)
—BL1(LB-0)
- BL_2(LB-0)
=TS 0(8-0)
= TS_1(LB-0)
=TS 2(18-0)
— SB_O(LB-0)
—SBL1 (LB-1)
L sB_2(L8-2)

= 11

- .
%B_0 (LB-0)
[SB_10B-13

[®e_zB2;

e B M P

Down actions

Action Group 1 Action Group 2

SetBit Toggle, LB-2)
Set Bit (Toggle, LB-1) :|—» [+]
Set Bit (Toggle, LB-0)

[+]

Way 2. Select the overlapping objects together, click the right mouse button, and then select
[Conver to Combo Button].
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Cut

Copy

Muiti. Copy

Paste

Delste

Greup

Unaroup

Convertto Combo Button
Attribute

Security settings

Goto desti window

Jump ta selected shape/picture librariss
SB_D (LB-0) (Rack)
SW.O(LW-0)

FK_D (Front)

Ctl +G

Comba Button Object's Propertics

General Security Shape Font  Profile

Comment

Lamp
Mode:  Norne

Down actions

Action Group 1
Popup Window [70. Login & Log
Set Word (Write constant value : 0.
Set Bit (Set ON, LB-0)

[+)

Action Groug 2

o

9-12

After [Convert to Combo Button] is clicked, a review window shows for users to review the

actions that can be triggered by the Combo Button. Actions that are not highlighted can be

merged; actions that are highlighted in yellow will be automatically adjusted to meet merging

condition; and actions that are highlighted in red cannot be merged. The user can move the

mouse cursor to the yellow or red area to see explanations.

Review your merged actions

Down actions Up actions

(X8

Modify or delete invalid actions.

SW_0

FK_0

Action Group 1

Action Group 2

Unable to convert the objecttoa.. kg [+]

)

Set Word (Write constantvalue: 0., —# o

[+)

Change common window (30.Ke.. —# [+

)

oK

] [ Cancel

@ Note

B The Comment of the generated Combo Button will follow the setting of the frontmost

object that has a Comment.
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B The Security settings of the generated Combo Button will follow the settings of the
frontmost object. If the Security settings of the objects layers down are different from the
frontmost object, an alert is shown after conversion.

B The Sound settings of the generated Combo Button will follow the settings of the
frontmost object that has Sound settings. If the Sound settings of the objects layers down
are different from the frontmost object, an alert is shown after conversion.

B The Picture or Shape, and the Label settings of the generated Combo Button will follow
the settings of the frontmost object that has these settings. When there’s no object using
a picture or a shape, the Combo Button will follow the Label settings of the backmost
object that is mergeable.

B The generated Combo Button will have the Vibration setting enabled if any of the
overlapping objects has Vibration setting enabled.

B The generated Combo Button will follow the Operation Log settings of the overlapping
object that uses Operation Log. When Operation Log is used for multiple overlapping

objects, an alert is shown after conversion.
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10.User Password and Object

Security

This chapter discusses the protection for operations provided by setting up user passwords and

security classes.

10.1.
10.2.
10.3.
10.4.
10.5.
10.6.
10.7.
10.8.

OVBIVIBW ...ttt ettt et ettt et e e e e e sttt e e e e s seaaabrbbteeeeeeessannnbbeeeeeeeseessannnreeas 10-2
User Password and Operable Object Classes ......cccouvvrreieeiiricciiiieeeee e cecinree e 10-2
Enhanced Security Mode and Control Address........ccceeveeeeeecciiieeeeee e 10-6
Enhanced Security Mode USQBE .....cccceieiriiiiieee ettt e e e e e e 10-10
Object SECUNItY SETEINGS. . cvviiii e e s 10-23
Example of Object Security SEtHiNGS.....cccocvuiiiiiiiiiie e 10-28
Protecting Password Settings from Unauthorized Editing ........cccccvveveeiieiccniieennnnnn. 10-31
Bulk Changing of Security Settings of Multiple Objects .........ccccovivieeeeiieicciiieeee, 10-32
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10.1. Overview

This chapter discusses the protection for operations provided by setting up user passwords and
security classes. Authentication modes are:

® General Mode

® Enhanced Security Mode

In addition, cMT / cMT X series allows the use of LDAP protocols for user authentication.

To set up the protection system, please:
1. Set user password and operable classes.
2. Set object class for objects.

An object belongs only to one security class. Setting the object class to “None” means any user
can operate this object.

10.2. User Password and Operable Object Classes

The security parameters can be found in [System Parameter Settings] » [Security].

10.2.1. General Mode

Up to 12 sets of user and password are available. A password should be one non-negative
integer. There are six security classes: Ato F.
Once the password is entered, the objects that the user can operate are classified. As shown

below, “User 1” can only operate objects with class A or class C.

0 Note

B General Mode is not used for cMT / cMT X Series.

System Parameter Settings @
|| Cellular Dot Wetwork | 802.1X (WiF) | PrintexiBackup Server | Time Syme/DST [ eMeil | Recips Databose
| Dievice I Model I General I Systern I Eemate | Security Extended Memory

(@) General mode heanced seeurity mode LDAP Editahle

Select operable classes for each vser
Pazzword range ;0 ~ 4294957205

0. Ensble  Passwond
111111

222222

333333

]

1
]
]
]
]

m

H
1
2
3
4
5
6
7
i

IEEEEOEEE

IHEEEEEEE
ID000EEEOE
10000EEEE
100000000
10E0oEEEOE

[ [T ’
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4

4 Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
10.2.2. Enhanced Security Mode

Up to 11 users can be set here. In addition, [Administrator] setting is provided. Administrator
has all privileges and can operate all object classes. A username can contain Chinese characters,
letters, and numbers, and a password can only contain letters and numbers. Each user can

have up to 12 operable classes: Ato L. (Up to 127 users can be set in Administrator Tools.
Please see “10.4 Enhanced Security Mode Usage” for more details.)

Enhanced Security Mode provides a [Control address] for users to manage the accounts

directly on HMI. Please see “10.3 Enhanced Security Mode and Control Address” for more
details. Alternatively, use USB Security Key to log in automatically. Insert the USB disk in which
the key is saved to log in. Please see 10.4.3 Login / Logout Automatically with USB Security Key”
for more details.

System Parameter Settings @
[ Extended Memory |  CelllarDataNetvork |  TimeSymc/DST |  e-Mal | FIP ‘
Device | Maodel General | Sysem | Remote | Security ‘
General mode © Enhanced security mode [ External server... ] [ Editsble... |
[ Use existing vser accounts and administrator settings on HMI first (if existed). Otherwise, vse settings below.
Enable Secret user User name Password ClassA Cl #
1 ) |} userl L . © 7
2 ] ] user2 [ ] . @ M 3
3 F user3 L J . e ¥
4 [ userd L] . e @
5 [} = userd L ] - © [¥]
6 1 userb ® . @ [¥]
_— X
£ m »
Class Comment -
Class A
ClassB
ClassC s
Administrator
[T Secret user User name : | admin
Password: 90000® | |8
Control
Device : | Local HMI EEO S
Address: [PLW v | 8950 16-bit Unsigned  rgaze .
CMTP file password
[T Check password when open CM TP file Settings
Execute auto login/ogout when insert an USE key into HMI
| Enable
* Simulation does not support this function and L W-11165s display expiration time of USE key.
OK ] [ Cancel 1 I Help ]

I__| WE!NTEK EasyBuilder Pro V6.07.02


https://dl.weintek.com/public/MT8000/Project/Part_Sample/Security.zip

User Password and Object Security 10-4

@ Note

B In Enhanced Security Mode on a cMT / cMT X model, the Control Address can only be
assigned to a word register of Local HMI. Please note that security features will work only
on HMI when the control address is LW. Remote login on cMT Viewer will not be possible.

B  EasyAccess 2.0’s HMI Viewer on a eMT/iE/XE/mTV model doesn’t support Enhance
Security Mode, please use VNC Viewer instead.

B Usernames that contain Chinese characters cannot be changed by using EasyWeb or HMI

system settings; they can only be edited in EasyBuilder Pro.

&

= Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
10.2.3. LDAP Mode

LDAP (Lightweight Directory Access Protocol) enables applications to access Directory server
providing database-like data structure, and here, the primary use of LDAP is to enable
centralized user account management. When using LDAP mode, user account management is
up to the Directory server, with HMI validating user login via the LDAP protocol. To have LDAP
set up on HMI, users only need to provide necessary information about the directory server
and set the operable classes for each group, without the need for managing

username/password for each user.
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LDAP ()
Enable
General Error
Host | 192 . 168 . 1 . 100 | [] use domain name

Port: 389 =
Base DM : DC=testDC=org
Users base DM : CMN=users, DC=test, DC=0rg

Groups base DN :  CN=builtin,DC=test, DC=0rg

Directory type

* LDAP is only supported on Active Directory

Group Mame ClassA ClassB ClassC ClassD ClassE ClassF Class G ClassH Class] (
1 Engineer " " "
2 Management v v v v v v v v v
’;ISales %
4| [l 3
’ New... ] ’ Delete ] [Import from Server
ok || cancel

10.2.4. Remote HMI Mode

In this mode, user accounts can be managed on a remote HMI, instead of the local HMI. The

accounts on a remote HMI can be used to log in the local HMI; therefore, managing the

accounts on the local HMI is not necessary.
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Security

External server

) Mone ) LDAP

General

@ Remote HMI

Remote HMIIP: 182 . 168

158 |

Result address

Device & |Local HMI

Address : [PLW a

16-bit Unsigned

Result address PLW-0
1: Succeeds
8: Account not exists
16: Password error

1024 : Remote HMI cannot be connected

10.3. Enhanced Security Mode and Control Address

The Control Address is used for login and account management. The Control Address can only

be assigned to LW register on Local HMI, and 20 consecutive registers will be used. To log in

using Control Address, please select to log in by [user name] or [user index].

Please set [user name] and [password] in [System Parameter Settings] » [Security] » [Enhanced
security mode] in advance.

10.3.1. Control Address Settings

When control address is set to LW-n, where n is an arbitrary number, the following addresses

will be designated:

Address Tag Name Description
LW-n (1 word) command Commands to be executed: Login, Logout,
Add/Setting/Delete Accounts, etc.
LW-n + 1 (1 word) command Displays the result of executing
execution commands.
result
LW-n + 2 (1 word) user index The index of accounts (used with Option

I__| WE!NTEK
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List Object).

LW-n + 3 (1 word) user Binary value. Level A = bit0, Level B =

privilege bitl, ...

LW-n + 4 (8 words) user name Account name (Case-sensitive and only
allows Chinese characters, letters and
numbers).

LW-n + 12 (8 words) password Account password (Case-sensitive and
only allows letters, numbers, or special
characters).

After setting the [Control address], the relevant addresses can be found in [Address Tag Library]
» [User-defined tags].For example, setting [Control address] to LW-0: (UAC stands for User
Account Control)

LW-0 = [UAC command]

LW-1 = [UAC command execution result]

LW-2 - [UAC user index]

LW-3 - [UAC user privilege]

LW-4 ~ LW-11 - [UAC user name]

LW-12 ~ LW-20 > [UAC password]

@ Note

B In Enhanced Security Mode on a cMT / cMT X model, the Control Address can only be
assigned to a word register of Local HMI. Please note that security features will work only
on HMI when the control address is LW. Remote login on cMT Viewer will not be possible.

B EasyAccess 2.0’s HMI Viewer on a eMT/iE/XE/mTV model doesn’t support Enhance

Security Mode, please use VNC Viewer instead.
10.3.2. Commands

Setting different values in LW-n [command] enables different commands:

Set Value Command Corresponding Address

1 Log in by user name Set [user name] and [password] first. After
entering the user name and password, the
system will check if they are valid in
[System Parameter Settings] » [Security] »
[Enhanced security mode].

2 Log in by user index Set [user index] and [password] first.
Please refer to 10.4.4 Enhanced Security
Mode with Option List Object.

3 Log out
Change the password Set [user name] and [password] first.
of current logged-in Please fill in the original password in [user
user name] and new password in [password].
5 Add an account Set [user name], [password] and [user
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privilege] first.

6 Add a temporary Set [user name], [password], [user
account (minutes) privilege], and [user index] first. [user
index] is for specifying a time period (in
minutes), within this period the account is
valid. If O is specified, this account stays
valid until the HMI is powered off.
7 Delete an existing Set [user name] first.
account by user
name
8 Delete an existing Set [user index] first.
account by user index
9 Setting the privilege Set [user name] and [user privilege] first.
of an existing account
by user name
10 Setting the privilege Set [user index] and [user privilege] first.
of an existing account
by user index
11 Setting the password Set [user name] and [password] first.
of an existing account
by user name
12 Setting the password Set [user index] and [password] first.
of an existing account
by user index
13 Read the privilege of Set [user name] first. If the command
an existing account succeeds, [user privilege] can be displayed.
by user name
14 Read the privilege of Set [user index] first. If the command
an existing account succeeds, [user privilege] can be displayed.
by user index
15 Add a temporary Set [user name], [password], [user
account (days) privilege], and [user index] first. [user
index] is for specifying a time period
(number of days), within this period the
account is valid. If O is specified, this
account stays valid until the HMl is
powered off.
16 Add an expiring Set [user name], [password], [user
account (minutes) privilege], and [user index] first. [user
index] is for specifying a time period (in
minutes), within this period the account is
valid. O is an invalid value for this setting.
17 Add an expiring Set [user name], [password], [user

account (days)

privilege], and [user index] first. [user
index] is for specifying a time period
(number of days), within this period the
account is valid. O is an invalid value for this
setting.

L—| WE!NTEK
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18 Remaining minutes Set [user name] first. If succeeded, the
for user name remaining time (in minutes) will be
displayed in [user index].
19 Remaining minutes Set [user index] first. If succeeded, the
for user index remaining time (in minutes) will be
displayed in [user index].
20 Remaining days for Set [user name] first. If succeeded, the
user name remaining time (number of days) will be
displayed in [user index].
21 Remaining days for Set [user index] first. If succeeded, the
user index remaining time (number of days) will be

displayed in [user index].

@ Note

Add a temporary account / expiring account: The difference between temporary accounts
and expiring accounts is that temporary accounts are not stored in the system and will be
invalid after HMl is turned off. Both temporary accounts and expiring accounts will be
automatically deleted when they are expired.

Delete the existing account: The currently logged in account cannot be deleted.
Offline/Online Simulation: Simulate using the account settings in the program. Any
modifications of the account during simulation will not be reserved for next simulation.
admin: Default administrator account, cannot be deleted, has all privileges and cannot be
changed.

System Register PLW-10754: Displays current user name. (Only available for cMT / cMT X
Series)

The [user privilege] address does not display the privileges assigned to current user
account, please use system register LW-9222 to display the privileges.

LDAP mode does not support login with [user index].

E Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.

10.3.3.

Command Execution Results

After the command is executed, the system will store the result code to control address LW-n +

1. The listed result codes below are shown in hexadecimal format.

Result Codes Command execution result

(0x001) Succeeds

(0x002) Invalid command

(0x004) Account exists (when adding a new account)
(0x008) Account not exists

(0x010) Password error

(0x020) Deny command
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(0x040) Invalid name

(0x080) Invalid password character exists

(0x100) Invalid import data

(0x200) Out of validity range (when log in by USB Security Key).

The [Effective Time] can be set in Administrator Tools.

0 Note

B Users can add a new event in Event (Alarm) Log, and designate the [Read address] to LW-n
+ 1 [command execution result]. Open [Message] tab » [Text] » [Content] and specify the

message to be displayed

in Event Display Object for showing command execution result.

10.4. Enhanced Security Mode Usage

10.4.1. Importing User Accounts

The user accounts can be set using other tools we provide, apart from the settings in [System
Parameter Settings] » [Security] tab. Administrator Tools can also be used to set user accounts.
Administrator Tools can be found in the installation directory. After the program starts, select

the [User Accounts] check box. Up to 127 accounts can be added.

[ Administrator Tools @
Bave Contents of the TSE data
=} 3B Security Key
=} e-Madl SMTP Server Settings
= e-bail Contacts
User Account Settings
Ma. Secret  User name Password Clas & Class B Clas Clam D Class E Cla=F Claz
1 [7]  oo1oot 001001 ] ] (] ] ] |
2 [[]  o0z002 002002 ] [} L L I
3 [[] 003003 003003 ] [} [} L L I
4 [ 004004 00004 ] ] O O [
(3] [C] 005005 005005 ] ] ] ] |
6 [[] 008006 006006 [l [l [ [l [l |
4 | i b
Add l l Remove l Impaort... l l Export... l
Effective Time
[ Restrict the using terms
0 +A8 2517 - e 201% +H 251727 - ‘ Bave to folder ‘ - ‘
Help Topics

& For more information, see “36 Administrator Tools”.

The added accounts can be stored in USB disk or SD card and imported in HMI by a Function

I__| WE!NTEK
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Key Object. To do so, create a Function Key Object, and select [Import user accounts].

Mew Function Key Object &J

General | Security | Shape | Label |

Comment :

[ Activate after button is released

Function mode

@ Import user accounts

_ Use [USB Security Key] to Login
i Data position

) SD card @ USB disk

Account import mode

_ Dverwrite @ Append

[[] pelete file after importing user accounts

oK ] [ Cancel J

|

@ Import vzer data/Uze [TEE Security Key] Settings...

When finished, insert the external device to HMI, and press Function Key to import accounts. If
[Overwrite] is selected, the existing accounts will be overwritten with new accounts and
automatically log out after importing. If select [Delete file after importing user accounts] check
box, the system will delete the account data saved in the external device after importing. If the
[Effective Time] in Administrator Tools is specified, the importing can only be done in the time
limit specified. The imported accounts will not be deleted by system when the effective time
ends.

10.4.2. Login with USB Security Key

Instead of entering user name and password to login, a key can be used to do so. In EasyBuilder
Pro installation directory, launch Administrator Tools, select [USB Security Key] check box. The

account information uses the predefined data in [System Parameter Settings] » [Security].
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User Password and Object Security

3 Administrator Taols

e-Mail Contacts

USB Security Key

Effective Time

Restrict the using terms

2017 +8 251731

Help Topics

Have Contents of the TSE data
Taer Accounts
» TRE Security Key

e-Mail SMTP Server Settings

User name :

Password :

Confirm :

admin

2017 +8 25173

Save to folder ‘ - ‘

0 Note

B Please note that the user accounts used for USB Security Key must already exist in HMI.

C?For more information, see “36 Administrator Tools”.

USB Security Key can be stored in USB disk or SD card, and create a Function Key to log in by

USB Security Key as shown below:

L—| WE!NTEK
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Mew Function Key Object [é]
General | Security | Shepe | Label |
Comment :
[ Activate after button is releszed

Function mode

' Import user accounts

@ Use [USB Security Key] to Login

A Data position

) SD card @ USB disk
H
[ oK | I Cancel I
@) Import vser data/Ts= [TEE Security Kex] Sethngs...

When finished, insert the external device to HMI, and press Function Key to log in using USB
Security Key. If the [Effective Time] in Administrator Tools is specified, the login can only be

done in the time limit specified. The system will log out automatically when the key expires.
10.4.3. Login / Logout Automatically with USB Security Key

As shown below, in [System Parameter Settings] » [Security], select [Enable] check box for

[Execute auto. login/logout when insert an USB key into HMI].
Execute anto logindo gout when insert an TSE key into HMI

[¥] Enable
Statug addres:
ELC : [Locsl HMI v | Settings. .
Address : [Lw .] 1000

# Bitmulation does not support this fonction and LW-11165z display expiration time of USE kew.

This function allows automatic login / logout using an USB security key. Insert the USB disk in
which the key is saved to HMI to log in, and remove the USB disk to log out. The login / logout
status will be written into a designated address, the result codes of login / logout:

0x00: No Action

0x01: Login Succeeds

0x04: Login Fails

0x08: Login Succeeds

0x10: Logout Fails

& For more information about USB Security Key, see “36 Administrator Tools”.
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0 Note

10-14

B When Auto Login / Logout is enabled, log in by [Function Key] object is not possible, but it
is still possible to log in / out with a designated control address.

B This function does not support On-line / Off-line simulation.

B Only the USB Security Key saved in USB disk is valid.

¥

= Click the icon to download the demo project that explains how to use USB Security Key to

log in / out. Please confirm your internet connection before downloading the demo project.

10.4.4.

Enhanced Security Mode with Option List Object

Enhanced Security Mode uses Control Address LW-n + 2 as account index. With Option List

Object, account names and privileges can be displayed. Users can select whether or not to

display the account privileges and secret users in Option List. Secret users are set to be hidden

in [System Parameter Settings] » [Security] » [Enhanced Security Mode]; their account names

will be hidden in Option List if [Secret user] check box is not selected. If the control address is

set to LW-0, the monitor address for index of Option List is designated to LW-2.

b

Mew Option List Object

Option list | Mapping I Becurity | Shape | Label |

-

=

Commeint ;
Attribte

Mode [Dmp-dnwn Lizt

]
~]

Diirection [ann

Background : |

|[+]

Selection ;||

| [+]

Sonrce of item data [T_Tser account

Sort
Lecending

Monitor addres:

[ Descending

Dizplaor
Frivilege

[7] Becret nzex

PLC . |Local HMI

v] Settings...

-

Lddres: [LW

10.4.5. LDAP Mode

LDAP (Lightweight Directory Access Protocol) enables applications to access Directory server

providing database-like data structure, and here, the primary use of LDAP is to enable

centralized user account management. When using LDAP mode, user account management is

up to the Directory server, with HMI validating user login via the LDAP protocol. To have LDAP

L—| WE!NTEK
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set up on HMI, users only need to provide necessary information about the directory server
and set the operable classes for each group, without the need for managing

username/password for each user.

‘ dc=net ‘ dc=com ‘ dc=org

. dc=example
ou=people ‘ ‘ ou=group
uid=userA ‘ ‘ uid=userB

The control addresses used by LDAP Mode are the same as the control addresses used by
Enhanced Security Mode. Please see chapter 10.3 in this user manual for more information on
the control address. Please note that obtaining LDAP user name using Option List object is not

possible; therefore, [Log in by user index] is not supported.

0 Note

B A user may be a member of multiple groups; in this case, the user has permission to
operate all classes assigned for all the groups the user is in. As shown in the following

figure, if a user is a member of both Engineer and Sales groups, the user can operate

classes A~F.
Group Mame ClassA ClassB ClassC ClassD ClassE ClassF
1 Engineer % % %
2| Sales v v v

B The credentials in the list in Enhanced Security Mode can also be managed and validated
in LDAP mode. Please note that when a username exists in the lists of both modes, the
system will only validate user using Enhanced Security Mode. As shown in the following
figure, in the case where username Angela exists in the user list in both LDAP server and

Enhanced Security Mode, the HMI will validate user under Enhanced Security Mode.

LDAP Server Enhanced Security Mode
Marne Type No. Enable  Secret user Tser name Pazsword
1 [l Angela 1
Angel U
% . nllge a User 5 0 P 5
= =& 3 A Helen 3
% Cindy User
& Dora User
& Elly User
% Fanny User

I__| WE!NTEK EasyBuilder Pro V6.07.02
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Search for user in Enhanced Security Mode

\L Mot Found

Search for user in LDAP Server Found

Validate User

|

B LDAP Mode does not support login with [user index].

LDAP is only supported on Active Directory.
B HMI cannot change user’s password; therefore, when adding a new user in LDAP server,

please do not select [User must change password next logon].

Mew Object - User x

& Createin: = org/employee

Password: | |

Confirm password: | |

[ User must change password at next logon
[] User cannot change password

[] Password never expirss

[J Account is disabled

<Back |[ MNed> | | Cancel

10.4.5.1. General Tab

Set LDAP server and operable classes for each group.
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Enable

General SSL

LDAP (Lightweight Directary Access Protacal)

Error

Host |

152 168 1 100 | [[] use domain name

Port :
Base DM :
Users base DN :

Groups base DN :

Directory type

* LDAP is only supported on Active Directory

389 = # Default port of LDAP is 389
DC=test,DC=0rg
CMN=users, DC=test, DC=0rg

CMN=bulltin,DC=test,DC=0rg

Group Mame ClassA ClassB ClassC ClassD ClassE ClassF Class G ClassH Classl
IT‘Engineer v v
2 Management v o o v o " o "
3 Sales v
4| 1} 3
’ MNew. ] ’ Delete ] ’Importfrom Server
ok || cancel
Setting Description
Host Set the IP address of the host or use domain name.
Port By default the port number is:
LDAP: 389
LDAPS: 636
Base DN LDAP server’s domain name (DN).

User base DN

Organizational units (OU) that hold users.

Group base DN

Organizational units (OU) that hold groups.

New Add a new group.

Delete Delete a group.

Import from Log in LDAP server using user credentials to import all
Server allowable groups.

Group Name
and Class

Select the operable classes for each group. The group
name can be 64 words in maximum, case-sensitive, and

allows letters / numbers / symbols / Unicode.

[\& WEINTEK
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10.4.5.2. TLS/SSL Tab

Enable settings in this tab for LDAPS (LDAP over SSL) connection with the AD server.

LDAP (Lightweight Directory Access Protocol) @
[¥] Enable
[ General | TLS/SSL | Error
[¥] Enable
[] server verification
se certificate on HMI first (if existed). Otherwise, use imported files below
CA certificate : None
ok | cancel
Setting Description
Enable Enable TLS/SSL security for secured LDAP
communication.

Server When establishing connection, the HMI will verify

verification

whether the certificate supplied by the server matches

the one stored on HMI.

Use certificate
on HMI (if
existed)...

Use current certificate on HMI or import a new

certificate.

10.4.5.3. Error Tab

When LDAP server cannot be connected, an error code shows in the designated address.

I__| WE!NTEK
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LDAP (Lightweight Directary Access Protacal) @

Enable

General SSL Error

Error address

Device : [Lacal HMI

Address : [PLW 0 18-bit Unsigned

Error : PLW-0

(0:none, 1 or more : error)

oK ” Cancel

Setting Description

Error address The result of login is output to this address.

Value | Description

0 No error

1 Error on LDAP server or no password is

entered.

2 Unknown error

257 | Remote LDAP server cannot be connected.

258 | Wrong username or password.
259 | Verification failed
512 | Unknown TLS

513 | Domain name does not match CN.
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10.4.5.4. LDAP Settings (Import from Server)

Get group information from LDAP server.

LDAP

Username : administrator

Password: 00000000

Fetch all groups

Group Name
1 [V] Engineer

2 [¥] Management

3 [v] Sales
Checkall | [ Uncheckall |
[Add groups] [Replace allgroups] I Cancel

Setting Description
Username Log in LDAP Server using username.
Password Log in LDAP Server using password.
Fetch all Fetch all groups of the DN in LDAP server.
groups Error Message Description

Can’t contact LDAP server

LDAP server cannot be

connected.

Invalid Credentials

Wrong username or
password used for login
LDAP server.

Unknown

Error on LDAP server or no

password is entered.

@ Note

B The maximum number of groups allowable in LDAP mode is 128 groups. When importing
from LDAP server, the system will check the number of groups in LDAP server first,

exceeding 128 groups will result in unsuccessful import.

I__| WE!NTEK
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B Importing duplicate group name will not clear the operable classes of that group.
10.4.6. Remote HMI Mode

In this mode, user accounts can be managed on a remote HMI, instead of the local HMI. The
accounts on a remote HMI can be used to log in the local HMI; therefore, managing the

accounts on the local HMI is not necessary.

External server @
) Mone ) LDAP @ Remote HMI
General
Remote HMIIP: 132 . 168 . 2 . 158 |
Result address
Device : [Local HMI
Address @ |pLW 0 16-bit Unsigned
Result address PLW-0
1: Succeeds

8: Account not exists
16: Password error

1024 : Remote HMI cannot be connected

Setting Description

Remote HMI IP The IP address of the remote HMI that holds the user
accounts.

Result address When an error occurs while trying to authenticate the

account or connect to the remote HMI, the

corresponding error code will be output to the

designated result address.

0 Note

B The accounts can be authenticated via both local and remote HMI. When the same
account exists on both local and remote HMI, the authentication is done via the local HMI,

instead of the remote HMI. As shown below, user Angela will be authenticated via local
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HMI.
Accounts on Remote HMI Accounts on Local HMI

Enable Secretuser User name Password Enable Secret user User name Password
1 Angela 111 . 1 Angela 17.
> Bella 222 . 2 Army 27.
3 Gigi 333 . 3 Allen 3 .

[\& WE!NTEK

Search for user on Local HMI

¥

Search for user on Remote HMI

¥

Validate User

Not Found

Found

Found

EasyBuilder Pro V6.07.02
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10.5. Object Security Settings

Settings in the Security tab allow users to configure conditions so that the object is operable

when the condition is met. The sound emitted when operating the object can be selected.

cMT, cMT X Series eMT, iE, XE, mTV Series
New Numeric Object = New Set Word Object @
| General | Data Entry | Format | Trigger Ach’onSem’ng‘. Secwity |Shape | Font | | Genersl | Secuity [Shape l Label |
Safety control Safety control
[”] Display confirmation request Min. press time (sec) :
Enable/Disabls [ Display confirmation request Max. waiting time (sec) : | 10
[V] Use register statusivalue Ensble/Disable
@ Bit O Word [V] Use register statusivalue @ Bit *) Word
Device : (Local HMI =3 Device : [Local HMI v][M
pdins: LB -0 ‘ et g
Enable if Bitis :
Ensble if bitis: [ON___ v AR
[¥] Use control token
Control token : [1: Control Token - Local Only v | [ Token Library..
* For environment of vsing multiple clients (M T Viewers).
Action : (Do nothing when disabled ]
Action : Do nothing when disabled -
User restriction
Objectclass : [Class : 4 -] User restriction
Objectclass: [Class: 4 x)

["] Disable protection permanently after initial activation

[7] Display warning message if access denied ["] Disable protection permanently after initial activation

[] Make invisible while protected [7] Display warning message if access denied
*If the user tries to operate on an object without authorization, LB-12056 will be set to [ Make invisible while protected
ON. *1f the user touches an vnauthorized object, LB-12056 will be set to ON.
Sound
7] Ensbls Sound Librery...| B Sound
e = L) =est [T Enable Sound Library Sound Index : Default
Ele Flay

[ ok [ cencel |[ hep | Cancel Help

10.5.1. Security Tab

Setting Description

Min. press Press and hold the object for longer than the [Min. press

time (sec) time] set here to activate the object.

Display After pressing the object, a dialog appears for operation

confirmation confirmation. If the response to this dialog comes later

request than the set [Max. waiting time (sec)], this dialog
disappears automatically and the operation will be
canceled.
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I@ FPlease confirm the operation

0K Cancel

10.5.2. Enable/Disable

When [Use register status/value] or [Use control token] is selected, whether the object is
operable is determined by the status of the designated address or acquisition the control token,
respectively. As shown in the following figure, only when LB-0 is in OFF state and “2: Control
Token” is acquired will this object be operable.

Enable/Disable
[V] Use register statusivalue
Device : [Local HMI [ Settings..|
Address: [LB ,J 0 [

Enable if Bitis :

[¥] Use control token
Control token : [2; Control Token #1 = ] Token Libraxy...
Ensble if token is : [Acquired |

* For environment of using multiple clients (M T Viewers)

Action : (Do nothing when disabled -
Do nothing when disabled

User restriction Hide when disabled
o) O Rl b T T Cxecyed label when disabled

The following table describes the action this object will take when it’s token is not acquired.

Setting Description

Do nothing When the control token is not acquired, the object is
when disabled displayed.

Hide when When the control token is not acquired, the object is
disabled hidden.

Grayed label When the control token is not acquired, the label of the
when disabled object turns gray.

D\pWE!NTEK EasyBuilder Pro V6.07.02
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10.5.2.1. Use Register Status/Value

When selected, the status of the designated bit/word address determines whether the object

is operable.
Setting Description
Bit The object is operable when the designated bit isin
On/Off state.
Word When [Use Register Status/Value] and [Word] are both

selected, the status of a designated word address
determines whether the object is operable.

Enable if value is: >, <, ==, <>, >= <=

When the value in the word address reaches the
condition specified here, the object is operable.
Tolerance: This setting is available for <> and ==.
<>: The object will be operable when:

value in address > [value in address + tolerance]

or

value in address < [value in address - tolerance]

==: The object will be operable when:

value in address is between [value in address + tolerance]
and [value in address - tolerance] (including value in
address * tolerance)

For example:
[] Use register statnshvalne ) Bit @ Ward
Device * | Logal HMI [ Settings...
Address [LW v] il 16-bit Tnszned
Enable if value is : z] 10
Toleramce © 1

When the value in the designated word address is
between 9~11, the object is operable.

Please note that [Word] option is only available for Set

Word and Numeric objects.

0 Note

B Word objects supported on cMT/cMT X Series include: Set Word, Numeric, ASCII, Combo
Button.
Word objects supported on iE/XE/eMT/mTV Series include: Set Word, Numeric.
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10.5.2.2. Control Token

cMT
viewer
Contrl Token
cMT cMT
viewer viewer

One cMT / cMT X HMI can be simultaneously controlled by multiple cMT Viewer clients. To
ensure system safety by preventing an object to be controlled by multiple clients

simultaneously, a control token can be set. Only one cMT Viewer client can acquire the control
token at a time, and only the cMT Viewer client that acquires control token can operate the
object. The rest of the clients can acquire the token one by one when the token is not
occupied.

The applicable objects include: Combo Button, Numeric, ASCII, Direct Window, and Indirect
Window.

Setting Description
Control Token Select a control token for the object.
Token Library... Add/delete control token.

For more information, please see “Chapter 34 Control

Token” in this user manual.

Enable if Token is When [acquired] is selected, only the device that
obtains the control token can operate the object.
When [unacquired] is selected, only the devices that
do not obtain the control token can operate the
object.

10.5.3. User Restriction

Set the security class of the object to be operated by an authorized user.
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Tzer restriction
Objectclass | Class A ~

[] Disable protection permanently after initial activation

[ Display warning messge if ancess dendsd
[ Miake fnvisble while protectsd

Setting

Description

Object class

“None” means any user can operate this object. Only
account “admin” can operate “Administrator” object
class.

Disable
protection
permanently

Once the permitted class of the user matches that of the
object, the system will stop checking the security class
permanently, that means, any user can operate this

after initial object freely after it is unlocked.

activation

Display When an unauthorized user attempts to operate the
warning object, a warning dialog (Window no. 7) appears. The
message if content of the message in the dialog can be modified.

access denied

Make invisible
while

protected

When the user's privilege does not match the object

class, the object will be hidden.

L—| WE!NTEK
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10.6. Example of Object Security Settings
The following shows an example of setting object security class:

1. Create a project, go to [System Parameter Settings] » [Security] » [General] to enable 3
users:

User 1 = Operable class: A

User 2 = Operable class: A, B

User 3 = Operable class: A, B, C
2. Design Window no. 10 as shown:

User name : r‘E#?##;*# | L8218
Password : rEi#lf#i‘if |1W922f?

bit 75 bit?
Currentstatus : A1 1111111111111 | cwszzz

" Logout 169950

SB_0

Class A Button |
SB_1

‘Class B Buiton

8B 2
‘Class C Button |

Create two [Numeric Input] objects:

[LW-9219] User no. (1~12), Length = 1word

[LW-9220] For entering user password. Length = 2 words

Create a [Numeric Display] object:

[LW-9222] Displays the operable object class of current user. (16-bit Binary)
Create a [Set Bit] object

[LB-9050] logout

Create three [Set Bit] objects:

Each set to different classes but all select [Made invisible while protected].

3. After setting, please save and compile the project and execute off-line simulation. The
below shows how it works when simulating.
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Username : | 1 | Lwszis
Password : | 0 | Lwezzg

bit15 bitd

Current status : | 0000000000000000 I Lwazzz

Logout 159050

User name : | 1 ILW9279
Password : ‘ 111 |1W922”

bit 15 bitd

0000000000000001 | Lwgzzz

L ogou{ LBS050
Class A Button

Current status :

Username : | 3 |1W9275"
Password : | 333 |W9m

bit15 b0
Current status - | 0000000000000111 | tmezzz

Logout (59050

|

Class A Bution

Class B Button

L

Class C Button

Username: | 3 | Lwezig

Password : | 333 | twez0

bit15 bitd

Current status - | 0000000000000000 | Lwszzz

Logout LB205D

L

I__| WE!NTEK

Before entering the password, it displays
“0000000000000000”, which means that
the user operable object class is “None”.
[Class A Button] ~ [Class C Button] objects
are classified from “A” to “C” and selected
[Made invisible while protected]; therefore

they are hidden at this moment.

Enter User 1 password “111”.

Since User 1 is only allowed to operate class
A objects, [Class A Button] object appears for
operating. [LW-9222] bit O turns to “1”

means that user can operate class A objects.

Enter User 3 password “333”.

Since User 3 is allowed to operate class A, B,
C objects, [LW-9222] bit 0 ~ bit 2 turns to “1”,
means that user can operate classA~ C

objects.

Click [Logout] button to log out, the
system will return to the initial state, and
current user can only operate class “None”

objects.

EasyBuilder Pro V6.07.02
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@ Note

B Password input: If the password is incorrect, [LB-9060] will be ON; if the password is
correct, [LB-9060] will be OFF. All user passwords (User 1 to User 12) can be obtained
from system registers [LW-9500] ~ [LW-9522], 24 words in total.

B Changing password directly on HMI: When [LB-9061] is set ON, the system will read data
in [LW-9500] ~ [LW-9522] to update user password. The new password will be used in
future operations. Please note that the user operable object classes will not be changed

due to the change of password.
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10.7.

Protecting Password Settings from Unauthorized Editing

Before sending the project to others who may edit the project afterwards, it is recommended

to click [Editable] button in Security settings tab to open read-only mode. This mode can

protect password settings from unauthorized editing.

System Parameter Settings

B

Cellular Data Network | Printer/Backup Server | Time Sync/DST | e-Mail

l Recipes

Device | Model | Geneal | SysemgSeting | Security | Non-ASCIIFonts | Extended Memory

Select operable classes for each vser
[ Use existing user accounts on HMI first (if existed). Otherwise, use settings below.

() General mode @ Enhanced security mode Editable...

>

m

o
XDDDIQBZ

* Simulation does not support this function and L W-11165s display expiration time of USE key.

No. Enable  Secretuser User name Password Class 4
1 & = userl 1 ¥
2 [#] ] user2 2 ¥
3 ] ] uzer3 3 ®
4 ] ] userd 4 @
5 ] [ uzerS 5 ®
6 &l A vserf 6 wl
7
~| Read-only Settings
Class
Class & [¥]Enable read-only
ClasB
ClasC
= Password : 111111 (1 ~ 4294967295)
Administeator
[7] Secret usd [¥] Mask password
Control addre
LAl [ OK ] [ Cancel J
Address: [pLw 8950
Project password
7] Enable
Execute auto logindogout when insert an USE key into HMI
[¥] Enable
Status address
PLC: Local HMI ~ [ Settings...
Address : [LW - ] 0 [16-bit Tnsigned

[ OK ]f Cancel ]

Help

When [Enable read-only] is selected, a password will be required for changing security settings

in the project.
When [Mask password] is selected, passwords will be masked by asterisks (*).

@ Note

B The protected projects cannot be decrypted since they are encrypted by users, therefore,

please remember your password.

I__| WE!NTEK
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10.8. Bulk Changing of Security Settings of Multiple Objects

Selecting multiple objects in a group and then selecting [Security settings] in the right-click

menu can open an Objects’ Security Properties window that allows users to change the

security settings of all the selected objects at a time.

@ Note

B When the selected objects have different security settings pages, Objects’ Security
Properties will automatically adjust and show the settings that users are allowed to

change. The rest of the settings will be hidden or greyed out. The following is a window

Objects' Security Properties
Security ‘

Safety control
[V] Display confirmation request Max. waiting time (sec) : 10

Enable/Disable
[V] Use register statusivalue
@ Bit ) Word

Device : (Local HMI v [ Settings...
Address: (LB v 0

Ensble if bitis :
[7] Use control token
* For environment of using multiple clients (cM T Viewers).

m

Action : [Do nothing when disabled

User restriction
Objectclass: |Class: &

[ Disable protection permanently after initial activation

[ Display waming message if access dended

[ Make invisible while protectsd
*If the user tries to operate on an object without authorization, LB-12056 will be set to ON.
Sound
[¥] Enable  |Sound Library...| Beep

Play

[ ok ][ cancel [ o |

that shows when selecting a Bit Lamp and a Numeric object.
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Objects' Security Properties IE'

Security
Enable/Disable
ze repgister statushvalue
@ Bit Wioxd

Device:[LgcalHMI v][ Settings. . ]

Addresz: |LE -| 0
Enable if bitds :

Action : [Hide when dissbled

ser restriction
Object class : fClass: &
[E] Make invisible while protectsd
#If the nzer tries fo operate on an object without authorization, LB-12056 will be st o ON.
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11.Index Register

This chapter explains how to use Index Register.

110, OVOIVIBW ..ueiiiiieieee ettt e e ettt e e e e e ettt e e e e e s e bttt e e e e e s e anbsbeeeeaeeeesaannnrraneaaaens 11-2
11.2. Examples of INdeX REGISTOI ......cceicuiiiiieieee et 11-3
11.3. Examples of Using Tag-Based PLC and Index RegISters .......ccccecvereeecrieeececveeeeeeenenn. 11-5
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11.1. Overview

EasyBuilder Pro provides Index Registers for changing addresses flexibly. With Index Registers,
user can change the object’s read/write address directly on HMI without changing its settings.
There are 32 Index Registers, divided into 16-bit and 32-bit. cMT / cMT X models offer 32
Private Index Registers, also divided into 16-bit and 32-bit.

Address @
PLC name : [LOCE| HMI v]
Device type : | LW-3002 (32bit-float) : input high limit b

Address & ||\ 5501 (16bit) : address index 1

LWw-9202 (16hit) : address index 2
LW-3203 (16bit) : address index 3
LW-3204 (16bit) : address index 4

Address format :

LW-3205 (16bit) : address index 5
LW-9206 (16bit) : address index &
LW-9207 (16bit) : address index 7
LW-3208 (16bit) : address index 8
LW-3209 (16bit) : address index 9
LW-3210 (16bit) : address index 10
LW-9211 (16bit) : address index 11
Tag Library... Lw-5212 (16hit) : address index 12
LW-3213 (16bit) : address index 13

m

L}

LW-3214 (16hit) : address index 14

LW-3215 (16bit) : address index 15

LW-3219 (16bit) : user no. {1~12)

LW-9220 (32bit) : password

LW-3222 (16bit) : classes can be operated for current user (bit 0:A, bit 1:B,bit
LW-3230 (32bit) : address index 16

LW-3232 (32bit) : address index 17

LW-3234 (32bit) : address index 138

LW-9236 (32hit) : address index 19

LW-9238 (32bit) : address index 20

LW-3240 (32bit) : address index 21

LW-3242 (32bit) : address index 22

LW-3244 (32bit) : address index 23

LW-5246 (32bit) : address index 24

LW-9248 (32bit) : address index 25

LW-3250 (32bit) : address index 26 52

The corresponding address of 16-bit Index Register 0 to 15: LW-9200 (16bit) to LW-9215 (16bit)
The maximum offset range is 65536 words.

The corresponding address of 32-bit Index Register 16 to 31: LW-9230 (32bit) to LW-9260
(32bit)

The maximum offset range is 4294967296 words.

The corresponding address of 16-bit Private Index Register 0 to 15: PLW-9200 (16bit) to
PLW-9215 (16bit)

The maximum offset range is 65536 words.

The corresponding address of 32-bit Private Index Register 16 to 31: PLW-9230 (32bit) to
PLW-9260 (32bit)

The maximum offset range is 4294967296 words.

When using [Index register], the address is designated by the following equation:
The constant set in [Address] + the value in the chosen Index Register.

The way to use Private Index Registers is the same as that of Index Registers. The difference is
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that Private Index Registers work for objects in cMT Viewer app, which runs independently on
each client device; therefore, operations in this app will not make the HMI show the same
screen.

0 Note

B Index Registers work for the Word registers. For Bit registers, adding 1 to the value in the
Index Register, the offset is 16 bits.
B Index Registers do not work for PLB and PLW registers.

11.2. Examples of Index Register
The following explains the way to designate the register while Index Register is used.

If not selecting [Index register] check box and set address to [LW-10]. The system will directly
read / write LW-10.

Address @
PLC name : [LN-E' HMI ']
Device type : [LW v]
Address: 10 [ system tag

Address format : DDDDD [range : 0 ~ 10799]

[T Index register

o) [ s

If select [Index register] check box and set [Index] to [INDEX 0 (16-bit)], the system will read /
write [LW(10 + value in Index Register 0)].
If the data in [LW-9200] is “5”, the designated address is [LW(10+5)] = [LW-15].

Address @
PLC name : [LN-E' HMI ']
Device type : [LW v]
Address: 10 [ system tag

Address format : DDDDD [range : 0 ~ 10799]

Index : |INDEX 0 (16-bit) - Index register

o) [ s

Here’s a demo project shown as an example:
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Demo Project - Index Register

Index Function of Word

Example 1
The following shows an example of using a Word register and select [Index register]. If the
value in [LW-0] is O, in [LW-10] is 3, and in [LW-20] is 6, the result is:

Index Function of Word

[ ] (oo ]

Index O (LW-9200) LW-0 + Index O (LW-9200)

Index Function of Word

(o]

Index O (LW-9200) LW-0 + Index O (LW-9200)

If the value in Index 0 (LW-9200) is 10, then [LWO + Index 0] = read [LW-10] = 3.

Example 2

The following shows an example of using a Bit register and select [Index register].
If the state of [LB-16] is ON, and the state of [LB-32] is OFF.

Since 1 Word equals to 16 Bit, adding 1 in Index Register, the offset is 16 bits.
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Index Function of Bit

If Index 6 (LW-9206) is set to 2, then switch [LB-0 + Index6] reads LB-32 which is in OFF state.

0 Note

B When using Index Registers for Bit register, the offset is 16 bits. For example, if the Bit
register is LB-0, and set the value in Index Register to 1, then LB-16 will be activated. If set

the value in Index Register to 2, then LB-32 will be activated.

X

Click the icon to download the demo project. Please confirm your internet connection.

11.3. Examples of Using Tag-Based PLC and Index Registers

Index Registers only support one-dimensional array variables.

Example 1: INT
If [Index register] is enabled and [Index] is set to [Index 0 (16-bit)], the system will read / write

“Application.PLC_PRG.TestInt[0 + value in Index Register 0]".
If the data in [LW-9200] is “5”, the actual address is “Application.PLC_PRG.TestInt[5]".
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Device : | weintek Buitin CODESYS -
Tag: [Appﬁcaﬁon.PLc_PRG.Tesunt[oj v]
Data type : INT
Address format : |Application.PLC_PRG.TestInt[0 + INDEX 0]
Index : |Index 0 (16-bit) v | [¥]index register
e

Example 2: Bit

If [Index register] is enabled and [Index] is set to [Index 1 (16-bit)], the system will read / write
“Application.PLC_PRG.TestBool[0 + value in Index Register 1]”".

If the data in [LW-9201] is “7”, the designated address is “Application.PLC_PRG.TestBool[7]".

Device : | weintek Buitin CODESYS -
Tag: {Applicaﬁon.PLC_PRG.TestBooI[O] ']
Data type : BitArray
Address format : [Application.PLC_PRG. TestBool[0 + INDEX 1]
Index : |Index 1 (16-bit) v | [¥]index register
=

Note that, unlike its non-tag counterpart, the 16-bit offset is not necessary for Bit array tags.
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12.Keyboard Designh and Usage

This chapter explains how to design and use keyboard in EasyBuilder Pro.

12.1.
12.2.
12.3.
12.4.
12.5.

OVBIVIBW ...ttt ettt e e e ettt et e e e s e sttt e e e e e s e s anbrbbeeeaeeeesaannnreebeaeeessessnnnneens 12-2
Steps to Design a Popup Keyboard.........oooiiiiieei e 12-2
Steps to Design a Keyboard with Direct WindOW .........occcviiiiieeeiiicccireeeee e 12-5
Steps to Design a Fixed Keyboard on SCreen.........eeveiveecciiiiieeee e 12-6
Steps to Design a Unicode Keyboard........c.oooviiiieeei e 12-7
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12.1. Overview

Numeric Input and ASCII Input objects need keyboard as an input tool. Both numeric keyboard
and ASCII keyboard are created with Function Key object. Apart from the keyboards provided
by EasyBuilder Pro, you can create the keyboard if needed. System keyboard is available on
cMT / cMT X Series models.

The types of the keyboards are:

® Popup Keyboard (with or without title bar)

® Fixed Keyboard

® Unicode Keyboard

® System Keyboard (available on cMT / cMT X models)

12.2. Steps to Design a Popup Keyboard

1. Create and open a window for the new keyboard. For example, set to “window no. 200”.

Windows 4
| Object st -
- 199 -
Mew M
.. 201 =
Open
.. 303
. 203 Close
204 Delete
- 203 Settings
.. 206 -

2. Adjust the height and width of “window no. 200” and create a variety of Function Key
objects in [ASCIl/Unicode mode].

GP_0

e

Set one of the Function Key objects as the [Esc] key.

I__| WE!NTEK EasyBuilder Pro V6.07.02



Keyboard Design and Usage

12-3
Keyboard input
© [[Es] v
Set another Function Key object as the [Enter] key.
Keyboard input
@ [[Enter] v]

The rest are mostly used to enter numbers.
Keyboard input

© [[ASCI]{ [Unicode] | 1

3. Select a suitable picture for each Function Key object.
ddds
8
v 4 A 3
4. Select [System Parameter Settings] » [General] » [Keyboard] » [Add] to add “window no.
200”. Up to 32 keyboards can be added.
4 Add a ‘keyboard window -Eﬂ
Window no. :  200. Keyboard v
[ OK J [ Cancel ]
5.

After the keyboard window is added, when you create Numerical Input and ASCII Input
objects, “200. Keyboard” can be found in [Data Entry] » [Keyboard] » [Window no.]. The

[Popup position] is for designating the display position of the keyboard on the HMI screen.
The system divides the screen into 9 areas.
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Keyboard
Use a popup keypad
() System keypad @ Custom keypad
Window no. : (200, Keyboard -
Animatn; Done, Nom]
Hide title bar
Popup position
[Relative to HMI sereen v
@ |-
Hint : If the keyb 5 the
ind window,yp ]I;: @ @ @ 0w, or on the same
E E B

6. Select “200.Keyboard”. When you press Numerical Input or ASCII Input objects on the

screen, “window no. 200” will pop up. You can press the keys on the keyboard to enter
data.
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12.3. Steps to Design a Keyboard with Direct Window

1. Create a Direct Window object and set a read address to activate it.
In [General] » [Attribute] select [Title bar] and the correct [Window No.].

New Direct Window Object

General l Position | Security

Comment :
Attribute

Window No.: (300, Keyboard =

Style [Popup weindow v

[¥] Title bar

Read
Device : |Local HMI JEE &
Address: |LB v 0

2. Open the [Position] tab and select [Auto. adjust window size].

| General | Position | Security |

[¥] Auto. adjust window size

Alignment :
{relative to object display region}

3. Create a Numeric Input object, and don’t select [Use a popup keypad] check box.
Mumeric Input Object's Properties @
General | Dats Entty | Numeric Format | Security | Shape | Font | Pofile |

Input order
[] Enable

Kevhoard

| ] sz a popup keypad |

4. Create a Set Bit object, set address to [LB-0] and set [Set style] to [Set ON]. Overlay it on
the Numeric Input object. Pressing the Numeric Input object will open the keyboard

window.
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Mew Set Bit Object =

Generel | Secusity | Shape | Label |

Commment :

TWrite address

PLC name : [Local HMI v] Setting...

Address : [LB vl 1]

[] Wrrite after button is released

Attribute
Setstyle : [Set ON -]

5.  Add Set Bit objects on the [Enter] and [ESC] Function Key objects respectively. Set address

to [LB-0] and [Set style] to [Set OFF]. In this way when pressing either [Enter] or [ESC] key
will close the keyboard window.

12.4. Steps to Design a Fixed Keyboard on Screen

You can also place a fixed keyboard on the screen instead of popup keyboard or Direct Window.
This type of keyboard can’t be moved or closed.

1. Create a Numeric Input object, in [Data Entry] » [Keyboard] don’t select [Use a popup
keypad] check box.

2. Use Function Key objects to design the keyboard and place it on the screen.

3. Press the Numeric Input object and enter a value with Function Key objects directly.

I__| WE!NTEK EasyBuilder Pro V6.07.02



Keyboard Design and Usage 12-7

12.5. Steps to Design a Unicode Keyboard

The following steps explain how to create a Unicode keyboard with Function Key objects.
1. Place an ASCII Input object on the window and select [Unicode].
2. Create Function Key objects as shown in the following figure. A simple UNICODE keyboard

is created.
New ASCI Object
General irData Entry I Security [ Shape I Font ‘
Comment :
[¥] allow input - "
AE 0 (W .
* Set value after leaving focus can be setup in genersl system setting page — U Keyboard input
B0 © |[ASCII]/ [Unicode] | &
a
|| Multi-line display Keyboard input
* ASCII valve of line feed (LF) character : 10 (Oxd) i B =) @ [[ASCI]/[Unicode] | B
[ Mesk Fr highflow b B v Keyboard input
[ | Reverse w byte —
© |[ASCII]/ [Unicode] | 7
Data format [N s :
e i
© |[ASCII]/ [Unicode] v | &
Read/Write
Device : [Local HMI '][ et
Address: [LW v|0 Tword(s)

@ Note

B You can group up the elements of the designed keyboard and save to Group Library for
future use.

in Click the icon to download the demo project. Please confirm your internet connection before
downloading the demo project.
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13.0bjects

This chapter explains how to use different objects.

13.1.
13.2.
13.3.
13.4.
13.5.
13.6.
13.7.
13.8.
13.9.

13.10.
13.11.
13.12.
13.13.
13.14.
13.15.
13.16.
13.17.
13.18.
13.19.
13.20.
13.21.
13.22.
13.23.
13.24.
13.25.
13.26.
13.27.
13.28.
13.29.
13.30.
13.31.
13.32.

2T 1= o1 o PP PPPPPPPPRS
WOrd Lamp et
ST Bit.eiiiiiiiieieee e
SEtWOId ..t
FUNCLION KEY ..vvvvvieiiiiiriiieieeeeeeeeeeeeesesesesesesesesesesenene
Toggle SWItCh .....eeeeiieieeii e,
Multi-State SWItch ......coovviiiiiiiiieee e
SHABE et

Direct WindOW .....oocuvieeiiiiiieei e
Moving / Rotating Shape ........ccccceeevvveeeeveeccneeenee,
ANIMAtion ...
Bar Graph....ccc oo
Meter Display.....ccccoveeeeeeiieccireee e
Trend Display «.cccccevveeeeeeii e
History Data Display.....cccccoeecvviiveeeeeieccciiieeeeeeee,
Data Block Display .....ceeeeeeevcciviieieeee e,
2 1o |
Alarm Bar and Alarm Display.......ccccccvvvieeeeeeeeiecnnns
Event Display.....cccoovveeeieiiiecciieeeee e
Data Transfer.....ccvviieeiiiiiee e
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13.33.
13.34.
13.35.
13.36.
13.37.
13.38.
13.309.
13.40.
13.41.
13.42.
13.43.
13.44.
13.45.
13.46.
13.47.
13.48.
13.49.
13.50.
13.51.
13.52.
13.53.
13.54.
13.55.
13.56.
13.57.

RECIPE VIBW .eteveiiiiiiietireteteieteteretetetereeasesesesereseseserereretereterereteae.aeereereree...—... 13-242
FIOW BIOCK ...ttt sttt e e e s s e e e s sareeeesaas 13-250
(0] o= -1 { (o] o o= S TP 13-255
COMDBO BULEON. ...ttt ettt e e s snne e e e s saneee 13-268
Circular Trend DiSPlay ....uueeeeeiee e e e s e e e e e e e e e s 13-276
PICEUNE VIBW ... ettt e e e e e st e e e e s e e s nanr e eeeeens 13-287
FIlE BIOWSE ...ttt e sttt e e s st e s ettt e e s sabeeeessnreeeesnns 13-290
e oo a0/4 5o Yo ] o PP 13-294
T @ g - o P PP UPRUPPPPRROPPPPRI 13-299
BaArCOTE ...ciiiieiee et e e s st e e e s s abeeeeeaas 13-304
Y 0T - o LSRR 13-314
D) -] o - 1 O PP PPPPRRPPPPPRI 13-316
(D3 =Y o o Lo Yot | P 13-334
DYNAMIC DIAWING ..utiiiiiiiiiiiieieieiereiererererererererererererererer——————————————————.....—.—.——. 13-337
PDF REAEN ...ttt sttt ettt e e e sttt e e s st e e e s abee e e s sabeeeessnreeeesans 13-343
L o 11T PO UPPPPPPRRUPPRPRNt 13-345
VINC VIBWET ...ttt ettt ettt e e e e e sttt e e e e e s e s abbbe e et e e e eeseannbeeeeeeaeesannans 13-347
(6010 - [l K31 =T [ {o ] NPT PPPPI 13-352
EVENT Bar Chart .ottt s e e s s e e e e e 13-355
JANo A o] o I L =4 = L= PP 13-360
(67 173 Vo - TSP SPRPPPR 13-367
TOUCKN GESTUIE ..ceieieiiee ettt s bt e e st e e s st e e e s sabeeeessasreeeeenns 13-369
PLC WED BrOWSET «...vtiieiiiieeeeeiieee sttt ettt e sttt e e st e e st e s ssabae e e s sabaeeessannaeesenns 13-371
(603 Vo [} [ o TSP PPRPPPRI 13-375
FTP SEIVEI .ttt et esessbesesesebssssssssesssnnnnnsnnnnnnns 13-379
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13.1. BitLamp

13.1.1. Overview

Bit Lamp object displays the state of a designated bit address. If the bit state is OFF, the State O
shape will be displayed. If the bit state is ON, the State 1 shape will be displayed.

"OFF" State "ON" State

13.1.2. Configuration
o

L4

Click [Object] » [Bit Lamp] icon on the toolbar to open a Bit Lamp object property dialog box.

Set up the properties, press OK button, and a new Bit Lamp object will be created.

General Tab
New Bit Lamp/Toggle Switch Object ==
General |Security | Shape | Label |
Comment :

@ Bit Lamp ) Toggle Switch

Read address

PLC name : [Local HMI [ Settings...

[] Invert signal

i

Mode : [None v
["]Hide picture/shape if no corresponding picture for current state
=
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Objects
Setting Description
Comment User can describe the information of the object.

Bit Lamp / Toggle Switch
Switch between Bit Lamp and Toggle Switch features.

Read address

Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the bit device that controls the [Bit
Lamp] object. Users can also set address in [General] tab while
adding a new object.

Invert signal

Reverses the display of ON / OFF states. For example, if [Invert
signal] check box is selected, when the designated bit is OFF, the
object displays ON state.

Blinking

The appearance of the object may alternate between states when
the bit is ON or OFF.

Mode:

None

No blinking.

Alternating image on state 0

The appearance of the object alternates between State 0 and 1
when the bit is OFF.

Alternating image on state 1

The appearance of the object alternates between State 0 and 1
when the bit is ON.

Blinking on state 0

The State 0 appearance of the object will blink when the bit is OFF.
Blinking on state 1

The State 1 appearance of the object will blink when the bit is ON.
Hide picture/shape if no corresponding picture for current state
If selected, when there are not enough pictures to represent all the

states, hides the picture. Otherwise, displays the last state.

@ Note

B In[Label] tab, if select [ON=OFF (use state 0)] check box, both state 0 and 1 follow the

settings of state 0.
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13.2. Word Lamp

13.2.1. Overview

Word Lamp object displays the state according to the value of a designated word register. Up to
256 states are available. When the value of the register is 0, State 0 appearance of the object is

displayed, and with the register value being 1 the object displays State 1, and so on.

Nurmeric Display (LW0) Word Lamp (LWO)
1 EZx3
Numeric Display (LW0) Word Lamp (L WO)
1 ExX

Numerie Display (LW0) Word Lamp (L W0)

1 BE=x

13.2.2. Configuration

H

Click [Object] » [Word Lamp] icon on the toolbar to open a Word Lamp object property dialog

box. Set up the properties, press OK button, and a new Word Lamp object will be created.
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General Tab

New Word Lamp/Multi-State Switch Object

General | Security | Shape | Label |

Comment :

@ Word Lamp

Read address

() Multi-State Switch

Offset: 0

PLC name : [Local HMI

v} Settings...

Address : [LW v|0

Attribute

16-bit Unsigned

[V Hide pictore/shape if no corresponding picture for current state

OK { Cancel

13-6

Setting

Description

Comment

User can describe the information of the object.
Word Lamp / Multi-State Switch

Switch between Word Lamp and Multi-State Switch features.

Mode / Offset

Word Lamp object offers the following three modes:

Value

The state is displayed according to the value in the designated word

address and plus the [Offset].

As shown below, if the value within LW-200 is 3, since the offset is

set to 3, the shape of state 0 is displayed. (value 3 - offset 3)
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New Word Lamp/Multi-State Switch Object

Genersl | Security | Shape | Label |

Comment :

@ Word Lamp (7 bulti-State Switch

Mode : | Value -
Offset: 3

Read address

LSB

PLC: [L.Uca] HMI v] Settings...

Convert the value from decimal to binary. The least significant

active bit in a binary data word selects the state displayed.

Decimal Binary

Displayed state

0 0000000000000000

State = 0 when all bits are 0.

1 0000000000000001

The lowest non-zero bit is

bit 0, state = 1. .
2 | 0000000000000010 E‘tel"og’aetztggﬁ-zero bit is
3 | 0000000000000011 E‘teo"og’aetztgiﬁ-zero bit is
4 | 0000000000000100 Eﬂez',"!t”a‘?eti“;’_"zem bit is
7 0000000000000111 E‘teo'log’t";zt:if_‘-zero bit is
8 | 0000000000001000 H‘te_,"log’t"aetzt:zf_‘-zero bft fs
16 0000000000010000 H‘&"O:t"aetzt:gf_‘-zero bft fs
32 0000000000100000 H‘tes'log’t"aetzt:g_‘-zero bft fs
64 0000000001000000 H‘tes'log’t"aetzt:gf_‘-zero bft fs
128 | 0000000010000000 H‘te;,o:t"aetzt:gf_‘-zero bft fs
256 | 0000000100000000 E‘tes'los"t"aetztggf‘-zero bit is

512 0000001000000000

The lowest non-zero bit is
bit 9, state = 10.

1024 0000010000000000

The lowest non-zero bit is
bit 10, state = 11.

2048 0000100000000000

The lowest non-zero bit is
bit 11, state = 12.

4096 0001000000000000

The lowest non-zero bit is
bit 12, state = 13.

8192 0010000000000000

The lowest non-zero bit is
bit 13, state = 14.

16384 | 0100000000000000

The lowest non-zero bit is
bit 14, state = 15.

32768 | 1000000000000000

The lowest non-zero bit is
bit 15, state = 16.

Bit combination

Lamp state depends on the states of bit combinations, where PLC 1
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represents the least significant bit (LSB), PLC 2 represents the next
LSB, and so on. Maximum number of bit is 4, for a total of 16
states. Changing [No. of states] in Attribute group box changes the
number of read addresses.

® Word Lamp (7) Multi-State Switch
hode : | Bit combination v

Read address

PLC 1: | Local HMI w | Settings...
Address 1: || |0

PLC 2 : | Local HMI w | Settings...
Address 2: || w1

PLC 3 : | Local HMI w | Settings...
Address 3: || V(2

PLC 4t | Local HVI v || Settings...
Address 4: || v|(3
Attribute

Mo. of states: |16 v

Change state by time

The state displayed changes on a time basis. The frequency can be
set.

Read address

Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the word device that controls the
[Word Lamp] object. Users can also set address in [General] tab
while adding a new object.

Attribute

No. of states

The number of states is utilized by the object. The state is
numbered from 0, so the number of states minus 1 will be the state
number. If the value within the word register is > [No. of states]
defined in Attribute, the highest state will be displayed.

If the number of states is set to 8, the valid states will be O, 1, 2, ...,
7. In this case if the word value is 8 or higher, the system will
display the state 7 shape.

Hide picture/shape if no corresponding picture for current state

If selected, when there are not enough pictures to represent all the
states, hides the picture. Otherwise, displays the last state.

@ Note

B In[Label] tab, Language 1 determines the relevant settings of the font. For Language 2~8,
only the font size can be changed and other settings follow Language 1.

L—| WE!NTEK

EasyBuilder Pro V6.07.02



Objects

New Weord Lamp Object @ New Word Lamp Object
General | Security | Shape | Label General | Security | Shape | Label
[ Use label [ use label
[#] Use label library Label tag : Label 0 hd [#] use label library Labeltag : Label 0 A
Label Library... Label Library. ..
State : |0 (o] (1] State : |0 =TI B @)
Attribute Attribute
Font : | Arial Font: | Arial
Color :  INEG— |~ Size : Coor: I~ Size :
Align : | Left - Blink : Align @ Left Blink : | Mone
[ 1talic Italic
Duplicate these attributes to Duplicate these attributes to
[ Every state ] [ Every language ] [ All [ Every state ] [ Every language I [ All
Movement Movement
et (Nomovenent__7) -
Content Content
text
[ trading Duplicate this label to every state [ trading Duplicate this label to every state
Co JCom
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13.3. SetBit

13.3.1. Overview

The Set Bit object provides two operation modes: manual or automatic. Manual mode can
trigger a designated bit address to change the state between ON and OFF when the object is
touched. In automatic mode, the bit is automatically activated when a pre-defined condition
occurs; touching the button will not be effective.

13.3.2. Configuration

=2

Click [Object] » [Set Bit] icon on the toolbar to open a Set Bit object property dialog box. Set up

the properties, press OK button, and a new Set Bit object will be created.

General Tab

Mew Set Bit Object (23]

Gereral | Security | Shape | Label

Comment

Write address

PLC name : | Local HMI +| [ Setting...

Address : [LB v] 0

[T wirite after button is released

Attribute

Setstyle : ‘smom "

Set OFF
Toggle
Macro Momentary

Periodic toggle

Execute maa Set ON when window opens
Set OFF when window opens
Set ON when window doses
Set OFF when window doses
Set OM when backlight on
Set OFF when backlight on
Set OM when backlight off
Set OFF when backlight off

o) (o

Setting Description

Write address Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the bit device that controls the Set
Bit object. Users can also set address in [General] tab while adding
a new object.
Write after button is released
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If this function is selected, the action is delayed till button is
released; otherwise, the action is executed once the button is
pressed. This function does not work with momentary buttons.
Mode / Offset Set style Description

Set ON Set ON the designated bit of the device.

Set OFF Set OFF the designated bit of the device.

Toggle Alternates the bit state each time pressed.

Momentary Holds the bit ON only while button is
pressed.

Periodical toggle | Set a designated bit ON and OFF at a set time
interval. Time interval can be selected; the
range is from 0.1 to 25.5 seconds.

Set ON when Set ON the bit within the window when the

window opens window opens.

Set OFF when Set OFF the bit within the window when the

window opens window opens.

Set ON when Set ON the bit within the window when the

window closes window closes.

Set OFF when Set OFF the bit within the window when the

window closes window closes.

Set ON when Set the bit ON when the backlight is turned

backlight on ON.

(N/A for

cMT-SVR)

Set OFF when Set the bit OFF when the backlight is turned

backlight on ON.

(N/A for

cMT-SVR)

Set ON when Set the bit ON when the backlight is turned

backlight off OFF.

(N/A for

cMT-SVR)

Set OFF when Set the bit OFF when the backlight is turned

backlight off OFF.

(N/A for

cMT-SVR)

Macro Set Bit object can trigger the start of a Macro routine when the

Macro has been created in advance.

& For more information, see “18 Macro References”.

Trigger mode

If [Set style] is set to [Toggle], there is a further selection to make of
whether the macro operates after Off to ON, ON to OFF transition,

or at both of the changes of state.

@ Note

B |n[Label] tab, if select [ON=OFF (use state 0)] check box, both state 0 and 1 follow the

settings of state 0.
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B Using address types other than PLB or PLW_Bit for Set Bit objects with [Periodic Toggle]
attribute is not supported by cMT-SVR.
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13.4. Set Word

13.4.1. Overview

The Set Word object provides two operation modes: manual or automatic. Manual mode can
change the value in a designated word address when the object is touched. In automatic mode,
the word register is automatically activated when a pre-defined condition occurs; touching the
button will not be effective.

13.4.2. Configuration

==

Click [Object] » [Set Word] icon on the toolbar to open a Set Word object property dialog box.
Set up the properties, press OK button, and a new Set Word object will be created.

General Tab

Mew Set Word Object (==

General | Sequrity | Shape | Label

Comment :

Write address
PLC name : [Lgcal HMI v] Setting. ..
Address : [L‘.I‘u' |0 16-hit Unsigned
[ write after button is released
Motification
Enable @ set ON (7 set OFF
Before writing [ After writing
PLC name : [Local HMI v] Setting. ..
Address :[LB v] 0
Attribute
Set Style : [Wrihe constant value -

Setvalue: 0

o) (o
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Setting Description
Write address Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the word device that controls the

Set Word object. Users can also set address in [General] tab while
adding a new object.

Write after button is released

If this function is selected, the action is delayed till button is
released; otherwise, the action is executed once the button is
pressed.

Notification If this check box is selected, it will notify a designated bit address
(setting ON or OFF).
Before writing / After writing
Set the state of the designated bit address before or after the
manual operation.

Attribute Set Style
Select the button action from the drop down list, see Example 2.
Dynamic limits
Set the [Bottom limit] and [Upper limit] by a designated register,

see Example 1.

Example 1
Set the [Bottom limit] and [Upper limit] by a designated register. When Dynamic Address is

LW-n, where n is an arbitrary number, the rule of setting Upper / Bottom limit is:

Content 16-bit 32-bit 64-bit (cMT / cMT X only)
Dynamic address LW-n LW-n LW-n
Bottom limit LW-n LW-n LW-n
Upper limit LW-n+1 LW-n+2 LW-n+4
When Dynamic Address is LW-100, the rule of setting Upper / Bottom limit is:
Content 16-bit 32-bit 64-bit (cMT / cMT X only)
Dynamic address LW-100 LW-100 LW-100
Bottom limit LW-100 LW-100 LW-100
Upper limit LW-101 LW-102 LW-104
Example 2

The available button actions are:

® Write constant value

Write a preset value. Each time the button is pressed, the value in [Set value] is written to the
designated register. Data format is as set by the [Write address] above; it can be 16-bit BCD,
32-bit BCD, ...64-bit Double. In the following figure, when the button is pressed, the number
12 is written to the designated register.
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Attribute
Set Style @ | Write constant value 7

Setvalue @ 12

® Write constant string (cMT / cMT X only)
Write a preset string. Each time the button is pressed, the string in [Set string] is written to the
designated register. The string format can be: UTF-8, Unicode, Latin-1...etc. In the following

figure, when the button is pressed, the string “abcd” is written to the designated register.

Attribute
SetStyle | Waite constant string -
setsting . abed

String format : | UTE-8 (Default) v

® Increment value (JOG+)
Increase value in register by a set amount in [Inc. value], each time when the button is pressed,
up to the [Upper limit]. As shown below, each button press increases the value in the register

by 1 until the value is 10.

Attribute
Set Style : IIncrement value (J0G+) -
Inc. value : 1 Upper limit : 10

® Decrement Value (JOG-)
Decrease value in register by a set amount in [Dec. value], each time when the button is

pressed, down to the [Bottom limit]. As shown below, each button press decreases the value in

the register by 1 until the value is 0.

Attribute
Set Style : IDecrement value (10G-) -
Dec, value ; 1 Bottom limit: 0

® Bounce (up->down->up) (cMT / cMT X only)
Each time when the button is pressed, the value in the register is increased by the [Inc.
value] until the [High limit] is reached, and then the value is decreased by the [Inc. value],
each time when the button is pressed, down to the [Low limit]. As shown below, the
system will increase the value in the register by 1 each time when the button is pressed,
until the value is 10, and then decrease the value by 1 each time when the button is
pressed, until the value is 0, and then increase the value again.
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A ttribte

set style lEu:uume (up-=down-=up-=...)
Lo limit : ) High limit: 10

Inc. walue |

® Press and hold increment (JOG++)

When the button is held longer than a set time in [JOG delay], it will increase the value in a
register by a set amount :[Inc. value] at a set rate :[JOG speed], to the [Upper limit].

As shown below, when the button is pressed, it increases the value in the designated register

by 1. When the button is held longer than 1 second, it increases the value in register by 1 every
0.5 second, till the value is 10.

Attribute
Set Style : |Press and hold increment (JOG++4) v
Inc, value : 1 Upper limit ; 10
JOG delay [1.0 gecond(z) v] J0G speed : [U.E second(s) -

® Press and hold increment (JOG--)

When the button is held longer than a set time in [JOG delay], it will decrease the value in a
register by a set amount: [Dec. value] at a set rate: [JOG speed], to the [Bottom limit].

As shown below, when the button is pressed, it decreases the value in the designated register

by 1. When the button is held longer than 1 second, it decreases the value in register by 1
every 0.5 second, till the value is 0.

Attribute
Set Style : IPress and hold decrement (J0G—) -
Dec. value ; 1 Bottom limit : 0
10G delay : IJ_.I:I second(s) v] JOG speed : ID.E second(s) TI

® Periodic JOG++

This automatic function increases the value in the register by a set amount: [Inc. value], at a set
rate: [Time interval], to the [Upper limit]. As shown below, the system will automatically

increase the value in the register by 1 every 0.5 second, till the value is 10. Then the value
returns to 0 and add 1 every 0.5 second again.
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Attribute
Set Style : | Periodic J0G++ {up-=0->up-=...) -
Inc. value : 1 Upper limit : 10
Time interval : | 0.5 second(s) 'I

® Automatic JOG++
This automatic function increases the value in the register by a set amount: [Inc. value], at a set
rate: [Time interval], to the [Upper limit].then holds this value. As shown below, the system will

automatically increase the value in the register by 1 every 0.5 second, till the value is 10, and

then stop.
Attribute
Set Style : | Automatic J0G ++ (up to high limit) -
Inc, value: 1 Upper limit: 10
Time interval : ID.E second(s) TI

® Automatic JOG--

This automatic function decreases the value in the register by a set amount: [Dec. value], at a
set rate: [Time interval], to the [Bottom limit].then holds this value. As shown below, the
system will automatically increase the value in the register by 1 every 0.5 second, till the value

is 10, and then stop.

Attribute
Set Style | Automatic JOG— (down to low limit) -
Dec, value : 1 Bottam limit ;10
Time interval : IU.E second(s) TI

® Periodic bounce

Increases the word address value to the [Upper limit] by a [Inc. value] at a set rate in [Time
interval], then decreases to the [Bottom limit] by the same value at the same rate. As shown
below, the system will increase the value in the designated register by 1 every 0.5 second, till
the value is 10, and then decrease the value by 1 every 0.5 second till the value is 0 whenever

the screen is active.
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Attribute
Set Style ! | Periodic bounce (up->=down-=up-=...) -
Bottom limit @ 0 Upper limit : 10

Inc, value : 1

Time interval : ||:|.5 second(s) v|

® Periodic step up

Step up to the [High limit] by [Inc. value] at a set rate in [Time interval], then reset immediately
to the [Low limit]. The action repeats whenever the screen is active. As shown below, the
system will increase the value in the designated register by 1 every 0.5 second, till the value is

10, and then reset to 0 and increase again, and the action repeats.

Attribute

Set Style : | Periodic step up (low to high...) v

Low limit : 0 High limit ; 10

Inc, value : 1

Time interval : ||:|.5 second(s) v|

® Periodic step down

Step down to the [Low limit] by [Dec. value] at a set rate in [Time interval], then reset
immediately to the [High limit]. The action repeats whenever the screen is active. As shown
below, the system will decrease the value in the designated register by 1 every 0.5 second, till

the value is 0, and then reset to 10 and decrease again, and the action repeats.

Attribute
Set Style |Periudir_ step down (high to low...) -
Low limit: 0O High limit : 10

Dec, value : 1

Time interval : ||.'.|.5 second(s) "l

® Set when window opens / Set when window closes

Automatic function occurs whenever the screen is active. The value entered in [Set value] is set
into the word address when the action occurs. If [Set value] is set to 5, when the window
opens / closes, the system enters 5 into the designated register.

® Set when backlight on / Set when backlight off (Not supported on cMT-SVR)

Automatic function occurs whenever the backlight is active. The value entered in [Set value] is
set into the word address when the action occurs. If [Set value] is set to 5, when the backlight
turns ON / OFF, the system sets 5 into the designated register.

® CyclicJOG+

Each time when the button is pressed, increases the word address value to the [Upper limit] by

I__| WE!NTEK EasyBuilder Pro V6.07.02

13-18



Objects 13-19

[Inc. value] then reset to the [Bottom limit]. As shown below, each time when pressing the
button, the system will increase the value in the designated register by 1, till the value is 10,

and then reset to 0 and increase again by pressing the button.

Attribute

Set Style © | Cydic J0G+ -

Bottom limit : 0 Upper limit: 10

Inc, value : 1

® Cyclic JOG-

Each time when the button is pressed, decrease the word address value to the [Bottom limit]
by [Dec. value] then reset to the [Upper limit]. As shown below, each time when pressing the
button, the system will decrease the value in the designated register by 1, till the value is O,

and then reset to 10 and decrease again by pressing the button.
Attribute

Set Style : |Cydic J0G- -]

Bottom limit @ 0 Upper limit: 10
Dec, value : 1

® CyclicJOG++

When the button is held longer than a set time in [JOG delay], it increases the value in a
register by a set amount in [Inc. value] at a set rate in [JOG speed], to the [Upper limit], then
reset to the [Bottom limit]. As shown below, when the button is held longer than 0.5 second,
increase the value in the designated register by 1 every 0.1 second, till the value is 10, and then

reset to 0 and increase again by holding the button.

Attribute

Set Style : | Cycic J0G++ v

Bottom limit @ 0 Upper limit: 10

Inc, value : 1

JOG delay : [ 0.5 second(s) v| JOG speed : |U.l second(s) ~

® CyclicJOG- -

When the button is held longer than a set time in [JOG delay], decrease the value in a register
by a set amount in [Dec. value] at a set rate in [JOG speed], to the [Bottom limit], then reset to
the [Upper limit]. As shown below, when the button is held longer than 0.5 second, decrease
the value in the designated register by 1 every 0.1 second, till the value is 0, and then reset to
10 and decrease again by holding the button.
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Attribute
Set Style @ | Cydic J0G— -

Bottam limit : 0 Upper limit : 10

Dec, value : 1

10G delay : [D.E second(s) v] 10G speed : [D.l second(s) T]

® Object Control Command (cMT / cMT X only)
Listed for selection are commands (with their corresponding command values) available for
the control address of various functions. For a given function, with write address set to its

control address, Set Word writes the command value and achieves function control.

Attribute
SetStyle © [Objest Control Cammand -

Obiect Type : (Database Server -
Command [[1] Sart v]

® System Tag Command (cMT / cMT X only)
When a system tag is set as write address, for example, LW-9134: Language Mode, the

commands relating to the system tag can be selected.

Attribmte
Het Style [S}rstem Tag Commaind v]
Langvage © | Languags 1 - |
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Set Word Object’s Properties

General| Security | Shape |Label | Profile |

User restriction

Safety control
Min. press time (sec) :

|| Display confirmaticn request Max. waiting time (sec) : |10
Interlock

Use interlock function © Bit @ Word

|| Hide when disabled

Grayed label when disabled

Trigger if value is 1
PLC: [Local HMI v |[ Semings.. |
Address : [LW ~|1 16-bit Unsigned

Object class : [None

M
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Setting

Description

Interlock

Use interlock function

When this option is enabled and [Word] is selected, whether
the object is operable depends on the condition of a word
address specified in [Trigger if value is:]. In the settings above,
the object is operable only when the value in LW-1 is greater
than 1.

Hide when disabled

The object is hidden when the specified condition does not
occur in the specified word address.

Grayed label when disabled

The label of the object turns gray when the specified condition
does not occur in the specified word address.

[ ]

Trigger if value is:

This setting is for specifying a trigger condition. The available
options are: >, <, ==, <>, >=, and <=. A tolerance value can be
set for conditions == and <>.

For example:

Hide when disabled
[]Grayed label when disabled

Trigger if valueis : | == w

Tolerance : | 1 |

When the value is the specified word address is greater than
or equal to 11, or smaller than or equal to 9, the object will be

hidden and is not operable.

@ Note

B Using address types other than PLW for Set Word objects with automatic attributes such
as [Periodic set up], [Periodic set down], [Automatic JOG++], [Automatic JOG--], and
[Periodic JOG++]...etc, is not supported by cMT-SVR.
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13.5. Function Key

13.5.1. Overview

The Function Key object can be used for several tasks, such as switching between windows,

keypad design, Macro execution, screen hardcopy, and setting USB security key.

Function Keys with [Screen hardcopy] or [Import user data/Use [USB Security Key]] selected do

not work remotely on cMT Viewer.

13.5.2. Configuration

Fn

Click [Object] » [Function Key] icon on the toolbar to open a Function Key object property

dialog box. Set up the properties, press OK button, and a new Function Key object will be

created.

General Tab

cMT / cMT X Series eMT, iE, XE, mTV Series
New Function Key Object [#35] | New Function Key Object (=)
Genersl | Security | Shape | Label | [ General |Security [ Shape | Label |
Comment : Comment :
[ Activate after button is released [T Activate after button is released

© Change full-screen window *) Change common window ‘ © Change full-screen window ~) Change common window

() Retom to previous window ) Close window () Display popup window

(") Display popup window ) Display calculator window

Animation: [ Sefting.. | [(owe] Window n0. : (50 Keypad 1 - Integer =
Window no. : [50. Keypad 1 - Integer -
. _ Retumn to previous window ) Closs window
Keybosrd input Keyboard input
[Eatir] [Entex]
\

) Execute macro ") Execute macro
Haxd copy screen to USB disk, 8D caxd or printer ) )

(0) Screen hardcopy Window title bar

Haxd copy screen to USE disk, 8D cexd or printer
() Screen hardcopy

") Acknowled ge all events (alarms)

*) Import user data/Use [USE Security Key] Import user detarllse [USB Security Key]
Notification okt ——

[]Enable [ Enable
OK Cancel | Help I [I] Cancel Help
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Setting Description
Activate If this function is selected, the action is delayed till button is

after button

released; otherwise, the action is executed once the button is

is released pressed.
Change Change full-screen window: Change to another base window.
window Change common window: Change common window.

Display popup window: A pop-up window displays in the base
window. If [Close this popup window when parent window is closed]
check box is selected, the pop up window will be closed when
change the base window to another window. Otherwise, a function
key in the pop up window is needed to close it.

(@ Display popup window

Close this popup window when parent window is dosed

Style : lWith title bar ']

Window no. : [ 11 Window_011 -

(cMT / cMT X Series) Animation Setting: cMT / cMT X Series allows
using transition effects for opening popup windows using Function
Keys. The settings can be opened by clicking [Animation Setting].

) Change full-screen window (7) Change common window
@ Display popup window [ Animation Setting.. |
Window no. : (50, Keypad 11 - Integer -

The effects are shown below. Different effects may be used for Start

(window appears) and End (window disappears).

Effect Name Transition

Fade

Fly

Float

i3
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Wipe -
-
. :
Circle K ’
b
Clock
Zoom 2 !
Turn P
" 4 ‘ b
Push

[Duration] specifies how many milliseconds (ms) a transition effect
takes to complete.

[Direction] The direction of the transition.

Return to previous window: If this is selected, the Function Key will
change from the current screen to the previous one displayed. For
example, when window no. 10 is changed to window no. 20, press
the function key to return to window no. 10. This function is only
available for base window.

Close window: Close any active pop-up windows, message windows
included.

Display calculator window(cMT / cMT X Series): If this option is
selected, clicking this Function Key can open a calculator with an
unchangeable appearance. This calculator allows operators to do
simple calculation and enter the result to a destination object by
pressing the Enter key.
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X

SERE

)

i
anuna

IF MS || M+
[ ]
[, ]
1
(o ]

= Enter

Selecting this option opens [Keep calculation open after paste]
checkbox, which keeps the calculator displayed after the value is
entered to the object.

Function Key Object's Properties =]

Generel | Secusity | Shape | Label | Protile |

Comment :

[ Activate after button is released

() Change full-screen window (7) Change conmmaon window
() Retum to previous window () Close window
(7 Display popup window @ Display calenlator window

bomir e )

| [T Keep caleulator open after paste |

E Click the icon to watch the demonstration film. Please confirm

your internet connection before playing the film.

Keyboard
Input

Configures the button as a keypad key, and the character it enters,
via [Numeric] or [ASCII] objects.

Enter: Same as the keyboard’s “Enter” function.

Backspace: Same as the keyboard’s “Backspace” function.

Clear: Clear the value in the word register.

Esc: Same as the [Close window] function; it is used to close the
keyboard window.

Delete: Same as the keyboard’s “Delete” function, deletes the
number or character on the right side of the text cursor.

Left: Same as the keyboard’s “<-” key moves the text cursor to the
left side of the previous number or character.

Right: Same as the keyboard’s “—” key moves the text cursor to the
left side of the next number or character.

Line feed: Move the cursor down to the next line.

Inc: Increment by 1.

Dec: Decrement by 1.

ASCII/UNICODE: Specify the character to be entered by this key.
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Execute Select this check box to execute one of the Macros from the drop
Macro down list that has already been configured by users.

C3—_‘For more information, see “18 Macro References”.

(@) Execute macro Macra [[ID:UUU] macra_0 v]

Window title Function Key defined can be used to move a pop-up window which
bar has no [window title bar] to a preferred position on screen. Select

the pop-up window and then click on a preferred position, the

window will be moved.

[ 1
H § #
FK-\T Alarn Status ] ‘
Select the window titie bar firstly. Touching the screen for the new position
the popup window will be maoved.

il Click the icon to download the demo project. Please confirm

your internet connection before downloading the demo project.
Hard copy Print the current window. Before using this function, choose a printer
screen to . . .

model in [System Parameter Settings] » [Model] » [Printer].
USB disk, SD [Sy gs]» [Model] » | ]
card or If a monochrome printer is used, selecting [grayscale] can provide a
printer better print result, but the text may not be clearly printed. To

improve text printing, avoid using [grayscale].

Hard copy screen to 1USE disk, S0 card or printer
@ Screen hard copy Printer : [HP PCL Series (LISE) v]

|:| Rotate image 90 degrees Mode : [mlur *]

Crop window
This option can be selected for taking a cropped screenshot.
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Crop Window x
10. WINDOW_010 -
Trigger time Message
10:07:29 Event triggered!
x v
oK Cancel
Acknowledge
all events
(alarms) Acknowledge all events once by pressing the Function Key.
(cMT / cMT X
Series)

Import user
data / Use
[usB
Security Key]

A Function Key can be used to import the e-mail contacts or user
accounts set, also, to log in using USB Security Key.
B

Function mode

() Import e-mail settings and contacts

(©) Use [USB Security Key] to Login
Data position

© 8D card @ UsB disk

Account import mode

) Overwrite @ Append

[ Delete file after importing user accounts

[ oK ] [ Cancel

Data Position

Select the external device to store data from [SD card] or [USB disk].
Account import mode

If [Overwrite] is selected, the existing accounts will be overwritten
with new accounts in the external device after importing. If [Append]

is selected, HMI will append more accounts while the old accounts
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still exist.

Delete file after importing user accounts

If select this check box, the system will delete the account data saved
in the external device after importing, this can prevent the account

data from leaking out.

Notification If this selection is enabled, it will notify a designated bit address to
set ON or OFF, each time the button is pressed.

@ Note

B [Overwrite] is the only option when importing the e-mail contacts. This means that all
existing contacts will be removed first, and then the new contacts are added.

o For more information, see “6 Window Operations”, “12 Keypad Design and Usage”, “36

Administrator Tools”.
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13.6. Toggle Switch

13.6.1. Overview

Toggle Switch object is a combination of Bit Lamp object and Set Bit object. The appearance of
the object is controlled by the ON / OFF state of the read bit address. As well, pressing the

button sets the value in the bit address according to the settings.

13.6.2. Configuration

Click [Object] » [Toggle Switch] icon on the toolbar to open a Toggle Switch object property

dialog. Set up the properties, press OK button, and a new Toggle Switch object will be created.

General Tab

New Toggle Switch/Bit Lamp Object (=2
Generel |Security | Shepe | Label |

Comment :

Bit Lamp @ Toggle Switch

[T Read/Write vse different addresses
Read address

PLC name : [Local HMI v ] Settings...

Address : [LB v] 0

[ Invert signal

Write address :

[7] Wrrite when button is released

Attribute

Macro

Execute macio

[ OK ] [ Cancel [T]
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Setting Description

Comment User can describe the information of the object.
Bit Lamp / Toggle Switch
Switch between Bit Lamp and Toggle Switch features.

Read/Write

use different Different addresses can be used to read data and write data.

addresses

Read address Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the bit device that controls the

[Toggle Switch] object. Users can also set address in [General] tab
while adding a new object.

Invert signal

Reverses the display of ON / OFF states. For example, if [Invert
signal] check box is selected, when the designated bit is OFF, the
object displays ON state.

When [Read/Write use different addresses] option is not selected,
the title of this group box will be “Read/Write address”.

Write address Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the bit device that controls the
[Toggle Switch] object. Users can also set address in [General] tab
while adding a new object. The address can be the same or
different from [Read address].
Write after button is released
If this function is selected, the action is delayed till button is
released, otherwise, the action is executed once the button is

pressed. This function does not work with momentary buttons.
Attribute Set style Description
Set ON Set ON the designated bit of the device.

Set OFF Set OFF the designated bit of the device.
Toggle Alternates the bit state each time pressed.
Momentary Holds the bit ON only while button is

pressed.

Macro Toggle Switch object can trigger the start of a Macro routine when

the Macro has been created in advance.

& For more information, see “18 Macro References”.
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13.7.1. Overview

Multi-State Switch

Multi-state Switch object is a combination of Word Lamp object and Set Word object. The

appearance of the object is controlled by the value of the read word address. As well, pressing

the button sets the value in the word address according to the settings.

13.7.2. Configuration

Click [Object] » [Multi-State Switch] icon on the toolbar to open a Multi-State Switch object
property dialog box. Set up the properties, press OK button, and a new Multi-State Switch

object will be created.

General Tab

cMT / cMT X Series eMT, iE, XE, mTV Series
New Multi-State Switch/Word Lamp Object [=3]| | New Multi-State Switch/Word Lamp Object (==
General | Security | Shape | Label | General ‘ Security | Shape | Label
Comment : Comment :
() Word Lamp © Multi-State Switch () Word Lamp © Multi-State Switch
[T Read/Write use different addresses [ Read/Write use different addresses
Read address Read address
PLC name 1[Local HMI v] Settings... PLC name =[Loca| HMI v] Settings...
Address : | Ly v|0 16-bit Unsigned Address : |Lw v|0 "~ [16-bit Unsigned
Exrror handling...
Write address : Write address
[ Write when button is released
Attribute Attribute
Cyelical : [Disable | Cyelical : [Disable -
[ User-defined mapping [T User-defined mapping
Send notification after writing sucessfully Send notification after writing sucessfully
[T Enable []Enable
G Coc ) (o

I__| WE!NTEK

EasyBuilder Pro V6.07.02




13-33

Objects
Setting Description
Comment User can describe the information of the object.
Word Lamp / Multi-State Switch
Switch between Word Lamp and Multi-State Switch features.
Model / Different modes can be selected: [Value], [LSB].
Offset r For more information, see “13.2 Word Lamp”.
Read/Write

use different

addresses

Different addresses can be used to read data and write data.

Read address

Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the word device that controls the
Multi-state Switch object. Users can also set address in [General]
tab while adding a new object.

When [Read/Write use different addresses] option is not selected,
the title of this group box will be “Read/Write address”.

Write address

Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the word device that controls the
Multi-state Switch object. Users can also set address in [General]
tab while adding a new object.

Write after button is released

If this function is selected, the action is delayed till button is
released; otherwise, the action is executed once the button is

pressed.

Attribute

Switch style
Select the object’s operation mode, see Example 1.

User-defined mapping
The value placed in the write register of each selection, the action

taken when an illegal value is entered, and error notification to a

designated bit address can be set.
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Mapping [E
State Falue
1} 1}
1 1
2 {exror)
Input illegal
'@ Remain current state _) Jump to error state
Error notification
[] Enable ") Set ON @ Set OFF
PLC name :Local HMI ] [ setting...
ik [C—
Remain current state
If an illegal value is entered, Multi-state Switch will remain at the
current state.
Jump to error state
If anillegal value is entered, Multi-state Switch will jump to the
error state.
Error notification
If anillegal value is entered, automatically set the value placed in
the designated register.
Send

notification
after writing
successfully

After the system successfully writes data to PLC, the designated bit

address will be set On/Off.

Error handling
(cMT / cMT X
Series)

The action taken when an illegal value is entered or notify a
designated bit address. This is similar to [User-defined mapping];
the difference is the value corresponding to each state need not to

be preset.

Example 1
® JOG+

Increase the value of a designated register by 1 each time when pressing the button, till the
value equals to [No. of states]. A cyclic action can be enabled. As shown below, each time

when pressing the button, the state number will add 1 start from state O, till state 4 ([no. of

state]-1), and returns to 0 and step up again.
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Atfribute
Switch style : [JOG+ - Mo, of states : |5 v]
Cydical : [Enable v]
[ user-defined mapping

® JOG-
Decrease the value of the designated register by 1 each time when pressing the button, till the
value equals to 0. A cyclic action can be enabled. As shown below, each time when pressing the
button, the state number will minus 1 start from state 4 ([no. of state]-1), till state 0, and

returns to state 4 and step down again.

Attribute
Switch style : [JDG— v] Mo, of states : [5 vl
Cydical : [Enable v]
[T user-defined mapping
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13.8.1. Overview

13-36

Slider object is used to change the value in a designated word register address by moving the

slide on the screen.

13.8.2. Configuration

e

Click [Object] » [Slider] icon on the toolbar to open a Slider object property dialog box. Set up

the properties, press OK button, and a new Slider object will be created.

General Tab

cMT / cMT X

Slider

[¥|Background

[¥]Dynamic Scale

General |Outiine | Security I Shape|

O

Low lmit:

[T Caarse increment

Write address

Comument :
Attribute
= —
Low/High limit : @ Constant () Address

Eesolution : |

High limit: 100

Cancel

it |

Help

PLC : (Lol HMI

v] Settings...

bddress [LW -

Notification
[ Enahle

Watch address
[ Enahle

0

I__| WE!NTEK

EasyBuilder Pro V6.07.02



Objects

eMT, iE, XE, mTV

13-37

New Slider Object (=22
| General |[Qutline | Security | Shape |
Comment :
Attribute
Dixection: Resolution : 1
Low/High limit : @ Constant ) Address
Low limit: o Highlimit: 100
[7] Cosrse increment
Write address
PLC: [Local HMI [ Settings...
Address : [LW <0 16-bit Unsigned
Notification
[7] Enable ) SetON ©@ Set OFF
[V] Before writing [ After writing
PLC : | Locsl HMI ~ |[ Settines...
Address : [LB >0
Watch address
[7] Enable
PLC : |Local HMI
Address: [Lwy «|0 16-bit Tnsigned
o) (o
Setting Description
Attribute Direction
Select the direction of the slider. (Right, Up, Left, Down)
1] =
right
left ‘ ;,
up down
Resolution

Sets the value change in the word register for each step of the

Slider. For example, if set to 10, the register value changes by 10

points for each increment or decrement on the Slider.

Constant

Sets the range of the Slider. For example, If set [Low limit] to 5, and
[High limit] to 100, the Slider will enter values between 5 and 100.

Address

Set the [Low/High limit] by a designated register, see Example 1.

Coarse increment

Apart from moving the roller to change the value as in [Resolution],
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if this option is selected, the word value will increase / decrease by

the [Increment] value each time the object is touched.

Write address

Click [Setting] to select the [Device], [Address], [Device type],
[System tag], [Index register] of the word device that controls the
Slider object. Users can also set address in [General] tab while
adding a new object.

Notification

If enabled, the state of a designated bit address will be set to ON or
OFF before or after writing.

Click [Setting] to select the [Device], [Address], [Device type],
[System tag], [Index register] of the bit device that controls the
notification settings. Users can also set address in [General] tab
while adding a new object.

[Before writing] / [After writing]

Change the state of a designated bit register before, or after the
slider is slid.

Watch address

When moving the roller, the new value written to the word register

address can be displayed in real time.

Example 1

Set the low or high limit by a designated register. When write address is LW-n, where n is an

arbitrary number, the rule of setting limits is:

Content 16-bit 32-bit 64-bit (cMT / cMT X only)
Address LW-n LW-n LW-n

Low limit LW-n LW-n LW-n

High limit LW-n+1 LW-n+2 LW-n+4

When address is LW-100, the rule of setting limits is:

Content 16-bit 32-bit 64-bit (cMT / cMT X only)
Address LW-100 LW-100 LW-100
Low limit LW-100 LW-100 LW-100
High limit LwW-101 LW-102 LwW-104
Outline Tab

cMT / cMT X Seires
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Slider @
[¥1Background | General | Outline |Se<:urit5-I | Shapel
e e~
#Dyname Scsk e —
3lider button type

il l@a||@

eMT, iE, XE, mTV Seires

[ New Slider Object =
| General | Outline | Security | Shape |
Slider button type

Fame. ] Transparent
Beckgound : [ [v] [ Transpavent
k. ] Transparent

Setting Description
Slider button ) ]
Select slider button type, by default, a picture selected from the
type (cMT / . ) .
Picture Library can be the slider button.
cMT X)
Slider button Four default styles are offered, and the width and color of the
type (eMT, iE, Frame, Background, Slot can be set.
XE, mTV)

Slider button type Slot

’ELo =

1

Frame Background

13.8.3. Combo Setting

cMT / cMT X Series HMI support combo setting for Slider, which allows setting of multiple

related objects at a time. Slider can be set with Background and Dynamic Scale.
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Background
Slider ==
[¥IBackground General
iSider o ]
0 50 100 Styls: (Vertial
Tick Mark | Scale Label
Main scale
Tieks:
Sub scale
e
Setting Description
Margin Specify the space between the background edge and
the objects.
Color/style Customize
ColoxfStyle
© Customize ) Pictore
Round : 10 B

oo [Tt 5] Bl
e [ ek

Select a suitable background pattern and color.

Picture
ColorStyle
(1 Customize (@) Pictre
Picture Library

Use the default picture or choose a picture from

Picture Library.
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Dynamic Scale

Slider (=)
[#Back d General ‘
wsider ——
GDynamic Scale 0 50 100 Stle - (Vertia
‘ ‘ ‘ ‘ ‘ ‘ ‘ Alignment : _—Bomm -
Tick Mark | Scale Label |
Color: I [~]
Main scale
Tl
Sub scale
ek
Setting Description
Style The scale style will follow the Slider.
Alignment The position of the scale bar along the Slider.
Tick Mark Configure the number of tick marks for main and
sub scales, and the color of tick marks.
Scale Label Configure the font, font color, font size and other

attributes of scale label.

In Slider settings if [Address] is selected for
Low/High limit, then Scale Label’s [Dynamic limits]
will be set automatically.

In Slider settings if [Left] is selected for Direction,
then Scale Label’s [Reverse (Left/Right)] will be set
automatically.
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Tick Mark | Scale Label
Use scale label

Font : { Arial v]

Cor: T —

Leftdecimal Pt. : 4 ke Rightdecimal Pt.: 0 —
Dymamic limits
[7]Reverse (LeftRight)

Left: LW-1 Right : LW-0
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13.9. Numeric

13.9.1. Overview

Numeric object can be used to input or display the value of a designated word register.

13.9.2. Configuration

=

Click [Object] » [Numeric] icon on the toolbar to open a Numeric object property dialog box.

Set up the properties, press OK button, and a new Numeric object will be created.

General Tab

cMT, cMT X Series eMT, iE, XE, mTV Series
I Numeric Object's Properties ' 4 New Numeric Object ’
[ Shape | Font | Profile ‘ General lDah Entry I Format lSecun'ty | Shape | Font l
General | DataEntry |  Format Trigger Action Setting | Security | & i
Comment : ot
== [¥] Allow input
[¥] Allow input
* Set value after leaving focus can be set up in general system setting page
) . [V] Read/Writs use different addresses
[7] Read/Write use different addresses
Read
Read . _
Device : (Locel HMI B exem)te) Devie : [l M k3 Excm]cey
Address: [LW -0 I & Adinss: (U /0
— Vi -
Device : [Local ] = Eem|Ce) Device : [Local HMI B exems|tey
Address: [LW -0 : Adws: K o/
Notification Noﬁnﬁnaﬁon
[7] Enable (7] Ensble
OStON  © SetOFF © Beforewiitng @ After writing @SN~ @S0 @ Before wilting: @ Afterwriing
Device : (Local HMI JCEIE Device : [Local HMI L)
Address: [LB B Address:: |LB )0 ‘
Notification on invalid input
7] Enable o SetON ) Set OFF
Device : Logal HMI - &
Address: |LB ~|0 |
o J[ conce J[ teo ] o J[ conced J[ nep ]
Setting Description
Allow input If selected, the input features and relevant settings are enabled.
Read / Write Different addresses can be used to read data and write data.
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use different
address

Read address

Click [Setting] to select the [Device], [Address], [Device type],
[System tag], [Index register] of the word device that displays the
value. Users can also select a tag defined in Address Tag Library.
When [Read/Write use different addresses] option is not selected,
the title of this group box will be “Read/Write address”.

Write address

Select the [Device], [Device type], [Address] of the word device
that system writes to.

Notification

With notification enabled, the state of the designated bit address
can be set on / off, before / after writing.

Notification works differently comparing cMT / cMT X Series with
eMT/iE/XE/mTV Series.

cMT/cMT X Series: Trigger the object to open a keyboard window »
Notification before writing » Enter a value and press ENTER » Start
writing operation » Notification after writing.

eMT/iE/XE/mTV Series:

Trigger the object to open a keyboard window » Enter a value and
press ENTER » Notification before writing » Start writing operation

» Notification after writing.

Notification
on invalid
input

If anillegal value is entered, automatically set the state of a

designated register.
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Data Entry Tab
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cMT, cMT X eMT, iE, XE, mTV Series
Numeric Object's Properties New Numeric Object
{Jﬂ?il;_ Font Profile ‘ ]’Gemml; Data Entry ;‘Fommt ISecun'ty I Shape l Font ‘
l General Data Entry I Format | Trigger Action Setting I Security ‘ E——
Mode : | Touch v
Input order Input order
[] Enable

[¥] Enable

[ Stop sequential input function after input

[7] Stop sequential input function after input

M v

Other options
["] Display lower and vpper limits
["] Display current value

Inputorder: | s [FlGrow Inputorder: 1 4 [Tl Group
Keyboard Keyboard
[] Use a popup keypad [] Use & popup keypad
["] Hide title bar
D System keypad @ Custom keypad [ Restart the keypad if input value is out of range
Window 0. : (50, Keyped 1 - Integer - Window no.: [50. Keypad 1 - Integer -
Animation : [Mone, None] Popup position :
{relative to HMI screen}
[ Hide ti bar E
Popup position
[Re]mive to HMI screen v
Hint : If the keyboard is an USB keyboard, on indirect/divect window, or on the same
window, please don't check "Use a popup keypad".

Hint : If the keyboaxd is an USB keyboard, on indirect/direct window, or on the same
window, please don't check "Use a popup keypad".

[ OK J[ Cancel I[ Help J [ OK H Cancel H Help
Setting Description
Mode Touch

Used when data entry is initiated by touching the screen object.
Bit control

Used when data entry is enabled by turning ON a designated bit,
and entry ends when the bit goes OFF.

Input control

Specify a bit address that enables or ends data entry. The order of
data entry is specified in [Input order] and an external USB
keyboard is needed for data entry. For cMT-SVR, use cMT Viewer’s
keyboard.

Input order

Perform continuous input by setting [Input order] and [Group].
The criterion of searching the next input object:

® The range of [Input order]: 1 ~ 511, range of [Group]: 1 ~ 15.
® |[f [Group] is not selected, its input order is O.

® The system only searches for the objects within the same
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Group.

® The lower number of order is entered before the higher
number of order.

® For multiple objects within the same group and with the same

input order, the object placed in the lower layer is entered first.

¥

4 Click the icon to download the demo project. Please confirm

your internet connection before downloading the demo project.

Keyboard Use a popup keypad
If selected: A pre-designed pop-up keypad can be chosen by
selecting a check box and selecting the relative position on the HMI
screen. When data entry is enabled, the pop-up keypad displays in
the selected position, and closed when data entry ends.
If not selected: When data entry is enabled, the pop-up keypad is
not displayed. Users may:
® (Create a custom design on the same screen window.
® Use a USB keyboard.
System keypad
cMT / cMT X Series model has its own system keypad, select this
checkbox to use the system keypad, or select [Custom keypad] to
set up a customized keypad.
Animation Setting
When using a cMT / cMT X Series model with [Custom keypad]
selected, the transition effect of the keypad window can be

selected.

r See Chapter 13.5 Function Key in this manual for the list of
effects.

Hide title bar

Use a keypad without the title bar.

Popup position

When using a cMT / cMT X Series model with [Custom keypad]
selected, the position where the keypad pops up can be selected.
The position can either be relative to HMI screen or relative to
object.

Relative to HMI screen Relative to object
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B~ = H
il =
s |||l = B B H
E E E B B

Restart the keypad if input value is out of range
When entering data, if the value entered is not within the valid

range, the system will automatically restart the keypad.

Other options
(ForcMT/
cMT X Series)

Display lower and upper limits
If selected, when entering a value, the range

1234
is displayed near the object.

Display previous value Range: 0 to 9999
If selected, when entering a value, the value Current value: 5

before update is displayed near the object.

& To create a keyboard in current window, see “12 Keypad Design and Usage”.

IIl Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.

Example 1

This example demonstrates how to use [Input Order] and [Group] to perform continuous input

in several Numeric objects. After entering data in one object, entry will be passed to the next

input order object which is in the same group.

1. Create three Numeric objects, and set [Input order] to 1, 2, and 3 respectively. Include

the three objects in [Group 1] as shown in the following figure.

LW-0

LW-1

L—| WE!NTEK

Input order

Enable

[ Stop sequential input function after input

Input order : 1 = [¥]Group: 1

Ak

Input order

Enable

[ 5top sequential input function after input

Input order : 2 = Group 1
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Input order
| Enable

Stop sequential input function after input

Input order : 3 = V| Group 1

LW-0 —P W1 LW-2

Orderl Order2 Order3

g S

2.  When finish entering data in the last object, to end data entry of all objects, please select

[Stop sequential input function after input] check box.

Input order
| Enable

I | Stop sequential input function after input I

Input order : 3 = | Group 1
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Format Tab

s

Numeric Object's Properties (23]

Shape | Font I Profile
Generol | DataEntry | Format | Trigeer ActionSetting | Security

Display

Device data format : | 16-bit Unsigned v | [[Mask
Display format
e

Leftof decimal Pt. : 4 = Rightof decimal Pt.: 0 2

Scaling

Method : [Inherpolaﬁon v

[T Dymamic scales
Scaling low : 0 Sceling high : 9999

Limits
() Direct @ Dymamic limits
[7]Use consecutive addresses

Device low
Enable

Device:[LocalHMI '][ el

Address: (LW v|0 \
Device high

Enable

Device : [Local HMI - |E<E

Address: (LW v|0 \

[¥] Use alarm color Lowlimit: [ ] [[|Blink
High timit: [ I | [~ Blink

[ OK ][ Cancel H Help ]

Setting Description

Device Data Set the data format of a designated word register. Options include:
Format BCD, Binary, Unsigned, Signed, HEX, and Float. 16-bit uses 1 word
where 32-bit uses two words.
Mask
If selected, any values entered will be hidden by displaying them as

“uxn

asterisks

Display Numeric
format General Numeric formats.
Customized
Each “*” sign represents each integer digit, and each “#” sign
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represents each fraction digit that will be displayed in the Numeric
object. Float and Double formats are only supported on cMT / cMT
X models.

Apart from “*” signs, extra texts can be entered in the [Format]
field, for example: kg. The available alignment options are: [Left],
[Center], [Right], [Leading zero].

“uskn

The numeric value represented by sign will be displayed from
the highest digit to the lowest in the Numeric object.

Truncated digits

Specify the number of digits to be truncated, from the lowest digit
to the highest.

The number of “*” signs = [Left of decimal Pt.] - [Truncated digits] -

[Right of decimal Pt.].

The number of “#” signs = [Right of decimal Pt.] - [Truncated digits].

Please see the following examples:
Display Format @

Example 1

[Left of decimal Pt.] = 5, [Truncated digits] =0,

50 5 stars ™" must be used.

Use [Format] = "**kg***g" and [Align] = "Leading zero™
=3 If read data is 12345, the result will be "12kg345g™
=>Ifread data is 123, the result will be "00kg123g™

Example 2 : Change [Truncated digits]
[Left of decimal Pt.] = 5, [Truncated digits] = 2,
so 3 stars ™" must be used and last two digits will be truncated.
Use [Format] = "**kg*00g" and [Align] = "Leading zero™
=> If read data is 12345, the result will be "12kg300g™
=>Ifread data is 123, the result will be "00kg 100g™

Example 3 : Use "Left” Align
[Left of decimal Pt.] = 5, [Truncated digits] =0,
s0 5 stars ™" must be used.
Use [Format] = "Total : **kg***g" and [Align] = "Left"
=>Ifread data is 12345, the result wil be "Total : 12kg3450™
=2 Ifread data is 123, the result will be "Total : 123g"

Close
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Display Format @
Example 1 : common case
[Left of decimal Pt.] = 3, [Right of dedimal Pt.] = 3, [Truncated digits] =0,
s0 three ™" symbols and three "#" symbols must be used.
Suppose [Format] = "™***kg###g" and [Align] = "Leading zero™
== If the data is 123.456, the result shown will be "123kg456g"
== If the datais 1.234, the result shown will be "001kg234g™

Example 2 : with truncated digits
[Left of decimal Pt.] = 3, [Right of decimal Pt.] = 3, [Truncated digits] = 4,
so0 two "*" symbols must be used and the last four digits will be truncated.
Suppose [Format] = "**0kg000g" and [Align] = "Leading zero™
=>If the data is 123.456, the result shown will be "120kg000g™
=>If the data is 12.3, the result shown will be "010kg000g"™

Example 3 : using "Left” align
[Left of decimal Pt.] = 4, [Right of decimal Pt.] = 3, [Truncated digits] =0,
so0 four **" symbols and three "% symbols must be used.
Suppose [Format] = "Total : *, ***kg###g" and [Align] = "Left”
== If the data is 1234.567, the result shown will be "Total : 1,234ka567g"
=> If the data is 123.456, the result shown will be “Total : 123kg4569™

Close

“ukn

When leading zero is not used, the text enclosed in two signs
will not show, for example:

[Left of decimal Pt.] =5, [Truncated digits] = 0, and Display Format
is “Total=**kg***g”

If the data read is 255, the result would be: "Total=255g"

If the data read is 1000, the result would be: "Total=1kg000g"
Scientific Notation

Express numerical data using scientific notation; for example,

number 100 is displayed as 1e+2. Scientific notation is not available

for device data formats: BCD, HEX, or Binary.

Number of
digits

Left of decimal Pt.
The number of digits before the decimal point.
Right of decimal Pt.

The number of digits after the decimal point.

Scaling

Interpolation

If this check box is selected, [Engineering low] and [Engineering
high] boxes appear. Values entered in these boxes correspond to
the display range required. The setting also requires [Input low]
and [Input high] in the limits section. See Example 2.

Test: Preview the result of Interpolation. See Example 2.
Dynamic scales: Set the [Engineering low] and [Engineering high]
by a designated register. See Example 4.

Macro subroutine

The value read from or written to the register can be computed by

macro subroutines selected in [Read conversion] and [Write

conversion]. The macro subroutines should be defined in Macro

L—| WE!NTEK
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Function Library. To use this feature, see “13.9.2.1 The rule of using
Macro subroutine”.

Limits This section allows users to apply display limits to the values held in
the input register. The color when the register value is outside
limits can be set.

Direct

Sets the limits by entering values in [Input low] and [Input high]. If
the value entered is outside the limits, the value in the register
cannot be changed.

Dynamic limits

Set the limits by a designated register.

To use consecutive addresses, see Example 5.

On a cMT / cMT X model, the [Use consecutive addresses] option
can be deselected so that users can designate different addresses
to set the high and low limits respectively. When the scaling
method used is interpolation, both high and low limit addresses are
required.

Use alarm Low limit

color When the value in the register is outside the [Low limit], display

digits by the color set.

High limit

When the value in the register is outside the [High limit], display
digits by the color set.

Blink

When the value in the register is outside either limit, the digits
flash.

L—| WE!NTEK
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Limit Tab
cMT, cMT X eMT, iE, XE, mTV Series
Numeric Object's Properties @ f New Numeric Object
\ Security [ Shape | Fomt Profile | [ MLt s
Genersl | DataEntry |  Fommat Limits Trigger Action Setting | | Genem ] Do | Fompat | Limi | Soomity | Soge. ] Font|
© Disct @D — *) Direct © Dymamic limits
7] Uss difforent addresses Use different addresses Usage..

. Device low/high

Device low
Enable Device : [Local HMI 'J[—]‘ﬁ‘

Device : [LucalHMI v] < Address: |[LW v| 0

Address: |[LW v|0
Device high

Enable
Device : (Local HMI B e
Address: |[LW v|0
[ Use elarm color Low linit: () Eeuk (] Use slaam color Lowlmit: [ ] [IBlak
High it : [ ) (Bl Highlinit: [ N || [ Blink
[ oK ] [ Cancel J [ Help J [ oK ] [ Cancel J l Help

Setting Description
Limits This section allows users to apply display limits to the values held in

the input register. The color when the register value is outside
limits can be set.

Direct

Sets the limits by entering values in [Input low] and [Input high]. If
the value entered is outside the limits, the value in the register
cannot be changed.

Dynamic limits

Set the limits by a designated register.

To use consecutive addresses, see Example 5.

On a cMT / cMT X model, with [Use different addresses] option
selected, the high and low limits can be set respectively by
designating different addresses. When the scaling method used is

I__| WE!NTEK

EasyBuilder Pro V6.07.02



Objects 13-54

interpolation, both high and low limit addresses are required.

Use alarm Low limit

color When the value in the register is outside the [Low limit], display
digits by the color set.
High limit
When the value in the register is outside the [High limit], display
digits by the color set.
Blink
When the value in the register is outside either limit, the digits
flash.

Trigger Action Setting (cMT / cMT X)

Actions executed before/after writing can be classified into action groups. The groups are put
in sequence. The actions within the same group are executed at the same time. When all the
actions within the same group are completed, the actions in the next group are then executed.
Compared to the Notification actions selected in General tab, Trigger Action Setting offers
more flexible combination of actions. For more details about these settings, please also see

Action Trigger in Chapter 13.
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New Numeric Object =
| General | Data Entry | Format | Trigger Action Setting | Security | Shape | Font |
Actions before writing
2
Action Group 1 Action Group 2
SetBit Set ON, LB-0) | |
‘—’—b Set Word (Write constant value : 0... —
Delay (50 ms) =
<« | i »
Actions after writing
r”
Action Group 1 Action Group 2 Action Gro
Wait Until (LB-Ois on) [ —&/ Set it (Set ON, LB-1) H o
© || © |
< | m { 3
[ OK ] [ Cancel ] [ Help l
Setting Description
Actions The predefined action groups will be executed once the write

before writing

operation starts, and will not wait for it to be completed.

Actions after
writing

The predefined action groups will be executed when the write

operation is completed.

13.9.2.1. The rule of using Macro Subroutine

® There must be a return value and exactly one parameter.

Examples:
sub char test (shorta) // (Correct)

sub test (char a)
sub char test (char a, char b) // (Incorrect, two parameters.)

[\& WEINTEK

// (Incorrect, no return value.)
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® Use the Macro data type that corresponds to the object’s data format.

The mapping is as follows:

Macro Data Type Numeric Object Data Format

short 16-bit Signed

Int 32-bit Signed

unsigned short 16-bit BCD, 16-bit HEX, 16-bit Binary, 16-bit Unsigned
unsigned int 32-bit BCD, 32-bit HEX, 32-bit Binary, 32-bit Unsigned
float 32-bit Float

long 64-bit Signed (cMT / cMT X only)

unsigned long 64-bit Unsigned (cMT / cMT X only)

double 64-bit Double (cMT / cMT X only)

For example, if the data format of the numeric object is 16-bit Unsigned, only the
corresponding Macro data type: unsigned short, is available.

Examples:

sub char test(unsigned short a) // (Correct)

sub char test(chara) // (Incorrect)

® Supports only the local HMI address.

Examples:
GetData(var, "Local HMI", LB, 0, 1) // (Correct)

GetData(var, "MODBUS RTU", 0x, 0, 1) // (Incorrect)

® The following system defined functions are unable to be invoked:

ASYNC_TRIG_MACRO, SYNC_TRIG_MACRO, DELAY, FindDataSamplingDate,
FindDataSamplingindex, FindEventLogDate, FindEventLogindex, INPORT, INPORT2, OUTPORT,
PURGE, TRACE

® The following statements are not supported:
For-Next, While-Wend

Example 2
If [Interpolation] is selected, the scaling equation is as the following:
If A indicates the original data and B indicates the displayed data:
B = [Engineering low] + (A - [PLC low]) x Ratio
where, Ratio = ([Engineering high] - [Engineering low]) / ([PLC high] - [PLC low])
As shown below, the original data is 15, after conversion, 40 will be displayed.
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Braling

Method - | Interpolation v

Test...

[ Dvaimde seades

Engineering low ;10

«= Preview comversion resnlt

Engineering high : 50

Ltz
@) Durect ) D limidts
PLC law : ) PLC high: 20
Input low ;| 100 Input high : | 50

13-57

Click [Test] button to preview the result of Interpolation. Enter a value in [PLC] field as shown in

the following figure, for example, enter value 15, and the result, which is 40, will be displayed.

Conversion Test @
Mumber of digits
Left of decimal Pt. : 4 = Right of decimal Pt. : =
Engineering high Engineering low
HMI Engineering low PLC PLC low &l 10
40 = |10 +{ 15 - |o 1x
20 0
PLC high PLC low
o 15
: ]
PLC
Apply ] [ 0K I [ Cancel
Example 3

If the numeric format selected is not Float and decimal point is used, the decimal place of the

converted result will not be adjusted automatically, please adjust [Engineering high] to
correctly place the decimal point of the result gained in [Interpolation] mode. Please see the

illustration below.
1. Create two Numeric objects, set [Right of decimal Pt.] to 1 and select [Interpolation]

method for one of the objects as shown in the following figure.

L—| WE!NTEK
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Mew Mumeric Object

Data Entry | Numeric Format | security | shape | Font

g

Display
Data format :
Mumber of digits

Scaling

15-bit Unsigned -

Left of decimal Pt. : 4 =

[[Mask

Right of dedmal Pt. :

Method : | Interpolation

] Dynamic scales

Engineering low : 0

Limits
(@) Direct () Dynamic limits
PLClow: g
Inputlow : | o

2. Enter value “123”, the object set to [Interpolation] displays “246.0”

Engineering high :

PLC high: 100

Input high : | 200

Original Value

Converted Value

3. To move the decimal point one place to the left, adjust [Engineering high] as shown in the

following figure.

1 -

200

instead of “24.6”.

123

246.0

Mew Numeric Object

Data Entry | Mumeric Format | security | shape | Font

&

Lisplay
Data format :
MNumber of digits

Scaling

1&6-bit Unsigned -

Left of decimal Pt. : 4 =

[[Mask

Right of decimal Pt. :

Method : | Interpolation

[ bynamic scales

Engineering low : 0

Engineering high :

Original Value

Converted Value

Example 4

If [Interpolation] is selected, set the [Engineering low] and [Engineering high] by a designated
register. When Dynamic Address is LW-n, where n is an arbitrary number, the rule of setting

[Engineering low] and [Engineering high] is:

I__| WE!NTEK
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Content 16-bit 32-bit 64-bit (cMT / cMT X only)
Dynamic address LW-n LW-n LW-n
Engineering low LW-n LW-n LW-n
Engineering high LW-n+1 LW-n+2 LW-n+4
When address is LW-100, the rule of setting limits is:
Content 16-bit 32-bit 64-bit (cMT / cMT X only)
Dynamic address LW-100 LW-100 LW-100
Engineering low LW-100 LW-100 LW-100
Engineering high LW-101 LW-102 LW-104
Example 5

Set the limits by a designated register. When [Address] is LW-n and [Use consecutive addresses]

is selected, the rule of setting limits is:

Content 16-bit 32-bit 64-bit (cMT / cMT X only)
Address LW-n LW-n LW-n

Low limit LW-n LW-n LW-n

High limit LW-n+1 LW-n+2 LW-n+4

When address is LW-100, the rule of setting limits is:

Content 16-bit 32-bit 64-bit (cMT / cMT X only)
Address LW-100 LW-100 LW-100

Low limit LW-100 LW-100 LW-100

High limit LW-101 LW-102 LW-104

Example 6

The following demonstrates how to use [Macro subroutine] for scaling when configuring

Numeric object.

The following two macros are used, one for [Read conversion] and one for [Write conversion].

Read Conversion

Write Conversion

sub short read(short a)
short b
b=a+10

return b

end sub

sub short write(short a)
short b
b=a-10

return b

end sub

1. Create two Numeric objects: NE_O and NE_1 and use the same control address. Select

[Macro subroutine] for NE_1.

[\& WEINTEK

NE_O

(Without Macro conversion)

[

NE_1

(With Macro conversion)

=
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displays 70.

Mumeric Object's Properties

| Genewol | Dato.Entry | Format | Secusity | Shope | Font | Profile |

Displsyy

Mumber of digits
Left of decimal Pt. © 4

Display format
[ Enable

Sraling

Dievice data format © | 16-hit Signed | [[Mask

Method : [Macro subrouting

Fead conversion : [read

Write converson @ [write

NE_O

(Without Macro conversion)

0

Read Conversion

Enter 0 in NE_O then NE_1 will execute [Read conversion]. The value gained will be 10.

NE_1

{With Macro conversion)

10

Write Conversion

sub short read(short a)
short b
b=a+10

return b

end sub

sub short write(short a)
short b
b=a-10

return b

end sub

NE_O

(Without Macro conversion)

70

Read Conversion

Enter 80 in NE_1, [Write conversion] is executed and the value gained will be 70. NE_O

NE_1

(With Macro conversion)

80

Write Conversion

sub short read(short a)
short b
b=a+10

return b

end sub

sub short write(short a)
short b
b=a-10

return b

end sub
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If executing [Read conversion] and [Write conversion] by the same numeric object, the

value entered in this object is computed by the Macro subroutine of [Write conversion]

first, and then the result is computed by the Macro subroutine of [Read conversion]. In

Example 5, if the subroutine of [Write conversion] is set to b=a-20, then entering 80 in

NE_1 will get 60 after [Write conversion] and then the object displays 70 after [Read

conversion].

Security Tab
cMT, cMT X eMT, iE, XE, mTV Series
Numeric Object's Properties [#35] | Numeric Object's Properties
L*erg@_lilili)gg Entry l Format I Limits l Trigger Action Setting Lanial ] Data Entry Format I Limits I Trigger Action Setting ‘
Security | Shape | Font I Profile Security | Font I Profile |
Safety control Safety control
V| Display confirmation request Max. waiting time (sec) : 10 [¥] Display confirmation request Max. waiting time {sec) : 10
Enable/Disable Enable/Disable
[V] Use register statusivalue [V] Use register statusivalue
@ Bit ©) Word @ Bit Word
Device : (Local HMI B e Device : [Lacal HMI B e
Address: |LB |0 Address: |LB v|0
Ensble if bitis Ensble if bitis
[¥] Use control token [¥] Use control token
Controltoken : [1: Control Token - Local Only_~ | [ Token Library.. Control token : [1: Control Token - Local Only v | [ Token Library...
Enable if token is : | Acquired v Enable if token is : | Acquired v
* For environment of using multiple clients M T Viewers). * For environment of using multiple clients (M T Viewers).
Action : [Do nothing when disabled v ] Action : lDo nothing when disabled v ]
User restriction User restriction
Object class : [Nom v J Object class : [None v J
*1f the user tries to operate on an object without anthorization, LB-12056 will be set to *If the vser tries to operate on an object without authorization, LB-12056 will be set to
ON. ON.
Sound Sound
V| Enable Sound Library...| Beep [¥] Enable Sound Library...| Beep
Play Play
[ OK J [ Cancel ] i Help [ OK ] { Cancel ] I Help.
Setting Description

Safety control

Displays a confirmation request window before executing a command.

Enable/Disable

Use register status / value

With this option selected, whether an object is operable
depends on whether the specified condition occurs in the
designated address.

Use control token

With this option selected, whether an object is operable
depends on whether a control token is acquired or
unacquired.
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Action modes:
Do nothing when disabled
The object is not operable, and its status remains
unchanged when the specified condition does not occur in
the designated address.
Hide when disabled
The object is hidden when the specified condition does not
occur in the designated address.
Grayed label when disabled
The value in the object turns gray when the specified
condition does not occur in the designated address.

User Set the security class of the object to be operated by an

restriction authorized user.

Sound When enabled, the selected sound will be played when the
object is touched.

Font Tab
Mew Mumeric Object @
|Genera\ | Data Entry | Mumeric Format | Security IShapel Font |
Attribute
Font: Arial -
Cobr : IE— | Sie
Content
Setting Description
Color When the value is within the limits, display digits using color set in

I__| WE!NTEK
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this tab.
Align Left: Align the number to the left.
Center: Align the number to the center.
Right: Align the number to the right.
Leading zero: The number is preceded with leading zeros when the

number of digits is less than that set.

Left
Center
Right
Leading zero

Size Set the font size.
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13.10. ASCII

13.10.1. Overview

ASCII object can be used to input or display ASCIl or UNICODE characters held in designated

word registers.

13.10.2. Configuration

==

Click [Object] » [ASCII] icon on the toolbar to open an ASCII object property dialog box. Set up

the properties, press OK button, and a new ASCII object will be created.

General Tab
cMT, cMT X eMT, iE, XE, mTV Series
New ASCI Object New ASCI Object
Genersl [‘DaﬁaEntry‘] Secm’t}: |§hape ‘IVFont ‘l"fﬁggex Ach‘onSetﬁng“ General ‘Security I Shape | Font ‘
Comment : Comment :
[¥] Allow input [7] Allow input
* et value after leaving focus can be st up in general system setting page
7] Multi-line display [7] Multi-line display Vertical alignment :
* ASCII value of line feed (LF) chavacter : 10 (Ox4) * ASCII value of line feed (LF) character : 10 (Ox4)
[ Mask [ Reverse highllow byte [ Mask [ Reverse highlow byte
Data format Data format
Bt Brntn
Read/Write Read
Device : (Local HMI & Device : Local HMI ¥ EE S
Address: |[LW ~v|0 1 word(s) Address: [LW ~|0 1 word (s)
Notification
[T Enable
L OK J [ Cancel ] [ Help ] [ OK ] I Cancel ] [ Help
Setting Description
Allow input If selected, the input features and relevant settings are enabled.
Multi-line If selected, the ASCII object can display multi-lined text. If a line
display

feed character LF (OxA) is used in the string, a newline will be

created.
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Vertical When [Multi-line display] is enabled, the method to vertically align
alignment . .
multiple lines of text can be selected.
Mask If selected, any values entered will be masked by asterisks (*)..
Reverse Normally an ASCII code is displayed in “high byte”, “low byte”
high/low byte order. Reverse selection makes the system display ASCII characters

in “low byte”, “high byte” order.

ABCD BADC

The left object is in normal form, and
another is high/low bvte reversed.

Data format

Select encoding from UTF-8 (default), Unicode, or Latin-1.

Diata format

el —

Read address

Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the word device that displays
characters. Users can select a defined address tag from Address Tag

Library, or set address in [General] tab while adding a new object.

Address @

PLC name : [L°ﬁ| HMI 'I

Device type : [LW v]

Address: 0 [ system tag
Address format : DDDDD [range : 0 ~ 10799]
[] Index register
Mo. of word : 1
Tag Library... OK ] [ Cancel

No. of words

Select the maximum number of words to be displayed.
cMT / cMT X Series: max. 160 words

eMT/XE/mTV/iP: max. 64 words

Notification

With notification enabled, the state of the designated bit address
can be set on / off, before / after writing.

Notification works differently comparing cMT/cMT X Series with
eMT/IiE/XE/mTV Series.

cMT/cMT X Series: Trigger the object to open a keyboard window »
Notification before writing » Enter a value and press ENTER » Start
writing operation » Notification after writing.

eMT/IiE/XE/mTV Series:

Trigger the object to open a keyboard window » Enter a value and
press ENTER » Notification before writing » Start writing operation
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» Notification after writing.

0 Note

B A UNICODE character uses 1 word, and an ASClI character uses 1 byte. Therefore 1 word
can be used as 1 UNICODE character or 2 ASCII characters. (1 word equals to 2 bytes)

Font Tab

cMT, cMT X eMT, iE, XE, mTV Series

ASCI Object's Properties [E55] | NewAscI Object

| General | Data Entry | Security | Shape | Font | Trigger Action Setting | Profile |

| General | Security | Shape ‘ Font | Data Entry|

Content Content

AA AA

[7] Preview with actual font size [] Preview with actual font size

Text area position

Horonsl Vorsal

*Please use "Droid Sans Fallback" font if the content of text is determined in ron time. (This
font will increase HMI startup time.)

Attribute Attribute
Font: Droid Sans Fallback v Font: Droid Sans Fallback v
Cobr Cobr
Text alignment Text alignment
Horizontal : | Center v Horizontal : | Centex A

Text area position

*Please use "Droid Sans Fallback" font if the content of text is determined in ron time. (This
font will increass HMI startup time.)

(o J[ concd ][ reo | (o J[ conea J[ 1w ]
Setting Description
Attribute The font, size, color, and alignment can be set.
Text Multiline text is aligned within the label outline. The method to
Alignment align multiple lines of text can be selected.
Text area Multiline text is aligned within the object outline.
position The label outline is highlighted by red dotted line and the object

outline is highlighted by blue dotted line. Please note that this
feature is ineffective when [Multi-line display] is enabled in General
tab.

When object is selected. When text is selected.

n ADAA ] sAAAA=
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Trigger Action Setting (cMT / cMT X)

Actions executed before/after writing can be classified into action gro

13-67

ups. The groups are put

in sequence. The actions within the same group are executed at the same time. When all the

actions within the same group are completed, the actions in the next

group are then executed.

Compared to the Notification actions selected in General tab, Trigger Action Setting offers

more flexible combination of actions. For more details about these settings, please also see

Action Trigger in Chapter 13.

ASCII Object's Properties

lGenemllDataEnh’ylSecuﬂtylShnpe l Font J Trigger Action Setting | Profile |

=l

Actions before writing
2
Action Group 1 Action Group 2
Set Bit (Set ON, LB-0)
]—b Set Word (Write constant value : 0...
Delay (50 ms) t o
<l . '
Actions after writing
o2
Action Group 1 Action Group 2 Action Gro

Wait Until (LB-Oison) |—® Set Bit (Set ON, LB-1) > o

© ©
< m »
[ OK ] [ Cancel ] [ Help

Setting Description
Actions The predefined action groups will be executed once the write
before writing operation starts, and will not wait for it to be completed.
Actions after The predefined action groups will be executed when the write
writing operation is completed.
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13.11. Indirect Window

13.11.1. Overview

Indirect Window object opens or closes a pop-up window assigned by a designated word
register. There are two ways to use Indirect Window object: The first is to use the profile of
Indirect Window object, and let the pop-up window be resized and displayed in the defined
profile; the second is to automatically resize the window according to the size of the pop-up

window to be displayed. To close the pop-up window, assign 0 to the designated word register.

The difference between Direct Window and Indirect Window is that Direct Window is
controlled by a bit register, while Indirect Window is controlled by a word register.

13.11.2. Configuration

Click [Object] » [Embed Window] » [Indirect Window] icon on the toolbar to open the object

13-68

property dialog box. Set up the properties, press OK button, and a new Indirect Window object

will be created.

General Tab
cMT / cMT X Series eMT, iE, XE, mTV Series
New Indirect Window Object (=] New Indirect Window Object (=]
Genersl | Bosion | Sty Ounarl, [ien]
Comment : Comment :
Attribute Read address
Style: |Embedded in parent window - Device : (Local HMI v [ Settings...
Address: [LW ~|0 16-bit Unsigned
Read Attribute
Device : [Local HMI 7)) &) Style : | With title bar >
Address: LW v|0 16-bit Unsigned
Animation
Effect Duration Direction
Start : | Float v 100 o ms From Left v
End: Ry v| 100 & ms [ToLeft -]
o ) [¥] Use window no. offset Offset: (.10 v
V] Use window no. offset Offset: |10 v
[ OK ] [ Cancel ] | Help OK J [ Cancel ] | Help
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Setting Description
Style This setting is available only on cMT / cMT X Series. When a base

window contains an underlay window, this setting determines the
display style of an Indirect Window placed in the underlay window.
Please see Example 2 below.

Embedded in parent window

The Indirect Window is displayed in its parent window. When an
Indirect Window is placed in an underlay window, the Indirect
Window is displayed in the underlay window when it is called in the
base window.

Popup window

The Indirect Window is displayed in the base window. When an
Indirect Window is placed in an underlay window, the Indirect
Window is displayed in the base window when it is called in the
base window.

Title Bar Setting

When [Enable title bar] is selected, a field shows for entering the

caption in the title bar. The caption can be selected from Label Tag

Library.

Attribute

Style - [Popup window ']
Tifle Bar Sefting... |

Resd| Popup Window Property
Title setting
[¥] Enable title bar

Andny
[¥] use label library Label_1: text =

.

Read address

Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the word device that controls the
pop-up window. Users can also set address in [General] tab while

adding a new object.

Attribute

Style
Set the display style of the pop-up window. There are two styles:
® No title bar
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The pop-up window has no title bar and cannot be dragged.

® With title bar

The pop-up window has a title bar that can be dragged to move the

window.
Animation Effect
(cMT / cMT X Different effects may be used for Start (window appears) and End
Series) (window disappears).
Effect Name Transition
Fade
Fly E
Float
Wipe
. :
Circle 3 -
[ 4 l b
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Clock

Zoom J l}

Turn 2
" 4 l &

Push

Duration

Specifies how many milliseconds (ms) a transition effect takes to

complete.
Direction
The direction of the transition.

Use window

no. offset

Sets the offset of the window number for selecting the pop-up

window. The window number of the pop-up window is calculated

by the value in the word register added to the offset. For example,

assume the value in the register is 20 and offset is 5, the pop-up

window number will be 25.

[\& WEINTEK
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Position

cMT / cMT X Series

eMT, iE, XE, mTV Series

New Indirect Window Object

| General | Position | Secwsity |

New Indirect Window Object

i' General 1 Position ‘

[¥] Auto. adjust window size

[¥] Dymamic position

{relative to object display region} )

[¥] Auto. adjust window size

Alignment: Alignment:

O ) °
{relative to object display region}

13-72

Device : [Local HMI | Settings... |

Address: LW v |0

¥ Address: LW-0

Y Address: LW-1
[¥] Enable shift window animation: Duration: 1

4 I 13 < I 13
L OK I [ Cancel ] ‘ Help OK l [ Cancel ] [ Help

Setting Description

Auto. adjust
window size

Automatically resizes the Indirect Window and align the pop-up
window to the preset region.

Alignment

Sets a reference point of the pop-up window from one of the five
positions on the screen; for example, if the lower-right region is
selected, the lower-right corner of the pop-up window is aligned to

the lower-right region of the Indirect Window. See Example 1.

Dynamic With this option selected, the position of the window on the screen
position can be changed dynamically by the values in the designated
address.
Enable shift window animation
With this option selected, the window changes position with
transition effect.
Example 1

Here is an example of using Indirect Window. The setting is shown in the following figure, set

the address to LW-0 which assigns the window number. Create window no. 11 and 12 first.

1. Create an Indirect Window object, set address to LW-0, and select [Auto. adjust window
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size].
2. Select the region where the window is to be displayed.

New Indirect Window Object

[ General | Position |

(V] Auto. adjust window size

Alignment:
{relative to object display region}

3. Enter value 11 in LW-0, the pop-up window displayed is window no. 11.
4. Enter value 12 in LW-0, the pop-up window displayed is window no. 12.
5. Enter value 0 in LW-0, the pop-up window is closed.

Popup Window No. 11| Popup Window No. 12|

<- The frame of Indirect Window <- The frame of Indirect Window

Window11

To close the pop-up window, apart from entering 0 in the designated word register, another

way is to place a Function Key object in the pop-up window, and set the key to [Close window].

Example 2

Here is an example showing the difference between these two styles: [Embedded in parent
window] and [Popup window]. The style setting determines how an Indirect Window placed in
an underlay window is displayed when it is called in the base window.

1. Addtwo base windows: Window no. 10 and Window no. 11. Add an underlay window in

Window no. 10 and set Window no. 11 as the underlay window.

Window Settings

MName :  WINDOW_010
Window no. : | 1p

Size
Width : 800 Height: 430

Background
) —
Transparency : D 0%

* [Transparency] is used only on popup, directfindirect and keyboard windows.

Underlay windaw

I Bottom : (11, window_011 | -

2. Create several objects in Window no. 10.
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Wndow 10

3.  In Window no. 11 create an Indirect Window object and a Numeric Input object. Set both

read addresses to LW-0.

WD (L0

wndow T -

4. By entering a window number in the Numeric Input object, the Indirect Window is

displayed according to the selected style.

Embedded in parent window
., cMT Viewer ( Simulation ) "

Window 10

e el W - - :

@0 ux
TREEE
TR
TR
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Popup window
™ eMT Viewer ( Simulation ) EI@

Window 10

mMacl o MmN o0 )
Window 11 ( | 50

@ Note

B For eMT/iE/XE/mTV models, a screen can display up to 24 pop-up windows simultaneous
including System Message Window, Direct Window and Indirect Window. For cMT / cMT X
Series, the number of pop-up windows is not limited.

B The system does not allow opening the same window with two Direct (or Indirect)
windows in one base window.

B |f the pop up window has monopoly property enabled, then when the window pops up,
all background windows may not be operated until the monopolizing window has been
closed.

E Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.
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13.12. Direct Window

13.12.1. Overview

Direct Window object opens or closes a pop-up window assigned by a designated bit register.
When the state of the bit register changes, the pop-up window appears at the predefined
location. The display area for the pop-up window is limited by the size of predefined location.
Returning the state of the bit register closes the pop-up window. The difference between
Direct Window and Indirect Window is that Direct Window is controlled by a bit register, while

Indirect Window is controlled by a word register.

13.12.2. Configuration

is]

Click [Object] » [Embed Window] » [Direct Window] icon on the toolbar to open a Direct
Window object property dialog box. Set up the properties, press OK button, and a new Direct

Window object will be created.

General Tab
cMT / cMT X Series eMT, iE, XE, mTV Series
New Direct Window Object (== New Direct Window Object [=2a)
General | Position | Security Generel | Position |
Comment : Comment :
Attribute Attribute
Trigzer: [QN = Trigger : [ON .,}
Window No. : [Z.Monim Mode % Sl {N° fitle bar '}
Style : [Embeddedinpaxent window v Window No. : [3. Fast Selection VJ
Read address
Read Device : [Local HMI [ Settings.. |
Device : ILocalHMI ,][ o ]@ Address: |LB v|0
Address: |LB v|0
Animation
Effect Duration Direction
Start 100 & ms  [FromLeft v
End : [split v 100 &) ms[Vertical Out -
e—
[= | = |
[l,lo.o‘ lileeos |
[ OK ] I Cancel ] ‘ Help [ OK ] [ Cancel J [ Help J
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Objects
Setting Description
Style This setting is available only on cMT / cMT X Series. When a base

window contains an underlay window, this setting determines the
display style of a Direct Window placed in the underlay window.
Please see Example 2 in Chapter13.11 in this manual.

Embedded in parent window

The Direct Window is displayed in its parent window. When a
Direct Window is placed in an underlay window, the Direct Window
is displayed in the underlay window when it is called in the base
window.

Popup window

The Direct Window is displayed in the base window. When a Direct
Window is placed in an underlay window, the Direct Window is
displayed in the base window when it is called in the base window.
Title Bar Setting

When [Enable title bar] is selected, a field shows for entering the
caption in the title bar. The caption can be selected from Label Tag

Library.
Attribute
Trigeer: [QN =

Window No. (3. Monitor Mode z)

Style [Popup window v]

[ Titl BorSetting.. |

Read| Popup Window Property @

Title setting

[¥] Enable title bar
Anim
text

[¥] use label library [Label_l : text ']

Read address

Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the bit device that controls the
pop-up window. Users can also set address in [General] tab while

adding a new object.

Attribute

Style
Set the display style of the pop-up window. There are two styles:
® No title bar

The pop-up window has no title bar and cannot be dragged.
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® With title bar
The pop-up window has a title bar that can be dragged to move the
window.

Window no.

Set the pop-up window number.

Animation Effect
(cMT / cMT X Different effects may be used for Start (window appears) and End
Series) (window disappears).
Effect Name Transition
Fade
=
Fly Z
Float
Wipe
. :
Circle 3 -
[ 4 l b
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Clock

Zoom

Turn 2

Push

Duration

Specifies how many milliseconds (ms) a transition effect takes to
complete.

Direction

The direction of the transition.

Position
cMT / cMT X Series eMT, iE, XE, mTV Series
 New Direct Window Object &= | | NewDirect Window Object =
General | Position | Security General | Position
Auto. adjust window size Auto. adjust window size
) ©
Alignment: . Alignment: >
{relative to object display region} < B {relative to object display region} | !
Dymamic position
Device : [Local HMI v [ Settings...
Address: (LW ¥o [
¥ Address: LW-0
Y Address: LW-1
Enable shift window animation: Duration: 1 ‘{
< m ] » < m ] »
[ oc J[ cancel J[ rep | ok J[ cocel J[ o ]
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Setting
Auto. adjust

window size

Dynamic
position

Example 1

13-80

Description

Automatically resizes the Direct Window and align the pop-up
window to the preset region.

Alignment

Sets a reference point of the pop-up window from one of the five
positions on the screen; for example, if the lower-right region is
selected, the lower-right corner of the pop-up window is aligned to
the lower-right region of the Direct Window. See Example 1.

With this option selected, the position of the window on the screen
can be changed dynamically by the values in the designated
address.

Enable shift window animation

With this option selected, the window changes position with
transition effect.

Create window no. 11 which can be controlled by a Toggle Switch with address LB-0.

1. Create a Direct Window object and set read address to LB-0.

2. Inthis example, the reference point for alignment is set to the lower-right region.

New Direct Window Object @

General | Position

V| Auto. adjust window size

)
Alignment:
{relative to object display region}

3.  When LB-0’s state is ON, window no. 11 will show.

Con

Fast Sel

4. When LB-0’s state is OFF, window no. 11 will be hidden.
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Fast Sel

@ Note

B For eMT/iE/XE/mTV models, a screen can display up to 24 pop-up windows simultaneous
including System Message Window, Direct Window and Indirect Window. For cMT / cMT X
Series, the number of pop-up windows is not limited.

B The system does not allow opening the same window with two Direct (or Indirect) Windows
in one base window.

B |f the pop up window has monopoly property enabled, then when the window pops up, all
background windows may not be operated until the monopolizing window has been closed.

D Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.
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13.13. Moving / Rotating Shape

13.13.1. Overview

Moving / Rotating Shape is an object that changes its state, moves, and/or rotates according to
the user-defined parameters. The state, moving distance, and rotation direction/angle are

determined by values in consecutive registers.

13.13.2. Configuration

i

Click [Object] » [Animation] » [Moving / Rotating Shape] icon on the toolbar to create the
object, set up the properties, press OK button, and a new Moving / Rotating Shape object will

be created.

I__| WE!NTEK EasyBuilder Pro V6.07.02



13-83

Objects
General Tab
New Moving / Rotating Shape Object (3]
General | Security | Shape | Label |
Comment :
Device : (Local HMI -
Read address
Device : |Local HMI :
Addes: LW ~]0  [16-bit Unsigned
Usage...
Attribute
Position
Mode : [X&,Ya:ds -
Rotate
Mode : [Rohﬁe v
Direction : @ Clockwise () Counterclockuwise
Limit address
[¥] Limit from register
Device : [Local HMI -
R — et
Usage...
Coc J o ) ]
Setting Description

Read address

Click [Setting] to configure the [Device], [Device type], [Address],
[System tag], or [Index register] of the word devices that control
the display of object’s state and moving distance. Users can also set
the address in [General] tab while adding a new object.

Attribute

Select the object’s movement mode and range. See “13.13.2.1
[llustration of Modes” in the following part.

Display ratio

The size of shape in different states can be set individually as

shown in the following figure.
Ratio : 1 Ratie : 12 Ratie : 1.4 Ratie : 16

£ I E7E T

Rotate

Select Clockwise or Counterclockwise for Direction and define the

[\& WEINTEK
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angle range (unit in degree) within which the object may rotate.
The allowable range is 0~360 degrees, and the Max. angle should
be greater than Min. angle.

For more information please see “13.13.2.2 Rotation Modes”.

Limit address The object’s moving range can be set by adjusting the data in the
designated register, see Example 1.

Example 1
Supposed that the object’s moving range is limited by register LW-n, the addresses in the
following table are used to limit the moving / rotating range.

Data format 16-bit 32-bit 64-bit (cMT / cMT X only)
Position - [Min. X] address LW-n LW-n LW-n
Position - [Max. X] address LW-n+1 LW-n+2 LW-n+4
Position - [Min. Y] address LW-n+2 LW-n+4 LW-n+8
Position - [Max. Y] address LW-n+3 LW-n+6 LW-n+12
Rotate — Input Low LW-n+4 LW-n+8 LW-n+16
Rotate — Input High LW-n+5 LW-n+10 LW-n+20
Rotate — Scaling Low LW-n+6 LW-n+12 LW-n+24
Rotate — Scaling High LW-n+7 LW-n+14 LW-n+28
13.13.2.1. lllustration of Modes

Available modes are: (Assume Read Address is LW-n)

® Xaxisonly

The object is only allowed to move along the X-axis. The moving distance ranges from [Min. X]
to [Max. X].

Attribute
Mode : |X axis only v
No. of states : g -
Min. X: 0 Max. ¥ : 600
Data format 16-bit 32-bit 64-bit (cMT / cMT X only)
Object state LW-n LW-n LW-n
Moving distance on X-axis LW-n+1 LW-n+2 LW-n+4

® Yaxisonly
The object is only allowed to move along the Y-axis. The moving distance ranges from [Min. Y]
to [Max. Y].
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Attribute
Mode : ['\" axiz only -
Mo. of states : [3 -
Min. ¥ : 0 Max. ¥ : 480
Data format 16-bit 32-bit 64-bit (cMT / cMT X only)
Object state LW-n LW-n LW-n
Moving distance on Y-axis LW-n+1 LW-n+2 LW-n+4

® X&Yaxis
The object is allowed to move along the X-axis and Y-axis. The moving range in Xand Y
directions is defined by [Min. X], [Max. X] and [Min. Y], [Max. Y] respectively.

Attribute
Mode : X &Y axis -|
Mo, of states : [3 v]

Min.X: 0 Max. X @ &00

Min.Y: 0 Max. Y : 480
Data format 16-bit 32-bit 64-bit (cMT / cMT X only)
Object state LW-n LW-n LW-n
Moving distance on X-axis LW-n+1 LW-n+2 LW-n+4
Moving distance on Y-axis LW-n+2 LW-n+4 LW-n+8

For example, if the object’s read address is LW-100 and the data format is [16-bit Unsigned],
LW-100 is used to control the object’s state, LW-101 is used to control the object’s moving
distance on the X-axis, and LW-102 is used to control the object’s moving distance on the Y-axis.
The following figure shows that the object’s read address is LW-100 and initial position is (100,
50). To move the object to the position (160,180) and change its state to State 2, assign 2 to
LW-100, 160-100 = 60 to LW-101, 180-50 = 130 to [LW102].

(100, 50) Lwi100 Lwio1 Lwioz

Emm L (o I |

State X Offset Y Offset

I Lwio0o Lwi1o1 Lwioz

""""""""" 2 | 60 130 |
State X Offset Y Offset

(100. 50)

(160, 180)_nea postion
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® Xaxis w/ scaling

The object moves in X-axis only with scaling. Suppose that the value of the designated register
is DATA, the system uses the following equation to calculate the moving distance on the X-axis.
[Scaling high]-[Scaling low]

Displ =(Data-[Input low])x
isplacement=(Data-[Input low]) [Input high]-[Input low]

Data format 16-bit 32-bit 64-bit (cMT / cMT X only)
Object state LW-n LW-n LW-n
Moving distance on X-axis LW-n+1 LW-n+2 LW-n+4

® Y axis w/ scaling

The object is for Y axis movement with scale, and the equation to calculate the moving
distance on the Y-axis is the same as the one in [X axis w/ scaling].

Data format 16-bit 32-bit 64-bit (cMT / cMT X only)
Object state LW-n LW-n LW-n
Moving distance on Y-axis LW-n+1 LW-n+2 LW-n+4

® X axis w/ reverse scaling

This works in the way as [X axis w/ scaling], but the moving direction is in reverse.
® Y axis w/ reverse scaling

This works in the way as [Y axis w/ scaling], but the moving direction is in reverse.

13.13.2.2. Rotation Modes

The addresses that control the moving / rotating shape are consecutive addresses starting
from Read Address (LW-n), and they may vary depending on the selected mode. Please click

[Usage...] to open the window that shows the control addresses relating to rotation
parameters.

-

Maowing / Rotating Shape Object's Properties [=]
General | Becusity | Shape | Label | Fmiile |
Conument :
Device : | Loeal HMI -]
Fead address
Device : | Local HMI 2
Address: [LW ~| 100 Bé-bit Signed
Uaage...
Address Usage
Control

Chject state :LW-100
Moving distance on X axis :Lw-104
Rotating angle :LwW-108
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® Rotate
Select rotating direction from clockwise or counterclockwise and set the Min. and Max.
angle range.
When rotation animation is enabled, two modes can be selected: Default and Shortest.
e.g. When the angle measure is set to clockwise and the rotating angle is changed from 10
degrees to 350 degrees, these two modes give different results:
Default: rotates 340 degrees clockwise (linear interpolation between the two numbers)
Shortest: rotates 20 degrees counterclockwise (in the direction that produces the shortest

animation path)

Rotate
Mode : [Rome 'I
Angle Measure : @ Clockwise Counterclockwise
Animation : @ Default ) Shortest
Min. angle : 0 Max. angle : 359

® Rotate w/ scaling
Select rotating direction from clockwise or counterclockwise. The angle of rotation is
calculated by the formula as shown below.
[Scaling high]-[Scaling low]
[Input high]-[Input low]

Angle of Rotation =(Data-[Input low])x

® Rotate w/ reverse scaling
Similar to [Rotate w/ scaling] but reverses the object from clockwise to counterclockwise

and vice versa.
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13.14. Animation

13.14.1. Overview

Animation object is defined by a pre-defined point set and states. Animation object will then
move to a given point in a given state defined by designated registers. The object state and
position depend on current value of two consecutive registers. The first register controls the

state of the object and the second register controls the position along the predefined path.

13.14.2. Configuration

—

né

Click [Object] » [Animation] » [Animation] icon on the toolbar. First, create the pre-defined
path. Move the mouse to each moving position, and click the left button to define positions
one by one. When it is done, right click on the screen, set up the properties, press OK button,
and a new Animation object will be created.

AN D position o &

positian i $

gasitiand 8

position 3 #
pOsition £ %

To change the object’s attributes, double click on the object to open Animation Object’s
Properties dialog box.
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Objects
General Tab
Animation Object's Properties @
General | shape |Label | Profile
Comment :
Attribute
Position & @) Controlled by register (7 Based upon time interval
Read address
PLC name : [ Local HMI v [ Setting...
Address : o] 16-bit Unsigned
—
Setting Description
Attribute No. of states

Configure the number of states for this object.

Controlled by register

Use the designated registers to control the object’s state and
position. See Example 1.

Based upon time interval

The object’s state and position will change from time to time. [Time

interval attributes] is used to set the time interval for states and

positions.
Time interval attributes
Position speed : 10 * 0.1 second(s)
Image state change : ['ﬁme—based v] Backward cyde
Image update time @ 5 *0.1second(s)

Position speed: The speed of movement. The unit is 0.1 second.
Supposed that [Speed] is set to 10, the object’s position will change
each second.
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Image state change: Determines how state changes, either
[Position dependent] or [Time-based]. If [Position dependent] is
selected, the object state will change when position changes. If
[Time-based] is selected, the object position will change based on
[Position speed] and the object state will change based on [Image
update time].

Backward cycle: Assumed the object has four positions: position 0,
position 1, position 2, and position 3, and [Backward cycle] is not
selected. When the object moves to the last position (position 3),
the next position will be back to the initial position 0, and repeat.
The moving path is shown as follows:

position 0 - position 1 - position 2 - position 3 - position 0 >
position 1 - position 2...

If [Backward cycle] is selected, when the object moves to the last
position (position 3), it will move backwards to position 2, position
1 and then the initial position 0, and start over again. The moving
path is shown as follows.

position 0 = position 1 - position 2 - position 3 - position 2 >
position 1 - position O...

Example 1

The object’s state and position are determined by the registers, and the addresses must be

configured correctly, as in the following table:

Data format 16-bit 32-bit 64-bit (cMT / cMT X only)
Object state LW-n LW-n LW-n
Object position LW-n+1 LW-n+2 LW-n+4

For example, if the designated register is LW-100 and the data format is [16-bit Unsigned], then

LW-100 represents object’s state, LW-101 represents position. In the picture below, LW-100 = 2,
LW-101 = 3, so the object’s state is 2 and position is 3.
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Profile Tab

13-91

ion Object's Prop

General | Shape | Label | Profile

Position
[T Pinned X
Size
[T Keep width/height ratio
Width :
Width (36) :
Shape rectangle size
Width :

Trajectory

r 191 ~

191 ~

aRER

100

a4 ~

Position 0

Height :

Height (%) :

Height :

1 56

100

1147

aRER

[ ook

| [ Cancel

Setting

Description

Shape rectangle size

Set the size of the shape.

Trajectory

Set the position of each point on the moving path.

@ Note

B Since multiple pictures might be used by an [Animation] object, [Set to original dimension]

will not return all pictures to the original size.
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13.15. Bar Graph

13.15.1. Overview
Bar Graph object displays data as a bar graph for visualization.

13.15.2. Configuration

Click [Object] » [Chart] » [Bar Graph] icon on the toolbar to open Bar Graph dialog box. Select
properties, click OK button, a new Bar Graph object is created.

General Tab
cMT / cMT X
Bar Graph
[¥1Background General | Outline I Range I Security | 5hape|
[FilBar Graph
[VIDynamic Scale Comment :
Read ddies
PLC : [Local HMI ~ | [ Settings...
Addeess: [L -0 T6-bit Unsigned
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eMT, iE, XE, mTV

Mew Bar Graph Object (=3

General | outline I Security I Shape

Comment :

Read address

PLC name | Local HMI ~] [ setting... |
Address:lw =0 [ [ebitunsigned
Setting Description
Read address Click [Setting] to Select the [Device], [Device type], [Address],

[System tag], and [Index register] of the word devices that controls
how the bar graph displays.
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Outline Tab
CMT / cMT X
Bar Graph
[¥|Background General | Outiine ‘Ranga I Security I Shape|
[¥|Dynamic Scale Style -
Type
@) Bar () Cireular
Attribute Help
Mode : Directian : 11 =
Bar width tio (%) : 100 z
Background
e R T —
Bar
oo (D e (I
o1 —
Dymamic color
[F] Ensbls
eMT, iE, XE, mTV
Mew Bar Graph Object @
|General| Chatline |Range |Secu:fity | Shape |
Twpe
@ Bar () Cirgular
Attribute
Bar width ratio (%) : 100 =
Background
Frne: Buskgomi.
Bar
Y e —
s
Setting Description
Type Choose either [Bar] or [Circular].
Attribute Mode

Choose either [Normal] or [Offset]. If [Offset] is selected, an
original value [Origin] must be entered for reference.
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Direction / Degree

Bar: Determine the bar graph direction. Available options are [Up],
[Down], [Right], and [Left].

Circular: Determine the circular bar graph direction. Available

options are [Clockwise] and [Counter clockwise].
Degree (&

Direction

@ Clockwise () Counterdockwise

Degree
Full circle

Start: 0

[ 0K ][ Cancel ]

If [Full circle] is selected, set the start degree.

If [Full circle] is not selected, set the start and end degree.

Bar width ratio (%)

The ratio of bar to object width. The figure below shows two ratios,
100% and 50%.

11

100% 50%

Hole Radius (%)
The ratio of the radius of the hole to the radius of the whole

circular bar graph. The figure below shows two ratios, 0% and 50%.

9

0% 50%

Color/Style

Set the bar’s frame and background color, bar style, and bar color.

See the picture below.

Frame

Frame
Background
Background Bar style
Bar

Bar style
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Dynamic (For cMT / cMT X Series models only) With this option selected, the
color interior color of the bar is determined by the value in the

designated address.

Bar
Interior : | LW-0 Fattern : :]
Sl | — |
Drymaside color
[/] Enable
Device : [Local HMI G
Address: [LW -0 16-Lit Unsigaed.
Index Color o
0 1 000000 ]
1 [ giisiid
1 [ tof0s0 |
3 [ e0ec0 3
4 W 77
5 [ eo0s0ff
] [ ££0000 b
7 ] i L N
4 [ b Delete
Range Tab
New Bar Graph Object @
| General | Outline | Range | Security | Shape |
Attribute
Min valve : 0 Max value : 10
Target indicator
(V| Enable Color : | [+
Targetvalue : Tolerance :
Alarm indicators
Low limit: 0 High limit: 10
Loveolor: [J[s] Highoobr: | I
Dymamic target/alarm/zero{span)
[7] Enable
Setting Description
Zero / Span The percentage of filling can be calculated by the formula, see
Example 1.
Target When the register value meets the condition, the color of filled
indicator area will change to the target color, see Example 2.
Alarm If the register value is larger than [High limit], the color of filled
indicators area will change to [High color]. If the register value is smaller than
[Low limit], the color will change to [Low color].
Please note that when [Dynamic color] is enabled, the Target
indicator and Alarm indicator settings will not be present and their
colors are determined by the designated addresses.
Dynamic When [Enable] is selected, the [Low limit] and [High limit] of [Alarm
taget/alarm indicator] and the [Target Value] of [Target indicator] will use
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/zero(span) designated registers, which is shown in their respective fields see
Example 3.
Example 1

The percentage of filling can be calculated by the following formula:

. Register value — [Zero]
Percentage of filling = [Span] = [Zero] x 100%

Assume [Offset] is selected. If (Register value — [Zero]) is greater than 0, the bar will fill up from
[Origin]. If (Register value — Zero) is less than 0, the bar will be drawn below [Origin].

For example, [Origin] is 5, [Span] is 10, and [Zero] is O.
For different value in read address, it will display as below:

If the value at read address is 4: If the value at read address is 8:
high limit = 10 - high fimit = 10 W
— = —_— ——&
origin = 5-------. _ 5 origin = 5-------- — 5
—_— —s
fow limit=5 |, fow limit =5 —
4] [ 8 |
Example 2

When the register value meets the following condition, the color of filled area will change to
the target color.

[Target Value] - [Tolerance] < Register value < [Target Value] + [Tolerance]
Assume [Target Value] is 5 and [Tolerance] is 1. As shown below, if the register value is equal to

or larger than 4 (=5-1) and equal to or less than 6 (=5+1), the filled area’s color of the bar will

change to the target color.
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Target value = 5

Tolerance = 1

If [Dynamic target/alarm] is enabled, [Low limit] and [High limit] of [Alarm indicator] are

defined by designated registers as shown in the following table. Furthermore, if [Dynamic

zero/span] is used, [Zero], [Span] and [Origin] will be defined by designated registers. Assume

the address is LW-n, the limits are:

Data format 16-bit 32-bit 64-bit (cMT / cMT X only)
Alarm Low Limit LW-n LW-n LW-n

Alarm High Limit LW-n+1 LW-n+2 LW-n+4

Target LW-n+2 LW-n+4 LW-n+8

Zero LW-n+3 LW-n+6 LW-n+12

Span LW-n+4 LW-n+8 LW-n+16

Origin LW-n+5 LW-n+10 LW-n+20

13.15.3. Combo Setting

cMT / cMT X Series HMI support combo setting for Bar Graph, which allows setting of multiple

related objects at a time. Bar Graph can be set with Background and Dynamic Scale.
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Objects
Background
TBarGraph A
Outine
[¥IBar Graph (]
[V|Dynamic Scale Margin: 10 + __
Cancel
ColoxfStyle
—— & i
Romnd : 10 [
oo Bockgronmd :
L i
Setting Description
Margin Specify the space between the background edge and
the objects.
Color/style Customize
ColoxfStyle
© Customize ) Pictore
Rownd : 10 |
Frane: [ Transparent |7 Bockewond :

Pt

Select a suitable background pattern and color.

Picture
ColorStyle
(1 Customize (@) Pictre
Picture Library

Use the default picture or choose a picture from

Picture Library.
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Dynamic Scale

J‘BarGraph @
[¥IBackground General | profile
e — ——
- s G
-
Tick Mark | Scale Label
Color : \:E Radivs : D
Main scale
Tk Lenaft: U
Sub scale
Tiks: Lenahy: {
Setting Description
Style The scale style will follow the bar type.
Tick Mark Configure the number of tick marks for main and

sub scales. If the style is circular, the radius and tick

mark length can be specified.

Scale Label Configure the font, font color, font size and other
attributes of scale label.
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13.16. Meter Display

13.16.1. Overview
Meter Display object displays the value of word register with a meter.

13.16.2. Configuration

A
Click [Object] » [Chart] » [Meter Display] icon on the toolbar to open the Meter Display dialog

box. Set the object’s attributes and then click OK to create a new Meter Display object.

13.16.2.1. eMT, iE, XE, mTV Series

General Tab
New Meter Display Object [==3a]
General | putine | Limits | Security | Shape |
Comment :
Read address
PLC name : [Loml HMI v] Setting...
Address :’LW -| 0 16-bit Unsigned
Setting Description
Read address Click [Setting] to select the [Device], [Device type], [Address],

[System tag], and [Index register] of the word devices that controls

the Meter Display object.
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Outline Tab
Meter Display Object's Properties
[ General | Outline |Limits | Secusity | Shape | Profile |
Degree
Background
Bakgomd: () Pofie: [
(V] Full circle [ Transparent
Tick marks
[7] Ensble
Color : [:] [¥] Coordinate
Mainscale : 4 S Sub.scale : 2 £
Length: 10 -
Pointer
[ ime. ] Froe : [ .
e |
Width : []:] Length: 50 %
Pin point
@ Circle () Rectangle
Radivs: 7 &
T 5 Frame : | | -
[ OK ] [ Cancel ] [ Help
Range mark Tick mark
Corrdinate
Pointer
Fin point
Setting Description
Degree Set the pointer to go around the meter clockwise or

counterclockwise.

Sets the object’s start degree and end degree measured clockwise
from the 12 o’clock position. The angle range is 0 to 360 degrees.
The following shows meters of different settings.
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® [Start degree] =290° ® [Start degree] = 120°
[End degree] = 70° [End degree] = 240°
® [Start degree] = 40° ® [Start degree] = 225°
[End degree] = 140° [End degree] = 315°

Background

Sets the object’s background color and profile color.

Full circle

When selected, the object will display the whole circle. Otherwise, the
object will only display a partial circle in the defined degree range, as
shown in the following figure.

Full eirele non-full eirele

Transparent

When selected, the object will not display the background and profile
color.

Tick marks

Configures the number of tick mark and color.

Pointer

Configures pointer’s style, length, width, and color.

Pin point

Configures the style, radius, and color of the pin point.
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Limits Tab

New Meter Display Object @

[ General | Outline | Limits | Secusity | Shape |
Value

Min.: 0 4 Max.: 100

Range limits
[¥] Enable

tov - ()
CH S—
on: (I
Width: 3
[T Use vser-defined radivs
[ Dymamic limits
Low limit: 30 A High limit: 60 [

Scale label
[V] Use scale label
Font: Arial v

Right of decimal point: 0

[ OK ][ Cancel ][ Help ]

Setting Description

Value Sets the object’s display range. Meter Display object will use the
value of [Zero] and [Span] and the value of register to calculate the

pointer’s position. See Example 1.

Range limits Configures the values of [Low limit], [High limit], their

corresponding display colors, and the width.

7\

Use user-defined radius
Configures the radius to display range limits.
For example, set to 80: Set to 30:
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0.0 0.0
75.00 ! 25.00 75.00 ! 25.00

Dynamic Limits

The low limit and high limit are set by registers. See Example 2.

Scale label Select the attribute of scale label on Meter Display.
MD_D
Seale label
[¥] Use szale label
Fomt: Arial -

No. of decimal : 0

Example 1: Pointer position calculation

Set object’s display range. Meter Display object will use the value of [Zero] and [Span] and the
value of register to calculate the pointer’s position. For example, supposed that [Zero] is O,
[Span] is 100, when the value of register is 30, [Start degree] is 0, and [End degree] is 360, then
the degree indicated by the pointer is:

{ (30 —[Zero]) / ([Span] — [Zero]) } * ([End degree] - [Start degree]) =

{(30-0) /(100 -0)} * (360 — 0) = 108

Pointer will be pointing at 108 degrees.

Example 2: Dynamic Limits
The low limit and high limit are set by the register.

Suppose the address is LW-n, the following table shows the read address of low limit and high

limit:
Content 16-bit 32-bit 64-bit (cMT / cMT X only)
Low limit LW-n LW-n LW-n
High limit LW-n+1 LW-n+2 LW-n+4

For instance, when address is LW-100, the rule of setting limits is:
Content 16-bit 32-bit 64-bit (cMT / cMT X only)
Low limit LW-100 LW-100 LW-100
High limit LwW-101 LW-102 LW-104
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13.16.2.2.

General Tab

cMT / cMT X Series

General SecmﬂylShape
P = Style : |Custom
7 1
4 40 Angle: [ () 240°
/ ~ \
® 3\
“ N “ [7] Enable animation
| / |
/ Value
\ e & /
'/ Min.: O
A S Mex.: 80
Read address =
Device : [Lacal HMI | e | e
Address: |LW ~|0 [ [16-bit Unsigned
Indicator | Range limit | Scale
Pointer Pin point
Image : | Picture lib
-
e ik Radius : [3
Fixed aspect ratio :
Width: [3% - i
Length: |72% v -
< I | '
(o J[ concel [ tep |
- Scale
S 1
74" 10 Y
"\ =, Tick Marks
/5% %
Low Limit Kl’ = o
\ / High Limit
\g» &
\ /
\ //
== -_/</
Indicator

[\& WE!NTEK

13-106

EasyBuilder Pro V6.07.02



Objects 13-107

Setting Description

Style Select a style from the drop-down list. Available options include:
[Custom], [Style 1], [Style 2], and [Classical]. If [Custom] is selected,
properties such as the width / length of the pointer or the radius of
the pin point, etc must also be manually set.

The following background-related settings are available using [Style
1], [Style 2], or [Classical]:

Color

Sets the color of the background picture of meter.

Outline

The following is the outline of Style 1 when [Full circle], [Half
circle], or [Quarter circle] is selected.

The following is the outline of Style 2 when [Full circle], [Half
circle], or [Quarter circle] is selected.

Rotation
Rotates the background picture clockwise according to the angles
set.

Angle Direction
Sets the range to label the scale, using twelve o’clock direction as
the 0° reference.
Degree
Available options include: [Predefined] and [Custom]. With
[Predefine] selected, pick from the thumbnails configure directions
and angle ranges with ease.
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Degree (==l

Degree
(@) Predefine () Custom

Direction : (@) Clockwise Counterdockwise

Full circle

Start: 225 End: 135

Degree =]

Degree .
© Predefine Custom

(D)

Direction : @
= Z - Q| P -

S
"l o D=l & D

L BECEVYWIRCR Y
0PC0OO®O O

Full circle

If selected, the full circle is drawn according to the selected
direction and the start angle. The limits are determined by the
value set in [Minimum] and [Maximum] field under [Value].

Enable

animation

If selected, the pointer slides to the designated position when the
read value changes; if not selected, the pointer directly points to
the designated position when the read value changes.

Value

Sets the lower and upper limits of the meter.

Read address

Displays the value in meter according to the value in the designated
word register.

Indicator Sets the style of pointer and pin point. If [Custom] is selected, the
direction of the pointer must points upward to correctly display.

Range limit Sets the colors to indicate different ranges.
Dynamic limits
The low limit and high limit are decided by the register. See
Example 2 in the previous section.

Scale Sets the number of main and sub scale, the color of tick marks and
scale label.

&

= Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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13.17. Trend Display

13.17.1. Overview
Trend display objects draw curves of the data recorded by Data Sampling object.

13.17.2. Configuration

o

e~

Click [Data/History] » [Trend Display] icon on the toolbar to open a Trend Display object
property dialog box. Set up the properties, press OK button, and a new Trend Display object

will be created.
13.17.2.1. eMT, iE, XE, mTV Series

General Tab

17:32:41 12/03/06

| | 0 | e | |

Description

Go to the earliest sampling data.

Go to the previous time interval.

] Click to stop auto-scrolling. When the new sampling data is
generated, the display does not scroll, nor is the new data outside
the display range displayed.

Click to start auto-scrolling. The display scrolls as the new sampling

data is generated.

Go to the next time interval.

R

Go to the latest sampling data.
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Objects
New Trend Display Object (=)
General | Trend | Channel | ¥ Seale | Security | Shape |
Comment :
Data Sampling Object index : 1 1. = ]
Trend type © | History =
*If no. of channels is changed, you must reset HMI's data samplings.
[¥] Refresh data antomatically
[ Mo line connection between records if the next record is eaulier (slower refresh speed)
H axis time range © () Pixel Q) Time
Default distance : 100 second (s)
[¥] Dymamic ¥ axis time range
Device : [Local HMI [ Settines..
Address: [pw v|0 16-bit Unsigned
History control
Device : [Local HMI v [ Settines..
Addes: Ly 4|00
Watch line
(V] Enable
Device : [Local HMI v [ Settines...
Address : [ﬁ 50
Time stamp output
[¥] Enable
Device : [Local HMI | [ Seftines...
Addess:[Lw |0
[E Cancel Help
Setting Description
Data
Sampling Select a Data Sampling object as the source data.
Object index

Refresh data
automatically

In history mode, when this option is selected, Trend Display will be
automatically refreshed every 10 seconds. If this option is not

selected, Trend Display can only be refreshed by changing window.

No line
connection
between
records if the
next record is
earlier

When HMI time is adjusted to an earlier time, and data sampling
keeps going on, selecting this option can prevent the system from
drawing a line to connect the gap between current trend curve
(earlier in time axis) and former trend curve (later in time axis). This

can slow down refresh speed.

Trend type

Select the mode of data source, either [Real-time] or [History].
Real-time

In this mode, the display object shows all sampled data since the
HMI started. The maximum number of records that can be sampled
is set in [Max.data records] (Real-time mode) of the Data Sampling
object. When the sampling data exceed this setting, the earlier
data will be deleted. To show older data, use [History] mode.

[Hold control]: Suspends the update of Trend Display. However, it
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does not stop the sampling process of Data Sampling object.
History

In this mode, the data comes from the history data files stored on
HMI. . The history data files are sorted by dates, and each is given
an index. The system uses [History control] to select the history
data files that are created on different dates.

The system sorts the history data of sampling data by date; the
latest file is record O (typically the data sampled today), the second
latest file is record 1, and so on. If the value of designated register
in [History control] is n, the Trend Display object will display data
record n.

Here is an example to explain [History control]. If the designated
register is LW-0, and the sampling data files available are
pressure_20061120.dtl, pressure_20061123.dtl,
pressure_20061127.dtl, and pressure_20061203.dtl, and it is
2006/12/3 today, based on the value of LW-0, the sampling data

file which will be selected by [Trend Display] is shown as follows:

Value of LW-0 Selected sampling history data
0 pressure_20061203.dtl
1 pressure_20061127.dtl
2 pressure_20061123.dtl
3 pressure_20061120.dtl

If use with Option List object and select data source as [Dates of

historical data], the history data will be sorted by date and
displayed in Option List object, see “13.29 Option List”.

Pixel

[Distance] is used to set the distance between two sampling points,

as shown in the following figure.

12/03/06

— Ffzo pixels
| /
\ /( N /

"\/ point 0 point 1

b | | wn | e | e |

Time

[Distance] is used to set the X-axis in unit of time, as shown in the
following figure.
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L 20 seconds
[

12/03/06 /\

A 1\ Al A
YN AR VAVl

A STV [V \
v T\ V

| | o | | |

Select [Time] for [X axis time range] and go to [Trend] » [Grid] and

enable [Time scale]. Please refer to [Time scale] in the later section.

g_yrt\amic Designate a 32-bit word register for adjusting the distance between
istance

between data two sampling points (select Pixel), or the time unit represented by

sample_s/ X-axis (select Time). If no value is entered, the default value will be
Dynamic X

axis time used.

range i- Click the icon to download the demo project. Please confirm

your internet connection before downloading the demo project.

Refresh data

- If selected, every time when opening the window on which the
automatically

Trend Display object in history mode is placed, the display is

automatically refreshed every 10 seconds. Please note that:

® The refresh status can be observed from the control button of
Trend Display object.
Showing Ml button: The automatic refresh feature is
enabled.
Showing 21 button: The automatic refresh feature is
disabled.

® When scrolling to the previous data, the automatic refresh
feature is disabled, the ] button is shown.

® If [Refresh data automatically] check box is selected, when
change back to the window, the display is refreshed, ignoring
the control buttons. For example, select [Refresh data
automatically], and scroll to the previous data, the automatic
refresh feature is disabled. In this case, changing to another
window and then change back will still refresh the display.

® If [Refresh data automatically] check box is not selected when
building the project, the feature can still be enabled by
pressing 21 button on HMIL. In this case, the automatic
refresh feature is disabled, that is, even when change back to
the current window, the display will not be refreshed.
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Hold control

When the register is set ON, suspend the update of Trend Display. It
does not stop the sampling process of Data Sampling object. This

setting is available only in Real-time mode.

Watch line

Use the [Watch line] function to display a “watch line” when user
touches the Trend Display object. It will also export the sampling
data at the position of watch line to the designated word device
and use Numeric objects to display the results, as shown in the

following figure.
Wateh line
/

12/03/06

AN .
[ 1 N\ A

|/ \y\/\/\/
N/

| | o | | |

| 4 | LW300

[Watch line] can also export sampling data with multiple channels.

The system will consecutively write each channel to the specified
address and the following addresses, in the same order as in [Data
Sampling] object. The address assigned to [Watch line] is the start
address, and sampling data for each channel will be exported to
the word devices starting from “start address.” If the data format of
each channel is different, the corresponding address of each
channel is arranged from the first to the last. If the watch register is
LW-300, watch function will export each channel’s data to the

following addresses:

Register | Channel Data format
LW-300 0 16-bit Unsigned (1 word)
LW-301 1 32-bit Unsigned (2 words)
LW-303 2 32-bit float (2 words)
LW-305 3 16-bit Signed (1 word)

&

= Click the icon to download the demo project. Please confirm

your internet connection before downloading the demo project.

Time stamp
output

Time stamp output
Suppose the address is set to LW-n, then:
If enabled, the system will use the time of the first sampling data as

“time origin”, and write the time stamp of the most recent sampled
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data (relative to “time origin”) to [LW-n+2].
When clicking on the curve, the time stamp of the closest sampled
point will be written to [LW-n].

Clear real-time data address (Data Sampling object) will clear the
time origin as well.

Time stamp is recorded in seconds.

Trend Tab

New Trend Display Object @

[General | Trend | Channel | ¥ Scale | Secusity | Shape |

[T Transparent
e -] oo
[¥] $how seroll controls
Grid
[7] Ensble Color : |G ||

@ Interval () Division

X axds

Interval : 4 2 second(s)
¥ axis

Division(s) : 4 .

Time scale
[7] Enable

Time/Date

[¥] Relative time mode

© HHMM:SS ) HH:MM () SSSSS
() SS88Y (Leading zero)

[¥] Time

[¥| Date © MMDDAY ) DDMMAY O DDMMYY O YYMMDD

Cotor: N T

[ oK ] [ Cancel Help

Setting

Description

Transparent /
Frame /
Background

Select the color of frame and background.

Show scroll

controls

Enable or disable the scroll control as shown in the following figure.

| «|@m "

Grid

Set the number of dividing lines and the line color. The number of
divisions depends on the setting in General tab » [Distance
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between data samples] / [X axis time range].

X-axis interval

The number of vertical grid lines.

® Select [Distance between data samples] in General tab:
Select how many sampling points will be included between two
vertical grid lines.

® Select [X axis time range] in General tab:

Select the time range between two vertical grid lines.

X-axis division

The number of vertical grid lines.

Y-axis division

The number of horizontal grid lines.

Time scale

Select [Time] / [Date] check box to display the time scale along the

X axis.
v

“IMMDDYY

/ /
A W A I W

[ N

HH: MM HH:MM HH:MM HH:MM HH:MM HH:MM HH:MM HH:M

I/‘

Font / Color / Size
Select the font, font color, and font size of the time scale.
The default font size is 8.

Time / Date

Relative time mode

When this mode is selected, the time of the earliest sampling data
will be the start time from which to count a relative time. This
mode works with time scale [SSSSSS] and under this mode, time

scale [Date] cannot be used.
T oz
Division(z) : 4
Time seale
[¥/] Time Sases =
Drate

Color: [ I |

Time/Drate
Felative time mode

Time HH:MM:EE -
Drate TYMMDD -
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The time of the latest sampling data will be marked on the top left
corner of the object. This group box is used to set the time / date

display format and font color.

Channel Tab
Mew Trend Display Object =
| General | Trend | Channel |Shape|
Data sampling object
Channel Display Description Data tvpe ¥ aale
y 0 16-bit Unsigned 16-bit Unsigned ~ Nome
Channel
Pen property
Color : | ~ Width :
[ Dynamic limits
Zero: 1 Span: 100
Channel visibility control
[¥] Enable
PLC name : [Local HMI ~|[[setting...
Display channel when the corresponding bit is :
) oN @ OFF
Setting Description
Y scale Set Y-axis to be Main Axis or Aux. Axis. See “Y Scale Tab” for more
information.
Chanre] Dupleyy Dexogbon Disis tpe T walke
L Troe heured & D-bat Unngred MmNz
2 Trs chagrel B Dbk Urnigrad M Ko
E Te chazil C L=t Unngrnd Aee Mgz
Channel Configure each sampling line’s format and color. At most 64

channels could be configured.

Dynamic limits

® Not selected:

[Zero] and [Span] are used to set the low limit and high limit of
sampling data. If the low limit is 50 and the high limit is 100 for one
sampling line, [Zero] and [Span] must be set as [50] and [100], so
that all the sampling data can be displayed in the trend display
object.
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Objects
® Selected
The low limit and the high limit are read from the designated word
devices, as shown below. When address is LW-n, the register’s
address:
Data Format 16-bit 32-bit 64-bit
(cMT/
cMT X
only)
Low limit LW-n LW-n LW-n
High Limit LW-n+1 LW-n+2 LW-n+4
For example, if LW-100 is used here, the low limit and the high limit
will be read from:
Data Format 16-bit 32-bit 64-bit
(cMT/
cMT X
only)
Low limit LW-100 LW-100 LW-100
High Limit LW-101 LW-102 LW-104
A typical usage of this is to zoom in and zoom out of Trend Display.
(Not available for cMT / cMT X Series). See Example 1.
i Click the icon to download the demo project. Please confirm
your internet connection before downloading the demo project.
Channel If [Enable] is selected, the bits of the assigned word register will be
visibility used to show/hide each channel. The first bit controls the first
control channel, and the second bit controls the second channel, and so

on. For example, suppose there are 5 channels and LW-0 is used,

channels which will be shown given the states of the control bits

are:
Channel Control Bit State Displayed
1 LW_bit-000 OFF YES
2 LW_bit-001 ON NO
3 LW_bit-002 ON NO
4 LW_bit-003 OFF YES
5 LW _bit-004 OFF YES

Note on using this feature: Each control bits are not reserved for
the channel. If a particular channel is not displayed, the control bit
is assigned to the next displayed channel. For example, if the third
channel of the 5 channels is not displayed, only 4 channels will be
displayed in Trend Display, and the used control bits will only be:
LW_bit-000~003.
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¥

4 Click the icon to download the demo project. Please confirm

your internet connection before downloading the demo project.

Y Scale Tab
[ Trend Display Object's Properties @‘
| General | Trend | Channel | ¥ Scale | Security | Shape | Profile |
Data sampling object
Channel Display Description Data type ¥ seale
1 Troe channel & 16-bit Unsigned Aux. Axis
2 Troe channel B 16-bit Unsigned Main Axis
3 Troe channel C 16-bit Unsigned Aux. Axis
Scale font
Font:
Color: GG v Size:_
Dymamic ¥-scale visibility
™
PLCname:[Locdp-QMI v][ Settings... ]
nadess: (W] 0 [
Display channel’s ¥-scale when the cormresponding bit is :
) ON @ OFF
Dynamic main axis
[V] Enable
PLC name : [Local HMI ~ ][ settings...
Address : 80 | iiﬁ-blt Unsigned
Cancel
Setting Description
Y scale Show whether Y-axis is Main Axis or Aux. Axis.
Y-axis will not be displayed when [none] is selected for Y scale in
Data Sampling Object group box. At most 32 Y axes can be
displayed, including one main axis and multiple aux. axes.
Scale font Select the font, font color, and font size of the scale.
Dynamic To show or hide Y-scale. If the control address is LW-50, then the
Y-scale . .. . .
isibilit first axis is controlled by LW _Bit 5000, and the second axis is
visibility
controlled by LW_Bit 5001, and so on.
Dynamic To change the main axis. If writing 1 into LW-80, the main axis will
main axis

be Channel 1; if writing 2 into LW-80, the main axis will be Channel,

and so on.

@ Note

B A Trend Display on an eMT/iE/XE/mTV model can display 6MB of data in maximum.

E Click the icon to watch the demonstration film. Please confirm your internet connection

I__| WE!NTEK EasyBuilder Pro V6.07.02


https://dl.weintek.com/public/MT8000/Project/Part_Sample/Trend_Hide_Channels.zip
https://www.youtube.com/watch?v=8gBxEqiomm4

Objects 13-119

before playing the film.
= Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
13.17.2.2. cMT, cMT X Series

General Tab

The Trend Display on cMT / cMT X Series combines Real-time mode and History mode. Drag
left to scroll the Trend Display to view history data and drag right to view the latest sampling

data. Pinch two fingers together to zoom out Trend Display or spread them apart to zoom in.

/

Zoom In Zoom Out

C?For more information about how sampling data is saved, see “8 Data Sampling”.
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New Trend Display Object
Genersl | Display | Trend | Channel | ¥ Scale | Data Format | Secusity | Shape |
Comment :
Data Sampling Object index : [1, v]
*If no. of channels is changed, you must reset HMI's data samplings.
Distance between data samples : [Mﬂlimgtgr v]
Default distance : 100 mm
Dymanmic distance between data samples
Device : [Local HMI )&
Address: [LW v|0  [16-bit Unsigned
Watch line
[¥] Enable
Device : [LocalHMI v] {a
Address: [LW v|0 [[6-bit Unsigned
Time stamp output
[¥] Enable [¥] Enable day output
Device : [Local HMI
Address: |[LW v|0
History control
[¥] Ensble
Device : Local HMI o e
Address: (LW v|0 [6-bit Unsigned
[ Enable reading multiple histories
[ OK ] [ Cancel ] [ Help J
Setting Description
Data
Sampling Select a [Data Sampling] object as the source data.
Object index
Millimeter Same as eMT, iE, XE mTV Series. The upper limit is 500 mm.
Time Same as eMT, iE, XE mTV Series.
Pixel Same as eMT, iE, XE mTV Series. The upper limit is 1920 pixels.
Dynamic Same as eMT, iE, XE mTV Series.
distance
between data
samples
Watch line Same as eMT, iE, XE mTV Series.
Time stamp When enabled, the number of seconds passed from the first
output

sampling data can be calculated.
Suppose the address is set to LW-n, then:

[LW-n]: The number of seconds passed from the first sampling data

to the closest sampled point.
[LW-n+2]: The number of seconds passed from the first sampling
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data to the most recent sampling data.

Enable day output

With this option selected, the number of days passed since
1970/1/1 can be calculated.

Suppose the address is set to LW-n, then:

[LW-n+4]: The number of days passed since 1970/1/1 to the closest
sampled point.

[LW-n+6]: The number of days passed since 1970/1/1 to the most

recent sampling data.

History
Control

Same as eMT, iE, XE mTV Series.

Enable reading multiple histories:

In the following two modes, days are calculated backward.

Number of days

Suppose the address is set to LW-n, then:

[LW-n]: The start day index from which to calculate number of days.
0: today, 1: yesterday, and so on.

[LW-n+2]: The total number of days before the start day.

Specific days

Suppose the address is set to LW-n, then:

[LW-n]: The start day index from which to calculate number of days.
0: today, 1: yesterday, and so on.

[LW-n+2]: The end day index, the specified value must be greater
than that of the start day index. For example, if start is 4 and end is

7, the specified days will be 4 days before to 7 days before.
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Display Tab
Trend Display Object's Properties @
| Genersl | Displey | Trend | Chowmel | ¥ Soale | Dats Format | Secusity | Shape | Profile |
Ciption button visibility
@ Predefined () Dymatnic
Enshble
Foom button vishbility
Enshle
Dizplay option
Adapt o device screen pivel denstty (DPI)
Show custom file name
Connect data gaps
Touch
Dizable T-axis scrolling with swiping up/down
Disshle X-axis zoom
Disahle ¥-axis zoom
Setting Description
Option
button Show or hide the option button of the object.
visibility (cMT .
) vl Predefined
Series)

Select [Enable] to show the option button.
Dynamic

Choose a bit address to control option button visibility.

Option button visibility
() Predefined @ Dymamic

Device : [Local HMI YCE )

Address: LB ~ |0
Zoom button
visibility Show or hide the zoom button | of the object.
Display Adapt to device screen pixel density (DPI)
option

With this option selected, text size, position, and the spacing
between Y axes will be adjusted according to the DPI of the screen

of the connected device.
Show custom file name

This option appears when [Customized file handling] is selected in
Data Sampling. With this option selected, the customized file name
is shown as caption in Trend Display.

Connect data gaps
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Data sampling stops when PLC is disconnected, and after PLC is
reconnected, the trend curve of the disconnected period is plotted
with a gap. With this option selected, the system will draw a line to
connect the gap between the former trend curve (before
disconnected period) and the current trend curve (after

disconnected period).

Touch

Disable Y-axis scrolling with swiping up/down

With this option selected, dragging the object with your finger will
only scroll X-axis range while Y-axis remains being placed in the
middle of the object even if it is zoomed in/out.

Disable X axis zoom

With this option selected, dragging the object with your finger will
only scroll Y-axis range.

Disable Y axis zoom

With this option selected, dragging the object with your finger will

only scroll X-axis range.
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Trend Tab

w

Trend Display Object's Properties

[ Genersl | Display | Trend | Channel | ¥ Scale | Data Format | Secusity | Shape | Profile |

|| Transparent

Frns oo |
L —

Font : | Arial =

Grid
[¥]Ensble

Cotor: (.

Interval : 4 4 second (s)

s - )

Time scale
MM/DDAYYY v

Y-axis: 4 & division(s)

[¥] Time

Position : | Below x-axis -

[V] Date

Time/Date
["] Relative time mode

)

g |

| Time

Date MM/DDAYYY v
3§

][ Cancel H Help

13-124

Setting

Description

Transparent /

Frame / Select the color of frame and background.
Background
Grid Set the number of dividing lines and the line color. The number of

divisions depends on the setting in General tab » [Distance
between data samples] / [X axis time range].

X-axis interval

The number of vertical grid lines.

® Select [Distance between data samples] in General tab:
Select how many sampling points will be included between two
vertical grid lines.

® Select [X axis time range] in General tab:

Select the time range between two vertical grid lines.

X-axis division
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Objects
The number of vertical grid lines.
Y-axis division
The number of horizontal grid lines.
Time scale Select [Time] / [Date] check box to display the time scale along the
x axis. The position of the time scale can be selected.
The default font size is 8.
Time / Date Relative time mode
When this mode is selected, the time of the earliest sampling data
will be the start time from which to count a relative time. This
mode works with time scale [SSSSSS] and under this mode, time
scale [Date] cannot be used.
The time of latest sampling data will be marked on the top left
corner of the object. This group box is used to set the time / date
display format and font color.
Channel Tab
MNew Trend Display Object |E|
| General | Trend | Channel |Shape|
Data sampling object
Channel Display  Description Data type ¥ scale
p 0 16-bit Tnsigned 16-bit Unsigned  None
Channel
Pen property
Color : G| Width :
—
[] Dynamic limits
Zero: 1 Span: 100
Channel visibility control
[¥] Enable
PLC name : |Local HMI =] [ setting...
Display channel when the corresponding bit is :
o @ OFF
Setting Description
Y scale Set Y-axis to be Main Axis or Aux. Axis. See “Y Scale Tab” for more

information. At most 32 Y axes can be displayed, including one

I__| WE!NTEK

EasyBuilder Pro V6.07.02



Objects 13-126
main axis and multiple aux. axes.
Chamne] Duplyy Dexppbon D e T e
! T chaored & L6-bat Urnngred MmNz
2 Tree chaered B Lirebek Uy grand Mo K
3 Te (3 Li=bet Unngrand Aee Aaas
Channel Configure each sampling line’s format and color. At most 64
channels could be configured.
Dynamic limits
® Not selected:
[Zero] and [Span] are used to set the low limit and high limit of
sampling data. If the low limit is 50 and the high limit is 100 for one
sampling line, [Zero] and [Span] must be set as [50] and [100], so
that all the sampling data can be displayed in the trend display
object.
® Selected
The low limit and the high limit are read from the designated word
devices, as shown below. When address is LW-n, the register’s
address:
Data Format 16-bit 32-bit 64-bit
(cMT/
cMT X
only)
Low limit LW-n LW-n LW-n
High Limit LW-n+1 LW-n+2 LW-n+4
For example, if LW-100 is used here, the low limit and the high limit
will be read from:
Data Format 16-bit 32-bit 64-bit
(cMT/
cMT X
only)
Low limit LW-100 LW-100 LW-100
High Limit LW-101 LW-102 LW-104
Channel If [Enable] is selected, the bits of the assigned word register will be
visibility used to show/hide each channel. The first bit controls the first
control channel, and the second bit controls the second channel, and so

on. For example, suppose there are 5 channels and LW-0 is used,

channels which will be shown given the states of the control bits

are:
Channel Control Bit State Displayed
1 LW_bit-000 OFF YES
2 LW_bit-001 ON NO
3 LW_bit-002 ON NO
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4 LW_bit-003 OFF

5 LW_bit-004 OFF

Note on using this feature: Each control bits are not reserved for
the channel. If a particular channel is not displayed, the control bit
is assigned to the next displayed channel. For example, if the third
channel of the 5 channels is not displayed, only 4 channels will be
displayed in Trend Display, and the used control bits will only be:

LW _bit-000~003.

Y Scale Tab

The scale along the Y axis of a specific channel can be displayed. To enable Y Scale, [Grid]

Trend Display Object's Properties @

| General | Disploy | Trend | Chonnel | ¥ Scale | Dats Format | Secusity | Shape | Profile |

Diata sampling object
Channel  Display  Description Diata. type ¥ zoale
1 True 16-bit BCD 16-bit BCD Mone
2 16-bit BCD 16-bit BCD Mone

Hide chanmnel ¥ seale when chamnel data iz tnvisible

should first be enabled in [Trend] tab.

[Hide channel Y scale when channel data is invisible] option is selected by default. With this

option selected, whether channel Y scale is shown or hidden is determined by the settings in

Channel Visibility Control.

Y Scale can be configured on the in cMT Viewer as shown in the following steps.

1. Tapthe

button on the upper right corner of Trend Display object.

2. Tap [Trend Display Setting] » [Y Scale].

Cancel Option Done
Begin Date -
Ended Date -

TREND DISPLAY SETTING
Channel Visibility
Y Scale Or

Disable Y-axis scrolling

v

Reset to default

3. Set channel visibility.
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Option Channel Visibility

Channel 1
Channel 2
Channel 3
Channel 4
Channel 5

altafiallafa

~

Trend Display Object's Properties =

| General | Trend | Channel | ¥ Scale | Data Format | Security | Shape | Profile |

Channel : [Channel 1 ~ Channel 8

Channel 1 [16-bit Unsigned ]

Follow settings in the Data Sampling Right of decimal Pt. : |2

Channel 2 [16-bit Unsigned ]

[V] Follow settings in the Data Sampling Right of decimal Pt. : |2

(o J[ concel J[ rep |

Setting

Description

Follow
settings in the

Use the [Right of decimal Pt.] setting in Data Sampling.

Data

Sampling

Right of The number in this field determines the number of decimal places
decimal Pt of the value displayed; for example, when 1 is entered in this field,

and the original value obtained by Data Sampling is 45, then 4.5

will be displayed in Trend Display as a result.
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Example 1

The example explains how to zoom in or zoom out Trend Display. The feature described is not
available for cMT / cMT X Series.

In Channel tab select [Dynamic limits] check box. If the [Address] is set to LW-n, then LW-n

controls the low limit where LW-n+1 controls the high limit.

Dynamic limits

FLC name : [anal HMI v] Setting...

Address : [LW v] 0

Set [Address] to LW-0 and create two Numeric objects for entering the low / high limit. The
address that controls the low limit is LW-0; the address that controls the high limit is LW-1.
Let’s suppose the data is between 0 and 30; set the [Low limit] to 0 and the [High limit] to 30,

the trend curve is displayed as shown in the following figure.

17:01:50 081213

Low limit

o
High limit

En

To zoom out the Trend Display, enter a value greater than 30 in [High limit] as shown in the

following figure.

17:01:50 081213

Low limit

O]

High limit

\/\/\ =

To zoom in the Trend Display, enter a value less than 30 in [High limit] as shown in the following

figure.

17:01:50 0812113

Low limit

]

High limit

H
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X

Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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13.18. History Data Display

13.18.1. Overview

History Data Display object displays data stored by Data Sampling object. It differs from Trend
Display in that History Data Display object uses a table to display data. The following is an

Ch_Eﬂ
0

example of a history data display object.

=
&
o|lo|o|ololo|lo|o|o|o|=

e | e ) e ) o ) o ) e | e | e |
w
Lu

—

No. | Time| Date |C
3577 121:52 |16/09/07
3276 |21:52 |16/09/07
3575 121:52 |16/09/07
3574 121:52 |16/09/07
3273 |21:52 |16/09/07
3572 121:52 |16/09/07
3571 121:52 |16/09/07
3270 121:52 |16/09/07

3569 [21:92 [16/09/07
‘?tlﬁﬂﬂ 21-E2 [1RINQINT
4

o) ) e} e | e ] e ] ] ) e

A History Data Display on an eMT/iE/XE/mTV model can display 6MB of data in maximum. The

data will not be displayed after exceeding the limit.

13.18.2. Configuration

g L‘._\
o

Click [Data/History] » [History Data Display] icon on the toolbar to open a History Data Display

object property dialog box. Set up the properties, press OK button, and a new History Data

Display object will be created.
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CMT, cMT X eMT, iE, XE, mTV
New History Data Display Object [%34] || New History Data Display Object
General | Display | Display Format | Tile | Edit | Secusity | Shape | General | Display | Display Format | Tifle | Edit [ Secusity | Shape |
Data Sampling Object index : [1‘ ,] Data Sampling Object index : [14 v]
Style : | Default v [V] Refresh data antomatically
: Grid
Grid .
[V] Enable [¥] Auto fit short column [ Enable
Color : :} Column interval : 5§ 2
Color : [:] Colwnn interval : 5 -4
Profile color
Profile color [7] Transparent
[T Transparent Frame : :} Backgrownd : [ ]
Frame color : [:] Backgrowdeolor: [ Text
Font : | frial - Size : |12 -
= [ ) (2]
Font: [Arial Bold [Arial]) Droid Sans]  v|  Size:[12 | -
() Time ascending © Time descending
© Time ascending © Time descending Histpryconizol .
— Device : [Local HMI -JC Lo jjtet
7] Ensbls Address: |LW v|0 |16-bt
Device : (Lacal HMI [
Address: [LW |0 ~[l6E
History control
[¥] Enable Usage...
Device : [Local HMI '][ @)
Address: [LW v|0 [[B-bit Unsigned
[¥] Enable reading multiple histories
Mode : [Numbemf days v]
[ ok ][ cancel ][ hep [ ox J[ cancel |[ Heb |
Setting Description
Data
Sampling Select a Data Sampling object as the source data.

object index

Refresh Data

The system will refresh data every 10 seconds. When this option is

Automatically not selected, data can be freshed only by changing windows.
Style Select History Data Display object’s style.
Shows grids between rows and columns.
Color
Change the color of grids.
Column interval
Change the width of each column. The figures below are the
. examples.
Grid
No. [Time| Date [ChO[Ch1 Ch,Eﬂ Mo Tirme Date: i‘
3667 |21:57 |16/09/07] 1 0 0 3667 21:57 16/09/07
3666 |21:57 |16/09/07] 1 0 0 3666 21:57 16/09/07
3665 |21:57 |16/09/07] 1 0 0 3665 21:57 16/09/07
3664 |21:57 |16/09/07] 1 0 0 3664 21:57 16/09/07
3663 |21:57 |16/09/07] 1 0 0 3663 21:57 16/09/07
3662 |21:57 |16/09/07] 1 0 0 3662 21:57 16/09/07
3661 |21:57 [16/09/07] 1 0 0 3661 21:57 16/09/07
3660 |21:56 [16/09/07 0 0 0 3660 21:56 16/09/07
3659 |21:56 [16/09/07] 0 0 0 3659 21:56 16/09/07
2RRA [21-RR [HRNQINT n n n - QAR 21-ER 4RINAINT hd
. 0] | o
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Objects
. Change the color of frame and background. Use [Transparent] to
Profile color
hide frames and background.
Text Change the font and font size.
Time ascending
. Put earliest data at the top and the latest data at the bottom.
Time / Date ) .
Time descending
Put the latest data at the top and the earliest data at the bottom.
Hist The history files are sorted by date and each file is given an index.
istory
Control The latest one is assigned index O (in most cases: today), the
(eMT, iE'_XE' second latest file is assigned index 1, and so on. [History Control] is
mTV Series)

used to specify the history data to be shown.

Watch (cMT /

By tapping on a record in History Data Display object, data in the

cMT X Series) selected row can be output to the designated addresses.
History Same as eMT, iE, XE mTV Series.

Control (cMT Enable reading multiple histories:

é:m;)x In the following two modes, days are calculated backward.

Number of days

Suppose the address is set to LW-n, then:

[LW-n]: The start day index from which to calculate number of days.
0: today, 1: yesterday, and so on.

[LW-n+2]: The total number of days before the start day.

Specific days

Suppose the address is set to LW-n, then:

[LW-n]: The start day index from which to calculate number of days.
0: today, 1: yesterday, and so on.

[LW-n+2]: The end day index, the specified value must be greater
than that of the start day index. e.g. start: 4, end: 7, the specified
days will be 4 days before to 7 days before.

0 Note

B When using cMT / cMT X Series, use the gear icon in the upper-right corner of History

Data Display object in cMT Viewer to select the date and display the data.
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Begin Date

2020-02-10

Ended Date &

2020-02-10

El Click the icon to watch the demonstration film. Please confirm your internet connection
before playing the film.
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Display Tab
CMT, cMT X eMT, iE, XE, mTV
New History Data Display Object Il History Data Display Object (=l '
| General | Display | Display Format | Title | Edit | Seousity | Shape | | Generel | Display | Display Format | Tile | Edit | Security | Shape |
Time \ Time
] Time Color : _; 9] Time HH:MM - Color: N
Date ‘ Date
[¥] Date DDMMAYYY v Color: | [N V] Date Color: NN
[7] Move column [Date] to the front of colwmn [Time] [7] Move column [Date] o the front of coluwmn [Time]
Sequence no. Sequence no.
[¥] Sequence no. Color: | [N [¥] Sequence no. Color: | [N
Display charts : |5 5.
Row
(V] Multi-line display Number of lines: 5
Option button visibility
@ Predefined () Dynamic
[¥] Enable
< m | 3 < m g »
[ oK ] [ Cancel I [ Help. I [ oK ] [ Cancel ] l Help.
Setting Description

Time / Date

Enable or disable showing the time and date and configure its

format and color.

Move column [Date] to the front of column [Time]

Swap the position of column [Date] and column [Time].

Sequence no.

Show the sequence number of all records.

Multi-line display

Row Display a specified number of lines of data. Data will be displayed
as specified regardless of the actual number of lines of data.
Show or hide the option button
Predefined

Option Select [Enable] to show the option button.

button Dynamic

visibility (cMT

/ CMT X Option bution visbility

Series) () Predefined @ Dynamic

Device : [LDcalHMI ‘][ g ]

Address - |LB -0

Designate a bit address to control option button visibility.
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Data Format Tab

cMT / cMT X Series eMT, iE, XE, mTV Series
New History Data Display Object @ New History Data Display Object
[ General | Display | Display Format | Title | Edit | Secusity | Shape | [ General | Display | Display Format [ Title | Edit | Secuity | Shape |
Channel : | Channel 1 ~ Channel 6 - Channel : | Channel 1 ~ Channel 6 v
Channel 1 [16-bit Unsigned ] | Channel 1 [16-bit Unsigned ]
[7IDisplay V] Follow settings in the Data Sampling [¥] Display
T sading s [ — [ Leading zero Lo <) [ —)
£d 0 $

Channel 2 [16-bit Unsigned ]
[T/ Display

Channel 3 [16-bit Unsigned ]

Leading zero

[7] Display [T Display
Channel 4 [16-bit Unsigned ] | Channel 4 [16-bit Unsigned ]
[V] Display [] Follow settings in the Data Sampling [V] Display

Right of decimal Pt.: 0
Channel 2 [16-bit Unsigned ]
[T/ Display

Channel 3 [16-bit Unsigned ]

Center v I [ Leading zero Center v :]

0 Right of decimal Pt.: 0

] ) s [ ok ][ cancel ][ Hep }

13-136

Setting

Description

Channel

Each History Data Display object can display up to 64 channels. Check
[Display] to select the channels to be shown on the screen. In the
figure above, there are 4 channels (channel 1 to channel 4) in the
Data Sampling object, and only Ch.1 and Ch.4 are selected. The data
formats are shown next to channel name. The data format of each
channel is decided by the corresponding Data Sampling objects. The
result is shown below:

»

No. Time Date | ch.
12 [09:50:16[10/03/17] 0O
11 [09:50:15[10/03/17] 0O
10 [09:50:14[10/03/17] 0O
09:50:13[10/03/17] 0
0
0
0
0

9

8 [09:50:12|10/03/17
7 |09:50:11]10/03/17
3]

5

[ Vo] el M K ] M ] =0

09:50:10]10/0317
09:50:09/10/03/17

=
e
4

When using cMT / cMT X models, Data Sampling’s Data Format
settings can be applied to History Data Display object.

Two display modes are available when displaying [String] format in
History Data Display object:
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Channel 1 [Brring - 11 wordi=)]
Dizplayr [ Follow settings in the Data Sampling

[ Reverse highflow byte Left ~ | [ -

byteno.: 22 14 String format : | UTF-8 (Default) - |

® Follow settings in the Data Sampling.
® Reverse high byte and low byte data and then display.

Title Tab

New History Data Display Object

| General | Display | Display Format| Tile  |Edit | Secwity | Shape |

Headers
Use headers
Background

[ Transparent Color : [:]

Column Header text =

o) Lo J o

Setting Description

Use headers Enable or disable title, which is marked as shown below:

€Mo_[Time | Date |ch.i [chApal

1 VI B TOIOSTTT | | #

Background Transparent
When selected, hide the background for title area.
Color
Set the background color of title.

Setting Defines the text to be shown on the title.
The text can be edited in Label Tag Library. Build the Label Tag
Library first, and in History Data Display settings dialog select the
checkbox in the Label Library column, and then select the label tag.
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Title name Label ... Label tag Title -
Label 1 No.
- Time
Date
ch.l
ch2
ch.3

m

0 Note

B After running simulation on PC, to run simulation again using the same project that
contains some changed data, please find the HMI_memory, SD_card, or usb1 folder in
EasyBuilder Pro installation, and then delete the old data sampling records in it, to prevent

the system from reading old data in the second simulation.

Edit Tab
cMT / cMT X Series eMT, iE, XE, mTV Series
e Hls!oryData Display Object : e HisloryData Display Object
| General | Display | Display Format | Tite | Edit | Secuuity | Shape | | General | Display | Display Format | Tile | Edit | Secuuity | Shape |
[7] Enable [7] Ensble
*For data saved in an external device (USE disk/SD card), editing commands work only
when the device is plugged in.
Control Control
Device : [LQcalHMI v] s Device : [LocalHMl
Address: (LW v|0 [ [re-t gned Address: [LW ~|0 [
Enable control result
Command : LW-0 Command : LW-0
1 : Overwrite log data. 1 : Overwrite log data.
2 : Delete the sslected log
Result: LW-1
0 Success
1 : External device not connected
2 : Command not supported
3 : Record not found
Data Data
Device : [Local HMI Device : [Local HMI
Address: (LW v|0 Address: [LW v|0 \
Select Select
Device : [Local HMI B e Device : Local HMI B e
Address: (LW ~|0 [ [16-bit Unsigned Address: (LW ~|0 [16-bit Unsigned
Selection colox : E] Selection color : :]
o J[ conced |[ Heb ] [ o J[ concel |[ rep |
Setting Description
Control LW-n: Command
address —
Value Description
1 The data in Data Address will
overwrite the data in data log.
2 The selected data log will be deleted.

LW-n+1: Result (cMT / cMT X Series)
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Value Description

0 The command is executed
successfully.

1 The external device is not connected.
2 The command is not supported.
3 The record cannot be found.

Data address The system will start reading row by row from the selected one in

History Data Display, and change the data log accordingly.
Please note that the settings in this address must be identical to
that in Data Sampling.

Select

By changing the value in Select Address, the corresponding row in
address

History Data Display can be selected.

Please note that:

1. When the value in Select Address is 0, no row will be selected,
and the value in Data Address will stay the same as that of the
previously selected row number.

2. When the value in Select Address exceeds the total number of
rows in History Data Display, the last row (the one with largest
row number) will be selected.

0 Note

B When an external device is used to save data log, removing the external device will make
Edit function ineffective. Editing can keep on when the external device is inserted again
and the system starts reading historical data.

El Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.
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13.19. Data Block Display

13.19.1. Overview

Data Block is a combination of several word devices with continuous address, where the X axis
of Data Block Display object represents the address and the numbers on the Y axis represent
the data values in the corresponding address. Data Block Display object can display multiple
data blocks. For example, it can display two data blocks LW-12~LW-15 and RW-12~RW-15 in
trend curves simultaneously. It is very useful to observe and compare the difference of trend

curves.
o Dl Py @
twit | 4] ” /
twiz | 10 ]
twis | 20 | 2 /\ /
LW14 n 10 ~
l l l l
wis [ 30 LW12 LW13 LW14 LWI5 | | |

The display result

13.19.2. Configuration

Click the [Object] » [Chart] » [Data Block Display] icon on the toolbar to open the property
dialog box. Set up the properties, press OK button, and a new Data Block Display object will be

created.
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General Tab
[ New Data Block Display Object »
Genersl | Display Area | Secusity | Shape |
Comment :
No. of channel : 1 -
Watch line
[V Enable
[¥] Allow input Color: [ N -
Device : (Local HMI B eI e
Address: [LW v| o
Control
Device : [LocalHMI .] {o
Address: [Lw v|0 [[B-bit Unsigned
No. of data address: | LW-1
Data storage start address
[T]Oftset to control address
Device : |Local HMI |53
Address: |LW v|2 16-bit Unsigned
Limit
Min.: 0 Max. : 32767
[ oK ] [ Cancel ] [ Help
Setting Description
Comment Description of the object.
No. of Set the no of channel for this object. Each channel represents one
channel data block. The maximal number of channels is 12.
Watch Line If enabled, when user touches the [Data Block Display] object, it
will display a vertical cursor line on it, and store the data on the line
to the designated registers. See Example 1.
Allow input (cMT / cMT X Series)
With this checkbox selected, entering a value in the specified
address for watch line can move the verticle watch line to the
desired position.
Channel Select the channel to be configured.
Control Specify the control address also the data source.
address Control address is used to control and clear the drawn curve. After

executing the operation below, the system will reset the control
word to zero.

Enter “0” = No action (default)

Enter “1” = Draw (Without clear first)

Enter “2” = Clear
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Enter “3” = Redraw

No. of data address

If control address is LW-n, then LW-n+1 stores the number of word
devices in each data block, i.e. the number of data. The maximum
value is 1024.

Data storage start address

If [Offset to start address] is enabled, the [Offset value storage
address] will be set as [Control address] + 2.

If select 16-bit data format, the address for each data will be start
address, start address + 1, start address + 2 and so on.

If select 32-bit data format, the address for each data will be start
address, start address + 2, start address + 4 and so on.

For more information about control address, see Example 2 to 5.

Limit

Set the minimum and maximum limit for the curve.

;@ Note

B Without clearing the drawn lines, Data Block Display can be drawn a number of times by

entering value 1 in the control address repeatedly. The way to calculate the maximum

number of times is: 32 divided by the number of channels.
1 channel=>» 32 times
2 channels=» 16 times
16 channels=>»2 times

Example 1

How to use watch (Cursor Line) feature

Use “Watch” function to check the value of any point of the curve. When the user touches

[Data Block] object, it will display a “cursor line”, and the system will write the index and value

of that data on the cursor line to the designated address.

Data Format Index Value Channel 1 Value Channel 2 Value
16-bit Address Address + 1 Address + 2
32-bit Address Address + 2 Address + 4
64-bit (cMT/

Address Address + 4 Address + 8
cMT X only)

When watch address is set to LW-n, the value written into LW-n represents the channel index

number to be called up. (Start form 0)
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Channel 1
16 bit BCD
50 Watch indicator 1 | Control
7 | No. of Data
40
—\— 30 | Data 1
30 20 | Data 2
0 10 | Data 3
10 | S Y 10 | Data 4
] ] ] ] ] 10 | Data 5
10 | Data 6
10 | Data 7

@ Note

Channel 2
32 bit unsigned

1

7

40

50

30

40

40

30

30

Control
No. of Data
Data 1
Data 2
Data 3
Data 4
Data 5
Data 6
Data 7

Channel 2
32 bit unsigned

-

-

40

50

30

40

40

30

30

Control
No. of Data
Data 1
Data 2
Data 3
Data 4
Data 5
Data 6
Data 7

Channel 2
32 bit unsigned

-

-

40

50

30

40

40

30

30

Control
No. of Data
Data 1
Data 2
Data 3
Data 4
Data 5
Data 6
Data 7

+0
+1
+2
+3
+4

+)
+1
+2
+3
+4

+)
+1
+2
+3
+4

Watch
address

3

10

40

Watch
address

3

0

40

Watch
address

3

0

40

Index
16 bit BCD

32 bit
unsigned

[Data Index] is a 16 bit unsigned integer. When the designated register of cursor line is 32

If the channel to be viewed has no data, “0” will be displayed, as shown below. In the

example, there is no data in channel 1, when the cursor points at Data 4, “0” will be

Index

16 bit BCD

32 bit
unsigned

Index

16 bit BCD

32 bit
unsigned

Write the number of data to [No. of data address], i.e. “Control address+1”

Write “1” to [Control address] to draw the curve without cleaning the plot. All previous

[ |
bit device, it will be stored in the bit 0-15.
[ |
displayed as shown below.
Channel 1
16 bit BCD
50l Watch indicator Control
/\/ No. of Data
40
—\— Data 1
30 - Data 2
20 - Data 3
10 - Data 4
l l l l 1 Data 5
Data 6
Data 7
B If thereis less data in Channel 1, “0” will be displayed, as shown below.
Channel 1
16 bit BCD
50l Watch indicator 1 | Control
/\/ 3 | No. of Data
40
—\— 30 | Data 1
30 20 | Data 2
20 |- 10 | Data 3
10 | Data 4
1 1 1 1 1 Data 5
Data 6
Data 7
Example 2
How to show a data block
1.
2. Store the data consecutively beginning at [Data storage start address].
3.
curves will not be erased.
4.

The system will write “0” to [Control address] after marking the plot.
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Word Address

Last displayed graph Display

1 | Control

7 | No. of Data
20 | Data 1
30 | Data 2

10 |Data 3 Data 1
20 |Data 4
20 | Data 5
40 | Data 6

30 |Data 7 T

remains and the current
data graph overlays it.

The previous graph J

@ Note

B Do not change the content of [Control address], [No. of data address] and [Data storage
start address] between step 3 and step 4 above as doing so might cause error for the
trend curve plot.

Example 3

How to clear the graph

1. Write “2” to [Control address], all the trend curves will be cleared.

2. The system will write “0” to [Control address] after the trend curve is cleared.

Word Address

Last displayed h “
ast displayed grap 2 | Control .

7 | No. of Data

20 |Data1
30 |Data 2
10 |Data 3
20 |Data 4
20 |Data5 ] ] ] ! ! !

40 [Data 6 Clears the previous
30 |Data ¥ T { graph display. Even if

there is data, the graph
does not display.

Example 4
How to clear the previous trend curve and display new one
1. Write the number of data to [No. of data address], i.e. “control address+1”
2. Store the data consecutively beginning at [Data storage start address].
3.  Write “3” to [Control address], the previous trend curves will be cleared and the new
content in data block will be plotted on the screen.

4. The system will write “0” to [Control address] after the trend curve has been plotted.
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Word Address
Last displayed graph 3 | Control Redraw screen
7 | Mo. of Data
40

20 | Data 1

30 |Data 2

10 | Data 3 Data 1

20 | Data 4

20 |Data 5

40 [ Data 6 Clears the previous
graph display, then uses

30 [Data? the current data to
display the graph again.

Example 5

How to use offset mode

If [Offset to start address] is selected, [Control address], [No. of data address], and [Offset
value storage address] will use 3 consecutive addresses.

For example, assume the total number of channels is 3 (start from 0 to 2), and the [Control
address] are LW-0, LW-100, and LW-200, respectively. Then, the other addresses will be set as
follows: (In the example, format 16-bit Unsigned is used and [Offset value storage address] are

all m).
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Item Channel 0 Channel 1 Channel 2
Control Address LW-0 LW-100 LW-200

No. of data LW-1 LW-101 LW-201
address

Offset value LW-2 (=m) LW-102 (=m) LW-202 (=m)
storage address

Data 1 LW-0+m LW-100+m LW-200+m
Data 2 LW-1+m LW-101+m LW-201+m

The following figure on the left shows the result when offset mode is not used while the figure
on the right shows the result when offset mode is used.

No offset settings Has offset settings

Designated Designated

address Control address Control
+1 | No. of Data (n) +1 | No. of Data (n)
+2 Data 1 +2 Offset (m)
______ Tt Data (n) to be
) displayed on the
____________ graph +m Data 1
+{n+1) patan  |J) [T T Data (n) to be
: displayed on the
____________ graph
+(m+n-1) Data n

@ Note

B When [Control address] is set to LW-n, [No. of data address] and [Offset value storage
address] are as follows:
Data Type 16-bit 32-bit 64-bit (cMT / cMT
X only)
Control address LW-n LW-n LW-n
No. of data address LW-n+1 LW-n+2 LW-n+4
Offset value storage address LW-n+2 LW-n+4 LW-n+8
B If the control registers are 32-bit devices, only bit 0-15 will be used for control purpose, bit
16-31 will be ignored. (as illustrated below)
32 hit device
K| 16 13 0
+0 0 Control
+1 0 No. of Data
+2 0 Offset
B When the value in [Control address] is not zero, the system will read [No. on data address]
and [Offset value storage address].
B |tis recommended to use [Offset to start address] for data block display with multiple
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channels and the same device type. As shown in the following figure, The control words of

channel 1 is located from LW-n, the control words of channel 2 is located from LW-n+3,

and so on.

Display Area

Address

Control

No. of Data (n)

Channel 1

Offset (m)

Control

No. of Data (n)

Channel 2

Offset (m)

Channel 1's
data (n)

Channel 2's
data (n)

New Data Block Display Object

General | Display Area [VSecurity l-Shape |

Data samples : 50 $
[¥] Enable scroll switch

Profile color
[ Transparent
Frne - [ I
Grid
(V] Ensble

Horiz.: 4 + division(s)

Channel

Pen property

Samplesto sexoll 10 -

Background : 2
Cotr: [ )

Verti. : 4 & division(s)

OK ][ Cancel H Help

Setting

Description

Description

Data samples
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Configure the maximal number of data samples (points) to be

displayed.

Samples to scroll

Configure the number of data samples being scrolled.

Enable scroll switch

Clicking

Clicking

-

-

>

displays the previous or next data point.

displays the first or the last data point.

Profile

Set the color of the frame and background of the object.

Transparent

Hides the background. Color selection will not be available.

Grid

Set the number of horizontal and vertical divisions shown by grid.

Channel

Set the color, width and style of each curve.

"

- Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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13.20. XY Plot

13.20.1. Overview

XY Plot object is used to display values for two variables (x,y) for a set of data, where the data

comes from word registers. Up to 16 channels can be displayed simultaneously. This object
facilitates data observation and analysis. Additionally, negative numbers can be displayed as

well.

13.20.2. Configuration

e

Click [Object] » [Chart] » [XY Plot] icon on the toolbar to open a [XY Plot] object property dialog

box.

General Tab

I__| WE!NTEK

XY Plot Object's Properties (===
General |Di5|:v|a\-I Area | Shape | Proﬁle|
Comment :
Direction : Right | Mo.ofchannels: 2 =
Control Address
PLC name : ’Loml HMI v] Setting. ..
Address i[LW v] 10
Mo. of data address :
Read address
PLC name : [Loml HMI ']
Separated address for ¥ and ¥ data
¥ data
PLC name : | Local HMI
Address :’LW ~| 100 16-bit Unsigned
Y data
PLC name | Local HMI
Address i[LW - | 200 16-bit Unsigned
Limits
[ bynamic limits
X axis
Low: 0O High: 32767
Y axis
Low: 0O High: 32767
o) [ cans
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Setting

Description

Direction

There are four selections, right, left, up or down.

Right Up Down

Right direction Left direction Up direction origin—,

R

arigin =" = origin arigin= * Diown direction

No. of

channels

Set the number of channels for observation.

Control
address

Controls the operation of all channels simultaneously. When the
[Control address] is LW-n, assigning values to LW-n will issue
commands to XY plot according to the table below. Meanwhile,
LW-n+1 | controls the number of data points plotted. After
operation, the [Control address] will be reset to 0.

Control | Value Result
address

LW-n 1 Plots point on XY curve.

(The plotted points are kept.)

2 Clears all XY curves.

3 Clears then plots new XY curve.

LW-n+1 Any

Controls the number of data points plotted.
number

No. of data address
Controls the number of data points. Each channel can plot up to
1023 points.

Channel

Select a channel to configure.

Read Address

Device

Select a PLC which will be the source of [X data] and [Y data] and
designate a read address.

The format of the data register blocks used for the display channels
depends on whether [Separated address for X and Y data] and/or

[Dynamic limits] has been selected. See Example 1.

Dynamic
limits

® When not selected (See Example 2)

The Low and High limits can be set by entering constants. The Low
and High limits are used for calculating X and Y range in
percentage.

® \When selected (See Example 3)

A zoom effect can be created by changing the Low / High Limits.
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Example 1

The format of the data register blocks used for the display channels depends on whether
[Separated address for X and Y data] has been selected, and if [Dynamic limits] has been
selected. The following explains the situations where 16-bit register is used:

® [f [Separated address for X and Y data] is not selected, and set [Read address] to LW-n:

Select [Dynamic limits] Not select [Dynamic limits]

X data Y data X data Y data
Low Limit LW-n LW-n+2 Constant Constant
High Limit LW-n+1 LW-n+3 Constant Constant
1%t data LW-n+4 LW-n+5 LW-n+0 LW-n+1
2" data LW-n+6 LW-n+7 LW-n+2 LW-n+3
3 data LW-n+8 LW-n+9 LW-n+4 LW-n+5
4t data LW-n+10 LW-n+11 LW-n+6 LW-n+7

® |f [Separated address for X and Y data] is selected, and set [X data] to LW-m, [Y data] to

LW-n:

Select [Dynamic limits] Not select [Dynamic limits]

X data Y data X data Y data
Low Limit LW-m+0 LW-n+0 Constant Constant
High Limit LW-m+1 LW-n+1 Constant Constant
1%t data LW-m+2 LW-n+2 LW-m+0 LW-n+0
2" data LW-m+3 LW-n+3 LW-m+1 LW-n+1
3 data LW-m+4 LW-n+4 LW-m+2 LW-n+2
4t data LW-m+5 LW-n+5 LW-m+3 LW-n+3

Example 2

When [Dynamic limits] is not selected, the Low and High limits can be set. The Low and High
limits are used for calculating X and Y range in percentage.
Read Address Value — Low Limit
High Limit — Low Lmit
If [Separated address for X and Y data] is not selected and the address is LW-n, the

Scale (%) =

corresponding limits are retrieved from the addresses as shown in the following table.

Data format 16-bit 32-bit 64-bit (cMT / cMT X only)
X axis low limit LW-n LW-n LW-n

X axis high limit LW-n+1 LW-n+2 LW-n+4

Y axis low limit LW-n+2 LW-n+4 LW-n+8

Y axis high limit LW-n+3 LW-n+6 LW-n+12
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Example 3

If [Dynamic limits] is selected, a zoom effect can be created by changing the setting of Low /
High Limits.

In the following example, XL=X low limit, XH=X high limit, YL=Y low limit, YH=Y high limit, and
XY, XY1, XY2 are three XY data. When changing the high limits of X and Y axis, the result is

shown below:

BN N | K B | O 2l

LW100 control  LW101 display number

L 1]

Original
N
[0 Y50 Jo Yoo}
Y XY2 XY XY1 XY2

I I | ECEE 5N | SR B EN | ECE 5 | O P
LW100 control  LW101 display number LW100 control  LwW101 display number
E L1

Change the high limit of Y axis to 25. Change the high limit of Y axis to

(zoom in) 100 (zoom out)

Cs"'__lFor more information, see “13.17 Trend Display”.

0 Note

B X and Y data can be set to different formats. For example: If X data uses 16-bit unsigned, Y
data uses 32-bit signed, please note the address setting.
B When using a Tag PLC, such as AB tag PLC, X and Y must be in the same format. When using

different formats a warning will be shown.
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Display Area Tab

New XY Plot Object

Display Area. | Secuity | Shape |

Profile color
[ Transparent

O —

Curve

h ‘:

Pen property

Beekgrowd - [T

Brush property

Reference line
[¥] Limit from device

Device : Local HMI

v [ Setiings...

[T Reference line 1
[T Reference line 2
[T Reference line 3
[T Reference line 4

Address: |LW v 0

~ [16-bit Unsigned.

ok | [ cancel |[ Hep

13-153

Setting

Description

Profile color

Select the color of the frame and the background, or select
[Transparent] check box to hide the frame and background.

Curve

For each channel select the properties of color, width, and line

style.

Maker

Select the style of XY Plot. For eMT/iE/XE/mTV series, there are
four different types of XY plot as shown below:

Curve

clnl

Maker
rs 4 W

Pen property
Color ’,/'\\/\/

Brush property t

Podnt width

[FIE=—=

[\& WEINTEK
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For cMT / cMT X Series, , there are six different types of XY plot as
shown below:

Curve

Maker :

Fen property .
Color : I

Brush property
Foint width :

See Example 4.

Pen property

Select color, width and style for the line in XY plot.

Brush
property

Select point width.

Reference line

Up to 4 horizontal reference lines can be shown on the graph. Fill in
high, low limits and Y axis percentage values. Different colors can
be selected for each reference line.

If [Limit from PLC] is selected, designate a register to be the read
address of reference line.

Example 4

The curve shown in the following figure is drawn with 7 points numbered from PO to P6.

The steps the system draws the X-axis Projection are:

1. Calculates the two points in X-axis — (Xo, 0) and (X, 0).
2. Link all the points in the order of (Xo, 0), PO... P6, (X6, 0) and returns to (Xo, 0) at last.
3. Fill out all enclosed areas.

Enclosed region

Se
.
L]
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0 Note

B Without clearing the drawn points, XY Plot can be drawn a number of times by entering
value 1 in the control address repeatedly. The way to calculate the maximum number of
times is: 32 divided by the number of channels.

1 channel=>» 32 times
2 channels=»16 times
16 channels=>»2 times
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13.21. Alarm Bar and Alarm Display

13.21.1. Overview

Alarm Bar and Alarm Display objects are used to display alarm messages which are defined in
Event (Alarm) Log objects. When the trigger conditions are met, events or alarms will be
displayed as they occur in chronological order in Alarm Bar or Alarm Display object.

Alarm Bar scrolls all alarm messages in one single display line, whereas Alarm Display shows

alarm messages in multiple lines.

C?For more information, see “7 Event Log”.

I {When LW T >= 10) 13:21:06 Event 0 (when LWO

Alarm Bar - Displays alarm messages in one scrolling line.

13112106 13:21:28 Event 2 (when LB10 = ON)
13112106 13:21:28 Event 3 (when LBff = ON)
13i12i06 13:21:38 Event 0 (when LWO == 100)
13112106 13:21:28 Event 1 (When LW 1 >= 10)

Alarm Display — Displays alarm messages in multiple lines.

13.21.2. Configuration

% :'-:Q:-’:

Click [Data/History] » [Alarm Display] or [Alarm Bar] icon on the toolbar to open the object

property dialog box. Set up the properties, press OK button, and a new object will be created.
General Tab

The difference between these two objects is that Alarm Display allows an [Acknowledge

address] and a [Scrolling control address] to be set.
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New Alarm Display Object
General | Alsrm | Sort | Security | Shape | Font
Comment :
Acknowled ge address
[V] Enable acknowled ge function
Device : [Local HMI v] e\«
Address: |LW ~|0 16-bit Unsigned
Serolling control address
[¥] Enable serolling control
Device : (Lacal HMI B e
Address: [LW v|0 16-bit Unsigned
[ oK J [ Cancel ] [ Help
Setting Description
Enable If selected, the [Acknowledge value] selected for the associated
acknowledge event, specified in Alarm (Event) Log » Message tab will be written
function to the [Acknowledge address] designated in Alarm Display. For more

information, see “7 Event Log”.

Acknowledge value for Eventfalarm Display object
Acknowledage value : 11

Scrolling If enabled, the value in the designated control address indicates the
control number of lines to be scrolled down. The minimal value is 0, which
address indicates the first line. Please note that with this address enabled,

the horizontal and vertical scroll bars will not be available on the
object; please make sure that the width of the object is enough for

completely showing the content.

0 Note

B When using a cMT / cMT X Series model, press and hold the event on the screen to
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acknowledge an event; drag a finger on the screen to scroll.

B When using a cMT / cMT X Series model, a default minimal row height exists in Alarm

Display objects that have enabled Acknowledge function. The minimal row height

prevents the rows to be touch by mistake. On a small-sized HMI, the row height may be

slightly taller when Acknowledge function is enabled.

13-158

Alarm Tab
Alarm Bar Alarm Display
New Alarm Bar Object (==l New Alarm Display Object (=
Alam [Sort | Secuity | Shape | Font | | General | Alam |Sort | Secuity | Shape | Font
Display Display
Scroll speed : |Speed 5 Acknowledge style : |Click v
[ Move smoothly (may lead to highter CPU usage)
Include categories Include categories
1) ~ 255 {sze Event (4lam) Log object} 0 ~ 255 {see Event (4lam) Log object}
Color Color
[7] Transparent [7] Transparent
Frame : | I Background : s Frame : ‘ _v] Background : [ o
Acknowledge
T —
Grid
[¥] Enable
Color: | | .
[ OK ] [ Cancel ] [ Help OK I [ Cancel ] | Help
Setting Description
Include Events in the selected category will be displayed. The categories are
categories set in Event (Alarm) Log object.

For example, if the category is set to “2 to 4” here, only events in

categories 2, 3, 4 will be displayed. For more information, see “7

Event Log”.

cMT / cMT X Series
Dynamic Category Range is an option available only for cMT Series
models. With this option selected, an address can be designated for

dynamically selecting event categories to be displayed.
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Include categories
() Predefined @ Dynamic categons range
Device : [Lgcal HMI v][ Settings.. |
Address: (LW ~|0 16-bit Mnsigned
Fonge begin: LW-0
Rangeend . LW-1
Display Display settings are only available for Alarm Bar.
MNew Alarm Bar Object IEI
Alarm |S0rt |Secu.rit)r|Shape | Font |
Dizplay
Seroll speed
Multi-line display
Scroll speed
Select one of the speed settings at which the messages scroll.
Multi-line display
Messages can be displayed in multiple lines with this option selected.
Move When this option is selected, the message will move along the alarm
smoothly bar more smoothly. Please note that enabling this may lead to high
CPU loading.
Caption Caption settings are only available for Alarm Display on cMT / cMT X
Series.
Caption
e caption
Font size : |16 - Color : :]
Name
Caption Caption
Option
button Show or hide the option button
visibility (cMT .
Predefined
/ cMT X .
Series) Select [Enable] to show the option button.
Dynamic
COption button vidbility
) Predefined @ Dryenic
Device : [Local HMI &
Address: |LB ~| 0

Designate a bit address to control option button visibility.
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Sort Tab
Alarm Bar Alarm Display
New Alarm Bar Object (23] New Alarm Display Object
[Alem | Sort  |Secwity | Shope | Font | [General [ Alerm | Sot | Tifle [ Secuwsity [ Shape | Fomt |
Format Format
Sort Sort
Onlet Oer: [Ascending = Sortbi:
Order & Characters Onder & Characters
Display items Display order Display items Displaych... » Display order
= Tﬁ:n:w :ﬂ Tﬁ:n;w 0 Mesge
7] Message @ [V] Message 20 i @
[] Occurrence count 0 [=
(v] [] Elapsed time 0 (v]
[ Prioxity level 1}
[7] Category 10
B Subsbgy | 1 ¥
*Each column width is determined by: "Display chars" * (width of the character %)
* Set "Display chars” to 0 to autofit column width to the contents. (Exception: Event
message)
Date: [MMDDAYYY v Tue ! [HEMMSS  ~] Dete: [MMDDRYYY v Tue ! (HEMMSS v
[ ok [ cancel |[ teb | [ ok [ cancel ][ Heb
Setting Description
Order (Alarm Time ascending
Bar) Latest event is placed last in the list (the bottom).
Time descending
Latest event is placed first in the list (the top).
Order (Alarm Sort by:
Display) Ascending — Priority Level (cMT / cMT X Series)
Event with highest priority level is placed last in the list (the
bottom).

Descending — Priority Level (cMT / cMT X Series)

Event with highest priority level is placed first in the list (the top).
Ascending — Occurrence Count

Event with highest occurrence count is placed last in the list (the
bottom).

Descending — Occurrence Count

Event with highest occurrence count is placed first in the list (the
top).

Ascending - Time
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Latest event is placed last in the list (the bottom).
Descending - Time

Latest event is placed first in the list (the top).

Display order

Select the items to be displayed and use the up and down arrow
buttons to adjust the display order of the alarms.

Date Displays the date tag with each alarm message. The four formats of
date tag:
MM/DD/YY ~ DD/MM/YY ~ DD/MM/YY ~ YY/MM/DD
Time Displays the time tag with each alarm message. The four formats of
time tag:
HH:MM:SS ~ HH:MM ~ DD:HH:MM ~ HH
Title Tab

New Alarm Display Object [

[General | Alarm [ Sort | Tifle  [Secuity | Shape | Fomt |

Headers
[¥] Use headers

Column Header text
Tigerine | T o
Mo e
_ Occurrence count
Bagiine. | Eeped e

[ OK ][ Cancel ][ Help ]

Title settings are available on cMT Series. With [Use headers] selected, the text color and

column headers can be configured.
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Security Tab
Alarm Bar Alarm Display
New Alarm Bar Object (=] Alarm Display Object's Properties (=
[Alarm [Sort | Secusity |Shape | Font | [General | Alarm | Sort | Security [Shope | Fomt | Profils |
User restriction Enable/Disable
Object class : [None v [V] Use register statustvalue
*If the vser tries to operate on an object without authorization, LB-12056 will be set to Device : [LocalHMI v][ {a ]
ON. Address: [LB +]0
Enable if bitis :
Action : Do nothing when disabled v
User restriction
Object class : [None v]
*If the user tries to operate on an object without authorization, LB-12056 will be st to
ON.
[ oK ][ Cancel H Help l [ OK ][ Cancel H Help
Setting Description
Interlock When [Use interlock function] check box is selected,
whether the object is operable is determined by the
state of a designated Bit address. As shown in the above
settings, if LB-0 is ON, the object is operable.
Hide when disabled
When the designated Bit is OFF, the object will be
hidden.
User Set the security class of the object to be operated by an
restriction

authorized user.
Object class

“None” means any user can operate this object. Only

account “admin” can operate “Administrator” object

class.
Make invisible while protected

When the user's privilege does not match the object

class, the object will be hidden.

When this check box is deselected in Alarm Display
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Objects
object settings, the unauthorized user can see the Alarm
Display object, but cannot trigger the object or make any
change.
This check box is greyed out in Alarm Bar object settings.
Font Tab

Set the font size or select [ltalic].

New Alarm Bar Object (==
Alarm | Shape | Font
Attribute
[¥]1talic

The font, color, and content of the alarm messages displayed in Alarm Bar and Alarm Display

objects are set in Alarm (Event) Log object:

Event (Alarm) Log @
General | Message
Text
Content : Event 1: press once to acnowledge -
[ use label library Label Library...
Font: Arial -
Color : I | ~

i- Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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13.22. Event Display

13.22.1. Overview

13-164

Event Display object is used to display event messages which are defined in Event (Alarm) Log

and have met a trigger condition. The triggered events are displayed in the chronological order.

Event Display object displays: the date and time the event occurs, the time the event is

acknowledged, the time the event returns to normal, the event message, the occurrence count,

and the elapsed time. Multi-lined messages can also be displayed.

812013106 2200345 Event 3 (when LB11 = ON) -
6 rsiiEme T zmemas T Event 1 (When LW § 5= 10)
5 12/13/06 22:03:12 Event 0 {when LW0 == 100)
4 12/113/06 22:02: 57 Evant 3 (when LB11 = ON) =
3 12/13106 22:02: 56 22:03:04 Event 2 (when LB10 = ON)
2 1211306 2202856 220258 Fvanf 1 iWhan LW 1 5= 10) ﬂ
i Q72710 f4:32:86 14:32:57 14:32:5% Eventi
IWos<2 |
____________________________________________________________________________ Muiti-text

13.22.2. Configuration

l:.IIII

Click [Data/History] »[ Event Display] icon on the toolbar to open an Event Display object

property dialog box. Set up the properties, press OK button, and a new Event Display object

will be created.

I__| WE!NTEK

EasyBuilder Pro V6.07.02



Objects

General Tab

13-165

13.22.2.1. eMT, iE, XE, mTV Series
New Event Display Object New Event Display Object = J
General | EventDisplay | Sort | Security | Shape [ Font | Empty Waming| m[EvemDisp]ay]Son ]Secuxity]Shape l Font [Empty Wming]|
Comment : Comment -
Mot [Real-ﬁme vl Mode : [Hx.sﬁm'y v]
[V] Refresh data antomatically
Acknowledge
Device : [Local HMI ~CE &
Address: |[LW ~|0 }lﬁ-hitUnﬁgned
Event management
[V] Enable Event management
Device : [LocalHMI v“ e e [ Ensble E}
Address: LW v|0 |16-bit Unsigned Device : [LocalHMI '][ e ]
Serolling control Address: LW ~|0 16-bit Unsigned
(V] Ensble Serolling control
Device : [LocalHMI v] “ [V] Enable
Address: [LW 0 o lnsicned Device : [Locsl HMI 9| e te)
Address: |LW ~|0 16-bit Unsigned
History control
Usage..
Device : [Local HMI B et
Address: [LW v|0 Tnsigne
[¥] Enable reading multiple histories
Mode : Number of days (max. 90 days) -
[Cox [ cancel [ e [ ok [ cancel |[ Hebp
Setting Description
Mode The available modes are: [Real-time] and [History].
® Real-time
All the events triggered since HMI starts up are displayed.
® History
The system reads the event log in HMI memory and displays
them. The content can be updated by changing window. In case
when the trend display shows history data from today, the
display will refresh once per second.
Acknowledge When in Real-time mode and an event is acknowledged by touching
an active display line, the [Acknowledge value] specified in Event
(Alarm) Log object, Message tab, is output to the [Acknowledge
address] of Event Display object. For more information, see “7 Event
Log”.
Acknowledge value for Eventfalarm Display object
Acknowledge value @ 11
History When in History mode and if:
Control ® [Enable reading multiple histories] is not selected
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The history files are sorted by date and each file is given an index.
The latest one is assigned index 0 (in most cases: today), the second
latest file is assigned index 1, and so on. The history control address
is used to specify the history file to be displayed.

If control address is LW-100, and four files exist with dates:
EL_20100720.evt, EL_20100723.evt, EL_20100727.evt, and
EL_20100803.evt.

The index value given to each file is shown below:

Value in LW-100 The corresponding file
0 EL_20100803.evt
1 EL_20100727.evt
2 EL_20100723.evt
3 EL_20100720.evt

® [Enable reading multiple histories] is selected

Displays a list of events triggered in multiple days. The display range
is formed by two consecutive addresses. Please note that the history
control address is defined differently in “Number of days” mode and
in “Index of the last history” mode.

Number of days

Suppose the history control address is set to LW-n, then:

[LW-n]: The start day index (which is expressed as the number of

days before today. 0: today, 1: yesterday, and so on.)

[LW-n+1]: The total number of days to display. The days are
calculated backward from the start day.

Example: If today were 2010/6/10, and LW-n = 1, LW-n+1 = 3, then
the data range will start from 1 day before today, which is 20100609
(yesterday), and include data for 3 days: 20100607~20100609.

[EIEL_20100604 No.4 1KE EVT
[EEL 20100605 No.3 6KE EVT
EL_20100608 No.2 ITKE EVT
[FIEL_20100609 4KE EVT
FTEL_20100610 No.0 12KB EVT

Index of the last history

Suppose the history control address is set to LW-n, then:

[LW-n]: The index value of the file to start. O: the latest file, 1: the
second latest file, and so on.

[LW-n+1]: The index value of the file to end. The specified value
must be greater than that of the start index.

Example: If LW-n =1 and LW-n+1 = 3, then file No.1, No.2, No.3 will

be displayed.
[EIEL_20100604 No.4 1KE EVT
' No.3 6KE EVI
No.2 17KE EVT
[EAEL_20100609 No.1 4KE EVI
[EUEL_20100610 No.0 12KB E¥T

The maximum size of data that can be displayed is 4MB. Data
exceeding the limit will not be displayed.
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The following shows how data will be displayed according to data
size.

5 history data, each is 0.5MB - Data displayed: 8 x 0.5MB

5 history data, each is 1IMB - Data displayed: 4 x 1IMB

5 history data, each is 1.5MB - Data displayed:

2 x 1.5MB+1 x 1MB (partial)

¥

= Click the icon to download the demo project. Please confirm
your internet connection before downloading the demo project.

Event Enable event management
management If this check box is selected, writing a specific value into register
LW-n and LW-n+1, where n is an arbitrary number, will control [Event
Display] object with different commands as shown below:
Address | Value | Command
LW-n 0 Display all events.
1 Hide [Confirmed] events.
2 Hide [Recovered] events.
3 Hide [Confirmed] or [Recovered] events.
4 Hide [Confirmed] and [Recovered] events.
LW-n+1 |1 In real-time mode, delete a single selected
event.
Scrolling If enabled, the value in the designated control address indicates the
control number of lines to be scrolled down. The minimal value is 0, which

indicates the first line.

In the following figure, there are 10 events recorded in the object,
and value 3 is set at the control address. The upper event object
displays the events in time ascending order, and begins at the 4t
event; on the other hand, the lower one displays the events in time
descending order, and begins at the 7t" event.

4 18:48:19 Test Event
5 18:48:19 Test Event
evenilEg 6 1814820  TestEvent
7 18:48:20 Test Event
8 18:48:20 Test Event
Scrolling
Control
7 18:48:20 Test Event
6 18:48:20 Test Event
5 18:48:19 Test Event
4 18:48:19 Test Event
3 18:48:19 Test Event

If [Scrolling control address] is enabled, the scroll bar cannot be used
for scrolling, but still shows the relative position of the content. If the
control address holds a value that is larger than the total number of
lines, the display will stroll to the end. Please note that with this
address enabled, the horizontal and vertical scroll bars will not be
available on the object; please make sure that the width of the
object is enough for completely showing the content.
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El Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.

13.22.2.2.

cMT, cMT X Series

13-168

Event Display Object's Properties New Event Display Object @
General | Event Display [ Sort [ Secusity [ Shape [ Font [ Profile | | General | Event Display ] Sort ] Security | Shape | Font | Empty Warning |
Comment : Comment :
[Real-time ¥
Mode : [Hi&tory 'J
Acknowled g address [V] Refresh data automatically
Device : (Local HMI -C@
Address: |[LW v|0 16-bit Unsigned
Event management
[V] Enable Usage...
Device : (Local HMI B e
Address: |LW |0 16-bit Unsigned
Serolling control address Aerollig bonkol a
[] Enable [V Enable
Device : [Luce.lHMI ,] = | Device : [Local HMI vJ {s
Address: [LW ~|0 16-bit Unsigned Address: |[LW |0 16-bit Unsigned
History control
Usage...
Device : [Local HMI @
Address: |LW v|0
[7] Enable reading multiple histories
Mode : [Number of days (max. 90 days) v]
o J[ concad [ _Hep ] [ ox ][ cancel ][ e |

Setting Description
Mode The available modes are: [Real-time] and [History].
® Real-time
All the events triggered since HMI starts up are displayed.
® History
All events are displayed.
Scrolling If enabled, the value in the designated control address indicates the
control number of lines to be scrolled down. The minimal value is 0, which
address indicates the first line.
History When in History mode and if:
Control ® [Enable reading multiple histories] is not selected

The history files are sorted by date and each file is given an index
which is expressed as the number of days before today. O: today, 1:
yesterday, and so on. The history control address is used to specify
the history file to be displayed.

® [Enable reading multiple histories] is selected

Displays a list of events triggered in multiple days. The display range
is formed by two consecutive addresses. Please note that the history
control address is defined differently in “Number of days” mode and
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in “Specific days” mode.
Number of days
Suppose the history control address is set to LW-n, then:

[LW-n]: The start day index (which is expressed as the number of

days before today. 0: today, 1: yesterday, and so on.)

[LW-n+1]: The total number of days to display. The days are

calculated backward from the start day.

Specific days

Suppose the history control address is set to LW-n, then:

[LW-n]: The start day index. O: today, 1: yesterday, and so on.

[LW-n+1]: The end day index. The specified value must be greater

than that of the start day index.

Example: When start = 4 and end = 7, the specified days will be 4

days before to 7 days before.

For cMT / cMT X Series, all the events that occurred are displayed and updated in real-time.

Press the Option Button

" in the upper-right corner of the object and set the start and

end date. If the dates are not set specifically, all the events are displayed.

T

16:21:07
16:21:08
16:21:09

Event 0
Event 0
Event 0

Cancel

Include Categories

Begin Date
2021-02-09

Ended Date
2021-02-09

EVENT DISPLAY SETTING
Show triggered events
Show confirmed events

Show recovered events

Option

Done

0-255

)

LSRR
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cMT / cMT X Series eMT, iE, XE, mTV Series
NewiEvent Bsplay Object New Event Display Object =]
W Sot | Tite | Secusity [ Shape | Font | | General | EventDisplay |Sort | Security [ Shape | Font | Empty Warning|
oy Display
Style : [Coystal - Styie color : [ .. Acknowledge style :
e Max. eventno. : 200
Include categori
Include categories
© Predefined ) Dymamnic range 0 ~ 255 {see Event (Alam) Log object}
Color -
0 ~ 255 {see Event (Alarn) Log object} [ Tromspavent
- oo (R Sk [
[V] Use caption Select box :
Font size : Color : 9 P
cknowled ge
o T n—
Caption Caption
Retum to noxmal
T mp——
Acknowled ge i
- —
i el Color ;[ .|
Text: [:] Background : | Transparent
Option button visibility
@ Predefined ) Dymamic
[¥] Enable
[ OK ] [ Cancel ] [ Help [ OK J [ Cancel } [ Help I
Setting Description
Include Events in the selected category will be displayed. The categories are
categories set in Event (Alarm) Log object.

For example, if the category is set to 2 to 4 here, only events in
categories 2, 3, 4 will be displayed. For more information, see “7

Event Log”.
cMT / cMT X Series

Dynamic Category Range is an option available only for cMT Series

models. With this option selected, an address can be designated for

dynamically selecting categories to be displayed.
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Include categories
() Predefined @ Dhymamde category tnge
Device [Lgcal HMI v]l Settings. ..
Address - [LW -| 0 16-bit Tisigned

Range begin: LW-0
Range end : LW-1

Acknowledge

style

Select [Click] or [Double Click] to acknowledge each single event.
When an event occurs the user can tap the event line once or twice
to acknowledge the new event.

When acknowledged, the text color of the event will change to the
selected color, and the acknowledge value associated with that event
will be sent to the register designated in [Acknowledge address]. If
the address is set to LW-100, and the acknowledge value is set to 31,
when user acknowledges the event, value 31 is written to LW-100.
This can be used in conjunction with Indirect Window object so that
when an event is acknowledged, the corresponding message window
is displayed.

Max. event
no. (eMT, iE,
XE, mTV
Series)

The maximum number of events to be displayed in this Event Display
object. When the number of the displayed events equals to the set
maximum number, the new coming event will overwrite the latest
event.

Color

Different colors indicate different event states, such as acknowledged,
returns to normal, or selected. The system draws a highlight box
around the latest selected event.

Acknowledge
6 1312:19 Event 1 (When LW 1 >= 10)
S oAsdade Event 2 (when.LB10 = ON) PRaeons
T3 azazas T Event 2 (when LB10=ON) [
2 13:12:14 Event 1 (When LW 1 >= 10)
1. 1312:14 Event 0 (when L W0 == 100}
Sequence no. Return to normal Select box

History background (eMT, iE, XE, mTV)
When using Event Display object and select History mode, the

background color of the history record can be customized.
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New Event Display Object @
\!G%‘ Event Display | Security | Shape | Font |Empty Warning|

Include categories: 0 thra 255 {see Event (Alarm) Log object}

Color
[T Transparent
Frame : [ v Background : v

History background :  IEEEG—_— v

164543 [Evento A
¥
Bl >
Grid Displays a grid of rows and columns in the object. The color of the

grid lines can be selected.
Auto fit short column (cMT / cMT X Series Default style)

The column width automatically adjusts to the size of the content.

Caption (cMT

Available styles are: Default, Crystal, and Flat.

/ cMT X With [Use caption] enabled, the font size, color, and name of the
Series) caption can be specified for Recipt View object.
Option
button Show or hide the option button
visibility (cMT Predefined
/ cMT X
Series) Select [Enable] to show the option button.
Dynamic
Option butbon visbility
) Predefined @ Dymaomic
Davics : [Local HMI |t
Lddresz: (LB ~| 0

Designate a bit address to control option button visibility.
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Sort Tab
New Event Display Object
| Generel | EventDisplay | Sott | Title | Security | Shape | Font |
Format
Sort
Order & Characters
Display items Display ch... ~ Display order

] Sequence no. 0 ‘
[] Triggerdate 0
[¥] Trigger time 0 |E
[] Acknowledge time 0 @
[7] Recovered time 0 i E
[¥] Message 20
[] Occurrence count 0
[7] Elapsed time 0 -

* Each column width is determined by: "Display chars" * (width of the character %7

* et "Display chars” to 0 to autofit column width to the contents. (Exception: Event

message)

Date: |MMDDAYYY  ~ Time : |HH:MM:SS -
[ OK ] ( Cancel ] [ Help ]
trigger date  trigger time notification time return to normal time
0 12/14/06 15:26:21 15:26:31 15:26:36 Event 0 (when LV
2 12114106 15:26:48 Event 2 (when LE
Setting Description
Order Sort by:

Ascending — Priority Level (cMT / cMT X Series)

Event with highest priority level is placed last in the list (the
bottom).

Descending — Priority Level (cMT / cMT X Series)

Event with highest priority level is placed first in the list (the top).
Ascending — Occurrence Count

Event with highest occurrence count is placed last in the list (the
bottom).

Descending — Occurrence Count

Event with highest occurrence count is placed first in the list (the
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top).

Ascending - Time

Latest event is placed last in the list (the bottom).
Descending - Time

Latest event is placed first in the list (the top).

Display order

Select the items to be displayed and use the up and down arrow
buttons to adjust the display order of the events.

Date Displays the date tag with each event message. The four formats of
date tag: MM/DD/YY ~ DD/MM/YY ~ DD/MM/YY ~ YY/MM/DD
Time Displays the time tag with each event message. The four formats of
time tag: HH:MM:SS ~ HH:MM ~ DD:HH:MM ~ HH
Title Tab

New Event Display Object =

| General | EventDisplay | Sort | Tifle | Security [ Shape | Font |

Headers
[¥] Use headers

Column Header text

T e o

[AeknoWldze e Acknowled ge time
_ Recovered time
Memp Mo
_ Occurrence count
Hapeline | Ebye e

Coc ) Lo J[ b

Title settings are available on cMT / cMT X Series. With [Use headers] selected, the text color
and column headers can be configured.
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Security Tab
[ New Event Display Object @
| General l Event Display l Sort ‘ Security | Shape | Font |
Enable/Disable
[V] Use register statusivalue
Device : [Lacal HMI | e |t
Address: |LB v|0
Enable if bitis:
Action : [Do nothing when disabled v]
User restriction
Object class [None ']
*If the vser tries to operate on an object without authorization, LB-12056 will be set to
ON.
[ ok ][ cancel |[ el
Setting Description
Interlock When [Use interlock function] check box is selected,
whether the object is operable is determined by the
state of a designated Bit address. As shown in the above
settings, if LB-0 is ON, the object is operable.
Hide when disabled
When the designated Bit is OFF, the object will be
hidden.
User Set the security class of the object to be operated by an
restriction

authorized user.

Object class

“None” means any user can operate this object. Only
account “admin” can operate “Administrator” object
class.
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Make invisible while protected

When the user's privilege does not match the object

class, the object will be hidden.

When this check box is deselected, the unauthorized

user can see the Event Display object, but cannot trigger

the object or make any change.

Font Tab

In Real-time mode: Users may select Italic font and set the font size. The font is displayed
according to the setting in Event Log object.
In History mode: Users may select Italic font and set the font size, font and color, or tick the
[Font from label library] check box.

Empty Warning

Attribute
Font : | &xial]
Color : | EG—
[C] Font from label library
[ Italic

Size:[16

p
New Event Display Object

(V] Use empty waming
No alarm occurred.

Use label libraxy

1GM]E;mD:;p];yI Security l Shape [ Font ‘ Empty Waming ‘_

Font : (Axial

Color : [N [~ Size : |12

[ Italic

When [Use empty warning] is enabled, the text displayed when no event has occurred can be

specified. This feature is not supported on cMT / cMT X Series models.

¥

= Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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13.23. Data Transfer

13.23.1. Data Transfer (Per-page)
13.23.1.1. Overview

Data Transfer (Per-page) object can transfer values from the source address to the destination
address when the window in which this object is placed opens. The data transfer operation can
be activated by manually pressing the object or by detecting the change of state of the
designated bit.

@ Note

B When Data Transfer (Per-page) object in Bit-Trigger mode is placed in the common
window, it activates data transfer operation once the specified condition is met,
regardless of the current base window.

13.23.1.2. Configuration

4

Click [Object] » [Data Transfer] » [Data Transfer (Per-page)] icon on the toolbar to open the
property dialog box. Set up the properties, press OK button, and a new Data Transfer (Per-page)

object will be created.
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General Tab

e

New Data Transfer (Per-page) Object @

General lSecutity [ Shape ILabel |

Comment :
Attribute

Mode : [ Touch trigger v

[ Activate after button is released

No.of word : |

Source

Device : [Local HMI &)

Address: |LW v 0

Destination
Device : [Local HMI - <8

Address: |[LW v 0

Notification
[¥] Enable () 8etON @ Set OFF
[ Follow {set ON when data transfer starts)

Device : [Lacal HMI ~ <

Address: |LB v 0

[ OK ][ Cancel ][ Help ]

Setting Description

Source )
Data Transfer object reads the data from [Source Address].
address

Destination ) . o
Data Transfer object writes the data to [Destination Address].

address

Attribute No. of word
Enter the number of words to be transferred. Unit: word.
Mode
Touch trigger
Press the object to activate data transfer operation.
External trigger
The data transfer operation is activated when the state of the
designated bit address changes.
There is a further selection to make of whether the data transfer
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operation is activated after OFF to ON, ON to OFF transition, or at
both of the changes of state.

Trigger . . :
Specify a bit address for [External trigger] mode.

address

Notification When enabled, the system will set the designated address ON or
OFF when it’s ready for data transfer.
Follow

The notification bit will reset to its original state once the system
starts data transfer.
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13.23.2. Data Transfer (Global): Time-based
13.23.2.1. Overview

Data Transfer (Global) object in Time-based mode can transfer data from the source address to

the destination address based on a time schedule.

13.23.2.2, Configuration

't
Click [Object] » [Data Transfer] » [Data Transfer (Global)] icon on the toolbar and open the
Time-based tab. Click [New] and set up the properties, press OK button, and a new Data
Transfer (Global) object will be created.
cMT / cMT X Series

Data Transfer (Global)

[ Mew... ][ Delete ] [ Settings. ..
eMT, iE, XE, mTV Series

Data Transfer (Global)

Time-based ‘

[ New... ” Delete ][Setﬁngs...
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General Tab

Click the [New] button in the Data Transfer management dialog box.

Data Transfer (Time-based) (=224
[ General ‘
Comment :
Attribute
Address mode : Intervel : (3.0 second(s) =
No.of bit: 1
[V] Active only when designated window opened
[4. Common Window -
Source
Device : Local HMI -l 13
Address: LB v|0
Destination
Device : [Local HMI B et
Address: |LB v|0
Notification
[V Enable ) SetON @ Set OFF
[ Follow {set ON when data teansfer starts)
Device : [Local HMI -GS
Address: |LB v 0
[ OK ] [ Cancel ] | Help I
Setting Description
Attribute Address mode

Select the data type to be transferred from [Bit] or [Word].

No. of bit /No. of word

When [Bit] is selected in [Address mode], set the number of bits
transferred each time when data transfer is triggered.

When [Word] is selected in [Address mode], set the number of
words transferred each time when data transfer is triggered.
Interval

Select the time interval of data transfer; for example, when 3
seconds is set, the system will transfer data every 3 seconds.
Specifying a shorter time interval or a greater amount of data to
transfer may decrease overall system performance; therefore, a
longer time interval or a smaller amount of data to transfer is
recommended.

When a short interval is inevitable, please at least set an interval
longer than the time needed for data transfer operation; for
example, when the data transfer operation takes 2 seconds, the
interval must be longer than 2 seconds.
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Activate only

when
. Data Transfer object transfers data only when the designated
designated ) )
. window is opened.
window
opened
Source ]
Data Transfer object reads the data from [Source Address].
address
Destination ] ) o
Data Transfer object writes the data to [Destination Address].
address
Notification When enabled, the system will set the designated address ON or
OFF when it’s ready for data transfer.
Follow

The notification bit will reset to its original state once the system
starts transferring data.

I__| WE!NTEK EasyBuilder Pro V6.07.02



Objects 13-183

13.23.3. Data Transfer (Global): Bit Trigger
13.23.3.1. Overview

Data Transfer (Global) object in Bit Trigger mode transfers data from the source address to the
destination address when HMI detects that the state of the designated bit address changes.
This feature is not supported on eMT, iE, XE, mTV models.

13.23.3.2, Operation

“{
C
Click [Object] » [Data Transfer] » [Data Transfer (Global)] icon on the toolbar and open the Bit
Trigger tab. Click [New] and set up the properties, press OK button, and a new Data Transfer
(Global) object will be created.
cMT / cMT X Series

.

Data Transfer (Global)

Time-based | Bit trigger |

1:

[ New... ” Delete HSetﬁngs...
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General Tab
‘ Data Transfer (Bit Trigger) @ ]
General l
Corment :
Attribute
No.of word : 1
Source
Device : Lacal HMI ) EE (&
Address: |[LW v |0
Destination
Device : Local HMI <& S
Address: (LW v 0
Trigger
Device : (Local HMI v <]
Address: |LB v 0 |
Notification
[V] Enable () SetON @ Set OFF
[ Follow {set ON when data transfer starts)
Device : Local HMI | RIS te)
Address: |LB v |0
[ OK ] [ Cancel ] [ Help ]
Setting Description
Source )
Data Transfer object reads the data from [Source Address].
address
Destination ) ] o
Data Transfer object writes the data to [Destination Address].
address
No. of word Set the number of words transferred each time when data transfer
is triggered.
Trigger Set the address that controls data transfer and select the trigger
address mode.
Trigger mode
Trigger data transfer when the state of the designated register
changes from OFF to ON, ON to OFF, or at both of the changes of
state.
Notification When enabled, the system will set the designated address ON or
OFF when it’s ready for data transfer.
Follow

The notification bit will reset to its original state once the system

starts data transfer.
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13.24. Backup

13.24.1. Overview

Backup (Trigger-based) object and Backup (Global) object can transmit recipe data (RW, RW_A),
event log, recipe database, sampling data, and operation log to an external device (SD card,
USB disk), in a specified time range or format. For example, when the event log is saved in a SD
card, a USB disk can be inserted when HMI power is still ON, and use Backup object to copy the
data into USB disk from SD card, and then remove USB disk without turning off HMI power. The
data saved in USB disk can be used on PC for analyzing. When the system is backing up, the
state of system register [LB-9039] is set ON. With [e-Mail] option, information can be sent to
configured email contacts.

Backup (Trigger-based) object is triggered by pressing the object on the screen while Backup
(Global) object runs in the background regardless of screens being viewed. Backup (Global)

object is available only on cMT / cMT X Series models.

13.24.2. Configuration

b B

On the toolbar click [Object] » [File Operation] to find [Backup (Trigger-based)] and [Backup
(Global) objects.

Open [Backup (Trigger-based)] object property dialog box, set up the properties, press OK
button, and a new Backup (Trigger-based) object will be created.

When using a cMT / cMT X Series model, [Backup (Global)] object is available. Open [Backup
(Global)] object managing dialog box, click [New] to open the object property dialog box, set

up the properties, press OK button, and a new Backup (Global) object will be created.
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General Tab

Backup (Trigger-based)

cMT / cMT X Series eMT, iE, XE, mTV Series
New Backup (Per-page) Object (23] Backup (Per-page) Object's Properties (23]
Genersl | Security | Shape | Label | General | Advance | Security | Shape | Label | Profile |
Comment : Comment :
File source : | Historical data sampling - File source : | Historical data sampling B
Data Sampling object index : [1‘ v l Data Sampling object index : [ 1. v]
Backup position Backup position
© USB disk e-Mail © USBdisk 1 ) USBdisk 2 e-Mail
*Use LW-9032~9039 to change the backup folder name. Remote printer/backup server

*TTse LW-9032~9039 to change the backup folder name.

* To vse [Remote printer/backup server] to store data to a remote PC, enable the server in
[Printexr/Backup Server] page of [System Parameter Settings] dialog first.

Storage format Storage format
Format : [Comma Separated Values (*.csv) v] Format : [eMTD{EIiEJiPhnTV SERIES Data Sampling File (*dt]) v]

& Add BOM (Byte Order Mark) to file header for EXCEL can interpreting non-ASCII

strings correctly
[¥] Include time information Include millisecond {ms) information

Range Range
Start: © Today © Yesterday Start: © Cument ) Previous

Within : (30 day(s) - Within: (411 (max. 90 files) -
Trigger Trigger

Mode : [Tow:h trigger v] Mode : [Toux:h trigger v]

[¥] Activate after button is released [7] Activate after button is released
*LB-9039 indicates the status of file backup activity (backup in process if bit is ON). *LB-9039 indicates the status of file backup activity (backup in process if bit is ON).
(o J[ concel J[ tep | Coc ) D ) [ ven )

Backup (Global) cMT / cMT X Series

| Backup (Global)

General

Comment :
File source : | Historical data sampling )
Data Sampling object index : [14 v l
Backup position
© USB disk e-Mail

*Use LW-9032-9039 to change the backup folder name.

Storage format
Format : [Comma Separated Values (Xcsv) ']

& Add BOM (Byte Order Mark) to file header for EXCEL can interpreting non-ASCII

strings correctly
[¥] Include time information [ Inchude millisecond (ms) information
Range
Start: © Today © Yesterday
Within : (90 day(s) -
Trigger
Mode : (Extemal trigeer (bif) -]
Condition : [QFF--0N +| []Follow (set OFF when backup finished)
Device : [Local HMI ~EGE)
Address: |LB ~|0

*LB-9039 indicates the status of file backup activity (backup in process if bit is ON).

[oc J[ concel J[ rnep |
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Setting Description
Source [RW], [RW_A], [Recipe database], [Historical event log], [Historical
data sampling], [Operation log], [SQL Query]
Select one from the above for the source. When backing up
[Historical data sampling], use [Data Sampling object index] to select
the one to back up.
Options other than RW, RW_A will be available only when they are
used in the project file.
cMT / cMT X Series:
File soume : lOpemtinn Log v]
[ Enable checlamm for data inte grity (]
When Operation Log is selected as file source, [Enable checksum for
data integrity] option is provided for using Backup object to generate
a backup file with checksum. EasyConverter can then be used to
examine data integrity.
Backup Select the destination where the source files will be saved to.
position SD card / USB disk

The external device connected to HMI.

Remote printer/backup server (eMT, iE, XE, mTV Series)

To select this, enable MT remote printer/backup server at: [Menu] »
[Edit] » [System Parameters] » [Printer/Backup Server].

Please note that [Operation log] backup can only be saved to Remote
printer/backup server. To save into a SD card or USB drive, please use
the control address of Operation Log object.

&

E-mail

For more information, see “26 EasyPrinter”.

To use e-mail, go to [System Parameters] » [e-Mail] tab to configure
first. And then go to Backup object » [e-Mail] tab to configure the
recipient address, subject, and message.

Save format

Select the desired format to back up the file.
eMT, iE, XE, mTV Series:
® HMI Event Log File (.evt) / HMI Data Log File (.dtl)
® Comma Separated Values (.csv)
The [Event] column is included in the backup file to indicate the type
of the event.
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A B | c | b [ E |
Event |Category Date Time | Message
2013/7/4) 16:12:11 Event A
2013/7/4) 16:12:12 Event A
2013/7/4) 16:12:33 Event B
2013/7/4) 16:12:36 Event B
2013/7/4) 16:12:37 Event B
2013/7/4) 16:12:37 Event B
2013/7/4) 16:12:39 Event B
2013/7/4) 16:12:40 Event B

=R =1 =20 = =1
oo oo oo o o

0 = Event is triggered
1 = Event is acknowledged
2 = Event returns to normal
EasyConverter can be used to easily convert HMI Event Log File (.evt)
and HMI Data Log File (.dtl) to .xls or .csv format.
® SQLite Database File (.db)
cMT / cMT X Series:
® SQlite Database File (.db) (Only for backup to e-mail)
® Comma Separated Values (.csv)
Split by

No split Backup all historical data to the same file.

Date Files are separated according to the date of
historical data.

When [Customized file handling] is used in
Data Sampling, the backup files are
separated in the same way they are by the

rules of customized file handing.

Number of rows Files are separated according to the number

of rows set.

Add BOM (Byte Order Mark) to file header for EXCEL can
interpreting non-ASCII strings correctly.

When back up event log in .csv format, open the csv file in EXCEL. The
BOM (Byte Order Mark) can be added to the file header so that

the .csv file containing non-ASClI strings can directly be opened in
EXCEL. The title, export time, occurrence count, and elapsed time can

be included or omitted in the backed-up .csv file.
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Storage format
Format : [Cu:umma Separated Values (*.cav) "I
Splitby [ Date - |

Add BOM (Barte Oxder Mark) to file header for EXCEL con interpreting non- ARCIT

strings correcthr
[#] Include title [¥] Include export time
Include ocourrence count Include elapsed time
Event This groupbox will be available only when backing up a historical
category event log in CSV format. Two options can be found in this group box:
range All and Partial. Selecting partial and entering “3, 5, 8” in the field will

backup events in categories 3, 5, and 8. Selecting partial and entering
“3-8” will backup events in categories 3 to 8.

Range Historical data sampling
Select a number of files. For example, if [Start] is set to [Current], and
[Within] is set to [5 file(s)], the latest five files in memory will be
backed up.
Historical eventlog
Select a number of days. For example, if [Start] is set to [Yesterday],
and [Within] is set to [2 day(s)], the files obtained yesterday and the
day before yesterday will be backed up. Select [All] to save all files,
and the maximum is 90 days.

Trigger Mode
There are three ways to activate Backup function.
Touch trigger
Touch the Backup object to activate backup operation.
External trigger (bit)
Register a bit device to trigger the backup operation.
Select whether the backup operation is activated after Off to ON, ON

to OFF transition, or at both of the changes of state.

¥

= Click the icon to download the demo project. Please confirm
your internet connection before downloading the demo project.
External trigger (word)

Users can specify the number of days to backup data using [Trigger
address]. [Trigger address] usage (suppose LW-n is used):

LW-n: Will start to back up when the value changes from 0 to 1.
LW-n+1: The start date of backup.

LW-n+2: The number of days for backup. (The maximum: 90 days).
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Objects
Syntax @
LwW-0
Set 1 to trigaer backup activity
LW-1
Define badkup start file
0 current
1: previous
2 : previous of previous
n : and so on
LwW-2
Define badkup range
Unit : file na., max. value : 90
On cMT-SVR, Backup (Trigger-based) object only supports [Touch
trigger] mode but not [External trigger (bit)] and [External trigger
(word)] modes.
:i. Click the icon to download the demo project. Please confirm
your internet connection before downloading the demo project.
Trigger When the state of the designated register is set ON, the backup
address operation is activated. When the backup operation is done, the state

of the designated register is set OFF.

A@ Note

B All history files should have been saved in memory, either HMI memory, USB disk or SD

card. Otherwise, the Backup object will not work.

B The maximum number of days for backup is 90 days.
B When saving files to USB disk or SD card, the capacity of a FAT32 folder depends on the

length of the file names. Fewer files can be saved when the file names are longer.

CfFor cMT / cMT X Series, see “7 Event Log” and “8 Data Sampling” that explain the

mechanism of synchronizing data to external device.

¥

=4 Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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Backup Object's Properties

| General | Advance [Secusity | Shape | Label | Profie |

Serial number (range : 00000 ~ 65535)
[7] Enable

Source

Address : [LW v|0

* For example, when serial number is 123 :
A data sampling file - 20140407 d1l will be backed up to 2014040700123 .41
Anevent log file - 20140407 evt will be backed up to 2014040700123 evt.

Options
[V| Remove old files after backup

PLC name : [Local HMI v] Settings...

Setting

Description

Serial number

If enabled, when backing up history files, a user-defined, 5-digit
serial number can be appended to the end of the file name of the

history data backup.

The serial number is determined by the value in the designated
source address. After backup, the value of this LW address will

automatically increment by 1.

The range of the serial number is 065535

For example, if the serial number is 123, the appended 5 digits will

be 00123.

A data sampling file -20140407.dtl will be backed up as

2014040700123.dtl.

An event log file -20140407.evt will be backed up as

2014040700123.evt.

Options

Remove old files after backup

If selected, the old history files will be removed after backup.

0 Note

B cMT/cMT X Series does not support Advance settings.
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e-Mail Tab
Backup Object's Properties @
[ General | Advance | Security | Shepe | Label | Profile | e-Mail |
[V] 4dd txt extension to the filename to skip the anti-virus detection
Recipients
Subject
Subject : -
Use label library
Message
Opening : -
Use label library
Ending : 7
Use label library
Label Library.. | [Language | -
[ OK J [ Cancel Help
Setting Description
Add .txt
extension to If selected, when sending backup data as an email attachment, the
the filename filename extension .txt will be added to the file name. This
to skip the prevents the mail server or anti-virus software from blocking
anti-virus emails.
detection
Recipients, _ o _
Subject Back up the email address of the recipients, the subject of the
’ email, and the message content.
Message
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13.25. Media Player

13.25.1. Overview
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Media Player object plays video files on HMI. It can, for example, be useful in providing better

instructions onsite to facilitate maintenance.

This object does not work remotely on cMT Viewer.

13.25.2. Configuration

]

Click [Object] » [Media Player] icon on the toolbar to open a Media Player object property

dialog box. Set up the properties, press OK button, and a new Media Player object will be

created.

General Tab

cMT / cMT X (excluding cMT-SVR) eMT, XE
New Media Player Object &S] | [ Mew Media Player Object 52
General [ i i
Preview | Security m
Comment :
Control mode Comment :
_) No control
© Use U control Control address
) Use command control Enable
Resume mode PLC name : [Loml HMI v] Setting...
© Resume previous playback _) Resume after restart Address : 0
Command : (LW : 0 Status: [LW:0 +3
Parameter 1:|LW:0+1 Fileindex : LW :0 +4
Parameter 2: LW :0 +2 Starttime : |LW:0 +5
End time : [LW :0 +6
Update video playing time
Update period : Playing time : |[LW :0 +7
Lo ey Ext. device
© USE disk )50 card @ USE disk Folder name : video
Folder name : video
Attribute
Attribute [ Auto. repeat Background :  |INEG—— | ~
Bt | () —
*(05 version 2012, 11, 12 or later support media player only !
Co J (ot ) | o ) [ cmn ]
Setting Description

Control mode

No control: Disable manual control by user. Video playback starts
as soon as the window opens.
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Use Ul control: Use built-in user interface to control media
playback.

Use command control: Use control addresses to control media
playback.

Resume

mode

Defines where to resume video playback when changing back to a
window with media player. Options include Resume previous
playback and Resume after restart.

Control

address

® Selected

Designate a word register to control the object operations.
® Not selected

No manual control. Video will be played automatically when the
designated window opens.

Command (control address + 0)

Enter a value in the Command register to designate which action is
executed.

Parameter 1 (control address + 1)

Enter a value in Parameter 1 associated with each command action.
Parameter 2 (control address + 2)

Enter a value in Parameter 2 associated with each command action.
Status (control address + 3)

Indicates the status or errors.

File index (control address + 4)

The file number in the designated folder. It is recommended to file
the video name with a number.

Start time (control address + 5)

The start time of the video (second). 0, normally.

End time (control address + 6)

The end time of the video (second). (The time length of the video)
Update video playing time

If enabled, the elapsed playing time of video will be written into
[Playing time] register at a rate set by [Update period] in seconds.
Update period

Update period of [Playing time], range from 1 to 60 (second).
Playing time (control address + 7)

The elapsed playing time of video (Second). Normally between

start time and end time.

Ext. device

Play video files in SD card / USB disk.

Folder name

The folder name of video files stored in SD card or USB disk. Files
must be stored in root directory. Subdirectories won’t be accepted.
(For example, “example\ex” is an invalid directory.)

[Folder name] cannot be empty, must be alpha-numeric, and all in

L—| WE!NTEK

EasyBuilder Pro V6.07.02



Objects 13-195

ASCII character.
Attribute Auto. repeat
When finish playing all the video files, replay from the first file.
Ex: Video 1 > Video 2 > Video 1 > Video 2
Background
The background color of the object.

@ Note

B The data format for control address is 16-bit Unsigned or 16-bit Signed. If using 32-bit
Unsigned or 32-bit Signed, only the previous 16 bits will be effective.

Control command

The following are the settings of different commands.
® Playindex file

[Command] =1

[Parameter 1] = file index

[Parameter 2] = ignore (set 0)

@ Note

B Files are stored with file names in ascending order.
B If the file cannot be found, [Status] bit 8 is set ON.
B Please stop the playing video before switching to another.

® Play previous file
[Command] =2
[Parameter 1] = ignore (set 0)

[Parameter 2] = ignore (set 0)

0 Note

B |f [File index] is zero, the same file is replayed.
B If the file cannot be found, [Status] bit 8 is set ON.

® Play next file
[Command] =3
[Parameter 1] = ignore (set 0)
[Parameter 2] = ignore (set 0)

B |f there are no more files, the index O file is played.
B If the file cannot be found, [Status] bit 8 is set ON.

® Pause / Play Switch
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[Command] =4
[Parameter 1] = ignore (set 0)

[Parameter 2] = ignore (set 0)

® Stop playing and close file
[Command] =5
[Parameter 1] = ignore (set 0)
[Parameter 2] = ignore (set 0)

® Start playing from the designated time
[Command] =6
[Parameter 1] = target time (second)
[Parameter 2] = ignore (set 0)

0 Note

B Parameter 1 (target time) must be less than the ending of time or it plays the last second.

® Forward
[Command] =7
[Parameter 1] = target time (second)
[Parameter 2] = ignore (set 0)

@ Note

B Going forward to the designated second in [Parameter 1]. If the video is paused, the
forwarding action will be started by playing.
B When the designed time is later than the end time, it plays the last second.

® Backward
[Command] =8
[Parameter 1] = target time (second)
[Parameter 2] = ignore (set 0)

0 Note

B Going Backward to the designated second in [Parameter 1], if the video is paused, the
backward action will be started by playing.
B When the designed time is earlier than the beginning time, it plays from beginning.

® Adjust volume
[Command] =9
[Parameter 1] = volume (0 ~ 128)
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[Parameter 2] = ignore (set 0)

0 Note

B Default volume is 128.

® Set video display size
[Command] =10
[Parameter 1] = display size (0 ~ 16)
[Parameter 2] = ignore (set 0)

0 Note

B [Parameter 1 =0] : Fit video image to object size.
B [Parameter 1 =1~ 16]:Magnification from 25% ~ 400% in 25% increments where 1 = 25%,
2 =50%, 3=75% and so on.

@® Status (control address + 3)

When playing a video the system sets [File Open (bit00)] and [File Playing (bit01)] to ON. If the
file cannot be found, or an invalid command is entered, the Command Error bit 08 is set ON. If
the file format is not supported, or a disk I/O error occurs, during playback, the File Error bit 09
is set ON.

15 09 08 02 01 00 bit
|Reserved(a|lO) IOIOI |0 0]

00: File Opened / Closed (0 = closed, 1 = opened)

01: File Playing (0 = not playing, 1 = playing)
08: Command Error (0 = accepted, 1 = incorrect)
09: File Error (0 = accepted, 1 = incorrect)

0 Note

B The figure shows the status value associated with each state:
Stop =0, Pause = 1, Playing = 3

Playing

play command

(1,2,3) stop command toggle pause command
(5) (4)
Finish playing
Stop < Pause
stop command (5)

B [Command], [Parameter 1], and [Parameter 2] are write addresses. All others are read
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only.

Preview Tab

Users can test whether the video format is supported by using the preview function.

New Media Player Object 2

General | Preview

Play I I Stop I I ==

Setting Description

Forward << /

Go forward or backward of the video. (in minutes)
Backward >>

Play / Pause Select to start playing video or pausing.

Stop Stop playing and close the video file. To test another video, please
stop playing the current video first.

Load Select a video to preview.

@ Note

B Only one video file can be played at one time.

B If [control address] is not enabled and [Auto. repeat] is not selected, after finish playing
the first file, the system will stop playing and close the video file.

B If [control address] is not enabled, the system will find the first file in the designated
folder and start to play (in ascending order of the file name).

B |f the file can be previewed, the format is supported. If the video image quality is poor,
please adjust the resolution.

B The supported formats: mpeg4, xvid, flv...etc.

B The recommended frame rate for videos is 30fps.

¥

=4 Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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13.26. BACnet Schedule

13.26.1. Overview

BACnet Schedule helps visualize and access schedule data (Schedule) in BACnet IP controller
with a graphical Ul. This feature is only applicable for cMT / cMT X Series HMI.

MON TUE WED THU FRI SAT
01:00 01:00 01:00 01:00
Low Low Low Low

02:00
Low
03:00 03:00 03:00 03:00
Mid Mid Mid Mid
04:00
Mid
05:00 05:00 05:00 05:00
High High High High
06:00
High

Add BACnet/IP driver into the device list in System Parameter Settings and check whether a
Scudule is contained in the scanned BACnet/IP device or the imported tag file.

Click [Object] » [Time Related] »[BACnet Schedule] icon on the toolbar to open the BACnet
Schedule property dialog box. Configure the parameters and then click OK, a BACnet Schedule
object is created.
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Objects
General Tab
[ New BACnet Schedule Object @ 1
General
Comment :
Device : [ Master BMS Panel v
Address: [(17,1)Schedule v
Option button visibility
©@ Predefined ) Dymamic
7] Enable
[ OK I [ Cancel ] [ Help

Setting Description
Device Select the BACnet/IP device to be read.
Address Select the address tag of the Schedule to be read.
Option
button Show or hide the option button
visibility (cMT .

Predefined
/ cMT X .
Series) Select [Enable] to show the option button.

Dynamic

Oiption button visibility
(7 Predefined @ Dymamic
Device : [Local HMI G &S
Address: |LB ~| 0
Designate a bit address to control option button visibility.
Example 1

After downloading the project to HMI, the HMI will automatically read the schedule settings in

the BACnet IP device as shown below.
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Click . and then select Value Editor to configure the Values table containing these

columns: Name, Value, Data Type, and Color, as shown below.

%, MT Viewer  Simulation )

Option

Default Value
No Name
No Name
No Name
No Name

No Name

Values

Done

i

69b735db775cf3ffff

4deb2d2629a6cbsdb7

69b71d79fd7edfge7aefce

d76dfcab493e

e39ebcf75d35

OctetString

OctetString

OctetString

OctetString

OctetString

OctetString

Click + to add a schedule setting. Click © to refresh schedule data by reading from the

BACnet device.
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e
™, cMT Viewer ( Simulation ) | -E- | (]
@
SUN MON TUE WED THU FRI SAT
00:00 00:00 00:00 00:00 00:00
No Name No Name No Name No Name No Name

As shown in the following screenshot, in a schedule settings window, the Weekday, start time

(From), end time (To), and Value should be configured. Value can be selected from the value

table. (Clicking £ open Value Editor for editing the value table as well.)

(s
., eMT Viewer ( Simulation)

Cancel Option

Weekday

From

To

After the time settings are completed, the values will be written to the corresponding schedule tags

in BACnet device.
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13.27. PLC Control

13.27.1. Overview
PLC Control object can execute commands when it is triggered.

13.27.2. Configuration

it

Click [Object] » [PLC Control] icon on the toolbar to open the PLC Control Object management
dialog box. To add a PLC Control object, click [New], set up the properties, press OK button and

a new PLC Control object will be created.

PLC Control Object

[Local HMI = LB-8999] == Sound control : QFF-=0MN, PLC no response (67 k)
[Local HMI : Lw-100] == Change window (cdlear data after window changed)
[Local HMI : LwW-110] == Write data to PLC {current base window ID)

[Local HMI : Lw-120] == General PLC control

Local HMI : LW-120] => Change window (clear data after window changed

1:
2:
3:
4
5
6

[ MNew... ] [ Delete I [ Settings... I
Click [New] and the following dialog box appears. See “13.27.2.1 Type of Control”.

PLC Control
Comment :
PLC name : [Loal HMI ']
Attribute
Type of control : | Change window i

Change window
[ Active only w Write data to PLC (current base windaw ID)
General PLC control
[T urn on back Back light control {write back)
. Back light control
[Tl use windew r ooy contral
Execute macro program
Trigger address  Screen hardcopy

PLC name :  Local HMI
[ oK ] [ Cancel

ﬁNote

B The [General PLC Control] option is not available for cMT / cMT X Series.

B Triggering [Screen hardcopy] in cMT Viewer will result in files being saved into the USB
disk / SD card connected to the cMT / cMT X HMI. Likewise, the [Back light control] option
in cMT Viewer will control the backlight of the HMI itself.
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B Selecting [Change window] or [General PLC Control] as [Type of control] will require more

than one trigger word (consecutive). Using a user-defined tag PLC will require declaring an

array datatype.

13.27.2.1. Type of Control

® Change window

PLC Control
Comment :
PLC name : [Local HMI ']
Attribute
Type of control [Change window ']
Active only when designated window opened 4, Common Window V]
[ Turn on back light Clear data after window changed

[ Use window no. offset

Trigger address

Address : | Ly v] i} 16-bit Unsigned
[ OK. ] [ Cancel ]
Setting Description

Active only when
designated
window opened

Allow this operation only if a particular screen is displayed.

Turn on back light

The backlight is turned ON when the window is changed.

Clear data after

window changed

Reset the value at trigger address to zero when the window
object is changed. If [Use window no. offset] is selected, this

option will only show when a negative offset is used.

Use window no.

offset

Select the check box and select a window offset, the new
window no. to change to will be the value in [Trigger address]
plus the offset. For example, if [Trigger address] is LW-0 and
offset is set to -10. When the value in LW-0 is 25, the system
will change to window no. 15 (25-10=15). The range of the
offset is -1024 to 1024.

0 Note

B |f [LB-9017] is set ON, the write-back function will be disabled, the new window number is

not written back into a designated address.

Place a valid window number in the designated trigger address to change the base screen to

the new window number. The new window number is written back into the designated
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address.

For example, if current window is window no. 10, and [Trigger address] is set to LW-0,
When LW-0 is changed to 11, the system will change the current window to window no. 11,
and then write 11 to LW-1.

El Click the icon to watch the demonstration film. Please confirm your internet connection

before playing the film.

When the window is changed, the new window number is written back into the address that is

calculated by [Trigger address] and the data format, as shown in following table.

Data Format Trigger address Write address
16-bit BCD Address Address + 1
32-bit BCD Address Address + 2
16-bit Unsigned Address Address + 1
16-bit Signed Address Address + 1
32-bit Unsigned Address Address + 2
32-bit Signed Address Address + 2
64-bit Unsigned Address Address + 4
64-bit Signed Address Address + 4

¥

= Click the icon to download the demo project. Please confirm your internet connection
before downloading the demo project.

® Write data to PLC (current base window)

Each time the base window is changed, the new window number will be written into the
[Trigger address]. If [Use window no. offset] is selected, the window number of the base
window plus the window number offset will be written into the [Trigger address].

® General PLC Control (eMT, iE, XE, mTV)

Transfer word data blocks from PLC to HMI, and vise-versa, and the transfer direction is

controlled by the value in the [Trigger address].

Value in Action

[Trigger address]

1 Transfer data from PLC register 2 HMI RW register
2 Transfer data from PLC register > HMI LW register
3 Transfer data from HMI RW register = PLC register
4 Transfer data from HMI LW register = PLC register
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Four consecutive word registers are used as described in the following table:

Address Purpose Description

[Trigger Determine the The valid values are listed in the

address] direction of data above table. When a new control

transfer code is written into the register,

HMI will start to transfer. After data
transfer is finished, the value will
be set to 0.

[Trigger The size of data The unit is word.

address] +1

to transfer.

[Trigger
address] +2

Offset to the
start address of
PLC register

Assume the value is “n”, where n is
an arbitrary number, the start
address of PLC register is [Trigger
address + 4 + n].

Take an OMRON PLC as an
example:

If [Trigger address] uses DM-100,
[Trigger address + 2] will be
DM-102. If the value in DM-102 is
5, the start address of data source
would be DM-109 (100 +4 +5 =
109).

[Trigger

address] +3

Offset to the
start address of
LW or RW

memory in HMI

Take OMRON PLC as an example:
If set [Trigger address] to DM-100,
[Trigger address + 3] will be
DM-103. If the value in DM-103 is
100, the start address of memory
in HMI is RW-100 or LW-100.

Example 1

To use PLC Control object to transfer 16 words data in OMRON PLC, starting from address
DM-100, to the HMI address, starting from RW-200. The setting is shown below:

1. Firstly, create a PLC Control object, set [Type of control] to [General PLC control], and set

[Trigger address] to DM-10, that is, to use the four sequential registers start from DM-10

to control data transfer.
2. Confirm the data size and the offset addresses.

Set DM-11 to 16, since the number of words to transfer is 16 words.
Set DM-12 to 86, which indicates the address of data source is DM-100 (100=10+4+86).
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Set DM-13 to 200, which indicates the destination address is RW-200.

3. Set DM-10 according to the direction of data transfer.
If set DM-10 to 1, the data will be transferred from PLC to HMI RW register,
If set DM-10 to 3, the data will be transferred from HMI RW register to PLC.

® Back light control (write back)

When [Trigger address] is turned ON, HMI backlight will be turned ON/OFF and [Trigger
address] will be turned OFF. Any touch on the screen will turn the backlight on.

® Back light control

When [Trigger address] is turned ON, HMI backlight will turn ON/OFF and the state of [Trigger
address] will not be changed.

® Sound control

When the state of the designated [Trigger address] changes, the HMI will play the sound
selected from the sound library. There is a further selection determines whether the sound is
played after Off to ON, ON to OFF transition, or at both of the changes of state.

® Execute macro program

Select a pre-defined Macro from the drop-down list. When the state of the designated [Trigger
address] changes, the selected Macro is executed. There is a further selection determines
whether the Macro is executed after Off to ON, ON to OFF transition, or at both of the changes
of state. If select [Always active when ON], the macro will be executed repeatedly. (The
shortest time interval between runs is 0.5 second.)

® Screen hardcopy

PLC Control

Commen it

Device : (Local HML -
Attribute

Type: [Sereen hardcopy hd

Active only when designated window opened

Rotate image 90 degrees

Trigger

Device : | Local HMI &[G
Address: (L8 +|o
Screen hardcopy
Trigger mode : | OFF->0N -
5 sindow
Currentbase window (@ Window no. from register Designate window o,
Device : || gcal HMI el
Address : |LwW >0 16-bit Unsigned
Output to: [USB disk 1 -
| Customized filename handling Settings...
| Crop window Settings...
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When the state of the designated [Trigger address] changes, print the selected screen. If select
[SD card] or [USB disk] as [Printer], a “hardcopy” folder will be generated in the selected
external device for saving the printed screen in JPG format. The name of the JPG files starts
from yyyymmdd_0000.

To print the screen using a printer, go to System Parameter Settings » Model tab and set the
printer.

To print the screen using a remote printer, go to System Parameter Settings » Printer/Backup
Server tab and configure the parameters.

There are three options to specify the source window for hardcopy:

Current base window

Print the base window currently opened.

Window no. from register

Print the window designated by the value in a designated word address.

Designate window no.

Directly select a window to be printed.

Customized File Handling

This feature can be used to customize naming of the folders and the JPG files.

Setting Description

Folder name The folder name can be an alphanumeric name, and
certain half-width symbols are allowed:
l@#5%"&()_+{}'-=;",.

The folder name can also be specified by a naming syntax.
Dynamic format

The folder names can be set by a designated word
address, or by a naming syntax indicating the current
system time. The syntax can be specified by selecting
time buttons or entering the syntax in Format field. The
length limit is from 1 to 25.

Note: Up to 10 layers of folders can be created. The

exceeding layers will be ignored.

File name The way to specify a file name is similar to specifying a

folder name.

Note: If the file name already exists, the system will add

“_0001” to the file name as a serial number. The numbers

of the later files add up until “_9999”. The files after

“9999” will be ignored.

For example, if the three file names exist: “A.jpg”,
“A_0001.jpg”, “A_0003.jpg”. When trigger screen
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hardcopy with the same file name, the coming files will
be named in this order: “A_0002.jpg”, “A_0004.jpg”,
"A_0005.jpg”, and so on.

Crop window
With this option selected, taking a cropped screenshot is possible.

Crop Window x

10. WINDOW_010 hd

LQ, Event bit

Trigger time Message

10:07:29 Event triggered!

x v

OK Cancel

0 Note

B A background printing procedure is performed when the printed window is not the
current base window.

B If the hard-copied window is a background window, its [Direct Window] and [Indirect
Window] objects will not be printed.

o n

B When using a dynamic format name, the system will use a sign as a substitute for

invalid symbols.

B When using a dynamic format name, if screen hardcopy is triggered without specifying
the format first, the system will save the file in the default directory, which is:
hardcopy\yymmdd_0000.JPG

B OncMT/cMT X models, a triggered bit address is reset to its original state automatically,

whereas on eMT/iP/iE/mTV models, the state of a triggered bit address is retained.
i Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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13.28. Scheduler

13.28.1. Overview

Scheduler object turns bits ON/OFF, or writes values to word registers at designated start times.

It works on a weekly basis.

13.28.2. Configuration

il

Click [Object] » [Time-related] » [Scheduler] icon on the toolbar to open the Scheduler

management dialog box, click [New] to open the Scheduler property setting dialog box.

Scheduler

The following two demonstrations explain the usage of Scheduler.
Example 1
A motor is scheduled to power - ON at 9:00 and power — OFF at 18:00, Monday to Friday.
We are using LB-100 to control the motor state. LB-100 will be set ON at 9:00 and OFF at 18:00.
1. Click the Scheduler icon on the toolbar to open the Scheduler management dialog box,
click [New].
2. In[General] tab, select [Bit ON] in [Action mode] and set [Action address] to LB-100.

Scheduler @
General | Time Set | Prohibit

Comment : Scheduler 1

"] Power-OM start/fend action
Action mode

(@ Bit ON () Bit OFF () Word write
Action address
PLC name : [Local HMI v] Setting...

3. In[Time Set] tab, select [Constant].
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Scheduler

| General | Time Set | prohibit |

@ Constant _) Address

[ setting on individual day
Start

9 = HE =

End
Enable termination action

18 = 0 +

: HE )
[sun Mon Tue Wed

HE

2| (HH:MM:55)

[¥]Thu

S| (HH:MM:55)

Fri [[sat

4. Enter [Start] time as 9:00:00 and select Monday to Friday. Do not select [Setting on

individual day].

5. Enter [End] time as 18:00:00 and select [Enable termination action] check box.
6. Click [OK], a new Scheduler object will be created on the [Scheduler] list.

Example 2

A thermal heater is scheduled to heat up to 90°C at 08:00 and cool down to 30°C at 17:00,
Monday to Friday. LW-100 is used to store the set point value.

1. Click the Scheduler icon on the toolbar to open the Scheduler management dialog box,

click [New].

2. In[General] tab, select [Word write] in [Action mode] and set [Action address] to LW-100.

3. Select [Constant] for [Word write value settings] and enter 90 in [Start value].

Scheduler

General | Time Set | Prohibit

X5

Comment : Scheduler 2

Action mode
) BitON

Action address

|| Power-ON startfend action

7 Bit OFF

@ Word write

PLC name : ILgca| HMI

v] Setting...

Word write value settings
@ Constant

Start value : ag

End value : 3p

4. In [Time set] tab select [Constant].

Address 1 |Lw | 100

) Address

16-bit Unsigned

Enter [Start] time as 8:00:00 and select Monday to Friday. Do not select [Setting on

individual day].

6. Enter [End] time as 17:00:00 and select [Enable termination action] check box.

Return to [General] tab and enter 30 in [End value].

8. Click [OK], a new schedule object will be created on the [Scheduler] list.
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Objects
General Tab
Scheduler @
General | Time Set | Prohibit
Comment : Scheduler 2
Power-0N startfend action
Action mode
() Bit ON () Bit OFF @ Word write
Action address
PLC name : [Local HMI v] Setting...
Address :[LW | 100 16-bit Unsigned
Word write value settings
(@ Constant () Address
Start value : ap
Setting Description
Power ON Execute the defined action when the HMI is powered ON.
start/end ® Enabled
action When HMI is powered ON within the scheduled time range, the

start action will be performed automatically. When HMI is powered
ON outside the scheduled time range, the termination action will

be executed.

Inside scheduled range

Start time Power ON End time

[’ [ i

| n I_l

|

|

|

!

Start action Termination action
Outside scheduled range
Power ON Start time End time

S| S

Termination action Start action Termination action

® Disabled

When the HMI is powered ON at a time later than the start time,
the start action will not be performed, but the termination action
will be performed. When the termination action is not defined, the
scheduled range is not recognized and no action is performed.
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Action mode

Choose the action to do at the given time.

Bit ON

At the start time, set the designated bit ON. At the end time, set
the designated bit OFF.

Example: Start time : 09:00:00 End time : 17:00:00

Start time End time
ON : : '
09:00:00 12:00:00 17:00:00
Bit OFF

At the start time, set the designated bit OFF. At the end time, set
the designated bit ON.
Example: Start time : 09:00:00 End time :17:00:00

Start time End time
N 5 e
_I : I_
OFF : : :
09:00:00 12:00:00 17:00:00
Word write

The [Write start value] entered here is transferred to the
designated [Action address] word register at the start time. At end
time, the [Write end value] entered here is written to the [Action
address]. The valued can be entered manually or be set by using
[Address] mode. In [Address] mode, the value in the specified
address is the start value where the value in [Address + 1] is the
end value.

Example: Device address: LW-100

Start time: 09:00:00 End time: 17:00:00

Write start value: 10 Write end value: 0

Use register: If control address is LW-n, then enter 10 in LW-n and
enter 0 in LW-(n+1).

LW-100 10 LW-100 0

09:00:00 17:00:00
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@ Note

B Onlyisan [End time] is set in the [Time set] tab will the [Write end value] box appear.

Time Set

Specify start time and end time. [Constant] allows specifying a date or period and time.

[Address] allows controlling the time by the designated address.

[T setting on individual day

End
[|Enable termination action

Start
9 o0 o0 = (HH:MM:55)
[ sun Man Tue Wed Thu Fri

[T sat

Scheduler @ Scheduler
General | Time Set | prohibit General | Time Set | prohibit
@ Constant () Address () Constant (@ Address

Time setting address

PLC name :[Lccal HMI

v] Setting...

Control : Lw @ 0
Status: w0 +1
Actionmode : [y . +2
Start time {day) : Lw:0 +3
Start time (hour) @ [LW : 0 +4
Start time (minute) @ LW 0 +5
Start time (second) @ LW : 0 +6&
End time (day): Lw:0+7
End time (hour) : LW :0 +8
End time (minute) : LW :0 +2

End time (second) : |Lw : 0 + 10

® Constant
Setting on individual day

If [Setting on individual day] is selected

The same start time and end time can be assigned to different days of the week.

I__| WE!NTEK

Scheduler @I
General | Time Set | prohibit
@ Constant () Address
Setting on individual day
Start
] = : o o 0 2| (HH:MM:53)
) 5un @ Mon () Tue iwed O Thu () Fri () 5at
End
Enable termination action
17 = : |0 H : o | (HH:MM:55)
() 5un CIMon @ Tue CiWed () Thu () Fri () 5at

Start action
09:00

Termination action

Monday |-I

Tuesday
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@ Note

B Start and end time must be entered.

13-215

B Start and end time must be on a different time, or same time but different day.

If [Setting on individual day] is not selected

Start time and end time entered must start and end within 24-hours.

0 Note

Scheduler @
General | Time Set | Prohibit
@ Constant Address
Setting on individual day
Start
9 = o0 = 0 = (HH:MM:5S)
Sun V| Man V| Tue Wed Thu Fri Sat
End
/| Enable termination action
17 : 0 o0 F| (HH:MM:55)

Monday

Start action

Termination action

09:00 17:00

Tuesday

B  Start time and end time must be on a different time, different day.

B If an end time is earlier than a start time, the end action will occur in the next day.

Start date: Monday
Start time: 22:00

End time: 01:00

® Address

Monday Tuesday
o ——
22:00:00 01:00:00

The scheduler object retrieves the start/end time and day of week information from word

registers, enabling all parameters to be set and changed under PLC or user control.

Designated as the top address in a block of 11 sequential registers which are used to store time

setting data.

The format of the 11 word registers should normally be 16-unsigned integer. If a 32-bit word

address is chosen, only bits 0-15 are effective, and bits 16-31 should be written as zero.

The following describes each register.

Control (Time setting address + 0)

When [Control] bit is ON, the HMI will read and update [Action mode], [Start time], and [End

time] values.
15

‘ Reserved (0 fixed)

Bit 0: no action 1: read times/action mode
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B HMI will not regularly read the data from [Action mode] (address + 2) to [End time]

(address + 10). Please turn [Control] ON when the settings are changed.

Status (Time setting address + 1)

When the read operation is completed, Bit0O of this register turns ON. If time data read is out

of range or incorrect in any way Bit01 turns ON.

15

02 01 00
Bit

Reserved (0 fixed)

Bit 00: Status bit: Read operation completed. (0: reading or reading not started. 1:

reading completed.)

Bit 01: Error bit: Start or end time format incorrect. (0: corrected 1: error)

@ Note

B After the scheduler reads the data and the status is turned ON (The value in [Address + 1]
= 01), the control bit must be turned OFF (address = 0). The status bit and error bit will be
turned OFF (1-0) at the same time.

Control Bit
(PLC to HMI)

Data in Registers

(PLC to HMI)

Status Bit
(HMI to PLC)

Error Bit
(HMI to PLC)

1 |6 1 |
DN 1 1
L : <> L :
L) 1] L 1
OFF - . -
D22 LT L2
HMI confirms that Control Bit HMI confirms that Contral Bit:
issetON 1 isget OFF ! ! !
; | : | | | \
—— 3 Read Data . - - - %7 3 ReadData >
Lo 4 v o Vo
| HMI turns Status Bit ON = o
ON P 5[ 1 |8 o
Lo ! P o
DFF ] : : ¥ : [ : i
Lo Lo N
o a 4 o R
i ] ] i i 1
i Error Bit turns ON when 7 | X . |
| Ernor ocours : ' ' k . X
ON Vo |5 B N
Pl : e b
1 L L 1 1
OFF

= Communication delays
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Action mode (Time setting address + 2)
Enable/disable [Enable termination action] and [Setting on individual day]. Whatever the
[Enable termination action] bit is, all the time data, from [Control] to [End time (second)], will
be read.

15 02 01 00

it

Reserved (0 fixed) | 0|0 ‘

Bit 00 Enable termination action (0: Disabled 1: Enabled)
Bit 01 Setting on individual day (0: Disabled 1: Enabled)

@ Note

B If [Enable termination action] is OFF, all 11 registers are still read but end time is ignored.
B [f [Setting on individual day] is ON, make sure that all start end times are entered. If more

than one start / end day bit is ON, and error will occur.

Start/End Day (Start Day: Time setting address + 3, End Day: Time setting address + 7)

Designates which day of week is used to trigger the start or end action.
15 07 06 05 04 03 02 01 00 Bit

| Reserved (0 fixed) I Sat I Fri lThu |wgd lTue ]ManlSur |

Bit 00 Sunday (0: not used 1: used)
Bit 01 Monday  (0: not used 1: used)
Bit 02 Tuesday  (0: not used 1: used)
Bit 03 Wednesday (0: not used 1: used)
Bit 04 Thursday (0: not used 1: used)
Bit 05 Friday (0: not used 1: used)
Bit 06 Saturday (0: not used 1: used)

Start/End Time (Start Time: Time setting address + 4 to + 6, End Time: Time setting address +
8 to + 10)
Hour: 0 — 23 Minute: 0 — 59 Second: 0 - 59

Values outside these ranges will cause error.

@ Note

B 16-bit unsigned integer format must be used; BCD format is not supported here.

B In[Address] mode, [Control] bit should be set after HMI reboots to update scheduler
time.

B When using RW address, [Control] bit should be set after HMI reboots to update
scheduler time. Placing a Set Bit object with [Set ON when window opens] selected in the

common window is recommended, this can retain last settings after HMI reboots.
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Prohibit tab

Before the scheduled action is performed, the HMI will read the specified bit state. If it is ON,

the scheduled start/end action will be skipped. Otherwise, it will be performed normally.

@ Note

End time depends on [Action mode] (address + 2). [Enable termination action] (Bit 00)
and [Setting individual day] (Bit 01) are related:

Setting individual day Enabled Disabled
Enable termination action Enabled Enabled Disabled
Scheduler @
General | Time Set | Prohibit
Prohibit
| Use prohibit function
PLC name : |Local HMI ~| [ Setting...
Address : |1 |0

Action: Set Bit

ON o
Start time: 08:00:00
End time: 08:20:00 OFF
07:50:00

L—| WE!NTEK

Start time

The maximum number of Scheduler objects in a project is 64.
A time schedule applies one action only when the start time is reached.

User set OFF

08:00:00

End time

18:10:00

18:20:00

[Write start/end value] and [Prohibit] bit is read only once before start action. After that,
even to change the state of [Prohibit] bit or [Write start/end value], the end action and
the value written will not be affected. Also, to read data of [Write start/end value] and
[Prohibit] bit, there is a delay of start action due to the communication.
Each time RTC data is changed, scheduler list entries that possess both start and end
times will be checked for in-range or out-range conditions. For in-range, the start action
will occur. If the end action is not set, the new range is not recognized, the action will not

If several Scheduler objects are set to the same start time or end time, the action is
performed in ascending order of the schedule number.
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B In [Time Set] » [Address] mode, the system will read [Control] word regularly. The length
of the period depends on the system.

B In[Time Set] » [Address] mode, when start time and end time is out- range, error occurs
in the set action time. (Note: BCD is not an acceptable format)

B In[Time Set] » [Address] mode, the action will not start up until the first time the time
data is successfully updated.

¥

4 Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.

I__| WE!NTEK EasyBuilder Pro V6.07.02


https://dl.weintek.com/public/MT8000/Project/Part_Sample/Scheduler.zip

Objects

13.29. Option List

13.29.1. Overview

13-220

Option List object displays a list of items that the user can view and select. Once the user

selects an item, the corresponding data will be written to a word register.

There are two forms of this object — [List box] and [Drop-down list]. The [List box] lists all items

and highlights the selected one. The [Drop-down list] normally displays only the selected item.

Once the object is pressed, the system will display a list (which is similar to list box) as shown in

the following figure.

13.29.2. Configuration

=]

Listbox

14 Apr. 2009
13 Apr. 2009
12 Apr. 2009
11 Apr. 2009
10 Apr. 2009
09 Apr. 2009

Drop-down list

14 Apr. 2009 |

14 Apr. 2009

14 Apr. 2009
13 Apr. 2009
12 Apr. 2009
11 Apr. 2009
10 Apr. 2009

Click [Object] » [Option List] icon on the toolbar to open an Option List object property dialog

box. Set up the properties, press OK button, and a new Option List object will be created.
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cMT / cMT X Series eMT, iE, XE, mTV Series
New Option List Object New Option List Object
Option list iSoume data | Mapping I Security | Label | Option list ‘[Souxce daﬁl Mapping I Security | Shape [ Label ‘
Comment : Comment :
Attribute Attribute
Mode : [Drop-down List - Style : [ Classic v Mode : [Drop-down List v Direction : [pgymn -
Backgrownd colox: [T ] Fontsize : |Fixed size = Backgrownd color: [T ]
Selection color : [ T ) Row height : [gmall - Selection color : [ T ]
Monitor Monitor
Device : [Local HMI v] =2 & Device : {Local HMI v] & )&
Address: [LW v|0 16-bit Unsigned Address: LW v|0 16-bit Unsigned
Send notification after writing successfully Send notification after writing successfully
| Enable | Enable
[ OK ] [ Cancel ] i Help [ OK ] [ Cancel 1 ‘ Help
Setting Description
Attribute Mode: The list style, either [List box] or [Drop-down list].

Style: This option is available only when the selected mode is
[Drop-down list]. Available styles are: [Standard] and [Classic]. The
appearance of the obejects will be shown in cMT / cMT X Style
when [Standard] is selected, and shown in iE/eMT/XE style when
[Classic] is selected. When the project is converted from iE/eMT/XE
to cMT / cMT X, the default style will be [Classic].

Item no.: Set the number of items for the object. Each item
represents a state displayed in the list and the corresponding value
will be written to the [Monitor address].

Background: Set background color.

Selection: Set background color for the selected item.

Row height: Set the row height for the drop-down list.

Font size: When [Same size as label] is selected, the font size set in
Label tab will be used for the drop-down list. When [Fixed size] is
selected, the system default font size will be used for the
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drop-down list.
Source of item data: There are 4 sources available: [Predefine],

[Dates of historical data], [Item address], and [User account]. See

13.29.2.1..
Monitor The corresponding value of the selected item will be written to
address [Monitor address].

Write when button is released
If this check box is selected, the selected item value will be written
to [Monitor address] after the button is released.

Send
notification Set On/Off the designated bit address after successfully writing
after writing data to PLC.

successfully

@ Note

B The [write when button is released] option is not available on cMT / cMT X Series models.

13.29.2.1. Source of item data

® Predefine
The list is manually defined in [Mapping] tab.
The number of items can be adjusted by [Item no.], and each item represents one state. Each

item has a corresponding value which will be written to [Monitor address].

® Dates of historical data

cMT / cMT X Series eMT, iE, XE, mTV Series
New Option List Object [Fs=] New Option List Object @
[Option st Source data | Mapping | Secusity | Label | [ Option list| Source data | Mapping [ Secuity [ Shape | Label |
Source of item data : Dates of history data - ] Source of iter data : Dates of history data % ]
Ttemn data from dates of historical data Ttem data from dates of historical data.
Type : DataSam)dmg—v‘ Date : Type : W‘ Date :
Data Sampling object : l 1. = } [¥] Enable [delete history files] function
Control
Device : [Local HMI B et
Adees: LW 0
[f&ddress] : set 1 to delete the selected history data

Option List object can be used with historical data display objects, such as Trend Display object,
History Data Display object and Event Display object to control which history file should be
shown. The figure below is an example of Option List used with Trend Display.
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06/11/09 -

T <] lm% AL AR AL AR LA R ANAR AA LA
oo NI R N VR
06/09/09
06/08/09 =

KR | ies Dasm Diess Dasie Dasss Lot hiss
LIE.] LAL3
Setting Description
Type Two options are available: [Event (Alarm) log] and [Data sampling].
Date Set the date format. YYYY means a four digits year (EX: 2012), YY
means a two digits year (EX: 12), MM means month and DD means
day.
Data Select which Data Sampling object is displayed when [Type] is [Data
Sampling Sampling], and it should be the same as the [Data sampling object
object index] configured in [Trend Display] or [History Data Display].
Enable
[delete If selected, a control address can be set. Writing “1” to this address
history data] will delete the history data of the specified date.
function

@ Note

B In [Dates of historical data] mode, since the system automatically reads the historical data
and finds the date information, it is not necessary to configure in the [Mapping] tab.
B The error message displayed in Option List can be modified in [Mapping] tab.
Ttern Walue Ttemn data
p O fermor) Errox!!
® Item address
The list will be read from the given [Item address] and controlled by [Control address]. The

following options will be available:
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Option List Object's Properties (==
| Option list| Source dats. | Mapping | Security | Label | Profile |
Source of iten data : [Ihem address v]
Control
Device : [Local HMI | e | )
Address: |LW v|0 bt U
[Address] : set 1 to update itemn data [Address] + 1 :item count
Item
[7] Revers: highflow byte The length of each item : 5 word (s)
Encoding : [UTF-8 (Default) -
Device : [Local HMI <G ]S
Address: |[LW ~|0
Setting Description
Control [Address]: If the value at this address is changed to 1, the option
address list would be replaced by items defined at [Item address]. After

updating, the value will be restored to 0.
[Address + 1]: Define the number of items in [Iltem address].

Item address Assign the item address
UNICODE
The item will use UNICODE characters, such as Chinese characters.
The length of each item

Define the number of letters for each item, the unit is Word.

@ Note

B The UNICODE characters used here should be used by Text object, so that EasyBuilder Pro
will compile the needed fonts and download these fonts to HMI, then the UNICODE
letters can be correctly displayed.

B [The number of items] multiplied by [The Length of each item] must be less than 4096
words.

B The system automatically disables [Mapping] tab in [Item address] mode.

&

=a Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.

® User account

If [Enhanced Security] mode is enabled, [User account] would appear in the [Source of item
data] and it lists the names of users.
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Option List Object's Properties (=224)
[ Option list| Source data | Mapping | Secusity | Label | Profile |
Source of item data : LUser account v]
User account
Sort
[7] Ascending [7] Descending
Display
[T Privilege [7] Secret user
Setting Description
Sort Select the sorting method from [Ascending] of [Descending].
Display If [Privilege] is selected, the privileges for each user will be

displayed in option list.

If [Secret user] is selected, even though it is defined to be hidden in
[System parameter settings] » [Security] » [Enhanced Security], the
users will still be displayed in [Option List].

0 Note

B The address that controls user index is [Control Address +2 (LW-n+2)] which is set in

[System Parameters] » [Security] » [Enhanced Security].
Mapping Tab

This table displays all available states/items, their item data and values. To change the number

of available items, please go to [Option list tab] » [Attribute] » [Item no.].
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New Option List Object
| Option list | Source dataj Mapping ‘[Secuxity | Label | Shape |
Item Value Ttem data (A]
0 0
1 1 [i]
2 2
3 3
4 4
5 {errox)
Set default
Import item data from recipe record
Error notification
[T]Enable
[ OK ] [ Cancel ] [ Help
Setting Description
Item The system lists all available items. Each item represents a state
that will be displayed in the list. This field is read-only.
Value Here user can assign value for each item, basing on the following
two criteria:
For reading: If the value in [Monitor address] is changed, the object
selects the first-matched item. If no item is matched, the status
goes to error state and signals the notification bit register (if
requested).
For writing: The system writes this value to [Monitor address] when
user selects an item.
Item data Text displayed for each item. The Option List object displays the

text of all items in the list for users to review and select.

Import item
data from
recipe record

This feature is enabled when select [Recipe-Selection] as [Monitor
address]. Click [Import item data from recipe record] to open the
[Records of Recipe Database] setting dialog box. Select [Item data
source], the data belonging to the selected column will all be
imported to Option List object.
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Select a recipe item ...

Item data source : [NewItem v ]

[ Ok ][ Cancel ]

Before importing, the number of items in Option List changes
according to the number of items defined in Records of Recipe
Database.

After importing, modifying Records of Recipe Database will not

change the content of Option List.

Error state

On error state, the list box removes the highlight to represent no
item is selected and the drop-down list displays the data of error
state. Only the drop-down list uses error state, list box is not able to
use error state.

For example, item number 8 is the error state when specifying 8 in
[Item no.]. (The first item number is 0)

Set default Reset all values or states to default. That is, set 0 for item 0, 1 for
item 1, and so on.
Error The system will set ON/OFF to the specified bit register when error
notification is detected. The signal of the bit register could be used to trigger a
procedure for correcting the error by using objects such as Event
Log, Alarm Bar, or pop-up window.
¥

= Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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13.30. Timer

13.30.1. Overview

Timer object is a switch that can be used to control the mode to count time. The modes are
explained later. Timer object uses the following 6 variables:

Timer Variable Type Description

Input bit (IN) Bit The main switch of Timer.

Measurement bit (TI) Bit Turns ON when the Timer begins
counting time.

Output bit (Q) Bit Activated when the Timer finishes
counting time.

Preset time (PT) Word Presets a time before the Timer
begins counting time.

Elapsed time (ET) Word Displays the elapsed time.

Reset bit (R) Bit Resets the elapsed time (ET) to 0.

13.30.2. Configuration
-
e )
py

Click [Object] » [Time-related] » [Timer] icon on the toolbar to open the property dialog box as
shown in the following figure.

Timer @
Timer
Description @
Input bit (IM)
Mode : [On delay - PLC name : Local HMI ][ setting...
Time base : [0‘ 1 second(s) V] L T
Qutput bit (Q)
PLC name  Local HM ] [Setting... ]
m—| s o
TI— PT | PT Measurement bit (TT)
PLC name :[Lgal HMI v] Setting...
o T o
Elapsed time (ET) Preset time (PT)
Enable | Constant preset time
PLC name : | Local HMI PLC name i[LoaI HMI v] Setting...
Address : 1] 16-bit Unsigned Address : 10 16-bit Unsigned
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0 Note

B [Constant preset time] is only available for cMT / cMT X series.
If use cMT / cMT X Series, clicking the Timer icon on the toolbar will open the Timer managing

window, click [New] to configure.

Timer

[ Mew... ] [ Delete l [ Settings...
® Ondelay
Mode Register

Input bit (IN): The main switch of Timer.

IN— Measurement bit (Tl): Turns ON when the Timer
begins counting time.

TI— PT PT

s T Output bit (Q): Turns ON when the Timer finishes
Q counting time.
1 2 3 4 35

Preset time (PT): Presets a time before the Timer

begins counting time.

Elapsed time (ET): Displays the elapsed time.

Description
Period 1: When the IN turns ON, Tl turns ON and the ET starts counting. The Q remains OFF.
Period 2: When the ET equals to the PT, the Tl turns OFF and the Q turns ON.
Period 3: When the IN turns OFF, the Q turns OFF and the ET is reset to 0.
Period 4: When the IN turns ON, the Tl turns ON and the ET starts counting. The Q remains
OFF.
Period 5: Turns IN OFF before the ET reaches the PT, the Tl turns OFF, and the ET is reset to O.
Since the ET doesn’t reach the PT, the Q remains OFF.
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® Off delay
Mode Register
Input bit (IN): The main switch of Timer.
IN Measurement bit (TI): Turns ON when the Timer
= | | pr | | PT begins counting time.
Output bit (Q): Turns OFF when the Timer finishes
Q— counting time.

Preset time (PT): Presets a time before the Timer

begins counting time.

Elapsed time (ET): Displays the elapsed time.

Description

Period 1: When the IN turns ON, the Tl remains OFF and the Q turns ON, the ET is reset to 0.
Period 2: When the IN turns OFF, the Tl turns ON and the Q remains ON, the ET starts
counting.

Period 3: When the ET equals to the PT, the Q and Tl turn OFF.

Period 4: When the IN turns ON, the Tl remains OFF and the Q turns ON, the ET is reset to 0.
Period 5: When the IN turns OFF, the Tl turns ON and the Q remains ON, the ET starts
counting.

Period 6: Turns the IN to ON before the ET reaches the PT, the Tl turns OFF, the Q remains
ON, and the ET is reset to O,.

® Pulse

Mode Register

Input bit (IN): The main switch of Timer.

IN —I —l_ Measurement bit (T1): Turns ON when the Timer
begins counting time.

Output bit (Q): Turns ON when the Timer begins

Q— — counting time and turns OFF when the Timer

TI— PT PT

finishes counting time.

Preset time (PT): Presets a time before the Timer
begins counting time.

Elapsed time (ET): Displays the elapsed time.

Description

Period 1: When the IN turns ON, the Tl and Q turn ON simultaneously, and the ET starts
counting.

Period 2: When the ET equals to PT, the Tl and Q turn OFF simultaneously. Since IN is turned
OFF when counting time, the ET is reset to O.

Period 3: When the IN turns ON, the Tl and Q turn ON simultaneously, and the ET starts
counting.

Period 4: When the ET equals the PT, the Tl and Q turn OFF simultaneously.
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® Accumulated ON delay

Mode Register

Input bit (IN): The main switch of Timer.

=
—

- Measurement bit (TI): Turns ON when the Timer
TI did il P begins counting time.

I_I Output bit (Q): Turns ON when the Timer finishes
Q || counting time.
1 2 3 453 6 7 Preset time (PT): Presets a time before the Timer

begins counting time.

Elapsed time (ET): Displays the elapsed time.

Reset bit (R): Resets ET to O

Description

Period 1: When the IN turns ON, the Tl turns ON and the elapsed time ET starts counting, the
Q remains OFF.

Period 2: When the IN turns OFF, if the ET doesn’t reach the PT, the Tl turns OFF, and at the
same time the Q remains OFF. The ET is in the retentive state.

Period 3: When the IN turns ON, the Tl turns ON. The timer measurement starts again and
the ET starts counting from the kept value. The Q remains OFF.

Period 4: When the ET reaches the PT, the Tl turns OFF and the Q turns ON.

Period 5: When the IN turns OFF, the Q turns OFF. Turning ON the reset bit R will reset the ET
to 0, and then the reset bit turns OFF.

® Accumulated OFF delay

Mode Register
— R Input bit (IN): The main switch of Timer.
IN T AT Measurement bit (T1): Turns ON when the Timer
i PT J PT l begins counting time.
R4 I 1 B Output bit (Q): Turns OFF when the Timer finishes
Q- [ counting time.

i wis: = £ 1if {miae Preset time (PT): Presets a time before the Timer

begins counting.

Elapsed time (ET): Displays the elapsed time.
Reset bit (R): Resets ETto 0

Description

Period 1: When the IN turns ON, the Tl remains OFF and the Q turns ON.

Period 2: When the IN turns OFF, the Tl turns ON and the Q remains ON. The ET starts
counting.

Period 3: When the IN turns ON, the Tl and Q remain ON, and the ET is in the retentive state.
Period 4: When the IN turns OFF again, the ET starts counting from the kept value.

Period 5: When the ET equals to the PT, the Tl and Q turn OFF simultaneously. Turning ON
the reset bit R will reset the ET to 0, and then the reset bit turns OFF.
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A

Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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13.31. VideoIn

13.31.1. Overview
HMI provides the video In feature that enables users to monitor sites with cameras. The
images/video can also be stored in external devices for further analysis. Sampling applications

include site monitoring, or vehicle/building surveillance...etc.
The following tables show the video input and image capturing behaviors for different models.

cMT-FHD
Other
Model iP iE eMT mTV XE cMT-SVR | cMT-FHDX
cMT/cMTX
cMT-HDM
IP Camera N/A N/A Y N/A Y N/A Y Y
Supported USB Camera N/A N/A Y Y Y N/A Y Y
device type eMT3121A
Video Input N/A N/A N/A N/A N/A N/A N/A
eMT3151A
cMT / cMT X Series — Image Capture/
Model Non-cMT Series — Image Capture
Video Recording
IP Camera Image Capture: one image is captured
at the trigger moment.
Image One image is captured at the trigger moment. Video Recording: video is recorded, for
USB Camera
Capturing a pre-determined duration, around the
trigger moment.
Video Input Several images are captured around the trigger moment.

13.31.2. Configuration

]

Click the Video In icon on the toolbar to open the property dialog box. Set up the properties,

press OK button, and a new Video In object will be created.
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General Tab

eMT, iE, XE, mTV Series

Video Input USB Camera
New Video In (USE Camera) Object New Video In (USE Camera) Object
General General
Comment : Comment :
() USB Camera () IP Camera @ Video Input © USB Camera () IP Camera ) ¥ideo Input
* [USE Camera] can only be used in landscape (horizontal) mode.
*Set LB-12356 to enable web streaming, and then use web browser to view live vn‘leo from
Encode format: NTSC = USB camera. Note that [Video input (USE camera)] cannot be used at the same time.
Capture address Capture address
[¥] Use capture function Use capture function
Device : (Local HMI Y& Device : Local HMI B
Address: [LB ~|0 Address: LB ~|0 |
Storage medivm Storage mediun
©) USB disk () 8D card ©@ 8D cand
Record time
Before : 1 14 ssconds After: 1 24 seconds
Control address Control address
[¥] Use control function Use control function
Display adjustment
Device © Local HMI -C&E Device : Local HMI L@
Address: |[LW ~|0 {16-bit Unsigned Address: |[LW +| 0 | {16-bit Unsigned
Start/stop input : LW-0 Start/stop nput : LW-0
Pause : LW-1
Contrast adjustment : LW-2
Bright adjustment : LW-3
* [USE Camera] with [Pavse Control] requires OF version 20170214 or later.
[ o J[ concel J[ teo | (o J[ concel J[ neo |
IP Camera
New Video In (USB Camera) Objecl =
General
Comment :
() USB Camera ©) IP Camera ) Yideo Input
RTSP:#
[7] Streaming over TCP
Capture address
[¥] Use capture function
Device : Local HMI B
Address: |LB ~|0 |
Storage medium
() USB disk ©@ 8D card
Control address
Tse control function
[¥] Dynamic RTSP URL
Device : [Local HMI V] [
Address: [LW v]0 [ [16-bit Unsigned
Start/stop input : LW-0
Pause : LW-1
RTSP : LW-2 (64 words)
*TURL will be reloaded from R TSP address after object restarts.
* [P Camera] requires OF version 20160411 or later.

o J[ conel J[ reb |

L_I\’WE_!NTEK EasyBuilder Pro V6.07.02



Objects

cMT, cMT X Series

13-235

USB Camera IP Camera
New Video In (USB Camera) Object == New Video In (USB Camera) Object ==
General ‘ General ‘
Comment : Comment :
© USB Camera () IP Camera @ 7 USB Camera © IP Camera
* [USB Camera] can only be used in landscape (horizontal) mode. RTSP -
* Set LB-12356 to enable web streaming, and then use web browser to view live video from
USB camersa. Note that [Video input (USB camera)] cannot be used at the same time.
Capture address Capture address
[V Use capture function [V Use capture function
Device : [Local HMI B x| Device : Local HMI B x|
Address: |LB |0 Address: |LB |0
Record format Record format
9 Video ) Image 9 Video () Image
Storage medinm Storage medinm
@ USBdisk 1 (O USBdisk2 @ USBdisk 1 (O USBdisk2
Record time Record time
Before : 60 & seconds After: 60 & seconds Before : 60 & seconds After: 60 & seconds
Control address Control address
[V Use control function [¥] Use pause control [V] Use control function [V] Use pavse control
[¥] Dynamic RTSP URL
Device : [Local HMI JCE IS Device : [Local HMI JEEE
Address: [LW ~|0 16-bit Unsigned Address: [LW ~|0 16-bit Unsigned
Start/stop input : LW-0 Start/stop input : LW-0
Pause : LW-1 Pause : LW-1
RTSP : LW-2 (64 words)
#*URL will be reloaded from R TSP address after object restarts.
[ OK J [ Cancel J [ Help J [ OK ] [ Cancel ] l Help
Setting Description

Input channel

Select the Video Input channel from channel 1 or channel 2.

(Analog video systems)

Encode
Select the format from NTSC or PAL. (Analog video systems)
format
RTSP Enter the IP camera’s RTSP address.
When account and password are required for accessing the IP
Camera, an RTSP address with credentials embedded can be used.
For example:
admin:admin@192.168.1.119:554/cam/realmonitor?channel=1&subtype=0
Streaming over TCP
Select this check box to stream video over TCP.
Capture Select [Use capture function] check box and configure the settings.
address A non-cMT model can capture images while a cMT / cMT X model

not only can capture images but also can record an avi video from n
seconds before to n seconds after the triggering time of the
designated address.

Capture address

Designate the address that triggers image capturing.
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Storage medium

Designate the storage device.

Information about storage type and input type:

Input Type Storage Type

Analog Input | SD card or USB disk.

USB Camera | SD card only. Exception: cMT3092X

IP Camera SD card or USB disk.

Record time (cMT / cMT X Series)

The camera records the video from and to the specified recording
time (n seconds before and after the triggering time of the
designated address). The video is then saved to the specified
storage device. Please note that after the video is recorded, the
HMI may take a while to compress the video. The time needed for
compressing the video may differ between models depending on
CPU performance. A red dot appears in the object indicating that
recording or compressing is in progress. The HMI will not record
the next video during compression.

Record time (eMT Series)

Set a period of time to capture the images.

System Method

Analog video ® The longest period can be set from 10

system seconds before triggering [Capture address]
to 10 seconds after triggering.

® The time interval of image capturing is once
every second.

® The captured .jpg file will be named in the
following format:
Before or after [Capture address] is
triggered: YYYYMMDDhhmmss.jpg
The moment that [Capture address] is
triggered: YYYYMMDDhhmmss@.jpg

For example, set [Record time] “Before” and
“After” to “5” seconds. When the state of [Capture
address] changes from OFF to ON, the system will
start capturing one image per second, from 5
seconds before the triggering time to 5 seconds
after the triggering time, which is 11 images in
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Objects
total including the one captured at the triggering
moment.
UsB Only the image of the triggering moment is
Camera captured. The name format:
YYYYMMDDhhmmss.png.
IP Camera Only the image of the triggering moment is
captured. The naming format:
YYYYMMDDhhmmss.png.
i Click the icon to download the demo project. Please confirm your
internet connection before downloading the demo project.
Control If enabled, enter certain value to the control address and the
address following addresses can control Video Input object. For example, if

the designated control address is LW-n (n is any address), enter
certain value to the designated addresses will execute commands

as the following table.

Analog Video Systems

Address | Value | Command
LW-n 0 Stop displaying image

1 Open channel 1 and display the
image on HMI

2 Open channel 2 and display the
image on HMI

3 Open channel 1 but don’t display the
image on HMI (Capture function
operable)

4 Open channel 2 but don’t display the
image on HMI (Capture function
operable)

(W-n+1 |1 Pause / resume the video
LW-n+2 | 1~100 | Adjust the contrast ratio
(Analog video systems only)
LW-n+3 | 1~100 | Adjust the brightness
(Analog video systems only)
USB Camera / IP Camera
Address | Value | Command
LW-n 0 Stop displaying image
1 Start displaying image
LW-n+1l |1 Pause / resume the video
LW-n+2 | string | RTSP address for IP camera (64
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‘ ’ words) ‘

® After changing the value in [Control address (LW-n)], the
system will keep the new value.

® After changing the value in [Control address + 1 (LW-n+1)],
the system will execute the command and then reset the
value to 0.

® [f [Use control function] check box is not selected, the system
will play the image of the selected channel.

® [f [Display adjustment] check box is selected, the contrast

ratio and brightness can be adjusted. (Analog video systems)

@ Note

B Only one channel can be opened at a time, regardless of the type of camera used.

About analog video systems:
B Real-time images can still be captured when Video In is paused.
B Recommended analog video systems and resolutions:

1:1 50%
NTSC 720 x 480 360 x 240
PAL 720 x 576 360 x 288

+

=4 Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.

About cMT / ¢cMT X Series Video Recording

B Compressing the recorded video may take a period of time depending on the video
length.

B When HMI is compressing a video, it will not record new video even if the designated
address is triggered.

About USB Camera:

B USB camera cannot be viewed on cMT Viewer.

B When the USB Camera is disconnected during video playing, video will not resume when
camera is connected again. If [Control address] is used in the project, please use the
control address to stop and restart video. If [Control address] is not used, switch to
another screen and then return, or restart HMI in order to resume the video.

B The maximum size of Video In object of eMT3070A is 340*240, as for eMT3105P,
eMT3120A, eMT3150A, XE, and mTV Series, the maximum size of Video in object is
640*480.

B When using a USB Camera, the display resolution of the run-time video is determined by
the resolution supported by the USB Camera that is closest to the size of the object. The
resolution supported by the USB Camera may not be identical to the size of the object.
Therefore, it is good practice to adjust the size of object according to the actual resolution
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of the video.

B When using a USB Camera, the right and bottom edge of the Video In object will keep a
distance of 50 pixels away from the window edge to prevent the run-time video from
exceeding the window.

B When using a USB Camera, the background color of Video In object is black. If the
resolution of the run-time video is smaller than the object, the empty area is colored
black. Therefore, it is good practice to adjust the size of object according to the actual
resolution of the video. The tested and available USB Cameras are: Logitech C170,
Logitech C310, Logitech €910, LifeCam VX-2000.

E Click the icon to watch the demonstration film. Please confirm your internet connection
before playing the film.

& Click the icon to download the demo project. Please confirm your internet connection
before downloading the demo project.

About IP Camera:

B Viewing IP camera on cMT Viewer may be possible on a Windows PC, provided that
appropriate third-party codecs are used.

B As compatibility may vary, testing with an actual device is recommended.

B ARTSP address is required for using IP camera. The RTSP address can be found in the
configuration tool of the IP camera, or possibly from an online repository.

B When the IP Camera is disconnected during video streaming, video will not resume when
the camera is connected again. If [Control address] is used in the project, please use the
control address to stop and restart video. If [Control address] is not used, switch to
another screen and then return, or restart HMI in order to resume the video.

B When using an IP camera, the display resolution of the run-time video will be same as
that of the object drawn in the EasyBuilder Pro project. If the actual video resolution is
different from the size of the object, the resolution will be adjusted to fit the object,
which may cause distortion of video image. Therefore, it is good practice to adjust the size
of object according to the actual resolution of the video.

B Use the IP cameras that comply with ONVIF standard, and use RTSP for video streaming.

B To ensure the quality and smoothness of the video, and not to affect HMI’s general
performance, adjust the settings of IP camera when video lags or high CPU loading is
observed. As the project complexity and hardware specs vary from one case to another,
please fine-tune the video parameters accordingly.

B Recommended video specification:

Resolution 960x544 (max.)
Format H.264, MJPEG
Refresh Rate 15 fps
Transmission Speed 800kbps (max.)

Z. Click the icon to download the demo project. Please confirm your internet connection
before downloading the demo project.

E Click the icon to watch the demonstration film. Please confirm your internet connection
before playing the film.
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13.32. System Message

13.32.1. Overview

If objects use [Display confirmation request] or [local HMI supports monitor function only] is

turned on/off, the corresponding messages configured here will be displayed in pop-up

message boxes.

13.32.2. Configuration

Click the System Message icon on the toolbar to open the setting dialog box.

System Message

System Message

Confirmation reguired
Dialog size : @ small ) Middle ) Large

Message : Please confirm the operation

Use abel library

OK: 0K

Use fabel library

Cancel : Cancel

Use fabel library

Font : Aril

Deny write-command

Message : The system is being prohibited from writing device registers!
Font: Arial
Use abel library

Allow write-cormmand

Message : The system is now allowed to write device registers.

13-240

Font : Arial
Use label library
0K | | Cancel
Setting Description
Dialog Size Select the size for pop-up window and texts.
Confirmation If an object uses [Display confirmation request], this message
required would pop up when the object is used. [Message] shown on
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confirmation dialog box, and the text label of the 2 buttons, [OK]
and [Cancel], can be set. Please use the same font for the labels of
[Message], [OK] and [Cancel]. Additionally, only when selecting
[Label Library] for [Message], the use of Label Library for [OK] and
[Cancel] buttons can be enabled.

Deny Displays when system tag LB-9196 (local HMI supports monitor
write-command function only) is turned ON.
Allow Displays when system tag LB-9196 (local HMI supports monitor
write-command function only) is turned OFF.

@ Note

B cMT/cMT X Series does not support adjusting dialog size and using system tag LB-9196.
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13.33. Recipe View

13.33.1. Overview

Recipe View object can be used to display a specific recipe. All items and values of the recipe

can be viewed by using this object.

13.33.2. Configuration

Click the Recipe View icon on the toolbar to open a Recipe View object property dialog box. Set

up the properties, press OK button, and a new Recipe View object will be created.

General Tab

cMT / cMT X Series eMT, iE, XE, mTV Series
New Recipe View Object (3] Recipe View Object's Properties
General | Security -Shape | Font | General [Secuxitylshape IFont IPmﬁ!e |
-
Comment : Comment : |
[7] Filter enabled [] Refresh data automatically
| 5o -
[T Allow in-cell editing Recipe table
Recipe table Recipe name :
Recipe name : |123 2
Default sort method
Ttem name Display
1 Newltem = [¥] Enable
) Ascending @ Descending
Default sort method
[¥] Ensble Title
() Ascending © Descending Color: [E
Profile
Soe: [Cosal =] Seoolor: [ . B i
e Frame (I -
[V] Use caption rame : (.| Background: [ 1)
Font size : |16 v Color : S Grid
[¥] Enable
Name
Selection control
Color : | S ¥
T - o ]
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The name of each part of the Recipe View object is shown in the following figure.

Title-
Green Part
2
Selection
11.11 66.66 1111 AAAA  +— control-
profile- 22.22 77.77 2222 BBEB Pink Part
Frame and 33.33 88.88 3333 CCCC
Background color ||44.44 99.99 4444 DDDD
5555 |12.34 5555 EEEE
Grid-
dividing line

Setting

Description

Filter enabled

When selected, entering keywords in Recipe View to search for
specific text is possible.

Allow in-cell
editing

When selected, editing Recipe Database directly in Recipe View is
possible.

Refresh data
automatically

When selected, the system will automatically refresh Recipe View
when recipe is changed; otherwise, Recipe View will be refreshed
after window change.

Recipe table

Recipe name

Choose the recipe name or look for other recipes from the
drop-down list.

Display

Choose an item to be displayed by selecting its checkbox.

Default sort

Configure how the items are sorted. [Ascending] and [Descending]

method can be selected.
Style
(cMT / cMT X Available styles are: Default, Crystal, and Flat.
Series only)
Caption With [Use caption] enabled, the text, font size, color, and name of
(cMT / cMT X the caption can be specified. (Use caption is only available when
Series only) the selected style is Crystal or Flat.)
Title The item name assigned in [Data/History] » [Recipe Database].
Transparent
If selected, the title row has no shading; the color selection is not
available.
Profile The frame and background color of the object can be set.
Transparent
Select to hide the background, the color selection is not available.
Grid The dividing lines between columns and rows.

Enable

Select to show the grid.

Auto fit short column (cMT / cMT X Series Default style)

The column width automatically adjusts to the size of the content.
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Selection
Control

Shading color of the selected row.

0 Note

B There are
Selection

4 system registers that can be used to view/update/add/delete recipe database:

Current selection of record in Recipe View object, and it is numbered from zero. If the first

record is chosen, the value of Selection will be 0. When the value of Selection is changed,

the corresponding values will be updated, such as “No”, “Timer_1", “Timer_2", as shown

in the following figure.

Count

Numeric Input Object's Properties @
General |Da13 Entry | Mumeric Format I Security | Shape | Font | Proﬁle|
Description :
[ read/virite use different addresses
Read address
PLC name : | Local HMI ][ setting...
Address :[R.ECIPE v] H selection -l
v | Recipe_Solar b | ¥ Selection
Count
Command
Result
Motification he
[FEnable =t
Timer_2
Timer_3
Timer_4
Speed
L |

Show the number of records in current recipe.

Command

Enter certain value will send command to the selected record.

Enter “1”:
Enter “2”:
Enter “3”:
Enter “4”:
Enter “5”:
Enter “6”:

Result

Add a new recipe record.

Update the selected recipe record.
Delete the selected recipe record.
Delete all recipe records.

Write the selected recipe record to PLC.

Update the recipe record selected from PLC.

View the result of executing commands.

Displays “1”: Command successfully executed.
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Displays “2”: The selected record does not exist.

Displays “4”: Unknown command.

Displays “8”: Records reach limit (10000 records), no new records can be added.
Display “16”: Another command is being executed.

Display “32”: Transfer command failed.

C?Please go to [Data/History] » [Recipe Database] tab to create the recipe data before
using Recipe View object. See “24 Recipe Editor”.
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In this example, a recipe database is created to be displayed by Recipe View object. When you

select a recipe record on Recipe View object, the value of [Selection] and the corresponding

values will change accordingly. When finish designing, you can modify the recipe database by

entering a value in [Command].

Simple Recipe View & Recipe Database

No  Name  Timer_1 Timer_2 Timer_3 Timer_4

0 Mercury 10 1 11 12 26,500
1 Venus 0 1 21 27 33500
2 Mars 30 2 32 35 41500
3 Jupiter 50 3 53 56 50500
4 satum a0 5 85 a0 60500

System Registers:

Selection:‘ 2 | Count:‘ 3 |Command:‘ o |Resu1t:‘ L |
Selected records: (modify here)
No. Name:
| 2 | |Mar5 |
Timer_1: Timer_z: Timer_=: Timer_o: Speed:
ERE [ 32 ||ss | |a1500
1. Create arecipe as shown in the following figure.
Recipe Database
Definition |Dats | System Registers |
Recipes List :
Recipes @ ITtem name Data type Size  Display width Decimal Pt. Alignment
1. Recipe_Solar No 16-bit Unsigned 1 5 0 Left
Name ASCII 10 8 0 Left
Name_1 32-bit Signed 2 8 0 Left
Name_2 32-bit Signed 2 8 0 Left
Name_3 32-bit Signed 2 8 0 Left
Name_4 32-bit Signed 2 8 0 Left
Speed 32-bit Float 2 8 3 Left
A
A 4
[ Import... Jl Expont... J New Delete Settings
["] Prohibit recipe database update from remote HMI (or sst LB-12363 on)
* At most 100 items in one recipe are recommended. Moxe items might reduce the performance of HMI.
OK l [ Cancel ] [ Help l
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2. In Data tab create a number of records as shown in the following figure.

Recipe Database (==
| Definition | Date | System Registers
Recipes List :
[Eecipe Solar) ] No Name Newltemnl Newltern2 Newltern
1 0 Testl 10 11 0
2 1 Test2 20 21 1]
3 2 Test3 30 0 i]
4 3 Testd 50 0 0
5 4 TestS 60 ] 0
A
v
< 13 »
New Delet
L OK I ‘ Cancel ] [ Help ]

3. Create a Recipe View object and use the recipe database created in the preceding steps.

4. Create 4 Numeric objects using registers “Selection”, “Count”, “Command”, and “Result”.

5. Create corresponding input objects for “No”, “Name”, “Timer_1", ..., “Timer_4", “Speed”.
For example, “Name” is an ASCII item with size “10”. Create an ASCIl object and set device

type to “RECIPE” » “Name”.

Read address

PLC name | | Local HMI W Setting. ..

Address 1 |RECIPE

6. The project is then completed.
As shown above, “Mars” is selected and the corresponding items are also updated. There
are 5 records so the “Count” displays “5”. Try selecting different rows of the Recipe View
object. Fields “Name”, “Timer_1", ...will change accordingly.

8.  Try the following operations:

® Add:
To add current data as a new record, enter “1” in “Command”.
® Update:

To update recipe database, enter “2” in “Command”.
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® Delete:

To delete the selected record, enter “3” in “Command”.
® Sort the items.
® Click the title to change the order.
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Example 2

In this example, [RECIPE_Bit] can be used to read / write individual bits of Recipe data.
Although BOOL type items cannot be added to Recipe Database, individual bit access of 16bit /
32bit data is possible.

As shown in the following figure, select [RECIPE_Bit] for the read address of Bit object and
point to the target item, and then the available Bit selections will be displayed. In this manner,

Recipe Database can be used to record, read, and write bit data.

Recipes List :
Recipes H.‘.‘ F Tt namme Diata tpe Jize Display width Decimal Ft. & 1i et
e ie ‘ e 16-bit Unsigned |1 5 ] Align left
B 2-bit Unstgned 2 5 0 Align left
z 32-bit Unsigned 2 5 1} Align left
Read address
PLC name ! | Local HMI w | Settings...
Address | | RECIPE_Bit vl Helechon-0 -
myRecipe » Selection »
[_IInvert signal Count »
Command 3
Result 3
| A v 0
B 2 1
C » 2
3
Fil
5
B
7

= oo
(=]

[ 'y
o P =

Y
%]
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13.34. Flow Block

13.34.1. Overview

Flow Block object displays the flow status of the blocks in the pipe or the status of the
transportation lines. Unlike Moving Shape object which requires a precise measurement
between two points when drawing a straight line provided by users, the blocks flow at a fixed
interval in a horizontal or vertical straight line. For cMT / cMT X Series models, drawing
non-horizontal and non-vertical lines is possible.

The features of Flow Block:
® Each section of the Flow Block must be a horizontal or vertical straight line and the blocks
flow at a fixed interval within it. For cMT / cMT X Series models, drawing non-horizontal

and non-vertical lines is possible (angle limit: 5 degrees).
® Dynamic speed and direction adjustment (Speed and direction can be controlled by a

designated register.
® Security mechanism (Interlock), which hides Flow Block when the status of designated bit

is invalid.

13.34.2. Configuration

Bz

Click on the Flow Block icon on the toolbar or select [Objects] » [Animation] » [Flow Block] to

create object.

General Tab
Flow block Object's Properties
[ General [ outine | security|
Comment :
Flow speed
[T1Reverse direction
[l oynamic speed
Flow speed : [ 5 -
Setting Description
Reverse The blocks flow in the direction the object is drawn (the blue
direction arrow). If select this check box, the blocks flow in the opposite
direction.
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Flow-direction

>

—

Reversedirection

Dynamic Read address

speed The direction and speed at which the blocks flow can be controlled
by a designated register. The valid rage is -25 to 25. When a
negative value is entered, the blocks flow in a reversed direction.
Setting
Displays the address and format of the designated register. [System
register], [Index register], and [Tag Library] can be set here.

Flow speed 25 flow speed levels, the valid range is 0 to 25 when [Dynamic
speed] is not selected. A larger value indicates a faster speed.

Outline Tab
For setting the outline property of Flow Block. The following illustration shows each item.

Pipe Background Color

PipeBorder Widtl
Pipe
. Width
Pipe
Border
Color

Block " Block Block Block

Inter-  Length Width Color
val
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Flow block Object's Properties

}' Greneral j Ovutline | Security |

Pipe
Width: |23 v

[V] Border
Color: [ I

Background

Color: ()

Block
Style : | Arrow v

Width: |15 -

[¥] Dymamic color

Device : [Local HMI v] Settings...

Address : [LW ,] 0 16-bit Unsigned

Index Color A
1 000000 1

[ sttt

[] fotofn ‘

[ ¢0cc

W 74717 ) New

5 Fmmanandt

R S

L OK ][ Cancel ] Help

13-252

Setting

Description

Pipe

Sets the properties of the pipe within which the blocks flow. The
background color, border width and color can be set. When the

[Border] check box is selected, the background color must be set.

Block

Sets the properties of blocks. Style, width, length, interval and color
can be set.
Available styles are Rectangle and Arrow. The direction in which the

arrows point to indicates the direction of the flow block.
) 0 )|

Rectangle: 1MEE Appoyy:

Dynamic
color

Allows dynamic color change with 256 customized colors,
numbered from 0 to 255 allowed. The color is selected by entering
a value in the designated register. Entering a value greater than the

largest color number changes the Flow Block to the last color in the

list.

@ Note

B If both [Reverse direction] and [Dynamic speed] check boxes are selected in [General] tab,
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when entering a negative value in the designated register of dynamic speed, the blocks
flow in the direction the object is drawn.

When both [Arrow] and [Dynamic speed] are selected, the arrow will only show when a
value is given to the designated address.

To avoid the pipe lines from overlapping when drawing a turn, there is a minimum width
planned at each turn. As shown in Fig. 34.1, the sign on the cross cursor defines the

minimum width. Fig. 34.2 demonstrates that each turn is drawn in the minimum width.

(Fig. 34.1) (Fig. 34.2)

The valid range of the length, width, and height of the Flow Block can be adjusted
according to the size of the object drawn and the size of the window.

As shown in the following figure, when the size of the Flow Block is larger, the valid range
is restricted to prevent the flow block from exceeding the window size. When the size of

the object is smaller, the adjustment range will be larger.

To prevent the flow block from overlapping itself, when the distance between two lines is
shorter (Section A), the valid range is restricted. When the distance is longer (Section B),

the adjustment range will be larger.
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Example 1

The demonstration below shows how to use [Dynamic speed] to control the direction and

speed of Flow Block by a designated word register.

1.

¥

B

Create a Flow Block object and select [Dynamic speed] check box. Set [Address] to LW-O0,
and set the format to 16-bit Signed.

Flow block Object's Properties 22

General | outline | Security
Comment ;
Flow speed
[ reverse direction
Dynamic speed
Read address
PLC name : lLocal HMI vJ Setting...
Address :ILW vI i} 16-bit Signed

Create a Numeric object, set [Address] to LW-0. The high limit is 25, and the low limit is
-25. The format is 16-bit Signed.

@ Direct ) Dvmanmde lndts
PLC low @ -2% PLC high: 2%
Inputlow : | -25 Input high: |25

Execute simulation or download the project to HMI. When entering a positive value in
LW-0, the blocks flow in the direction the section is drawn. A larger value indicates a faster
speed. When a negative value is entered, the blocks flow in a reversed direction, and the

smaller value indicates a faster speed. When 0 is entered, it stops flowing.

Click the icon to download the demo project. Please confirm your internet connection.
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13.35. Operation Log

13.35.1. Operation Log Settings

13.35.1.1. Overview

Operation Log records user’s operation steps and displays the record in real-time. When an

error occurs, use operation log to analyze the problem. The backup tables can be used to

review the process in order to resolve the errors. Operation log, if configured properly, may

also be used to satisfy the requirement for audit trail and electronic signature.

eration Loe

1l
;O
o !

o
||U 3
o
S
[l=}
g|
o
[a}
2
=
& |

03/05M13  18:17:47 full privilege
03/05/13  18:17:46 full privilege
4

[\& WEINTEK

emT =000

Operation Log

Operation Log Object Can
be created on your project
screen, for reviewing data
when an error occurs.
Current User : admin

ID: Admin PW: 111
ID: Leo  PW:222
ID:Joy PW:333

After selecting the capsule to pack and
the label, run A1 machine, the process
is all recorded in Operation Log View.

Note:
To change the capsule or label,
please turn OFF A1 machine.
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13.35.1.2. Configuration

o~ '-\.\.\.
i
@,
L
Select the objects to be recorded. Click [Data/History] » [Operation Log Setting], and then
select [Enable operation log function] check box.

cMT, cMT X Series eMT, iE, XE, mTV Series
Operation Log @ Operation Log (55
[¥] Enable operation log function [¥] Enable operation log function
Object (= Enable Label library Comment W= 4 Object (= Enable Comment 2
= Global LAl = 4: Common Window ‘ |
[ User loginflogout 7] = Label_1: text %580 @ Open/Close System Information
= 4 : Common Window B 5: D_evn:e Response
tsjss_o ] ] Open/Close Sy.. EBFK_0 =
= 5: Device Response = 6 HMI Connection
Em e o ™ B Em e 0 ™
= 6 : HMI Connection = 7: Password Restriction
Emrg o B B EmFK 0 52
=l 7: Password Restriction [l 8 : Storage Space Insufficient
Em 0 B [l Em e 0 @
[= 8 : Storage Space Insufficient - =) 62 : ASCII Upper M )
2! i » [l:ﬂ SW_0 ]
[=] 63: ASCII Lower M -
[ selectar || Discardal | —
<« m »
[ Automatically enable operation log for new objects. [ T ] [ e ]
Storage settings =
Maximum record no. in HMI memory : 1000 = || Automatically enable operation log for new objects.
External devices for synchronization / backup Storage settings
[F]USB disk 1 [ usB disk 2 Maximum record no. in HMI memory : | 1000 v
External devices for synchronization / backup
[T usB disk 1

Behavior when HMI is insuffident
Behavior when HMI space is insuffident avior when SPace S MSuicen

_ > 5 (") Stop saving operation log
_) Stop saving operation log

™ Synchronize to external device. If the device does not exist, erase the oldest

5 Synchronize to external device, If the device does not exist, erase the oldest R

©)
~ records,

Control Control
Device : [Local HMI v][ (o ] Device : [LocaIHMI '][ <d ]
Address : |Lw +| 50 [16-bit Unsigned Address : [Lw ~|o 16-bit Unsigned

Control Command Usage.. @ Control Command Usage. . E

Setting Description

Object With Operation Log function enabled, user login/logout activities
and the objects that can be recorded are listed in the setting dialog
box sorted by window numbers.

[Filter]: By clicking = icon, all recordable objects are listed. Users
can use the filter to more easily locate the desired objects.

Enable The selected objects are recorded by Operation Log.

Label Library Use the labels in Label Library to display the comments in different
languages.

Comment The description of the object. The selected label will be shown in

this column, and if Label Library is not used, the comment in the
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Objects
object’s settings will be shown as below.
Set Word Object's Properties |E|
General |Securit5-I I Shape I Label I Proﬁlel
Comment : Login
Write address
PLC name : Local HMh, v | setting....
Address : 16-hit Unsigned
[ wurite after butkgn is released
= 10 WINDOW_010
AED ]
SW_0 Login
SW_1 Logout
EHoL_o Mser ID
WlSE 0 (ireen Label il
k=1 =2l Pad T ahal
4 L 3
By clicking "= icon, all objects whose comments contain the string
are listed.
Select all Selects all the listed objects. If [Filter] is used, clicking [Select all]
only selects the objects in the list.
Discard all Discards all the selected objects. If [Filter] is used, clicking [Discard

all] only discards the objects in the list.

Automatically

enable With this option selected, new objects created will automatically

operation log

for new be enabled for Operation Log.

objects

Storage Sets the way the records are stored.

settings Maximum record no. in HMI memory
Sets the maximum number of records that can be stored in HMI
memory.
External devices for synchronization / backup
Stores backup data to SD card or USB disk. Backup data can be
synchronized to database (cMT / cMT X Series).
Behavior when HMI space is insufficient
When HMI memory space is insufficient, two options are provided:
[Stop saving operation log]: Stops saving new records in order to
keep the earlier records.
[Synchronize to external device]: Stores the Operation Log to the
external device. When the device does not exist, the HMI clears the
oldest records in its memory.

Control Entering different values in the control address sends

address corresponding commands to Operation Log and returns the result

of executing the command.
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If control address is LW-n (where n is an arbitrary number), the
address that returns the result of executing the command is
LW-n+1.

Control address (LW-n):

(1): Clear all records.

(2): Copy the records to the USB disk.

(3): Copy the records to the SD card.

(4): Copy the records to the USB disk and clear the records in HMI
memory.

(5): Copy the records to the SD card and clear the records in HMI
memory.

(6): Enable Operation Log.

(7): Disable Operation Log.

(8): Use history data stored in USB disk after changing HMI.

(9): Use history data stored in SD card after changing HMI.

(10): Copy the records to the database server. (cMT / cMT X Series)
(11): Copy the records to the database server and clear the records
in HMI memory. (cMT / cMT X Series)

(12): Use existing historical data in database after changing to
another HMI. (cMT / cMT X Series)

Execution result (LW-n+1):

(0): Processing.

(1): Execution succeeded.

(2): The device does not exist.

(3): The record does not exist.

(4): Unknown error.

0 Note

B Operation Log can only record the operation of the objects that are manually triggered.

Objects that cannot be manually triggered are not recorded, such as Time Based Data

Transfer object.

B When running off-line or on-line simulation, Operation Log is stored under EasyBuilder
installation directory: HMI_memory\operationlog\operationlog.db

B Triggering Macro with a Set Bit object generates two records, the triggering of bit and the

triggering of Macro.
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13.35.2. Operation Log View

13.35.2.1. Overview

Operation Log View can be used to review the Operation Log.

13.35.2.2.

General Tab

cMT, cMT X Series

Configuration

eMT, iE, XE, mTV Series

Before using Operation Log View, please follow the steps described in the preceding

New Operation Log View Object New Operation Log View Object
General | Tifle | Security | Shape N General | Title | Security | Shape
Comment : Comment :
s s
— Cote: [ i
[ Transparent
coor: (I
Profile
[ Transparent
Fone | ([ Bekgond [
Grid
[¥] Enable [¥] Auto fit short column
Selection control
ot ()
Font
Font Neme © [ Arial [Arial] [Droid Sans] >
Name : [Axial v]
ot [
Cobe: (I
S Option button
ption button & . = .
. - © Predefined () Dynamic
© Predefined © Dynamic 2o :
5 [7] Enable
Device : (Local HMI <GS
Address: |LB |50
ok | cancel |[ hHep | [ o J[ conce |[ hep |
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Title
1
£
03/04/13 | 15:15:07 full privilege 10
A 03/04/13 | 1515.07 full privilege 10 [1 Ph
03/04/13 | 15:15.06 full privilege 10__[1 Selection
03/04/13 15:15:00 full privilege 10 |1
03/04/13 | 15:14:55 full privilege 10 1 Control
il 03/04/13 | 151455 full privilege 10 [
Profile 02/26/13 | 18:50:21 full privilege 101
02/26/13_|_1850:18 full privilege 10_[1
Frame & 02/26/13_|_18:50:15 full privilege 10__[1—
02/26/13_|_18:50:09 full privilege 10__[1
Background 02/26/13 | 18:50:07 full privilege 10 1w
4 | >
Grid
Setting Description
Style The style of Operation Log View object can be selected

from Default, Crystal, and Flat.

Title/Profile/Grid/
Selection control

These attributes can be configured when the chosen style
is Default.

Font

Sets the color, font, and font size of the text displayed in
Operation Log View object.

Option button
visibility (cMT /
cMT X Series)

Show or hide the option button *

Predefined
Select [Enable] to show the option button.
Dynamic

Ciption button wisbiite

() Predefined @ Drmeamdc

Device : [Local HMI | e
Ades: LB |0 [

Designate a bit address to control option button visibility.
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Title Tab

cMT, cMT X Series

eMT, iE, XE, mTV Series

13-261

New Operation Log View Object 23] Operation Log View Object's Properties @
|General | Title | Secusity | Shape | | General | Title |Shape I Proﬁle|
[¥] Use caption
Caption Title mame Title
Caption
< b
[ Use label library
Column Label ... Label tag Header text -
EE— O e f [ pe——
T [ Time 4
Ui [ User name
CET. [ Closs Sort
(TG [ Window () Time: ascending (@ Time descending
[ObjestName 0[] Object Name x
] L | L Order & Characters
Sort . . . :
(© Time sscending ® Tine descending Display s Displaych.. *
Date i}
Order & Characters Time 0
Display items Displaych.. Display order — 0 =l
Date 10 Class o =
Time 10 ] Findow 0 E|
Useriams H Object Nams 0
@ Ch.m ! Comment 0
Window 7 = ietion 0
[V] Object Name 12 wdd 2 User name
[V] Comment 30 fess S
Action 30 -
If Display chars”is 0, it means that the system will display all of characters.
Date: (MMDDAYYY  v| Time: [HHMMSS v Date : [MMiDD/YY v] Time: [Hetaiss -]
o ) (o [ ]
Setting Description

Use Caption

Sets the caption displayed in Operation Log View object.

Title Sets the title name of the columns displayed in Operation Log View
object.

Sort Sorts the records in time ascending or descending order.

Display order Sets the order of the displayed item. If [Display chars.] is 0, all
characters are displayed.

Date / Time Sets the format of date and time displayed in Operation Log View

object.

13.35.3. Operation Log Printing

13.35.3.1. Overview

Operation Log Printing can generate an Operation Log sheet by printing out using a printer or

by saving as JPEG file into an external device. Before using this function, please go to Operation

Log Settings to finish the settings.

Operation Logs printed using cMT Viewer will be saved to the USB disk / SD card connected to

the cMT / cMT X HMIL.
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13.35.3.2.

=

Select “Enable [Operation Log] printing” check box and click [Settings] button to open the

Configuration

Operation Log Printing dialog box.

General Tab

Printing

Manager

[~]Enable [Operation Log] printing

(=]

Settings...

oK ] [ Cancel

Operation Log Printing

General |Layout | Content

Printer

Qrientati

Font

Range

Address l[LB

Comment :

Device : [SD card

on

(@ Horizontal

() Vertical

Name : [ il

Size : |Middle

Type: () Date

Within : 1000

Trigger address

@) Record

record(s)

PLC name : [Loml HMIL

- | Setting...

-

[

OK

] [ Cancel

13-262

Setting

Description

Printer

Select the device to save the Operation Log sheet. If a printer is
selected, the paper size should be A4. If an external device is
selected, the Operation Log sheet is saved as a JPEG file. The
system generates a folder named "operationlogsheet", and the files
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saved in the folder are named "print date_sequence number". For
example, the first JPEG file saved on 2013/05/08 is named
130508 _0000 and so on.

Orientation Sets the layout of the Operation Log sheet to be horizontal or
vertical.
Font Sets the font and the font size to of the Operation Log sheet. The
following table lists the corresponding size.
Size Title Content
Large 20 pt. 16 pt.
Middle 16 pt. 12 pt.
Small 12 pt. 8 pt.
Range Sets the range of the Operation Log to be included in the sheet.
Date
Sets the range by date, counted from the start day through the
number of days entered. The maximum available range is 30 days.
Record
Sets the range by the number of records. The maximum available
range is 10000 records.
Trigger Sets the register to control Operation Log Printing. When the
address register is set ON, it starts printing. When the printing is done, the
register is set OFF automatically.
Preview Preview the result before generating the Operation Log sheet.
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Layout Tab

=

Operation Log Printing

General | Layout | Content

"~ Titl
[7]Printed on all pages Itie

Operation Log Report -

Fl [’

Use label library Header ‘

Header
[#]Frinted on all pages

€MT3000 Series -
Demo created by EasyBuilder Pro

- 5
Use label library Content

Footer
|¥]Printed on all pages

Weintek Labs. , Inc -
Professional in Human Machine Interface

Pl »

Use label library
Footer

Date/Time
Display print time

Date : [MM/DD/YY -] Tme: [HH:MMiss -]

Page Number Date/Time

The layout of each part is shown in the above figure.

Setting Description

Title Sets the content of the title. The title is limited to one line.
Printed on all pages
If selected, the title is shown on each page; otherwise, the title is

shown on the first page.

Header Sets the content of the header. The header can have 5 lines in
maximum.
Printed on all pages
If selected, the header is shown on each page; otherwise, the

header is shown on the first page.

Footer Sets the content of the footer. The footer can have 5 lines in
maximum.
Printed on all pages
If selected, the footer is shown on each page; otherwise, the footer

is shown on the last page.

Date/Time If selected, the date/time the in the sheet is shown on the
lower-right corner of each page; otherwise, the date/time is not

shown.

Page number Shown on each page.
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Content Tab

Operation Log Printing

General | Layout | Content

Title navme

Sort
() Time ascending

Crder & Characters

Date
Time
Class
Window

Comument
Action
Addres

EEEEEEEEE

Dizplay items

(Object Name

Information

Title

ObjectName ] Objct e
Camment ] Cornent
SR Action
AT Addes
Infommsion 11| Informaton

(@ Time descending

Dizplay chars
10
10

Display order

Date

Time

Class
Window
Object Name
Comment
Action
Address
Information

Date : [MMDDM

~| Tme: [HH:mmiss

7)

Preview

[

oK ] [ Cancel

13-265

Setting

Description

Title

Sets the title displayed.

Sort

Time ascending

The latest record is placed at the bottom.

Time descending

The latest record is placed at the top.

Date/Time

Sets the format of date and time displayed.

13.35.3.3.

Example 1

The following demonstration explains how to create an Operation Log project.

1. Create a Toggle Switch object and a Numeric object on window number 10.

2. Go to Operation Log Settings; enable the Toggle Switch object and Numeric object on

Demonstration

window number 10.
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Cibject

W= Enable

= 5:PLC Response

*F|FE_D

= & HMI Connection

*F|FE_D

= 7 Pazsword Eestriction

*F|FE_D

= 8 : Storage Space Insufficient

*F|FE_D

= 10 : WINDOW_010

IEEEEO O @ O O

13-266

Comument

Login
Logout
Taer ID

(rreen Label
Pad T ahal

UL

3. Create an Operation Log View object and finish relevant settings.

4. Run off-line simulation, trigger Toggle Switch and Numeric object. Operation Log is
displayed by Operation Log View object.

04/05/17
04/05/117

13:4822 TS O
13:48:19 NE 0

Toggle
Set word

Local HMI : LB-0
Local HMI : LW-0

bit set OFF-=ON
write 0-=0

i- Click the icon to download the demo project. Please confirm your internet connection.

Example 2

Upload Operation Log to PC by using Utility Manager or use Backup object to send the file by

email.

® Upload by Utility Manager

1. Open Utility Manager, click [Upload].
2. Select [Operation log], enter file name and HMI IP, and then click [Upload].

Upload

I~ Project
I~ RW
™ RW_A

[¥ Operation log

(==l

|eMT3000 Series

[~ Recipe database

=

C:\Usersluser\Deskiop'Operation Log file.db

I~ Data log
[~ Eventlog

™ Extend Memory (EM)

Browse.

Connection

Kl P

¥ Ethemet

" USE cable

Name

IP: 1192.168.1.100 -

Upload

Settings.
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® Send the sheet by e-mail

1. Open [System Parameter Settings] » [e-Mail] tab. Set e-mail server and the address of
recipient and sender.

2. Create a Backup object, under [Source] select [Operation log], and under [Backup
position] select [e-Mail].

New Backup Object =2 ]
General | Security I Shape | Label | e-Mail
Comment :
Source
EIRW TIRW_A ) Recipe database
() Historical event log Historical data sampling
Backup pasition
15D card () USE disk
Remote printer/backup server
Mote : Use LW-9032~3039 to change the backup folder name.
Mote : Use [Remote printer/backup server] to store data to a remote PC. Enable the
server in [System Parameter] [Printer/Backup Server] settings.
Trigger
Mode : | Touch trigger -

& For more information about e-Mail settings, see “5 System Parameter Settings”.

4

= Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.

I__| WE!NTEK EasyBuilder Pro V6.07.02


https://dl.weintek.com/public/eMT3000/Project/Part_Sample/Demo_Operation_Log.zip

Objects 13-268

13.36. Combo Button

13.36.1. Overview

Combo Button can execute multiple commands. The former way was to overlay multiple
objects in the same position, and the commands are executed in the order of the layer of the
objects. This takes time to test the order when planning the project. Combo Button allows
users to easily set multiple commands with one object, and freely adjust the order of executing
commands.
The following are the features of Combo Button:

® Executes multiple commands.

® Allows adjusting the order of executing multiple commands.

® Displays the state in Bit or Word Lamp.

13.36.2. Configuration

I

Click on the Combo Button icon on the toolbar or select [Objects] » [Combo Button] to create

object. Configure object properties, click OK, a new Combo Button object will be created.
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13.36.2.1. eMT, iE, XE, mTV

General Tab

New Combo Button Object @

General | Security | Shape | Font |

Comment :
Lamp

Mode : |None -

Bit lamp l
Word lamp

Actions

Set Bit (Set ON)
Set Word {Write constant value : 0)
Delay (50 ms .

4 [p] (%] [#)

Setting

Description

Lamp

The mode to display the state of a designated bit or word register.
None: Not using lamps to show states.

Bit Lamp

Displays the state of a designated bit address.

[Invert Signal] Reverses the display of ON / OFF states. For example,
if [Invert signal] check box is selected, when the designated bit is
OFF, the object displays ON state.

Word Lamp

Displays the state according to the value of a designated word
register.

[No. of state]: The number of states used by the object. The state is
numbered from 0, so the number of states minus 1 will be the state

number. If the value in the word register is > [No. of states] defined

I__| WE!NTEK

EasyBuilder Pro V6.07.02



13-270

Objects
in Attribute, the highest state will be displayed.
If the number of states is set to 8, the valid states will be 0, 1, 2, ...,
7. In this case if the word value is 8 or higher, the system will
display the state 7 shape.
Actions A combo button can execute up to 20 actions.
Key Description
Add actions.
E] Delete the selected action.
E] E] Change the order of the actions.
= Copy the selected action.
Paste the copied action.
Add Delay

Delays the action for a few milliseconds. A combo button can set

one [Delay] action only.

Set Bit
Sets the designated bit ON or OFF.

Set style Description

Set ON Set ON the designated bit of the device.

Set OFF Set OFF the designated bit of the device.

Toggle Alternates the bit state each time pressed.

Set Word
Sets the value in the designated register.

Set style Description

Write Writes a constant value to the designated

Constant register.

Value

JOG+ Increases value in register by a set amount in
[Inc. value] each time when the button is
pressed, to the [Upper limit].

JOG- Decreases value in register by a set amount in
[Dec. value] each time when the button is
pressed, to the [Bottom limit].

Dynamic Sets the Upper / Bottom limit by a designated

limits register.

When Dynamic Address is LW-n, where n is an
arbitrary number, set upper limit when using
[JOG+], and bottom limit when using [JOG-].

Change Window

Switch to the designated window.
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13.36.2.2. cMT / cMT X Series

General Tab

Combo Button Object's Properties (2]

General | Security | Shape | Font | Profile |

Comment :
Lamp
Mode : | None -
Down actions
Z
Action Group 0 Action Group 1 &
Set Bit (Set ON)
Set Bit (Set ON) |
Set Word (Write constant value : 0) > 1‘=
’J Execute macro (macro_0)
Execute macro (macro_0) o |
< | 1 | »
Up actions —
Action Group 0 Action Group 1 2
Set Bit (Set ON) ‘
£ |
Set Bit (Set ON) Change full-screen window (11. Window|
|

Wait Until (LB-0 is on)

< | m | »

()

* Up actions will be run simultaneously even if down actions are still runing. Use Wait Until to

avoid race condition.
[ o« ][ concel | Help

Bit/Word Lamp actions are explained in 13.36.2.1 eMT, iE, XE, mTV.

For cMT Series, actions can be classified into action groups, whichs are put in sequence.
Actions within a group are executed at the same time, and after the actions in the current
group have been all triggered, the actions in the next group will then be triggered. Please see
Ch13.53 Action Trigger for more information on the notes about action groups.

Setting Description
Down actions Execute action when the button is pressed.
Up actions Execute action after the button is pressed and released.
Delay Delay action for the specified time (ms).
Set Bit Sets the designated bit address ON or OFF.
Set ON
Sets ON the designated bit.
Set OFF

Sets OFF the designated bit.
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Toggle

Alternates the bit state.

Momentary

Momentary is a two-step action where pressing the button (Down
action) will set the bit ON and then releasing the button (Up action)
will set the bit OFF. Corresponding Down and Up actions will be

created.

Set Word Changes the value in the designated word address.
Write constant value
Writes the constant value to the designated register.
Increment value (JOG+)
Increases value in register by a set amount in [Inc. value], up to the
[Upper limit].
Decrement Value (JOG-)
Decreases value in register by a set amount in [Dec. value], down to
the [Bottom limit].
Dynamic Limits (JOG+, JOG-)
Sets the [Upper limit](JOG+) and [Buttom limit](JOG-) by a
designated register.
Write constant string

Writes the constant string to the designated register.

Change Switches to the designated window.

window Change full-screen window: Changes to another base window.
Change common window: Changes common window.
Return to previous window: Changes from current screen to the
previous one displayed. For example, when window no. 10 is
changed to window no. 20, this function can be used to return to
window no. 10. This function is only available for base window.
Animation Setting:
The effects are: Fade, Fly, Float, Wipe, Split, Circle, Clock, Zoom,
Turn, Push. Different effects may be used for Start (window
appears) and End (window disappears).
[Duration] specifies how many milliseconds (ms) a transition effect
takes to complete.

[Direction] The direction of the transition.

Execute Executes one of the Macros from the drop down list that has
Macro already been configured by users. In an action group, [Execute

Macro] is seen as completed as soon as it is triggered. Ever if a
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particular macro takes longer to complete, the system will not wait
for the macro to complete running before moving on to the next

action group.

Popup
Window

Opens a designated window.

Close
Window

Closes currently opened window.

Keyboard
Input

Configures the button as a keypad key, and the character it enters,
via [Numeric] or [ASCII] objects.

Enter: Same as the keyboard’s “Enter” function.

Backspace: Same as the keyboard’s “Backspace” function.

Clear: Clear the value in the word register.

Esc: Same as the [Close window] function; it is used to close the
keyboard window.

Delete: Same as the keyboard’s “Delete” function, deletes the
number or character on the right side of the text cursor.

Left: Same as the keyboard’s “¢” key moves the text cursor to the
left side of the previous number or character.

Right: Same as the keyboard’s “=” key moves the text cursor to the
left side of the next number or character.

Inc: Increment by 1.

Dec: Decrement by 1.

ASCII/UNICODE: Specify the character to be entered by this key.

Screen
Hardcopy

Saves current screen as a hard copy file into a SD card or USB disk.

Acknowledge

all events Acknowledges all events once.
(Alarms)
Import Data Imports e-mail contacts or user accounts, or is used as USB Security

Key login.

Data Position:

[SD card] or [USB disk].

Account import mode:

If [Overwrite] is selected, the existing accounts will be overwritten
by new accounts. If [Append)] is selected, accounts are appended.
Delete file after importing user accounts:

The system will delete the account data saved in the external
device after importing; this can prevent the account data from
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leaking out.

Wait Until

The next group will be executed only when the condition set for a
designated bit or word address is met.

Data Transfer
(Global)

Sends the value in the designated address to another address.

File Transfer

Transfer files by FTP. HMI will connect to the FTP server in passive
mode.

General Tab:

Download: Transfer file from FTP server to local HMI.

Upload: Transfer file from local HMI to FTP server.

Server address:

[Direct]: Designate server address related settings in EBPro.
[Dynamic]: Designate an address for changing the server address
related settings dynamically on HMI.

Suppose the dynamic address is set to LW-n, then:

LW-n: Host usage (0: IP, 1 Domain name)

LW-n+1: IP (4 words)

LW-n+5: Port

LW-n+6: Authentication (0: None, 1: Account)

LW-n+7: Username (16 words)

LW-n+23: Password (16 words)

LW-n+39: Domain name (64 words)

Delete the source file after successful transfer

Following successful transfer, the source file will be deleted. When
transferring in [Download (FTP -> HMI)] mode, please make sure
that the account has the write permission on the FTP server.

File Tab:

Set file position and full path of FTP server / Local HMI. When a
folder path is specified, all the files in that folder will be
transferred, not including files in subfolders. When a file with
identical file name already exists, it will be overwritten regardless.
Status Tab:

Designate an address for showing file transfer result and FTP server
response. Please use the following link for more information on FTP

server return codes.
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@ Note

B One Combo Button can only do one of these window actions, and only once: [Change
Window], [Popup Window], and [Close Window].

B At most 20 groups can be created in a Combo Button, and at most 20 actions can be
added into a group.

B  File Transfer Error Codes:

Error Code Description

File transferred successfully.

The HMI directory for download does not exist.
USB disk or SD card is not found.
HMI or FTP directory is empty.

Uploaded file does not exist.

Operation rejected by FTP server.
USB disk or SD card is full.

10 Unknown error.

OjcUnnihiwW|iL| O

¥

= Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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13.37. Circular Trend Display

13.37.1. Overview

Circular Trend Display object draws the trend curve of Data Sampling in a polar coordinate
system, where y-axis represents the radial coordinate and the x-axis represents the angular

coordinate. The way to use this object is similar to using Trend Display object.

051513 15:13
4

15:58 x 15:28
15:43

|« |@ o | |

13.37.2. Configuration

| ‘ |

e

Click the Circular Trend Display icon on the toolbar to open the property dialog box. Set up the
properties, press OK button, and a new Circular Trend Display object will be created.
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General Tab

eMT, iE, XE, mTV cMT, cMT X
Circular Trend Display Object's Properties @ || NewcircutarTrend Display Object
General | Trend | Channel | Security | Shape | Profile | Generel | Display | Toend | Channel | Secusiy | Shape |
o —— Comment :
DeSempling: (L] DetSompling: (1. )
Type : @ *If no. of channels is changed, you must resst HMI's data samplings.
*1If no. of channels is changed, you must reset HMI's data samplings. Distsnce - hour(s) Strt position: (717 =
Distance : |24 + | hour(s) Start position : | Up = — R -
I D i S Device : [Local HMI | CE) &
- [LocalHMI v][ = ][j] Address: (LW ~v|0 16-bit Unsigned
. AE-hi o Zoom infout
Address: LW v | 100 |16-bit Unsigned i Eabs
Zoom infout Device : (Logal HMI - CEE
[7] Enable T
Address: |LW v 0 16-bit Unsigned
Device : {LONIHMI 'M el|tey History control
Address: [LW v 200 [16-bit Unsigned [7] Enable
Hold control Devige : [Lacal HMI '}L:'_]
(V| Enable Address: (LW v|0 [16-bit Unsigned
ADd;vicef [Local HMI - Y EE K ] Eneble meding maliph hiskoris
T [LB—v] Mode : [anberofdays v]
Watch line :
] Ensble Watch line ==
Devicef [Local HMI v}@ Device : [Loal ML = Eem|te)
Address: [LW +| 300 ‘ nsignet s [T = 7 T
Time stamp output - Time stamp output
[V] Enable [V Enable
Device : Local HMI V][ : *7] Device : (Local HMI Y EE) S
Address: [LW v | 400 B32-bit Unsigned Address: [LW = j 32-bit Unsigned
[ OK ] [ Cancel ] [ Help J [ OK ] ( Cancel ] { Help ]
Setting Description
Data Sampling Selects the data source for drawing the trend curve.
Type (eMT, iE, XE, Selects the type of the trend from [Real-time] or [History].
mTV Series) Real-time

In this mode, it displays a fixed number of sampling data
from the moment HMI starts to present. The number of
sampling data is determined by the [Max. data records
(real-time mode)] setting of Data Sampling object. If the
number of sampling data exceeds this number, the earlier
data will not be displayed. To display earlier data or the
data in other days, please select [History] mode.

[Hold control] address can be used to pause refreshing the
display. This only stops displaying new data in the Circular
Trend Display object, and the data is still being sampled by
Data Sampling object.

History
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In this mode, it displays the sampled data sorted by date.
Select the data source from [Data Sampling], and then use
[History control] address to view the records of different
dates.

Note

If [Show scroll control] check box in Trend Tab is not
selected, the earlier data cannot be viewed when
exceeding the specified [Distance].

For example: Set [Distance] to 1 (hour.), then sampling data

earlier than one hour is not displayed.

Refresh data If enabled, the window in which the Circular Trend Display
automatically object (in history mode) is placed will be refreshed once
per second.

® The scroll controls can be used to check the refresh
status.
If ™ putton is displayed, the Circular Trend Display
will be automatically refreshed.
If 21 putton is displayed, the Circular Trend Display
will stop being refreshed.
® Scrolling backward and viewing earlier data will
disable [Refresh data automatically]. The button
displayed is 1 at this moment.
® If [Refresh data automatically] is selected, the display
is refreshed when change back to this window,
regardless of the use of scroll controls.
Example: If [Refresh data automatically] is selected,
scrolling to the earlier display stops auto-refresh. At this
moment change to another window and then change back,
the Circular Trend Display is still refreshed.
If [Refresh data automatically] is not enabled when
building the project, to enable it directly on HMI, simply
press > 1 Please note that auto-refresh remains disabled

after window change.
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Distance

Defines the time length that the circle represents, the unit

is hour, the range is 1 to 24 (hours).

Start position

The position from where to start drawing the trend curve.
(Up) (Right)

14:27:06 051513

14:26:46 051513

=
=

~

14:15

15:00 14:30 14:45
Q—y

14.45 14:30

o\

(Down) (Left)

14:27:36 051513 14:27:56 051513

14:45 14:30

14:30 5:00 14115 14.45

&

Dynamic X-axis

time range

If selected, a word register can be designated to control the
time length of Circular Trend Display. The unit is hour. If no

value is entered, the distance is set to default.

Zoom in / out

Enlarge or reduce the size of the object. The maximum size
is 10 times larger. If 0 is entered in the designated register,
the effect equals entering 1, the object remains the original

size.

Hold control

When the register is set ON, suspend the update of Circular
Trend Display. It does not stop the sampling process of
Data Sampling object. This setting is available only in

Real-time mode.

History control
(eMT, iE, XE, mTV
Series)

History data is sorted by date. The system uses [History
control] to select the history data that are created in
different dates and then displays it by Circular Trend
Display object.

If the value of the designated register in [History control] is
0, the Circular Trend Display object displays the latest
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record. If the value is 1, the second latest record is
displayed and so on. This setting is available only in History
mode.

If use with Option List object and select data source as
[Dates of historical data], the history data will be sorted by
date and displayed in Option List object, see “13.29 Option
List”.

In the following example, when history control address is
set to LW-n, and there are 4 sampling data: 20061120.dtl,
20061123.dtl, 0061127.dtl, 20061203.dtl. The
corresponding data selected by the value in history control

address is as the following list.

Value in LW-n The sampling data displayed
0 20061203.dtl
1 20061127.dtl
2 20061123.dtl
3 20061120.dtl

History control
(cMT, cMT X

Series)

Same as eMT, iE, XE mTV Series.

Enable reading multiple histories:

In the following two modes, days are calculated backward.
Number of days

Suppose the address is set to LW-n, then:

[LW-n]: The start day index from which to calculate number
of days.

0: today, 1: yesterday, and so on.

[LW-n+2]: The total number of days before the start day.
Specific days

Suppose the address is set to LW-n, then:

[LW-n]: The start day index from which to calculate number
of days.

0: today, 1: yesterday, and so on.

[LW-n+2]: The end day index, the specified value must be
greater than that of the start day index. For example, if
startis 4 and end is 7, the specified days will be 4 days
before to 7 days before.

Watch line

Displays a watch line when user touches the Circular Trend
Display object, and the sampling data at the position of the
watch line is output to the designated register. To display
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sampling data with multiple channels, the system
consecutively writes the data of each channel to the
designated word register and the following registers. If the
data format of each channel is different, the channels are
sorted by the data format of its corresponding register.
In the following example, when watch address is set to
LW-n, and there are 4 sampling data, the format of each
data is: 16-bit Unsigned, 32-bit Unsigned, 32bit Signed, and
16-bit Signed. The corresponding watch address is as the
following list.
Channel Data Format Data Length | Watch Address

0 16-bit Unsigned 1 Word LW-n

1 32-bit Unsigned 2 Words LW-n+1

2 32-bit Signed 2 Words LW-n+3

3 16-bit Signed 1 Word LW-n+5

Time stamp output If selected, the system will start counting time from the

first data sampled, and output the elapsed time counted of
the latest data sampled to the register designated in [Time
stamp output + 2]. When pressing a point on the trend
curve, the relative time of the nearest data sample is then
output to [Time stamp output address].

Note

The format of the register designated in [Time stamp
output] and [Time stamp output + 2] must be 32-bit. [Time
stamp output + 2] is only available for Real-time mode
while [Time stamp output] is available for Real time mode

and History mode.

Display Tab

MNew Circular Trend Display Object @

| Genewsl | Display | Trend | Chenmel | Security | Shape |

COption button visibility
@ Predefined ) Dymanmnic
Enable

Dizplay option
Adaptto device sereen pixel density (DPD)

Display settings in this page are only supported on cMT / cMT X Series models.
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Setting Description
Option
button Show or hide the option button
visibility Predefined
Select [Enable] to show the option button.
Dynamic
Option butbon visbility
) Predefined @ Dymaomic
Device : [LocalHMI V][ g ]
Address: |LB ~| 0
Designate a bit address to control option button visibility.
Display Adapt to device screen pixel density (DPI)
option

With this option selected, text size, position, and the spacing
between Y axes will be adjusted according to the DPI of the screen of

the connected device.
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Trend Tab
Circular Trend Display Object's Properties @
| General | Trend |Chanr|e| I Shape I Proﬁle|
Profile
[ show scroll controls
Grid

) Enable olor : I [~
R Co—
e —

Time scale
Channel scale
[T Enable
Time /Date
Time @ HH:MM:SS () HH:MM

[¥] Date @ MMDDNY (O DDMMYY (D DD.MMLYY (D) YY/MM/DD

o =

o) [ Lo ]

Time/Date <rostsns 0953
—>Frame
——> Background
Grid
2 1
10,

10:38 \o\’o/ 10:08=—> Time Scale

>Channel Scale

10:23

| wm | )

Scroll Control
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Setting

Description

Profile

Frame

Sets the color of the frame of the object.
Background

Sets the color of the background of the object.
Show scroll controls

The scroll controls are displayed for scrolling to view
the sampling data of other time range. The
minimum scrolling unit is determined by the setting
of [Distance] in General tab. If [Show scroll controls]
check box is not selected, the earlier data cannot be
viewed when exceeding the specified [Distance].
For example: Set [Distance] to 1 (hour.), then
sampling data earlier than one hour is not displayed.

Grid

Sets the number and the color of the dividing lines.
Y-axis

Sets the number of divisions on Y axis.

Font size

Sets the size of the font which labels the time scale
or channel scale.

Time scale

If enabled, displays the time scale. When the time
length is longer than 1 hour, the scale division is 1
hour. When the time length is set to 1 hour, the scale
division is 15 minutes.

Channel scale

If enabled, displays the channel scale. The color of
the font which labels the channel scale corresponds

to the setting of the trend curve of each channel.

Time / Date

Time
Sets the display format of time.
Date
Sets the display format of date.

L—| WE!NTEK

13-284

EasyBuilder Pro V6.07.02



Objects 13-285
Channel Tab
Circular Trend Display Object's Properties =]
| General | Trend | Channel | shape | Profie |
Data sampling object
Channel Display  Description Diata tvpe
y 0 16-bit Unsigned 16-bit Unsigned
1 16-bit UTnsigned 16-bit Unsigned
2 16-bit Tnsigned 16-bit Unsigned
3 16-bit Unsigned 16-bit Unsigned
4 16-bit Unsigned 16-bit Unsigned
Channel
Pen property
[ ynamic limits
Zero: 100 Span : 1000
Channel visibility contral
[¥] Enable
PLC name : | Local HM v | setting...
Address :’LW - | 250
Display channel when the corresponding bit is :
CIoN @ OFF
] [one
Setting Description
Channel Sets the style and the color of the trend curve, and

the upper and lower limit of data that can be drawn
on the trend curve. Up to 8 channels are supported
simultaneously.

Not selecting [Dynamic limits]

The upper and lower limits of the data are set by
constants.

Selecting [Dynamic limits]

The upper and lower limits are set by the designated
register. When the address is LW-n, the
corresponding addresses are as the following list.
Data format |16-bit 32-bit
Lower limit  |[LW-n LW-n
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Upper limit  [LW-n+1  [LW-n+2

Channel Visibility
Control

If [Enable] is selected, the bits of the designated
word register will be used to show/hide each
channel. First bit (Bit-0) controls the first channel;
second bit (Bit-1) controls the second channel, and
so on.

Display channel when the corresponding bit is:

If [ON] is selected, when the corresponding bit is
OFF, the channel is hidden. If [OFF] is selected, when
the corresponding bit is ON, the channel is hidden.
In the following example, the control address of
channel visibility is set to LW-0 and each channel
shows when the corresponding bit is OFF. If there
are 5 channels, the visibility of the channels is as the

following list.
Channel | Control address | Bit state | Display
0 LW _bit-000 OFF YES
1 LW _bit-001 ON NO
2 LW _bit-002 ON NO
3 LW _bit-003 OFF YES
4 LW _bit-004 OFF YES
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13.38. Picture View

13.38.1. Overview

13-287

Picture View object plays slideshow of picture files saved in an external device such as a USB

drive or SD card.

This object does not work remotely on cMT Viewer.

13.38.2. Configuration

e,

Click the Picture View icon on the toolbar to open the property dialog box. Set up the

properties, press OK button, and a new Picture View object will be created.

General Tab

=

New Picture View Object

General [Ouﬂhw ]Securityi

Comment :
File position
@ USBdisk1 (I USBdisk 2 (7 8D card
Directory
[V] Dymamic folder path
Device : |Lacal HMI
I — T
File selection
[V] Automatically display the newly generated image
[7] Send notification when switching to & new picture
@ SetON () Set OFF
Device : [Local HMI B e
Address: [LB v|0 '
[V Specify file from address
[ Disable left/right swiping and hide file browser/firstlast buttons
Device : | Local HMI
O — By

* Filenames must contain only A3CII characters. Unicode is not supported.

[ ok ][ concel |[ Hep |

I__|_ WE!NTEK

EasyBuilder Pro V6.07.02



Objects

Setting Description

File position Select the file source of the picture files from [SD card] or
[USB disk].

Directory Specify the directory where the picture files are saved. The

directory can be the one used for Video Input’s capture
feature or Function Key’s screen hardcopy feature. The
picture file saved in the external device can be
immediately displayed.

Dynamic folder path

Designate folder path by a local address.

File selection

Automatically display the newly generated image

When a new image is generated in the designated folder
path, Picture View object will automatically display the
new image.

Send notification when switching to a new picture

When [Automatically display the newly generated image]
is selected, the state of the designated address changes to
On/Off when the new picture is displayed on HMI.

Specify file from address (hide toolbar)

When enabled, the displayed picture is designated by a file
name in a local address, and the toolbar will be hidden.

@ Note

B The file name must be all in ASCII characters, and the Unicode characters are not

supported.

B The supported picture formats are: .jpg, .bmp, .gif, .png.

B The size of the picture that can be displayed on an iP/iE/eMT/XE/mTV model is calculated

in the following formula:

(image.width x image.height) < (screen.width x screen.height) x 4

Pictures with sizes exceeding this range cannot be displayed on HMI.

B Two-finger zoom in / out gestures are supported on capacitive touchscreens.
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Outline Tab

13-289

New Picture View Object (=234

|Geneml| Outling |Secu:fity|

Toolbar position : [] Hide delete button
et | ()

Font : [ Arial -

[ Display with aviginal size when a pictore size iz smaller than the object size

Setting

Description

Outline

Specify the position, background color, and font of Picture
View object. (Supported only on iP/iE/eMT/XE/mTV
models.)

Hide delete button

When selected, the delete button for deleting the viewed
picture will be hidden in the Picture view object.

Display with original size when a picture size is smaller
than the object size.

When selected, the picture will be displayed in its original
size if it is smaller than the Picture View object. This can

avoid distortion caused by enlarging the picture.

X

Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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13.39. File Browser

13.39.1. Overview

File Browser object can display filenames and their directories saved in the SD card or USB disk.
Apart from browsing for the files in the external devices, the filenames and the directories
selected in File Browser object can be written to the designated address.

This object does not work remotely on cMT Viewer.

13.39.2. Configuration

o
o,

Click the File Browser icon on the toolbar, or select [Object] » [File Browser] to open a File

Brower object property dialog box and set up the properties.

General Tab

New File Browser Object @

General | Qutline | Security | Shape |
Folder path address
[¥] Enable
Device : |Local HMI ~ [ Settings...
Address: |LW v 0 20 word (s)

File name address
[V] Enable
Device : (Local HMI [ Settings... |
Address: [LW v|0 20 word (s)

Full {folder + file name) address
[/] Enable
Device : |Local HMI v |[ Settings...
Address: [LW ~|0 20word(s)
Control address
[V] Enable

Device : [LocalHMI v][ Seftings... |
Address: [LW v|0 22 word(s)

Command : LW-0
0 :none, 1 : delete, 2 : rename
Result: LW-1
0 : success, 1 or more : error
New file name : LW-2

[ OK ][ Cancel H Help ]
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Setting

Description

Folder path address

Current directory.

File name address

The file name of the currently selected file.

Full (folder + file
name) address

The full directory and file name of the currently
selected file.

Control address

Designate the control address used for deleting a
file or changing file name in File Browser.
Command: Control Address

0: None

1: Delete

2: Rename

3: Select (only supported on cMT / cMT X Series
models)

Result: Control Address+1

0: Success

1 or more: Error

New File Name: Control Address +2
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Outline Tab
New File Browser Object @
| General | Outline ;[Secu.rity]Shape ‘
File position : (%) $D cand @ USB disk
File type : [ Al files -
Font
[Axial -]
Color : |G : Size : |12 -
Background
[ Transpaxent
Colo
Color
Gl : [ ] Select box . | [~
[ OK ] [ Cancel J Help
Setting Description
Folder position Select the position of the file from SD card or USB
disk.
File type File types to be displayed. Options include all files,

CSV files, or image files. For cMT / cMT X Series
models, there is also a PDF file option for use in

conjunction with PDF reader.

Font / Background
/ Color

@ Note

B The file name and the directory of the selected file will be written to the designated

Set the attributes and font of the object.

address. To change file selection in File Browser to another file by changing the address,
please enter the position of the file and then use the select command (=3).
B The system will read the folder path address and file name address when the HMI is

restarted or when an external device is inserted to the unit. If valid data is can be read
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from the designated address, the system will then automatically navigate to the
appropriate directory and highlight the file according to the data read. If [Folder path

address] is not enabled, the data at Full (folder + file name) address will be read.

El Click the icon to watch the demonstration film. Please confirm your internet connection
before playing the film.
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13.40. Import/Export

13.40.1. Overview

With Import/Export object, Recipe Database or String Table can be imported or exported.

13.40.2. Configuration

14

Click the Import/Export icon on the toolbar to open the Import/Export Object management
dialog box. To add an Import/Export object, click [New], set up the properties, press OK button

and a new Import/Export object will be created.

New... Delete Setfings... Exit
E J | | B |

L_I\’WE_!NTEK EasyBuilder Pro V6.07.02



Objects

General Tab

Import/Export @
General
Description :
Type : [Recipe database v]
Recipe [xecipe v]
File position : ) 8D cand ©@ USB disk % (") Remote HMI (cMT series)
Control address
PLC : (Local HMI v [ Settings...
Address : [LW v] 100 )
Command : LW-100
0 : none, 1 : import, 2 : export (no overwrite), 3 : export
Statos : LW-101
0 :idle, 1 : busy
Result: LW-102
1 : success, 4 or more : eror
File name address
[ Include folder path
PLC : (Local HMI ~ [ Settings...
Address : {LW +| 20 [ B0word(s
Folder path address
PLC : (Local HMI v |[Settings...
Address : [LW .] 0 ‘ 20 word(s)
o ][ concel |
Setting Description
Type Select the file source from Recipe Database or

String Table.

File position

Select the position of the file to be imported /
exported from SD card, USB disk, or Remote HMI
(cMT / cMT X Series). When Remote HMI is
selected, please note that only files in cMT / cMT X

Series models can be imported.

Recipe

Select the recipe. This option is hidden when select
String Table.

Control address

Designate the control address used for performing
import/export, or displaying the result.

Control: Control Address

Recipe Database:

0: None

1: Import

2: Export (no overwrite)
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3: Export
String Table:
0: None
1: Delete
2: Import
4: Export (no overwrite)
5: Export
Status: Control Address+1
0: Idle
1: Busy
Result: Control Address +2
1: Success
4: The file already exists, no overwriting.
Other: Error

File name address The name of the imported/exported file. If [Include
folder path] is selected, the full directory and file
name will be included at this address.

Folder path address The directory of the imported/exported file.

Remote HMI address When the file position is [Remote HMI (cMT / cMT
X Series) ], please enter the remote HMI’s IP
address in this field.

Example 1

The following is an example on recipe export/import settings.

Field Setting

File position USB disk

Recipe Recipe_A (or other recipe)
Control address LW-100

File name address LW-200

Folder path address LW-250

A W NR

Create two ASCII Input objects. Set address to LW-200 and LW-250 respectively.
Enter the file name in LW-200: 2015_recipe.csv.

Enter the folder path in LW-250: Setting.

Use a Set Word object to write value 3 to LW-100. Then, Recipe_A will be exported to the

USB disk, in the “Setting/2015_recipe.csv” file.
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@ Note

B When performing “Export (no overwrite)” command, if the target file already exists, the

export operation will be canceled, and the result value will be set to “4”.

The following lists the result values and the information.

Result (HEX) Information

Ox1 Success.

0x4 File already existed and will not overwrite.

0x10 Invalid command.

0x100 Data contains non-numeric data.

0x101 Path contains invalid string “.”.

0x102 Communication error while updating Recipe DB.

0x103 Error while reading Recipe DB information from
project file.

0x200 General exception.

0x201 General status error.

0x202 Import to unknown database type.

0x203 Error while validating Recipe DB table definition.

0x204 Error while validating Recipe DB table data.

0x205 Error while writing Recipe DB table definition.

0x206 Error while writing Recipe DB table data.

0x300 File error: Unknown error.

0x301 File error: Empty file name.

0x302 File error: The external device does not exist.

0x303 File error: Invalid file name (directory or special
files), or a folder with the same name already exits.

0x304 File error: Unable to remove file.

0x305 File error: Open file stream error.

0x306 File error: Unhandled BOM.

0x307 File error: Error while parsing CSV file (incorrect
formats).

0x308 File error: Insufficient space on the external device.

0x309 File error: Unable to find the file.

0x30A File error: The CSV file contains over 10000 data
rows.

0x400 Database general exception.
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0x401 Database error: Unable to open table.

0x402 Database error: Unable to get rows.

0x403 Number of columns in CSV file and in Recipe DB do
not match.

0x501 Unable to connect remote HMI.

0x503 Import from remote HMI database is prohibited.

0x504 Import from remote HMI database is not
supported.

E Click the icon to watch the demonstration film. Please confirm your internet connection before
playing the film.
¥

= Click the icon to download the demo project. Please confirm your internet connection before

downloading the demo project.
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13.41. Pie Chart

13.41.1. Overview

The Pie Chart object draws a pie chart that is divided into slices to illustrate numerical

proportion, according to the value of the designated read address.

13.41.2. Configuration

(1
\_/

Click the Pie Chart icon on the toolbar to open the property dialog box. Set up the properties,

press OK button, and a new Pie Chart object will be created.

General Tab
[ Pie Chart Object's Properties M
General | Security | Profile
Hole ]
Bordercolor: ] ___'
Data display
Style : [Value v]
Font: [Arial -
Right of decimal Pt. :
Read address
PLC name : Local HMI + [ Settings...
Text color : | |GG : Background color : || :
Pattern color : Pattern style : | [E
.
Setting Description
Angle Set the [Start degree] of the chart. Choose the Chart

to be [Clockwise] or [Counter clockwise].

If [Full circle] isn’t selected, then [End degree] must

[\& WEINTEK
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be set.

f Degree @1

@) Clockwise () Counterdodkwise

Start degree : 0 End degree: 0

J

Hole

Set the size of the hollow circle in the center of Pie
Chart.

No. of channels

Set the number of channels to be displayed in the

chart. The range is from 2 to 16.

Border color

Set the color of the border.

Data display

The [Style] can be set as [None], [Value] and
[Percentage]. The [Font] and [Size] are for the text
on the chart. For Value Style, the [Right of decimal
Pt.] can set the value on the chart to be displayed
with the decimal point. The [Right of decimal Pt.]

option is only available for [Value] style.

Read Address

The address is for channel 1. The following
consecutive addresses are for the rest of the
channels. For example, if the Read Address is LW-O0,
then the Read Address for channel 2 is LW-1;
channel 3 is LW-2...and so on.

Channel

Set the [Text color], [Background color], [Pattern
color], and [Pattern style] of the selected channel.
The [Background color] is for the [Pattern style] that
has background. If the [Pattern style] doesn’t have a
background, then the [Background color] doesn’t
need to be set.
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13.41.3. Combo Setting

cMT / cMT X Series HMI support combo setting for Pic Chart, which allows setting of multiple
related objects at a time. Pic chart can be set with Background and Legend.

Channel 3

Background
ackground Outline [
e ot —C—
[@lLegend Margin : m
Colorftyle
) Customize ® Ficture [ rwep ]

——
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Objects
Setting Description
Margin Specify the space between the background edge and
the objects.
Color/Style Customize
ColoxiStyle
© Customize ) Picture
Round : 10 =)
Frome: [ Tongeent[v]  Beckgowd
hatuicn; EE ok
Select a suitable background pattern and color.
Picture
ColorStyle
() Custommize @ Pictore
Picture Librery...
1
Use the default picture or choose a picture from
Picture Library.
Legend
Pie Chart (=]
Background General st
@IPie Chart ] oK ]
Comment:
Font: (il =
[V]Ensble
Fontsize :
Fontcolor : | |~
| Use label librany
Channels

Fontotor . | -
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Setting Description
Title Set whether to use a title for Pic Chart, and set the

font size / font color of the title. The title can be

selected from Label Library.

Channel Set the channel label. When using Label Library, the
number of the channels should be the same as the
number of states in the library.

¥

=a Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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13.42. Barcode

13-304

13.42.1. 2D Barcode Display

13.42.1.1. Overview

The 2D Barcode Display object transfers the information from the read address into QR Code or

Aztec Code.

13.42.1.2. Configuration

El5El
] =5

Click the 2D Barcode Display icon on the toolbar to open the property dialog box. Set up the
properties, press OK button, and a new 2D Barcode Display object will be created.

General Tab

New 2D Barcode Display Object

General | Security |

Comment :

Mode : [QR code ']
Correction level : [H (30%) - Default ']
Color :
[ Unicode
[ Reverse highflow byte

Read
Device : [Local HMI 3
Address: |LW v|0 |

Length: 16 word (s)

L OK ][ Cancel ][ Help

Setting

Description

Mode

Supports QR code and Aztec code.

[\& WEINTEK
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Correction level

2D barcodes have error correction capability to restore data
if the barcode is dirty or damaged.

QR code

Four correction levels are available: L, M, Q, and H. The data
restoration rate is listed below. (The data restoration rate for
total codewords. Codeword is a unit that constructs the data
area.)

Correction Level

7%

15%

25%

TOIL|T

30%

Aztec code

Aztec code supports error correction levels from 5% to 95%.
Specifying a higher correction value results in a larger printed
symbol and increases accuracy.

Color

Set the 2D barcode color.

UNICODE

By default, the 2D barcode is generated via ASCII encoding. If
this check box is selected, the 2D barcode is generated via
UNICODE encoding.

For characters that are not ASCII defined English alphabets or
numbers, for example, Chinese or Korean characters, please
select the Unicode check box.

Reverse
high/low byte

By default, the 2D barcode is displayed in high byte then low
byte order. With this option selected, the 2D barcode is
displayed in a reverse order, low byte then high byte.

Read address

The 2D Barcode Display object will display the 2D barcode
generated from the information entered by the read address.
The word length limit: 1 ~ 1024.

13.42.2. Push Notification Barcode Display

13.42.2.1. Overview

Push Notification Barcode Display object displays the QR code needed for setting up

EasyAccess 2.0 push notification via messaging applications.

13.42.2.2. Configuration

1

Click the [Object] » [Barcodes] » [Push Notification Barcode Display] to open the property

dialog box. Set up the properties, press OK button, and a new Push Notification Barcode

Display object will be created.

L—| WE!NTEK
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General Tab

13-306

New Push Notification Barcode Display Object @
General | Security |

Comment :

Mode : [QR code vJ

Correction level : [H (30%) - Default -

Cobr: [ I )

Unicode

Reverse highflow byte
Read

Device : (Local HMI Y& (&)
Address : [LW-llTIO (64 words) : QR code (URL) fo v]‘

Length: |64 word ()

[ OK ” Cancel H Help

Setting

Description

Mode

Supports QR code and Aztec code.

Correction level

2D barcodes have error correction capability to restore data
if the barcode is dirty or damaged.

QR code

Four correction levels are available: L, M, Q, and H. The data
restoration rate is listed below. (The data restoration rate for
total codewords. Codeword is a unit that constructs the data

area.)

Correction Level
7%
15%
25%
30%

TOL|T

Aztec code

Aztec code supports error correction levels from 5% to 95%.
Specifying a higher correction value results in a larger printed
symbol and increases accuracy.

Color Set the 2D barcode color.
UNICODE Cannot be changed by default.
Reverse

. Cannot be changed by default.
high/low byte
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Read address Cannot be changed by default.

System Parameter Settings

@

System Parameter Settings @

Extended Memory |  CellularDatalNetvork |  TimeSyneDST [ e-Mal |  Revipes

Device | Model | Geneml | SysemSeting | Remote | Secwity

[] Prohibit remote HMI connecting to this machine

[] Prohibit password remote-read operation (or set LB9053 on)

[T] Prohibit password remote-write operation (or set LB3054 on)

VNC server

[7] Password free

[] Password from project

[F] Monitor mode

EasyAccess server

Location of EasyAccess 2.0 server : [China v

Diagnoser

[] Enable

cMT viewer

Max connect count: 3 £ Count:1~10

Warning : too many connect count will affect performance.
o< J[ concel ]
Setting Description
EasyAccess Global: Supports push notification features of Wechat,
Facebook, and Line.

Server ’

China: Supports push notification features of WeChat only.

Push Notification Settings

After downloading the project file to HMI, the QR code will be shown on HMI screen. For more

13-307

information on setting up push notifications in WeChat, Facebook, and LINE, please refer to the

link below (see version 2.8 and later).

https://support.ihmi.net/ea20/release-notes
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13.42.3. Barcode Scanner (Android Camera)
13.42.3.1. Overview

By connecting an Android device (smartphone/tablet) equipped with a camera to a cMT / cMT
X HMI using cMT Viewer installed on the Android device, the camera can be used to scan 1D or
2D barcodes.

13.42.3.2, Configuration

Click the Barcode Scanner icon on the toolbar or click [Objects] » [Barcodes] and then select

[Barcode Scanner]. Configure the parameters and click OK; a Barcode Scanner object will be
created.

General Tab
Barcode Scanner (Android Camera) Object's Properties @
General | Security | Profile
Comment :
Control address
PLC : [LocalHMI v] Seftings...
Address : [LW v|0 7
Command : LW-0
(0 :none, 1 : start and cleax, 2 : stop, 3 : clear )
Execution status : LW-1
(0 :none, 1 : success, 2 or more : exroxr code )
Dsta length : LW-2
Status address
PLC: [Local HMI v [ Settins...
Address : [LB v} 0 [ '
Camera Status : LB-0
(0:off,1:0n)
Running Status : LB-1
(0 : stopped, 1 : scanning )
Barcode address
PLC : [Local HMI v [ Settines...
Address : [LW «| 10 ‘ 20words)
[V] Use Unicode
Read byte limit
[V] Enable Limit: {0 4 Bytes
o) o
Setting Description
Control address Control address: Gives Command to Barcode
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Scanner.

0: None

1: Start and Clear

2: Stop

3: Clear

Control address + 1: Shows Execution Status.
0: None

1: Success

2 or more: Error Code

Control address + 2: Shows data length scanned.

Status address

Status address: Shows camera status is On / Off.
0: Off

1: On

Status address + 1: Shows whether scanning is
ready.

0: Stopped

1: Ready for scanning

Barcode address

The address that stores the data read, UNICODE is

allowed.

Read byte limit

If the data read exceeds this setting, the execution

status turns to 2 (error code).

L—| WE!NTEK
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Security Tab
Barcode Scanner (Android Camera) Object's Properties 1?[
[ General | Security | Profile |
Sound Library
Library Name Size
[Project] » 0 Beep 0k
{ OK ] [ Cancel
Sound
[¥] Enable Sound Libraxy... Sound Index : Default
Play
—]
Setting Description
Sound If Enable is selected, when data is read, a sound is

emitted. The supported sound file format is .wav.

@ Note

B Barcode Scanner is currently supported on cMT-SVR and cMT3151 models. Barcode
Scanner cannot be opened using simulation mode or cMT Viewer.

B Supports: EAN/UPC, Code 128, Code 39, Interleaved 2 of 5 and QR Code.

B On the device, if other applications are also using the camera, or the camera is locked,
cMT Viewer may not operate properly.

B |nthe project, when multiple cMT Viewer devices are connected, since the same address
is shared between the devices, the devices will simultaneously scan if they are displaying

the same window with Barcode Scanner.
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Example 1
The following demo project shows how to scan QR code using a tablet.

1. Atthe beginning, the display is dark.

Barcode Scanner with Android Camera

Control address

Command

Start Stop Clear

Execute Status
Length (in Byte)

Status address

Ccamera @D Scanning

Barcode address

Data [ I

o | !
Unicode o000 0000 Jf 0000 | 0ooo | oooo | --

2. Tap Start button, the status of Scanning turns ON, the display turns bright, and is ready for

scanning.

Barcode Scanner with Android Camera

PR N SRee s g g AR
P — e Control address

=
, Scarwm wit Arciowd Camerd Command

ontrol aa3Tss

Start Stop Clear

Execute Status
Length (in Byte)

Status address

camera @D scanning €D

Barcode address

Data [ ]

o | !
Unicode 0000 0000 Jf 0000 | oooo | oooo | --

3. When a QR code is read, the Execute Status turns 1, and the QR code is captured, its
content will be displayed in Barcode Address group box. Unicode is also supported.
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Barcode Scanner with Android Camera

Control address

Command

Start Stop Clear

Execute Status
Length (in Byte)

Status address

Camera @D Scanning

Barcode address

Data ?Jeintek ]

Data iNelmek ]
Unicode 0957 J0o65 || o069 | oose | oo7a | --

4. If the size of the data read exceeds the maximum allowable size set in Read Byte Limit (10
bytes in this project), the Execution Status turns to 2 (error code). The exceeding part will
still be displayed in the ASCII objects in Barcode Address group box, since the data length
displayed depends on the ASCII object settings (20 words in this project).

Barcode Scanner with Android Camera

Control address

Command

Start Stop Clear

Execute Status
Length (in Byte)

Status address

Camera @D Scanning

Barcode address

Data barcode scanner ]

Data barcode scanner ]

Unicode 5067 Jloo61 | 0072 | 0063 | ooeF | -

5. After changing to another page, Scanning turns OFF, the parameters are reserved. The
parameters will be cleared when next time Start button is tapped, or Clear button is

tapped.
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Barcode Scanner with Android Camera

Control address

Command

Start Stop Clear

Execute Status
Length (in Byte)

Status address

Ccamera @D Scanning

Barcode address

Data barcode scanner ]

Data barcode scanner ]

Unicode o062 | 0061 | 0072 | 0063 | ooerF | --

13-313

=4 Click the icon to download the demo project. Please confirm your internet connection before

downloading the demo project.
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13.43. String Table

13.43.1. Overview

13-314

By pre-configuring the texts and their corresponding numbers in the String Table, the text can

be changed dynamically on HMI. String Table can also be used in a multi-language

environment.

13.43.2. Configuration

Click [Project] » [String] to open the property dialog box. Set up the properties, press OK
button, and a new String Table object will be created.

String Table
Section
([zD:000] Digits vJ[ Newsection || Delete Section
Description : Digits
String Table
String ID Langvage 1 Language 2 :ang\!age 3 Language 4 Langvage 5 Language 6 Langvage 7 Langvage 8
i 2 i T
2 3 three 2
5 Delete [ exportcsvrie.. |[ ImportcsvFie.. |
Copy [ Export EXCEL Fie... | [ Import EXCEL Fie... |
[ 0K H Cancel H Help }
Setting Description
Section A list of all the existing String Tables.
[New Section] Add a new String Table.
[Delete Section] Delete the selected String Table.
New Add a new string in the table.
Settings Set the content of the selected string.
Export CSV File... Export all the existing String Tables as a *.csv file.
Import CSV File... Import *.csv file into the String Table.
Export EXCEL File... Export all the existing String Tables as a *.xls file.
Import EXCEL File... Import *.xIs file into the String Table.

@ Note

B The font of each language in the String Table must be specified in Label Text Library.
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B Number of rows from all sections combined is limited to 10000.

Example 1

1. Create a String Table using the same settings as the preceding figure.

2. Create a Text object, select [Use string table] check box. In String ID group box, select

[Dynamic] and set read address to LW-0.

"

New Text Object @
Text | Security |

Use label library | Label Libraxy... |

V| Use string table String Table... '

Section : | [1D:000] Digits v
String ID
V| Dymamic
PLC : Local HMI v |[ Seftings.. |
Address ’LW -1 0 16-bit Unsigned

3. Create a Numeric object, set address to LW-0.
4. When the value in LW-0 is 0, the No. 0 string is displayed; when the value in LW-0 is 1, the

No. 1 string is displayed.
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13.44. Database

13.44.1. Database Server
13.44.1.1. Overview

Database Server object enables connection with MySQL or MS SQL database server, allowing
users to send data log or event log to the database, or use SQL Query to access data from the

database.

13.44.1.2. Configuration

Click the Database Server icon on the toolbar to create a Database Server object. Or, click

[Data/History] » [Database Server] in the menu.

Mew... ” Delete “ Settings...
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General Tab
New Database Server Object @
General | TLSASL | StatusiControl |
Comment :
;| 192 168 . 1 0
Port: 3306 5 *Default portof MySQL is 3306
Username : user
Password: O OOOGOOO ®
Database name : database
Customize timeout
[¥] Enable
Connect timeout : 10 S second(s)
Read timeout: 10 +| second(s)
Write timeout: 10 +| second(s)
) o) ()
Setting Description

Server system

Supported server systems: MySQL, MS SQL Server

IP

Enter the IP address of the database.

Use domain name

Domain name

127001

Supports designating a server using a domain name.

Use server name

Server system : | MS SQL Server v
Use server name v | e.g. HOSTWQLEXPRESS

Server name : PC_NAMEUNSTANCE_NAME

This option is only available when the selected server

system is MS SQL Server. An instance stands for a

communication port number, and the port number can

be used to identify multiple database servers on the

same computer.

A server name can be in one of the following formats.

<Computer name>\<Instance name>
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® <Computer name> (Connect to Default Instance :
MSSQLSERVER)
® <P address>\<Instance name>
® <|P address> (Connect to Default Instance :
MSSQLSERVER)
Port Enter the port number of the database.
Username Enter the username for connecting the database.
The maximum is 32 words.
Password Enter the password for connecting the database.

The maximum is 32 words.

Database name

Enter the name of the database for collecting historical
data.

Customize timeout

Timeouts for the following operations can be customized.
Connect timeout

The timeout for connection attempts. Connection
attempts will be terminated when the timeout is
reached.

Read timeout

The timeout for read operations.

Write timeout

The timeout for write operations.

13-318
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TLS/SSL Tab

New Database Server Object

[ General | TLSSSL | StatusiControl|

[V] Enable

Sosion

[V] Server verification

Use certificate on HMI first (if existed). Otherwise, vse imponrted files below
CA certificate : None

[¥] Server name must match certificate’s information

[ OK ][ Cancel H Help

Setting

Description

Enable

Enable TLS/SSL security. TLS version can be selected
from: TLS 1.0, TLS 1.1, and TLS 1.2.

Server verification

Enable

Verify whether the server certificate is signed by CA
(certificate authority) certificate. Server certificate is
sent from server during connection.

Server name must match certificate’s information
Verify whether the server’s domain name or IP
matches the records in the server certificate.
Domain name and IP records are stored in Subject

Alternative Name of the certificate.
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Status/Control Tab

13-320

New Database Server Object

| General | TLSASL | StatusiControl |

Status address

Device : |Local HMI

Address: LW v |0

v][ Settings...

Status : LW-0
(0 : stopped, 1 : disconnected, 2 : connected )
Error : LW-1

(0 :none, 1 or more : error )

Control address
[V] Enable

Device : |Local HMI

Address: |LW v 0

|  Seftings..

Command : LW-0
(0 :none, 1 : start, 2 : stop, 3 : vpdate )
IP - LW-1 {4 words)
Port: LW-5
Username : LW-6 {16 words)
Password : LW-22 {16 words)
Database name : LW-38 {16 words)

[ OK ][ Cancel H

Help

Setting Description
Status address LW-n: Displays the connection status of Database
Server.
Value Description
0 Not attempting to connect to
database.
1 Failed to connect to database.
2 Connection succeeded.
LW-n+1: Error indicator.
Value Description
0 No error.
1 Unknown error.
2 Failed to connect to database.
3 Database blocks the
unauthorized connection.
4 Incorrect database name.
5 Invalid domain name.
Control address LW-n: Controls the operation of Database Server.
Value Description
0 Ready
1 Start
2 Stop
3 Update
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LW-n+1: Sets the IP address of the database.

LW-n+5: Sets the port number of the database.
LW-n+6: Sets the username for connecting database.
LW-n+22: Sets the password for connecting database.
LW-n+38: Sets the name of the database for collecting
historical data.

@ Note

B If sampled data is successfully synchronized to the SQL database, three tables will be
generated in the database, and the sampled data is saved in *_data table.

Table Description

<HMI NAME> <DATALOG NAME> data Saves data sampling
<HMI NAME> <DATALOG NAME> data_format System folder

<HMI NAME> <DATALOG NAME> data_section System folder

B When synchronizing event log, the three tables generated in the database are listed as the

following table, and the event log is saved in *_event table.

Table Description
<HMI NAME> event Saves event log
<HMI NAME> event log System folder
<HMI NAME> event_update_time System folder

B If the content of data sampling / event log, such as data format or event message, is
changed and downloaded to HMI, please delete the tables listed above first, and then the
new content will thus be effective.

B Azure SQL Server is supported. To use Azure SQL Server, select MS SQL as server system
and use domain name. Azure SQL Server has firewall settings, please add the client into
whitelist, and see how to configure by opening the link below:
https://docs.microsoft.com/en-us/azure/azure-sql/database/single-database-manage#tma

nage-an-existing-server

Example 1
1. Create a Database Server object, set Status Address to LW-0, and Control Address to
LW-10.
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Database Server
[ General | StatusiControl
Status address

PLC : [Local HM

1

vlLSeﬂings.,,

Status

Eror

Control address
[V]Enable

:LW-0

(0 : stopped, 1 : disconnected, 2 : connected )

(LW-1

(0 :none, 1 or more : exror )

PLC : [Local HM

I 7Sl )

Address: Ly v |10

Command

i

Port
TUsemame
Password

Database name

:LW-10
(0 :none, 1 : start, 2 : stop, 3 : update )
:LW-11 {4 words)
:LW-15
:LW-16 {16 words)
:LW-32 {16 words)
:LW-48 {16 words)

o]

=

2.

Control Address to LW-80, to update or clear HMI historical data.

Data Sampling Object

Comment :

Sampling mode

Hold address

(@ Time-based (©) Trigger-based [Z] Enable
Sampiing time interval : |1 second(s) =
Control address
Enable
Read address PLC: [Lud HMI ~|[ settings...
P Lol o scimasis] || i ® bitUnsgned

History files

Data Record Enable

Datalength : 1word(s) ey Datzioo

[Syne. to 5D card

|| Sync. to USE disk

Sync to database
Enable

[ pisplay history from database

Database :

1. 127.0.0.1

=

succeeded), and the error indicator LW-10 displays O (no error).

NAME>_<DATALOG NAME>_data.

Table Action Records @

[[] hostname_datalog_data E = i X g
[] hostname_datalog_data_format [ i #= f@ > 1
[7] hostname_datalog_data_section = J #F M@ X 0
3 table(s) Sum i

L—| WE!NTEK
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Create a Data Sampling object, in [Sync. to database] group box select [Enable], and set

If the database is successfully connected, the status indicator LW-0 displays 2 (connection

Write 2 in LW-80 (sync. data). Open SQL database, the data can be found in table <HMI

Type Collation Size  Overhead
MyISAM  uff8_unicode_ci 2.1 KB =
MyISAM  uff8_unicode_ci 2.0 KB =
MyISAM  utfé_unicode_ci 1.0 KIB -
MylSAM utf8_unicode_ci 5.2 KiB 0B

EasyBuilder Pro
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E Click the icon to watch the demonstration film. Please confirm your internet connection before
playing the film.
i- Click the icon to download the demo project. Please confirm your internet connection before

downloading the demo project.
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13.44.2. SQL Query
13.44.2.1, Overview

SQL Query can exchange data with SQL database. Before enabling SQL Query, please configure

Database Server.

13.44.2.2, Configuration

b,
Click [Data/History] » [SQL Query] to open the settings dialog box. Configure the parameters
and click OK; a SQL Query will be created.

General Tab
5QL Query =
Genera! [[] Advanced mode
Command Description : SQL query 1
Database : | Local
Position : | USE disk
File path : Device : [Local HMI - |[_settings...
Address : ’LW v | 100 20 word(s)
Table name : table_name
Schema
Device : |Local HMI ~|[settings...
Address : [LW |0
Name Description Primary key Address Address forma
IT‘ D @ LW-0 16-bit Unsigned
2 Name LW-1 String
-
4| 1 | r
[ New ] [ Delete * Primary key should be auto increment.
[ OK J [ Cancel
Setting Description
Advanced Mode Without [Advanced Mode] selected:

Click [New] to add a new row or click [Import from
server] to import an existing database.

With [Advanced Mode] selected:

Manually enter syntax in Command tab to control
MySQL/MS SQL database. Please note that returning
from Advanced Mode to General Mode is not
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possible.

Description

User’s description about this query.

Database

Select the source database to read from.

Local: The source database is the SQLite database

stored in a USB disk or SD card attached to HMI.
Click the icon to watch the demonstration film.

Please confirm your internet connection before

playing the film.

Remote: The source database is the designated

Database Server.

File path

Use [Static] or [Dynamic] directory for a local
database. When [Static] is selected, please enter the
directory in this dialog box. When [Dynamic] is
selected, please designate an address as the data
source for the file path.

Table name

Enter the name of this query table.

Schema

The data read from database will be filled into the
corresponding address specified in the schema.
Please manually set Address Format after reading
data.

0 Note
[}

A Primary Key should contain only numeric values.

B In MySQL, Auto Increment must be enabled for Primary Key.

Column Name
data

Datatype PK NM UQ B UM ZF | AI| G Default/Expression
INT(11) ] O
OO0 DOOO O

4|

1 3

Column Name:
Collation:

Comments:

I__| WE!NTEK

data

Table Default

Data Type:  INT(11)
Default:
Storage: Wirtual Stored
Primary Key Mot Null [ Unique
[ Binary [ unsigned [ Zero Fil

Auto Increment | [T Generated
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Command Tab
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SQL Query

General Control address
Command Device [Loal HMI ']&]

Address @ |LW | 300

[¥]: Customize length for error message;

Error message

o edwords |5

Command ID

Row selection
Status :
Error code :

Error message :

1 LwW-300
LwW-301
LwW-302
LW-303
LW-304 (64 words)

Command

CommandID Description

1 Create

2 Read

3 Update

4 Delete

oK ] ’ Cancel
Setting Description

Control address

Designate five consecutive registers to execute SQL
commands and show results. Of the results, the
length of error message can be customized.

Command

In standard mode (without checking Advanced mode
box), the four basic commands of SQL (Create, Read,
Update, and Delete) and their command ID are
shown.

¥

= Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.

13.44.2.3. Advanced Mode

In the Command table in Advanced Mode, [No. of arguments], [No. of outputs], and [Action]

columns can be found. Outputting multiple results to consecutive addresses at a time is

possible.
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sat quer =
EzEal Control address
Command Device : ’Loml HMI v] e
Address : [Lw ~| 100 | [Le-bit Unsigned

[] customize length for error message

Enable result count

Command 1D : LW-100

Row selection : Lw-101

Status @ LW-102

Error code © LW-103
Error message @ LW-104 (64 words)

No. of results @ LW-168

Command
CommandID Description MNo. of arguments No. of outputs Action i
1 Create 2 1] IMSERT IMTO [Table]([name], [age]) v... =
2 Read o 3 SELECT [id], [name], [age] FROM [Tabl... —
3 Update 3 o UPDATE [Table] SET [name] = '${2}', [a...
New... ] [ Delete ] ’ Settings... ] ’ Copy Paste
[ ok ][ cancel
Setting Description
Control address Specify the ID number used to give this command.
Row selection Specify a row.
Status Displays the execution status. See Ch13.44.2.4.
Error code Displays the execution result. See Ch13.44.2.5.
Error message Displays the error message sent from database
server. The default length of the error message is 64
words. Customizing the length of the error message
is also possible, and the upper limit is 200 words.
No. of results Displays the number of output results.
New / Delete /
i Add, delete, set, or copy a SQL Query command.
Settings / Copy
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Query Tab
SQL Query Command @
Query CommandID: 5 =
SmEmens Description :  Update
S5QL Query: Update country SET Name = '${2}', Continent = '${3}, Surfacefrea = "${4}', F
4 | i | 3
Discard result
oK ] [ Cancel
Setting Description
Command ID Specify the ID number used to give this command.
Description Enter the description of this command.
SQL Query Enter the syntax for this command. An argument
should be enclosed in braces: S{argument no.}
Discard result With this checkbox selected, the result of executing

this command will not be shown in SQL Query Result
Viewer object. This checkbox can be selected for
commands that are done directly to the database
without the need for returning a result, such as
INSERT INTO, UPDATE, DELETE...etc.
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Argument Tab

SQL Query Command

Ul
LEY PLC name Address
Argument
1| Local HMI | LW-300
2 Local HMI LW-328
3 Local HMI LwW-338
4 Local HMI LW-340

5 Local HMI LW-342

& Local HMI Lw-344

Address format
String (2)
string (10)
32-bit Float
32-bit Unsigned
32-bit Float

String

][ Delete ][ Settings..

If argument is used in the syntax of a command in [Query] tab, the system will refer to the

address specified in this tab according to the argument number enclosed in S{argument no.}.

Output Tab

After reading database under Advanced Mode, the result will be stored in the addresses

specified in this tab. Selecting [Multiple results] option can output multiple query results to

consecutive addresses at a time.
[Multiple results] not selected

[Multiple results] selected

13-329

$QL Query Command == SQL Query Command ==
uer o
Sy PLC name Address Address format Multiple results 7
HLD(EIHM] LW-300 String (2) Bulk address
output Device : [Logal HMI e[
P 2 Logal HMI LW-302 String (26) l o ]
Address : |LW - | 200
3 Local HMI LW-328  String (10)
Results.
4 Local HMI LW-338 32-bit Float Maximum number of results : 2
5 Local HMI LW-340 32-bit Unsigned * Number of words in a result: 11 words
Nam * If the address of the output of the first result is LW-200 and the number of words in a result is OFFSET, the
& Local HMI LW-342 32-bit Float ‘address of the output of the Nth result is LW-200+OFFSET*N
7 | osal HMI | L-344 | string - Show the addresses of the Nth results: 1% L
(The Address column of the following table shows the output address of the Nth result)
PLCname Address Addressformat Word Length
mmes\ HMI LW-200 String (10) 10
2 Local HMI LW-210 16-bit Unsigned 1
-
o) o) i) -
e
Setting Description

Bulk address

Designate the start address for bulk output of
results. The upper limit of data records is 10000
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(maximum number of results x number of columns).

Maximum number The upper limit is 1000 results. Suppose maximum
of results number of results is set to 100, and the returned
number of query results is 300, then:
When [Row selection] is set to 20, the 20th~119th
results are output to bulk addresses.
When [Row selection] is set to 260, the 260t~299th
results are output to bulk addresses.
Show the Shows the output address of the N* result in the
addresses of the Address column of the table below this setting.
Nth results If the address of the output of the first result is

LW-200 and the number of words in a result is
OFFSET, the address of the output of the N result is
LW-200+OFFSET*N.

¥

4 Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.

13.44.2.4. Status

Value Meaning

0 Normal

1 Query result exceeds 1000 records. Using LIMIT clause can
constrain the number of rows in one page.

13.44.2.5. Error Code

Error Code Meaning

0 No mistakes

1 Unknown error

2 Invalid command

3 Database Server is not connected yet

4 Argument cannot be read

5 Cannot write and output

6 Incorrect number of arguments

7 Error in MySQL, please read error message
8 Unsupported datatype

9 Number of columns exceeds the limit
10 Number of rows exceeds the limit

11 Unable to read local database directory
12 Name of local database does not exist
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13

Internal error

13.44.2.6.

Converting Datatype

Converting datatype as shown in the following table will take place after reading MySQL

database. If conversion cannot run properly, error code 5 will show. For example, when

converting MySQL’s INT into EasyBuilder Pro’s 16-bit Unsigned, if the value exceeds the limit of

16-bit Unsigned, error code 5 will show.

MySQL data format EasyBuilder Pro datatype
TINYINT 16/32-bit BCD
SMALLINT 16/32-bit HEX
MEDIUMINT 16/32-bit Binary
INT 16/32-bit Signed
BIGINT 16/32-bit Unsigned
BIT

FLOAT 32-bit Float
DOUBLE

DECIMAL

DATETIME String

CHAR, BINARY

VARCHAR, VARBINARY
TINYBLOB, TINYTEXT

BLOB, TEXT

MEDIUMBLOB, MEDIUMTEXT
LONGBLOB, LONGTEXT
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13.44.3. SQL Query Result Viewer
13.44.3.1. Overview
SQL Query Result Viewer shows the results obtained by running SQL Query.

13.44.3.2. Configuration

a

Click on [Data/History] » [SQL Query Result Viewer] to open the settings dialog box. Configure
the parameters and click OK; a SQL Query Result Viewer will be created.

General Tab

' New SQL Query Result Viewer Object == \
Genersl [Secuity | Shape |
Comment :
saLquey:
soe:
Style Color: E}

Text

Font: [Arial [Arial] [Droid Sans] v

[¥] caption

Textsize: |16 v

[] Filter enabled

[ OK ] I Cancel Help

Setting Description

Comment User’s comment about this result viewer.

SQL Query Select an existing SQL Query to show its result.

Style/ Style Color Select a style and a color for this result viewer.

Text Set the font, font size, and font color for the texts
shown in this result viewer.
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Caption Set the font size and font color for the caption of this
result viewer.

Table This group box opens when selecting Default as
style. The attributes of the result query table can be
configured.

Filter enabled With this checkbox selected, entering keywords in
SQL Query Result Viewer to search for specific text is
possible.
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13.45. Dynamic Scale

13.45.1. Overview

Dynamic Scale offers customizable tick marks and scale labels and can be used together with
objects such as Trend Display, Bar Graph..., etc.

13.45.2. Configuration

B

Click the Dynamic Scale icon on the toolbar to open a Dynamic Scale object property dialog box.

Set up the properties, press OK button, and a new Dynamic Scale object will be created.

General Tab
New Dynamic Scale Object (=234
General
s
Tick Mark | Scale Label
Color : I:E Radius : - D
Main scale
Sub scale
et gt ———{]
(o« J[ conce
Setting Description
Style Select the style from [Circular], [Horizontal], or [Vertical]. If select

[Circular], set the [Direction] and [Degree].
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Degree (&
Direction
@ Clockwise () Counterdockwise
Degree
[¥]Full drde
Start: 0
[ o ][ cancl
Direction

Select from [Clockwise] or [Counterclockwise].

Degree

If [Full circle] is selected, set the start degree.

If [Full circle] is not selected, set the start and end degree.

Degree

Tick Mark Select the color of the tick mark, and set the number of ticks for the
main and sub scale (major and minor tick mark).
For [Circular] style, the length of the major and minor tick mark, and
the radius of the circular tick mark can be set.

Scale Label Displays major tick labels.
Circular
New Dynamic Scale Object @
General
s
Seale Label
Use scale label
Font : [Arial v]
Color E Size :

Right decimal Pt. : ¢ EI
Radius : - D

[ bynamic limits

Min.: 0 Max. : 100

[ o« J[ canea |

Set the font, font color, font size, and decimal point of the scale
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label.

Set the radius start from the center of the object to the position to
place the scale label.

Virtical / Horizontal

Mew Dynamic Scale Object @

Cremeral

Tick Magk | Scale Label

Use scale label
Font : [Arial v]
Left decimal Pt. : 4 = Right decimal Pt. : g =
[ oyniamic limits
Top: 0 Bottom : 100
o) Lo

Set the font, font color, font size, and decimal point of the scale
label.
Set the position to display the scale label.

The Max. and Min. limits of the scale label can be specified. If
[Dynamic limits] is selected, the Max. and Min. limits can be set by
the designated word addresses.

Min, : Max., LW-0 +1
PLC : | Local HMI - |[ Settings...
Address : [Lw v] i | |1E-bit Unsigned

¥

4 Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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13.46. Dynamic Drawing

13.46.1. Overview

Dynamic Drawing object enables drawing a shape in a specified region on HMI screen at run
time. The shape can be a line, a rectangle, a circle, or a dot. By setting the Attributes Addresses,

the style and the color of the shape can be customized.

13.46.2. Configuration

S
Click the Dynamic Drawing icon on the toolbar to open a Dynamic Drawing object property

dialog box. Set up the properties, press OK button, and a new Dynamic Drawing object will be

created.
General Tab
New Dynamic Drawing Object @
General i Color
Clear address
PLC: Local HMI v [ Settings...
Address [LB v] 0 i
Attributes address
PLC : (Local HMI v |[Settings...
Address : [LW v|0
LW-0 shape
0: none, 1: line, 2: rectangle, 3: circle, 4: dot
5: ellipse, 6: ellipse from rectangle
7: arc, 8: pie, 21: move origin
LW-1 armow/shape style { more )
LW-2 line/fill style { fore ¥
LW-3 inner color
L W-4 interior pattern color {rectangle, circle)
LW-5x1
LW-6y1
LW-7 %2 {radius of circle, are, pie), 1< {ellipse)
LW-8 y2, ry (ellipse), start dezree (arc, pie)
LW-9end degree (arc, pie)
* (xl1, y1) : start point (line, rectangle ellipse from rectangle)
center (circle, ellipse, arc, pie)
origin position relative to left-top comer {(move origin)
*(x2, ¥2) : end point {line, rectangle)
width and height {ellipse from rectangle)
[ ok ][ concel | Help
Setting Description
Clear Address Clears the drawing.
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Attributes Address Changes the attributes in the drawing.

Entering different values in different Attributes Addresses brings different effects, as shown in

the following table.

Attributes Attributes Attributes Attributes Attributes Attributes
Address Address+0 Address+1 Address+2 Address+3 Address+4
Default 0 Ones Tens Customizable Customizable
0: Non-arrow 0: Small 0: Solid line
1: Single-ended arrow (Hollow) | 1: Large 1: Dashed line
2: Double-ended arrow (Hollow) 2: Dotted line
Line 1 3: Single-ended arrow (Solid) 3: Dash Dot line Line color
4: Double-ended arrow (Solid) 4: Dash Dot Dot line
5 and up: Solid line
with thicknesses greater
than 2
0: Hollow Drawn in Line mode Interior pattern
Rectangle 2 Rectangle color
1: Solid Drawn in Pattern mode color
0: Hollow Drawn in Line mode Interior pattern
Circle 3 Circle color
1: Solid Drawn in Pattern mode color
Dot 4 Dot color
0: Hollow Drawn in Line mode Interior pattern
Ellipse 5 Ellipse color
1: Solid Drawn in Pattern mode color
Ellipse from 0: Hollow Drawn in Line mode Interior pattern
6 Ellipse color
Rectangle 1: Solid Drawn in Pattern mode color
Arc 7 Drawn in Line mode Arc color
0: Hollow Drawn in Line mode Interior pattern
Pie 8 Pie color
1: Solid Drawn in Pattern mode color
Move Origin 21
Attributes Attributes Attributes Attributes Attributes Attributes Attributes
Address Address+0 Address+5 Address+6 Address+7 Address+8 Address+9
Default 0
Line 1 Start point X Start point Y End point X End point Y
Right-bottom point | Right-bottom point
Rectangle 2 Left-top point X Left-top point Y
X Y
Circle 8 Center point X Center point Y Radius
Dot 4 Dot X Dot Y
Ellipse 5 Center point X Center point Y Radius on the X Radius on the Y
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axis axis
Ellipse from
6 Left-top point X Left-top point Y Width Height
Rectangle
Arc 7 Center point X Center point Y Radius Start degree End degree
Pie 8 Center point X Center point Y Radius Start degree End degree
Move Origin 21 New origin X New origin Y

The values in [Attributes Address+2] represent different Line or Pattern styles, as shown in the

following table.

Line mode

Pattern mode

0N | i v |

28] [21] [22] 23]
E& [25] 28
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Color Tab

Dynamic Drawing Object's Properties

| Genersl | Color | Profile |

=
o

Color

1 000000
] sttt
O] o010
[ c0cc0
W 777
[ 2080t
I £t0000
[ £t£100
[ 20100

Delete

il

L= R R - R =

(o ][ cone

Setting Description

New Adds a color to be used in the drawing.

Delete Deletes the selected color.
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Example 1

The following demo project demonstrates how to dynamically draw an arrow or a circle on HMI

screen. To build the project, follow these steps:

1. Create a Dynamic Drawing object, set Clear Address to LB-0, and Attributes Address to
LW-0.

2. Create a Toggle Switch object, set address to LB-0, and select Toggle as switch style, for
clearing the drawing.

3. Create 10 Numeric objects, set addresses to LW-0~LW-9, for specifying the attributes in the
drawing.

4. Run simulation or download the project to HMI to see the result. By entering 1 in LW-0, a
line is drawn, and entering different values in LW-1~9 can change the style, the color, and

the position of the line.

Demo Project - Dynamic Drawing

-> Dynamically changing pattern on HMI! I 0000

Attribute

0: none, 1

Attributes + 2: line/fill style

Attributes + 3: inner color

Attributes + 4: inter attern color
(rectangle,circle,ellipse,fan)

Attributes + 5: X1

Attributes + 6:Y1

Attributes + 7: X2(circle/arc/fan radius),
Rx(ellipse)

Attributes + 8: Y2, Ry(
Start circl

ributes + 9: End circle(arc/fan)
T Attributes + 9: End circle(arc/fan)

5. Press Clear Pattern button, and enter 3 in LW-0, a circle is drawn, and entering different

values in LW-1~9 can change the style, the color, and the position of the circle.
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Demo Project - Dynamic Drawing Attributes + 0: shape

: none, 1: line, 2: rectangle,

-> Dynamically changing pattern on HMI! I WOl 5 circle, 4: dot, 5: ellipse,

6: ellipse from rectangle,
7: arc, 8: fan, 21: reset start

Attributes + 1: arrow/shape style

Attributes + 2: line/fill style

Attributes + 3: inner color

Attributes + 4: interior pattern color
(rectangle,circle ellipse, fan)

Attributes + 5: X1

Attributes + 6:Y1

Attributes + 7: X2(circle/arc/fan radius),
Rx(ellips

Attributes + 8: Y2, Ry(ellipse),
Start circle(arc/fan)

ibutes + 9: End circle(arc/fan)
Fast Sel Attributes + 9: End circle(arc/fan)

@ Note

¥

B

Before using Attributes Addres